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0003 1. Überblick

Name und Funktion der Teile
Stromversorgung

2 31 4 5

6

1.	 Schalter LIGHT (Videoleuchte)
Mit diesem Schalter wird festgelegt, wie eine an 
den Anschluss LIGHT (Seite 4) angeschlossene 
Videoleuchte ein- und ausgeschaltet wird.
AUTO: Wenn der Schalter POWER der Videoleuchte 

eingeschaltet ist, schaltet sich die Videoleuchte 
automatisch ein, sobald der Camcorder 
aufzeichnet.

MANUAL: Die Videoleuchte kann mit ihrem 
Schalter auch ein- oder ausgeschaltet werden.

[Hinweis]
Wenn der Camcorder für die Aufzeichnung im Bildpuffer-
Aufzeichnungsmodus eingestellt ist, kann das Licht nicht 
eingeschaltet werden, solange nicht der Bedienvorgang zum 
Beginnen der Aufzeichnung ausgeführt worden ist (oder 
während Daten im Speicher abgelegt werden).

2.	 Schalter POWER
Mit diesem Schalter wird der Strom ein- () und 
ausgeschaltet ().

3.	 Anschluss DC IN (DC-Stromanschluss) (XLR, 
4-polig, Stecker)

4.	 Anschluss DC OUT 12V 
(Gleichstromversorgung, 4-polig, Buchse)

Stromversorgung für einen optionalen UHF-

Diversity-Tuner WRR-855S/860C/861/862 oder 
Sucher HDVF-L750 (maximal 1,8 A).

5.	 Aufsteckschuh für die Batterie
Legen Sie einen Akkusatz BP-FLX75 ein. Außerdem 
können Sie den Camcorder auch mit einem 
AC-Adapter AC-DN2B/DN10 über das Stromnetz 
versorgen.

„Vorbereitung der Stromversorgung“ (Seite 23)

[Hinweis]
Aus Sicherheitsgründen und zur Sicherstellung eines 
korrekten Betriebs des Camcorders empfiehlt Sony die 
Verwendung des Akkusatzes BP-FLX75.

6.	 Anschluss für Kamera-Adapter
Zum Anschluss eines HD-Kameraadapters CA-
TX70/FB70. Entfernen Sie zum Anschließen eines 
Adapters die Abdeckung.
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Weiteres Zubehör
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1.	 Steckplatz für drahtlosen Empfänger 
(Seite 30)

„Anbringen eines drahtlosen Empfängers“ (Seite 30)

2.	 Schulterriemenhalter (Seite 31)

3.	 Zubehörschuh (Seite 31)

4.	 Längsrichtungs-Fixierhebel des Suchers 
(Seite 25)

5.	 Querrichtungs-Fixierring des Suchers 
(Seite 24)

6.	 Sucheraufsteckschuh (Seite 24)

7.	 Anschlüsse VF (Sucher) (26-polig, rechteckig 
und 20-polig, rund)

Der analoge Schnittstellenanschluss (20-polig) ist 
für den Anschluss eines Suchers der HDVF-Serie, 
und der digitale Schnittstellenanschluss (26-polig) 
für den Anschluss eines HD-Suchers CBK-VF02 
vorgesehen.
Schließen Sie ein Sucher-Verbindungskabel an 
den mit dem verwendeten Sucher kompatiblen 
Anschluss an.

[Hinweise]
ˎˎ Verbinden Sie nicht mehrere Sucher gleichzeitig mit 

beiden Anschlüssen.

ˎˎ Schalten Sie den Camcorder zuerst aus, bevor Sie ein 
Schnittstellenkabel mit diesem Anschluss verbinden oder 
von ihm trennen.

8.	 Objektivsicherungsgummi
Ziehen Sie nach dem Verschluss des Objektivs mit 
dem Objektivfeststellhebel diesen Gummi über 
den unteren der beiden Vorsprünge. Dadurch wird 
die Fassung des Objektivs gesichert, so dass sich 
dieses nicht lockern kann.

9.	 Längsrichtungs-Fixierknopf des Suchers 
(Seite 24)

10.	 Anschluss für optionalen Mikrofonhalter 
(Seite 30)

11.	 Anschluss LIGHT (Videoleuchte) (2-polig, 
Buchse) (Seite 31)

12.	 Schulterpolster (Seite 31)

13.	 Objektivkabelklemme
Zum Einklemmen des Objektivkabels.

14.	 Anschluss MIC IN (Mikrofoneingang) (+48 V) 
(XLR, 5-polig, Buchse)

Anschluss eines Stereomikrofons an diesem 
Anschluss. Die Stromversorgung (+48 V) erfolgt 
über diesen Anschluss.

15.	 Anschluss LENS (12-polig) (Seite 28)

[Hinweis]
Wenn Sie das Objektivkabel an diesen Anschluss anschließen 
oder davon trennen, schalten Sie bitte zuerst den Camcorder 
aus.

16.	 Stativbefestigung
Bringen Sie den Stativaufsatz (optional) an, wenn 
Sie den Camcorder mit einem Stativ verwenden.

17.	 Objektivhalterung (spezielle 
Bajonetthalterung) (Seite 28)

18.	 Objektivfeststellhebel (Seite 28)

19.	 Objektivanschlusskappe
Nehmen Sie diese ab, indem Sie den 
Objektivfeststellhebel nach oben drücken. Wenn 
kein Objektiv angebracht ist, dient diese montierte 
Kappe als Staubschutz.

Bedienelemente in die Nähe des 
Objektivs

1

3

4
5

62

1.	 Taste REC START (Aufzeichnungsstart)
Drücken Sie diese Taste, um mit der Aufzeichnung 
zu beginnen. Durch erneutes Drücken wird die 
Aufzeichnung gestoppt. Die Taste VTR am Objektiv 
hat die gleiche Funktion.

2.	 Schalter SHUTTER
Stellen Sie diesen Schalter auf ON, um die 
elektronische Blende zu verwenden. Drücken Sie 
den Schalter zu SELECT hin, um die Einstellung 
der Belichtungszeit oder des Blendenmodus 
zu ändern. Wenn dieser Schalter bedient wird, 
erscheint die neue Einstellung etwa drei Sekunden 
lang auf der Sucheranzeige.

„Einstellung der elektronischen Blende“ (Seite 42)
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[Hinweis]
Wenn die Funktion „Flash Band Reduce“ aktiviert ist und 
der Schalter SHUTTER auf ON gestellt wird, wird Funktion 
„Flash Band Reduce“ deaktiviert und die Anzeige „FBR“ in 
der Sucheranzeige wird ausgeblendet. Wenn der Schalter 
SHUTTER danach auf OFF gestellt wird, wird Funktion 
„Flash Band Reduce“ aktiviert und die Anzeige „FBR“ in der 
Sucheranzeige wird wieder eingeblendet.

3.	 FILTER-Regler
Schaltet zwischen vier in diesem Camcorder 
integrierten ND-Filtern um.

Wenn dieser Wahlschalter verwendet wird, 
erscheint die neue Einstellung etwa drei Sekunden 
lang auf der Sucheranzeige.

Einstellung 
des Reglers 
FILTER

ND-Filter

1 CLEAR

2 1/4 ND (dämpft das Licht auf 
ungefähr 1/4)

3 1/16 ND (dämpft das Licht auf 
ungefähr 1/16)

4 1/64 ND (dämpft das Licht auf 
ungefähr 1/64)

Sie können eine Einstellung im Menü 
„Maintenance“ so ändern, dass für verschiedene 
Positionen des Reglers FILTER verschiedene 
Weißabgleich-Einstellungen gespeichert 
werden. Dadurch kann man automatisch den 
besten Weißabgleich für die momentanen 
Aufnahmebedingungen in Verbindung mit der 
Filterwahl erzielen.

„Einstellung des Weißabgleichs“ (Seite 40)

4.	 Regler MENU (Seite 92)

5.	 Schalter AUTO W/B BAL (automatische 
Einstellung des Schwarz-/Weißwertes)

Aktiviert die Funktion für den automatischen 
Schwarz-/Weißabgleich.
WHITE: Automatischer Weißabgleich. Wenn der 

Schalter WHITE BAL (Seite 6) auf A oder B 
steht, wird der Weißwert im entsprechenden 
Speicher gespeichert. Wenn der Schalter 
WHITE BAL auf PRST steht, ist die automatische 
Weißabgleichsfunktion deaktiviert.

BLACK: Automatische Schwarzeinstellung und 
automatischer Schwarzabgleich.

Sie können den Schalter AUTO W/B BAL auch 
verwenden, wenn die Funktion ATW (Auto Tracing 
White Balance) aktiv ist.
Wenn Sie den Schalter während der 
automatischen Einstellung des Weißabgleichs 
zur Seite WHITE drücken, wird die Einstellung 
abgebrochen und der Weißabgleich kehrt zu der 
ursprünglichen Einstellung zurück.
Wenn Sie den Schalter während der 
automatischen Einstellung des Schwarzabgleichs 
zur Seite BLACK drücken, wird die Einstellung 
abgebrochen und der Schwarzabgleich kehrt zu 
der ursprünglichen Einstellung zurück.

6.	 Regler MIC LEVEL (Mikrofon) (Seite 46)

LCD-Monitor-Seite (1)

6 7 8 9

21

10 12 12

13
14

11

3 4 5
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1.	 Belegbare Schalter ASSIGN. 1/2/3
Sie können im Konfigurationsmenü mit „Operation 
>Assignable“ Switch eine Funktion zuweisen 
(Seite 124).
Die Schalter ASSIGN. 1/3 sind mit einer Anzeige 
ausgestattet, um anzuzeigen, ob dem Schalter 
eine Funktion zugeteilt ist (ON) oder nicht (OFF).

2.	 Taste ONLINE
Wenn dieser Taste der Netzwerkclientmodus oder 
die Streaming-Funktion zugewiesen ist, halten Sie 
die Taste gedrückt, bis die LED orange leuchtet. 
Drücken Sie dann die Taste erneut, sodass die LED 
blau leuchtet, um den Netzwerkclientmodus oder 
die Streaming-Funktion zu aktivieren.
Um die Funktion zu deaktivieren, halten Sie die 
Taste gedrückt, bis die LED erlischt.
Diese Taste kann auch als belegbarer Schalter 
verwendet werden, wenn ihr andere als die oben 
aufgeführten Funktionen zugewiesen werden 
(Seite 125).

3.	 Regler ALARM (Einstellung der Lautstärke 
der Warntöne)

Mit diesem Regler wird die Lautstärke der 
Warntöne des eingebauten Lautsprechers oder 
optionalen Kopfhörers eingestellt. Wird der Regler 
auf die niedrigste Position eingestellt, kann man 
keinen Ton hören.
Steht jedoch „Maintenance >Audio >Min Alarm 
Volume“ im Konfigurationsmenü auf [Set], ist der 
Alarmton auch dann hörbar, wenn sich dieser 
Lautstärkeregler auf der niedrigsten Einstellung 
befindet.

ALARM

Minimal Maximal

4.	 Regler MONITOR (Einstellung der 
Monitorlautstärke)

Mit diesem Regler wird die Lautstärke von 
anderen Tönen als Warntönen des eingebauten 
Lautsprechers oder Kopfhörers eingestellt. Wird 
der Regler auf die niedrigste Position eingestellt, 
kann man keinen Ton hören.

5.	 Schalter MONITOR (Audiomonitor-Auswahl)
Mit der Kombination der beiden Schalter kann 
man den Ton wählen, den man über den 
eingebauten Lautsprecher oder den Kopfhörer 
hören möchte.

Wenn der untere Schalter auf CH-1/2 eingestellt ist

Oberer Schalter Audioausgabe
CH-1/CH-3 Audiokanal 1
MIX Audiokanal 1 und 2 gemischt 

(Stereo) a)

CH-2/CH-4 Audiokanal 2

Wenn der untere Schalter auf CH-3/4 eingestellt ist

Oberer Schalter Audioausgabe
CH-1/CH-3 Audiokanal 3
MIX Audiokanal 3 und 4 gemischt 

(Stereo) a)

CH-2/CH-4 Audiokanal 4
a)	� Durch den Anschluss von Stereokopfhörern an die 

Buchse EARPHONE können Sie den Ton in Stereo 
hören. („Maintenance >Audio >Headphone Out“ im 
Konfigurationsmenü muss auf „Stereo“ stehen.)

6.	 Belegbarer Schalter  ASSIGN. 0
Sie können im Konfigurationsmenü mit „Operation 
>Assignable“ Switch eine Funktion zuweisen 
(Seite 124).
Diesen Schaltern ist bei Auslieferung des 
Camcorders werkseitig Off zugewiesen.
Dies ist ein Pulsschalter. Bei jedem Drücken des 
Schalters wird die ihm zugewiesene Funktion an- 
oder ausgeschaltet.

7.	 Schalter GAIN
Wahl einer den Lichtverhältnissen entsprechenden 
Verstärkung durch den Videoverstärker. Die 
den Einstellungen L, M und H entsprechenden 
Verstärkungswerte können unter „Operation 
>Gain Switch“ im Konfigurationsmenü ausgewählt 
werden (Seite 101) (werkseitig ist L=0dB, M=6dB 
und H=12dB eingestellt).
Wenn dieser Schalter eingestellt wird, erscheint die 
neue Einstellung etwa drei Sekunden lang auf der 
Sucheranzeige.

8.	 Schalter OUTPUT/DCC (Ausgangssignal-/
dynamische Kontraststeuerung)

Schaltet den Videosignal-Ausgang des 
Kameramoduls zwischen den folgenden beiden 
Optionen um.
BARS: Ausgabe des Farbbalkensignals.
CAM: Ausgabe des aufgezeichneten Videosignals. 

Ist dies ausgewählt, können Sie die DCC-
Funktion 1) ein- und ausschalten.

1)	� DCC (dynamische Kontraststeuerung) Wenn die 
Irisöffnung vor einem sehr hellen Hintergrund auf das 
Hauptmotiv eingestellt ist, gehen die Hintergrundmotive 
im grellen Licht verloren. Die DCC-Funktion unterdrückt 
die hohe Lichtintensität und stellt einen Großteil der 
verloren gegangenen Details wieder her. Diese Funktion 
ist in folgenden Fällen für Aufnahmen besonders effektiv:
ˎˎ Aufnahme von im Schatten stehenden Personen an 

einem sonnigen Tag
ˎˎ Innenaufnahme eines Motivs gegen ein Fenster im 

Hintergrund
ˎˎ Szenen mit starkem Kontrast

9.	 Schalter WHITE BAL (Weißwertspeicher)
Einstellung des Weißwerts.
PRST: Die Farbtemperatur wird auf den 

voreingestellten Wert gesetzt (werkseitig: 
3200K). Verwenden Sie diese Einstellung, wenn 
Sie keine Zeit zur Einstellung des Weißwerts 
haben.

A oder B: Ruft die in Speicher A oder B 
gespeicherten - Einstellungen für den 
Weißabgleich ab. Drücken Sie den Schalter 
AUTO W/B BAL (Seite 5) in die Stellung 
WHITE, um den Weißabgleich automatisch 
einzustellen, und speichern Sie die 
Einstellwerte in Speicher A oder Speicher B.

B (ATW 1)): Wenn dieser Schalter auf B steht und 
„Operation >White Setting >White Switch 
<B>“ im Konfigurationsmenü auf [ATW] steht, 
wird die ATW-Funktion aktiviert.  
Sie können den Schalter AUTO W/B BAL auch 
verwenden, wenn ATW aktiv ist.  
Wenn dieser Schalter eingestellt wird, 
erscheint die neue Einstellung etwa drei 
Sekunden lang auf der Sucheranzeige.

1)	� ATW (Automatische Weißwertanpassung): Der Weißwert 
des aufgenommenen Bildes wird automatisch auf 
verschiedene Lichtverhältnisse eingestellt.

[Hinweis]
Je nach den Beleuchtungs- und Motivbedingungen 
können mit der ATW-Funktion möglicherweise nicht die 
entsprechenden Farben eingestellt werden.
Beispiele:
ˎˎ Wenn eine einzelne Farbe das Motiv, wie z. B. Himmel, 

Meer, Boden oder Blumen, dominiert. 
ˎˎ Wenn das Motiv durch eine Lichtquelle mit einer extrem 

hohen oder extrem niedrigen Farbtemperatur beleuchtet 
wird. 

Falls die Ausführung der automatischen 
Einstellung durch die ATW-Funktion zu lange 
dauert oder zu einem unzureichenden Ergebnis 
führt, führen Sie die AWB-Funktion aus.

10.	 Schalterabdeckung
Öffnen Sie diesen Deckel, um den Schalter MENU 
ON/OFF oder den Schalter MENU CANCEL/PRST/
ESCAPE zu verwenden.

11.	 Schalter MENU ON/OFF
Öffnen Sie zur Verwendung des Schalters den 
Deckel.
Dieser Schalter dient zum Aufrufen des Menüs auf 
der Sucheranzeige oder dem Testsignalbildschirm. 
Mit jedem Herunterdrücken des Schalters wird der 
Menübildschirm ein- und ausgeschaltet.
Dieser Schalter hat dieselbe Funktion wie 
die Taste MENU auf dem Bedienfeld der 
Skizzenbilderanzeige.

[Hinweis]
Es ist nicht möglich, den Menübildschirm durch Schließen 
des Deckels auszuschalten.

12.	 Schalter MENU CANCEL/PRST 
(Voreinstellung) /ESCAPE

Öffnen Sie zur Verwendung des Schalters den 
Deckel.
Dieser Schalter hat unterschiedliche Funktionen, je 
nachdem, ob ein Menü angezeigt wird oder nicht.

Verwenden Sie den Schalter auf die folgende 
Weise, falls das Menü angezeigt wird.
CANCEL/PRST: Auf Hochdrücken dieses 

Schalters auf diese Position nach Änderung 
einer Einstellung im Konfigurationsmenü 
erscheint eine Meldung zur Bestätigung, ob 
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die vorherigen Einstellungen abgebrochen 
werden sollen. Auf das erneute Hochdrücken 
dieses Schalters auf diese Position werden die 
vorherigen Einstellungen abgebrochen.  
Auf Hochdrücken dieses Schalters auf 
diese Position, bevor eine Einstellung im 
Konfigurationsmenü geändert wurde oder 
nachdem eine Einstellungsänderung im 
Konfigurationsmenü abgebrochen wurde, 
erscheint eine Meldung zur Bestätigung, 
ob die Einstellung auf ihren Anfangswert 
zurückgesetzt werden soll. Auf das erneute 
Hochdrücken dieses Schalters auf diese 
Position werden die Einstellungen auf ihren 
Anfangswert zurückgesetzt.

ESCAPE: Verwenden Sie diesen Schalter, um die 
hierarchisch aufgebaute Menüseite zu öffnen. 
Mit jedem Drücken des Schalters auf diese 
Position geht die Seite in der Hierarchie eine 
Ebene höher.

Verwenden Sie den Schalter auf die folgende 
Weise, falls das Menü nicht angezeigt wird.
CANCEL/PRST: Mit jedem Hochdrücken 

dieses Schalters erscheint auf der 
Sucheranzeige ein Fenster zur Bestätigung 
der Menüeinstellungen und des Status des 
Camcorders (Seite 13). Das Fenster besteht 
aus mehreren Seiten, zwischen denen dann 
jedes Mal umgeschaltet wird.

ESCAPE: Möchten Sie die Seite ausblenden, 
drücken Sie diesen Schalter zur Position OFF 
herunter.

13.	 SD-Karteneinschub UTILITY
Legen Sie eine SD-Karte ein, um die Camcorder-
Einstellungen zu speichern.

14.	 Anzeige ACCESS
Leuchtet orange auf, wenn auf die SD-Karte 
zugegriffen wird.

LCD-Monitor-Seite (2)

1
2

7 8 9

3

5

4

6

13

10

14 15 16 17

[1]
[2]

11 12

1.	 Eingebauter Lautsprecher
Mit dem Lautsprecher können Sie während der 
Aufzeichnung den E-E 1)-Ton und während der 
Wiedergabe den Wiedergabeton überwachen. 
Über den Lautsprecher werden zur Unterstützung 
visueller Warnmeldungen auch Warntöne 
ausgegeben (Seite 146).
Wenn Sie einen Kopfhörer an den Anschluss 
EARPHONE anschließen, wird der Lautsprecher 
automatisch stumm geschaltet.
1)	� E-E: Abkürzung für „Elektrisch-zu-Elektrisch“-Betrieb. 

Im E-E-Modus werden eingespeiste Video- und 
Audiosignale ausgegeben, nachdem sie nur die internen 
Stromschaltkreise durchlaufen haben. Dadurch können 
Eingangssignale überprüft werden.

2.	 LCD-Monitor
Anzeige der verbleibenden Batteriekapazität, 
verbleibenden Medienkapazität, Audio-
Eingangspegel, Zeitdaten usw. Sie können damit 
auch Kamera- und Wiedergabebilder überprüfen 
(Seite 13).
Sie können Position und Winkel des LCD-Monitors 
einstellen.

3.	 Anzeige WARNING
Diese Anzeige leuchtet oder blinkt, wenn eine 
Störung erkannt wird (Seite 146).

4.	 Anzeige ACCESS
Leuchtet blau, wenn die Disc beschrieben oder 
vom Aufzeichnungsmedium gelesen wird.

5.	 Audiosteuerfeld (Seite 9)

6.	 Bedienfeld der Skizzenbilderanzeige 
(Seite 9)
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7.	 Taste und Anzeige F REV (schneller Rücklauf)
Zur schnellen Wiedergabe in Rückwärtsrichtung. 
Die Wiedergabegeschwindigkeit ändert sich mit 
jedem Tastendruck in der Reihenfolge ×4  
×15  ×24. Während der Wiedergabe bei hoher 
Geschwindigkeit in Rückwärtsrichtung leuchtet die 
Anzeige.

8.	 Taste und Anzeige PLAY/PAUSE
Drücken Sie diese Taste, um Videobilder auf 
der Sucheranzeige oder dem LCD-Monitor 
abzuspielen. Die Anzeige leuchtet während der 
Wiedergabe.
Drücken Sie diese Taste während der Wiedergabe 
erneut, um auf Pause oder Standbildausgabe 
zu gehen. Dabei blinkt die Anzeige einmal pro 
Sekunde.
Durch Drücken der Taste F REV oder F FWD 
während der Wiedergabe oder Pause wird 
die Wiedergabe bei hoher Geschwindigkeit in 
Vorwärts- oder Rückwärtsrichtung gestartet.

9.	 Taste und Anzeige F FWD (schneller Vorlauf)
Zur Wiedergabe bei hoher Geschwindigkeit in 
Vorwärtsrichtung. Die Wiedergabegeschwindigkeit 
ändert sich mit jedem Tastendruck in der 
Reihenfolge ×4  ×15  ×24. Während der 
Wiedergabe bei hoher Geschwindigkeit in 
Vorwärtsrichtung leuchtet die Anzeige.

10.	 Taste PREV (vorherig)
Sprung zum ersten Bild des aktuellen Clips.
Wird dies zusammen mit der Taste F REV 
gedrückt, wird zum ersten Bild des zuerst auf dem 
Aufzeichnungsmedium aufgezeichneten Clips 
gegangen.
Wenn Sie diese Taste zwei Mal hintereinander 
in schneller Abfolge drücken, wird zum ersten 
Bild des vorhergehenden Clips gegangen (oder 
zum ersten Bild des aktuellen Clips, falls kein 
vorhergehender Clip vorhanden ist).

11.	 Taste STOP
Drücken Sie diese Taste, um die Wiedergabe zu 
stoppen.

12.	 Taste NEXT
Sprung zum ersten Bild des nächsten Clips.
Wird dies zusammen mit der Taste F FWD 
gedrückt, wird zum letzten Bild des zuletzt auf 
dem Aufzeichnungsmedium aufgezeichneten 
Clips gegangen.

13.	 Taste DISP SEL (Anzeige)/EXPAND 
(Erweiterungsfunktion)

Mit jedem Tastendruck ändert sich die Anzeige des 
LCD-Monitors folgendermaßen.

Display-Anzeige Beschreibung
Videobild mit 
eingeblendeten 
Informationen 
(CHAR)

Der LCD-Monitor zeigt 
dieselben Textinformationen 
an wie der Sucher an.

Videobild ohne 
eingeblendete 
Informationen 
(MONI)

Nur das Videobild erscheint.

Statusanzeige 
(STATUS)
(Seite 13)

Zähleranzeigen, 
Warnmeldungen, 
Audiopegel und ähnliche 
Informationen werden 
angezeigt. Es erscheint kein 
Videobild.

Die Funktion der Taste EXPAND wird in einer 
zukünftigen Aktualisierung unterstützt.

14.	 Taste HOLD (Anzeige anhalten)
Durch Drücken dieser Taste werden auf der Stelle 
die Zeitdaten auf dem LCD-Monitor angehalten. 
(Der Zeitcodegenerator läuft dabei weiter.) Bei 
erneutem Drücken dieser Taste laufen die Daten 
weiter.

Weitere Einzelheiten zur Zeitdatenanzeige siehe Seite 13.

15.	 Taste RESET/RETURN
Setzt den auf der Zeitdatenanzeige des LCD-
Monitors angezeigten Wert zurück. Entsprechend 
den Einstellungen des Schalters PRESET/REGEN/
CLOCK (Seite 9) und des Schalters F-RUN/
SET/R-RUN (Seite 9) wird die Anzeige mit dieser 
Taste folgendermaßen zurückgesetzt:

Schaltereinstellungen Funktion der Taste RESET/
RETURN

Schalter DISPLAY:
COUNTER

Rücksetzen des Zählers auf 
00:00:00:00.

Schalter DISPLAY:
TC

Schalter PRESET/
REGEN/CLOCK:

PRESET
Schalter F-RUN/
SET/R-RUN:

SET

Rücksetzen des Zeitcodes 
auf 00:00:00:00.

Schalter DISPLAY:
U-BIT

Schalter PRESET/
REGEN/CLOCK:

PRESET
Schalter F-RUN/
SET/R-RUN:

SET

Rücksetzen der 
Benutzerbitdaten a) auf 
00:00:00:00.

a)	� Von den Zeitcodebits für jedes Bild, das auf der Disc 
aufgenommen wurde, sind dies diejenigen Bits, die zur 
Aufnahme nützlicher Informationen für den Benutzer wie 
Szenennummer, Aufnahmeort usw. verwendet werden 
können.

„Einstellung der Zeitdaten“ (Seite 48)

Wenn Sie diese Taste bei aufgerufener 
Skizzenbildschirmanzeige oder 
Skizzenbilderanzeige mit Inhaltsmarkierungen 
drücken, kehren Sie zum vorherigen Bildschirm 
zurück.

16.	 Schalter DISPLAY
Hiermit werden die Daten der Zeitdatenanzeige 
des LCD-Monitors in der Reihenfolge COUNTER, TC 
und U-BIT durchlaufen (Seite 13).
COUNTER: Anzeige des Zählers für die Aufnahme-/

Wiedergabedauer.
TC: Anzeige des Zeitcodes.
U-BIT: Anzeige der Benutzerbitdaten.

17.	 Taste BRIGHT (Helligkeit)
Einstellung der Hintergrundhelligkeit des LCD-
Monitors.
Bei jedem Tastendruck wird die nächste 
Einstellung in der auf der folgenden Abbildung 

dargestellten Reihenfolge gewählt. Falls Sie die 
Taste bei ausgeschaltetem LCD-Monitor drücken, 
geht das Hintergrundlicht des LCDs im Zustand 
H an.

Einstellen Hintergrundlicht des LCD Monitors

H Hoch (zur Betrachtung des LCD 
Monitors bei Tageslicht im Freien)

M Mittlere Helligkeit zwischen H und L

L Niedrig (zur Betrachtung des LCD 
Monitors in geschlossenen Räumen 
oder nachts im Freien)

OFF Aus (auch das Display ist ausgeschaltet)
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Skizzenbilderanzeige- und Audiosteuerfeld

1 2 3 5

8

6

9 1011 12

74

1.	 Anzeige THUMBNAIL
Leuchtet bei der Skizzenbilderanzeige auf.

2.	 Taste THUMBNAIL
Drücken Sie diese Taste, um die 
Skizzenbilderanzeige aufzurufen (Seite 83) und 
eine Skizzensuche vorzunehmen.
Drücken Sie die Taste erneut, um zur 
ursprünglichen Anzeige zurückzukehren.

3.	 SET-Taste und Pfeiltasten
Nehmen Sie mit diesen Tasten die Zeitcode- und 
Benutzerbiteinstellungen vor und verwenden Sie 
sie für die Funktionen der Skizzenbilderanzeige.
Drücken Sie diese Taste bei angezeigtem 
Menü, um einen Punkt zu wählen oder eine 
Einstellungsänderung zu bestätigen.

4.	 Taste MENU
Mit jedem Tastendruck wird die Anzeige des 
Konfigurationsmenüs ein- und ausgeschaltet.
Die Funktion dieser Taste ist dieselbe wie die des 
Schalters MENU ON/OFF.

5.	 Schalter F-RUN/SET/R-RUN (Freilauf/
Einstellung/Aufzeichnungslauf)

Hiermit wird der Betriebsmodus für den internen 

Zeitcodegenerator gewählt. Der Betriebsmodus 
wird abhängig von der Schalterposition 
folgendermaßen eingestellt.
F-RUN: Der Zeitcode läuft unabhängig davon, ob 

der Camcorder gerade etwas aufzeichnet, 
weiter. Verwenden Sie diese Einstellung, wenn 
Sie den Zeitcode mit einem externen Zeitcode 
synchronisieren.

SET: Einstellung des Zeitcodes und der Benutzerbit.
R-RUN: Der Zeitcode läuft nur während der 

Aufzeichnung. Diese Einstellung erzeugt 
einen fortlaufenden Zeitcode auf dem 
Aufzeichnungsmedium.

„Einstellung des Zeitcodes“ (Seite 48)

„Einstellung der Benutzerbits“ (Seite 48)

6.	 Regler LEVEL CH1/CH2/CH3/CH4 
(Aufzeichnungspegel Audiokanäle 1/2/3/4)

Wenn die Schalter AUDIO SELECT CH1/CH2 und 
AUDIO SELECT CH 3-4 auf MANUAL gestellt sind, 
können Sie mit diesen Reglern die Audiopegel für 
die Aufnahme auf Kanal 1, 2, 3 und 4 einstellen.

7.	 Schalter AUDIO SELECT CH 3-4 (Auswahl der 
Einstellungsmethode für Audiokanäle 3/4)

Wahl der Einstellungsmethode der Audiopegel für 
die Audiokanäle 3 und 4.
AUTO: Automatische Einstellung
MANUAL: Manuelle Einstellung

8.	 Taste ESSENCE MARK
Wenn Sie diese Taste drücken, während eine 
Skizzen-Anzeige auf dem Bildschirm angezeigt 
wird, können Sie die folgenden Skizzen-Anzeigen 
der mit Inhaltsmarkierungen versehenen Bilder 
des gewählten Clips betrachten, in Abhängigkeit 
von dem Punkt, der in einer auf dem Bildschirm 
angezeigten Liste gewählt wurde.
All: Skizzenbildanzeige aller mit 

Inhaltsmarkierungen markierten Einzelbilder.
Rec Start: Skizzenbildanzeige der mit Rec Start-

Markierungen versehenen Einzelbilder und der 
ersten Einzelbilder von Clips (falls die ersten 
Einzelbilder nicht mit Rec Start-Markierungen 
versehen sind).

Shot Mark1: Skizzenbildanzeige der mit Shot Mark 
1 markierten Einzelbilder.

Shot Mark2: Skizzenbildanzeige der mit Shot Mark 
2 markierten Einzelbilder.

Sie können auch Shot Mark 0 und Shot Mark 3 bis 
Shot Mark 9 auswählen.
Wenn ein Clip mit Planungsmetadaten 
aufgezeichnet wird, die die Namen für die 
Szenenmarkierungen 0 bis 9 definieren, werden 
die Auswahloptionen in der Liste anhand der 
definierten Namen angezeigt.

9.	 Taste SHIFT
Zur Verwendung in Verbindung mit anderen 
Tasten.

10.	 Schalter PRESET/REGEN (Regenerierung)/
CLOCK

Wählen Sie die Art des aufzuzeichnenden 
Zeitcodes.
PRESET: Aufzeichnung eines neuen Zeitcodes auf 

dem Medium.
REGEN: Aufzeichnung eines fortlaufenden 

Zeitcodes, der mit dem auf dem Medium 

vorhandenen Zeitcode synchronisiert ist. Der 
Camcorder läuft ungeachtet der Einstellung 
des Schalters F-RUN/SET/R-RUN im Modus 
R-RUN.

CLOCK: Aufzeichnung eines mit der internen  Uhr 
synchronisierten Zeitcodes. Der Camcorder 
läuft ungeachtet der Einstellung des Schalters 
F-RUN/SET/R-RUN im Modus F-RUN.

11.	 Schalter AUDIO SELECT CH1/CH2 (Auswahl 
der Einstellungsmethode für Audiokanäle 
1/2)

Wahl der Einstellungsmethode der Audiopegel für 
die Audiokanäle 1 und 2.
AUTO: Automatische Einstellung
MANUAL: Manuelle Einstellung

12.	 Schalter AUDIO IN CH1/CH2/CH3/CH4 
(Eingangsauswahl Audiokanäle 1/2/3/4)

Wahl der von den Audiokanälen 1, 2, 3 und 4 
aufzuzeichnenden Audiosignale.
FRONT: Einspeisung der Audiosignale von einem 

an die Buchse MIC IN angeschlossenen 
Mikrofon

REAR: Einspeisung der Audiosignale von einem 
an den Anschluss AUDIO IN CH-1/CH-2 
angeschlossenen Audiogerät

WIRELESS: Einspeisung der Signale von einem 
tragbaren UHF-Tuner, falls dieser angebracht 
wurde
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Griff- und Speicherkartenseite

10

13 14

11 12

1

7

23456

98

Karteneinschübe für SxS-Speicherkarten (Seite 32)

1.	 Schalter ASSIGNABLE 4/5
Sie können im Konfigurationsmenü mit „Operation 
>Assignable“ Switch eine Funktion zuweisen 
(Seite 125).
Diesen Schaltern ist bei Auslieferung des 

Camcorders werkseitig Off zugewiesen.

2.	 GPS-Modul
Enthält das integrierte GPS-Modul.

„Abrufen von Ortsinformationen (GPS)“ (Seite 61)

[Hinweis]
Halten Sie den Camcorders nicht an dieser Stelle, wenn Sie 
die GPS-Funktion verwenden.

3.	 USB-Buchse
Wird verwendet, um diesen Camcorder in den 
USB-Verbindungsmodus zu versetzen und ihn 
als externes Speichergerät für einen Computer 
zu verwenden. Wenn ein Computer an diesen 
Anschluss angeschlossen wird, wird jede in 
den Camcorder eingesteckte Speicherkarte als 
Laufwerk für diesen Computer erkannt.

4.	 Anschluss externes Gerät
Schließen Sie hier ein tragbares HDD-
Speichergerät (Option) der Serie PSZ-HA/HB/
HC, ein tragbares SDD-Speichergerät PSZ-SA25 
(Option), ein externes USB-Festplattenlaufwerk 
oder ein USB-Flash-Laufwerk an, um Clips von dem 
in einen SxS-Kartensteckplatz des Camcorders 
eingesetzten Speichermedium auf USB-Medien zu 
kopieren.

[Hinweis]
Dieser Anschluss sollte zum Anschließen von Geräten 
der oben genannten Arten verwendet werden. Es kann 
nicht zum Anschluss eines USB-Hubs oder anderer Geräte 
verwendet werden.

5.	 Anschluss für USB-WLAN-Modul
Schließen Sie hier ein (mitgeliefertes) USB-WLAN-
Modul IFU-WLM3, den optionalen WLAN-Adapter 
CBK-WA02, den optionalen Netzwerkadaptersatz 
CBK-NA1 oder ein optionales Modem an, um 
mit WLAN-Geräten und Netzwerken Daten 
austauschen zu können.

„Anschluss von Geräten über WLAN“ (Seite 63)

„Herstellen der Verbindung zum Internet“ (Seite 67)

6.	 SD-Karteneinschub PROXY (Seite 57)
Legen Sie hier eine SD-Karte zum Aufzeichnung 
von Proxy-Daten ein.

7.	 Markierung  (NFC) 
Eine integrierbare NFC-Antenne ist vorgesehen. 

8.	 Taste SLOT SELECT (Auswahl SxS-
Speicherkarte)

Wenn sich sowohl im Einschub A als auch im 
Einschub B eine SxS-Speicherkarte befindet, 
drücken Sie diese Taste zur Auswahl der 
gewünschten Karte (Seite 33).

9.	 Netzwerkanschluss 
Stellt eine LAN-Verbindung mit einem Netzwerk 
über ein (separat erhältliches) Kabel her.

[VORSICHT]
ˎˎ Aus Sicherheitsgründen nicht mit einem Peripheriegerät-

Anschluss verbinden, der zu starke Spannung für diese 
Buchse haben könnte. Folgen Sie den Anweisungen für 
diese Buchse.
ˎˎ Verwenden Sie beim Anschließen des LAN-Kabels des 

Geräts an ein Peripheriegerät ein abgeschirmtes Kabel, um 
Fehlfunktionen aufgrund von Störungen zu vermeiden.

„Herstellen der Verbindung zum Internet“ (Seite 67)

10.	HDMI-Anschluss
Schließen Sie hier ein HDMI-Gerät, z. B. einen 
Monitor oder ein Aufnahmegerät an, um 
Video- und Audio-Signale in HD oder SD-HDMI 
auszugeben.

11.	 Anschluss GENLOCK IN (Signaleingang 
Taktsynchronisierung) (BNC)

An diesen Anschluss wird ein Referenzsignal 
eingespeist, wenn der Camcorder 
taktsynchronisiert oder der Zeitcode mit 
externen Geräten synchronisiert werden soll. Die 
unterstützten Referenzsignale hängen von der 
aktuellen Systemfrequenz ab, wie auf folgender 
Tabelle dargestellt.

Systemfrequenz Unterstützte Referenzsignale
59.94i 1080/59.94i, 480/59.94i
59.94P 1080/59.94i, 480/59.94i
50i 1080/50i, 576/50i
50P 1080/50i, 576/50i
29.97P 1080/59.94i, 480/59.94i
25P 1080/50i, 576/50i
23.98P 1080/23.98PsF

12.	 Anschluss TC IN (Zeitcodeeingang) (BNC)
Speisen Sie den Referenzzeitcode ein, um den 
Zeitcode des Camcorders mit einer externen 
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Quelle zu synchronisieren.

„Einstellung des Zeitcodes“ (Seite 48)

13.	 Anschluss VIDEO OUT (BNC-Ausführung)
Gibt Videosignale für die Überwachung aus.

14.	 Anschluss TC OUT (Zeitcodeausgang) (BNC)
Schließen Sie diesen Anschluss zur 
Synchronisierung des Zeitcodes dieses 
Camcorders mit dem Zeitcode eines externen 
Videorecorders am der Zeitcodeeingangsanschluss 
des externen Videorecorders an.

Tally-Anzeige und Anschlussbereich

43

1 8 9 10 117

65

2

1

1.	 Anzeige TALLY (hintere Kontrollanzeige) 
(rot)

Leuchtet während der Aufzeichnung. Leuchtet 
nicht, wenn der Schalter TALLY auf OFF steht. 
Blinkt auch, wenn die Anzeige WARNING aktiv 
ist. Die Kontrollanzeige vorne am Sucher und die 
REC-Anzeige auf der Sucheranzeige leuchten oder 
blinken auf dieselbe Weise.

„Fehler-/Warnsystem“ (Seite 146)

2.	 Schalter TALLY
Auf ON stellen, um die Anzeigefunktion TALLY zu 
aktivieren.

3.	 Anschluss EARPHONE (Stereo, Minibuchse)
Hiermit können Sie während der Aufzeichnung 
den E-E-Ton und während der Wiedergabe 
den Wiedergabeton überwachen. Wird ein 
Warnton ausgegeben, können Sie diesen über 
den Kopfhörer hören. Durch Anschluss eines 
Kopfhörers an dieser Buchse wird der eingebaute 
Lautsprecher automatisch ausgeschaltet.
Unter „Maintenance >Audio >Headphone Out“ im 
Konfigurationsmenü kann Mono- oder Stereoton 
gewählt werden.

[Hinweis]
Verwenden Sie Mono-Ohrhörer (2-polig) oder Stereo-
Ohrhörer (3-polig). Durch Verwendung anderer Ohrhörer 
kann der Camcorder beschädigt werden.

4.	 Wahlschalter AUDIO IN
Wählen Sie die Audioquelle, die Sie an die 
Anschlüsse AUDIO IN CH-1/CH-2 anschließen.
LINE: Beim Anschluss eines Stereoverstärkers oder 

einer anderen externen Audiosignalquelle
AES/EBU: Beim Anschluss einer externen digitalen 

Audiosignalquelle
MIC: Beim Anschluss eines Mikrofons.

5.	 Taste +48V/OFF (externe +48V-Stromquelle 
ein/aus)

Zum Umschalten zwischen den folgenden 
Einstellungen entsprechend dem für die 
Audioeingabe verwendeten Mikrofon.
+48V: Mikrofon, das eine externe Stromversorgung 

benötigt (Phantomspeisung)
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OFF: Mikrofon mit interner Stromversorgung oder 
ohne Bedarf einer Stromversorgung

6.	 Anschluss SDI IN (SDI-Eingang, BNC-Typ)
Anschluss zum Verbinden einer externen SDI-
Signalquelle mit dem Camcorder.

7.	 Anschlüsse AUDIO IN CH-1/CH-2 
(Audiokanaleingang 1 und 2) (XLR, 3-polig, 
Buchse)

Schließen Sie hier ein Audiogerät oder Mikrofon 
an.

8.	 Bodenabdeckung
Sie ist zum Schutz der Kabel bestimmt, die an die 
Anschlüsse auf der Rückseite angeschlossen sind.
Durch das Lösen der Schrauben, die die 
Abdeckung an der Unterseite des Camcorders 
festhalten, können Sie die Position der Abdeckung 
in Abhängigkeit von der Größe und der Form 
der Mikrofon- oder Audiokabelstecker anpassen. 
Nachdem Sie die Position angepasst haben, ziehen 
Sie die Schrauben fest, um die Abdeckung zu 
befestigen.

9.	 Anschluss AUDIO OUT (XLR, 5-polig, Stecker)
Ausgabe der auf den Audiokanälen 1 und 2 oder 
den Audiokanälen 3 und 4 aufgezeichneten 
Audiosignale.
Die Audiosignale werden mit dem Schalter 
MONITOR gewählt. 

10.	 Anschluss REMOTE (8-polig)
Zum Anschluss einer Fernbedienung zur 
Fernsteuerung des Camcorders.

[Hinweis]
Achten Sie darauf, vor dem Anschluss/Abtrennen der 
Fernbedienung an den/vom Camcorder den Schalter POWER 
des Camcorders auszuschalten.

11.	 Anschlüsse SDI OUT 1/2 (BNC-Typ)
Ausgabe des HD SDI- oder SD SDI-Signals (mit 
integriertem Audiosignal). Die Ausgabe aus 
diesem Anschluss kann mithilfe von „Operation 
>Input/Output >SDI Out1 Output“ oder „SDI 
Out2 Output“ im Konfigurationsmenü ein- oder 
ausgeschaltet werden.
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LCD Monitor-Informationsbildschirm (Statusanzeige)

Der LCD Monitor-Informationsbildschirm wird 
durch Drücken der Taste DISP SEL/EXPAND 
(Anzeigeauswahl/Erweitern) angezeigt 
(Seite 8).

1 2 3 4 5

6

78

910
11

1213

1.	 Anzeige des Dateisystems

2.	 Anzeige des Dateiformats

3.	 Statusanzeige
PB: Wird während der Wiedergabe eines Mediums 

eingeblendet.
NDF: Erscheint bei Wahl des Non-Drop-Frame-

Zeitcodes.
EXT-LK: Erscheint bei Synchronisierung des 

internen Zeitcodegenerators mit einem 
externen Signaleingang an der Buchse TC IN 
(Zeitcodeeingang).

HOLD: Erscheint, wenn der Betriebsmodus des 
internen Zeitcodegenerators auf R-RUN 
gestellt ist und angehalten wird.

4.	 Systemfrequenzindikator
Zeigt die Systemfrequenz des aktuell 
wiedergegebenen oder aufgezeichneten Videos 
an.

5.	 Anzeige des Audioformats
Zeigt das Audioaufzeichnungsformat oder das 
Audioformat des aktuell wiedergegebenen Clips 
an.

Anzeige Aufzeichnungsformat
16bit HD420 HQ

DVCAM
MPEG IMX 50

24bit HD422 50
MPEG IMX 50
XAVC Intra
XAVC Long

6.	 Audiopegelanzeigen
Zeigen die Audioaufzeichnungs- oder 
Wiedergabepegel von Kanal 1 bis 4 an.

7.	 Anzeige der verbleibenden Batteriekapazität
Zeigt das Symbol für die verbleibende 
Batteriekapazität und die verbleibende 
Aufzeichnungszeit an.

8.	 Anzeige der verbleibenden Medienkapazität
Zeigt die verbleibende Kapazität der 
Aufnahmemedien in den Steckplätzen als 
Balkenabschnitte an.

9.	 Bereich der Warnanzeige
Hier werden Warnmeldungen angezeigt, wenn 
Störungen bei der Aufzeichnung auftreten.

Einzelheiten siehe „Fehler-/Warnsystem“ (Seite 146).

10.	 Clipnamen-Anzeige
Zeigt bei der Aufzeichnung den Namen des 
gegenwärtig aufgezeichneten Clips bzw. im 
Aufzeichnungs-Standby den Namen des nächsten 
aufgezeichneten Clips an.

11.	 Zeitdatenanzeige
Schaltet die Anzeige der Dauer, des Zeitcodes und 
der Benutzerbitdaten abhängig von der Position 
des Schalters DISPLAY um.
Zeigt die Art der gegenwärtig in der 
Zeitdatenanzeige angezeigten Daten wie folgt an.
TCG: Aufgezeichneter Zeitcode
TCR: Wiedergabe-Zeitcode
UBG: Aufgezeichnete Benutzerbits
UBR; Wiedergabe von Benutzerbits
CNT: Zähler
DUR: Zeitdauer
CLK: Zeitanzeige (wenn der Schalter PRESET/

REGEN/CLOCK auf CLOCK steht)

Wenn die Taste HOLD gedrückt wurde, um den 
Zeitcodewert anzuhalten, so wird der Zeitcode im 
unten dargestellten Format angezeigt. Wenn die 
Taste HOLD erneut gedrückt wurde, um die Daten 
weiterlaufen zu lassen, wird der Zeitcode wieder 
im normalen Format angezeigt.

Die drei Punkte zeigen an, dass Zeitcode und 
Zählerfortschritt im Hold-Modus angezeigt werden.

12.	 Anzeige der Auflösung
Zeigt die Auflösung des ausgegebenen Videos an.

13.	 Aufzeichnungsformatanzeige
Zeigt das aktuelle Aufzeichnungsformat 
oder das Aufzeichnungsformat des aktuell 
wiedergegebenen Clips an.

Statusbildschirme

Mit den Statusbildschirmen können Sie die 
Camcorder-Einstellungen und unterschiedliche 
Typen von Statusinformationen überprüfen.
Wenn kein Menü angezeigt wird, drücken Sie 
den Schalter MENU CANCEL/PRST/ESCAPE nach 
oben in die Stellung CANCEL/PRST, um den 
Statusbildschirm anzuzeigen. Mit jedem Drücken 
wird der nächste Statusbildschirm ausgewählt.
Die folgenden Statusbildschirme können 
angezeigt werden.

Statusbildschirm Display-Anzeige
Bildschirm „Camera 
Status“

Einstellungen und 
Statusinformationen für 
die Aufnahme

Bildschirm „Audio Status“ Einstellungen und 
Statusinformationen für 
Audioeingänge und 
-ausgänge

Bildschirm „System 
Status“

Einstellungen und 
Statusinformationen für 
die Aufzeichnung

Bildschirm „Video Output 
Status“

Einstellungen und 
Statusinformationen für 
die Videoausgabe

Bildschirm „Network 
Status 1“

Einstellungen und 
Statusinformationen für 
das Netzwerk

Bildschirm „Network 
Status 2“

Einstellungen und 
Statusinformationen für 
das Streaming

Bildschirm „Assignable 
Button Status“

Bezeichnungen der 
Funktionen, die den 
belegbaren Schaltern 
zugewiesen wurden

Bildschirmanzeige
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Statusbildschirm Display-Anzeige
Bildschirm „Battery 
Status“

Status des am 
Camcorder 
angebrachten Akkus

Bildschirm „Media Status“ Statusinformationen zu 
Aufnahmemedien

Bildschirm „Camera Status“

Anzeigeelement Beschreibung
Gain Verstärkungspegel in dB-Einheiten
Shutter Status des elektronischen 

Verschlusses
Gamma Gammakategorie und -kurve
White Einstellung des 

Weißabgleichmodus
Gain Switch Status des Schalters GAIN
Zebra Streifenmusterstatus
Iris Blendenstufenwert
Focal Length Brennweite
Focus Distance Fokusabstand
Depth Of Field Schärfentiefe
Zoom Speed Für die Objektivtaste ZOOM 

konfigurierte 
Zoomgeschwindigkeit

Bildschirm „Audio Status“

Anzeigeelement Beschreibung
CH 1/CH 2/ 
CH 3/CH 4

Audiopegel, Eingangsquelle, 
Referenzeingangspegel und 
Windfiltereinstellungen für jeden 
einzelnen Kanal

Bildschirm „System Status“

Anzeigeelement Beschreibung
System 
Frequency

Systemfrequenz

File System Dateisystem
Rec Format Aufzeichnungsformat
Clip 
Continuous 
Rec

Clip Continuous Rec-Funktion 
aktiviert oder deaktiviert

Title Prefix Präfix des Clipnamen
Picture Size Bildformat
Simul Rec Simul Rec-Funktion aktiviert oder 

deaktiviert
Rec Function Aktiviertes spezielles 

Aufzeichnungsformat und 
Einstellungen

Picture Cache 
Rec

Bildpuffer-Aufzeichnungsfunktion 
aktiviert oder deaktiviert

Number Suffix des Clipnamen

Gamma Verwendete Gammakategorie

Proxy 
Recording 
Mode

Funktion zur Aufzeichnung von 
Proxy-Daten aktiviert oder 
deaktiviert

Bildschirm „Video Output Status“

Anzeigeelement Beschreibung
SDI Ausgabeeinstellungen des 

Anschlusses SDI OUT 
(Ausgangsbildformat, 
Ausgabeform, Ausgabefrequenz, 
Einblendung)

HDMI Ausgabeeinstellungen des 
Anschlusses HDMI 
(Ausgangsbildformat, 
Ausgabeform, Ausgabefrequenz, 
Einblendung)

Video Ausgabeeinstellungen des 
Anschlusses VIDEO OUT 
(Ausgangsbildformat, 
Einblendung)

Bildschirm „Network Status 1“

Anzeigeelement Beschreibung
Setting Netzwerkeinstellungsstatus
Wireless 
Network

Status der WLAN-Einstellungen

Device Name Bezeichnung des angebrachten 
USB-WLAN-Moduls

IP Address 
(Wireless)

IP-Adresse der WLAN-Verbindung

Anzeigeelement Beschreibung
MAC Addr. 
(Wireless)

MAC-Adresse des Geräts, das mit 
dem Anschluss des USB-WLAN-
Moduls verbunden ist

Wireless 
Network

Modemeinstellungsstatus

Device Name Bezeichnung des angebrachten 
Modems

IP Address 
(Modem)

IP-Adresse des angebrachten 
Modems

Wired LAN Netzwerkverbindungsstatus des 
kabelbasierten LAN

Wired LAN 
Remote

Status „aktiviert/deaktiviert“ der 
Fernbedienung bei Verbindung 
mit einem LAN-Kabel

IP Address 
(Wired)

IP-Adresse der kabelbasierten 
LAN-Verbindung

Bildschirm „Network Status 2“

Anzeigeelement Beschreibung
NW Client 
Mode Status

Status des Netzwerkclientmodus
Einzelheiten zum Status siehe 
„Status des Netzwerkclientmodus“ 
(Seite 15).

CCM Name Name des angeschlossenen CCM 
bei Verwendung des 
Netzwerkclientmodus

Streaming 
Status

Streaming-Verteilungsstatus

Streaming Size Bildformat der ausgewählten 
Streaming-Einstellung

Streaming Bit 
Rate

Bitrate der ausgewählten 
Streaming-Einstellung
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Anzeigeelement Beschreibung
Streaming Type Typ der ausgewählten Streaming-

Einstellung
Streaming 
Dest. Add.

Streaming-Zieladresse

Streaming 
Dest. Port

Streaming-Zielport

Number of 
Distribution

Anzahl der Streaming-
Verteilungsziele

File Transfer Fortschrittstatus der 
Dateiübertragung

Transfer to: Server-Name des Ziels für die 
Dateiübertragung

Status des Netzwerkclientmodus 

Statusanzeige Status Beschreibung
Off CCM nicht 

verbunden
Der 
Netzwerkclientmodus 
ist ausgeschaltet.

Connected CCM verbunden Der 
Netzwerkclientmodus 
ist aktiviert, der CCM 
ist verbunden und 
die CCM-Steuerung 
ist aktiviert.

Connecting Verbindung mit 
CCM wird 
hergestellt 
(Verbindung ist 
unterbrochen)

Es wird versucht, 
eine Verbindung 
mit dem CCM 
herzustellen (oder 
die Verbindung zu 
unterbrechen). 
Warten Sie, bis die 
Verbindung 
hergestellt ist 
(unterbrochen ist). 
Wenn sich der 
Status „Connecting“ 
nicht ändert, ist 
möglicherweise die 
Einstellung der 
CCM-Adresse falsch. 
Prüfen Sie, ob die 
Adresse richtig 
festgelegt ist.

Statusanzeige Status Beschreibung
Awaiting CCM-Verbin-

dungsbereitschaft
Der 
Netzwerkclientmodus 
ist aktiviert, aber die 
Netzwerkeinstellung 
ist deaktiviert. 
Aktivieren Sie die 
Netzwerkeinstellung 
für die Verbindung 
mit dem CCM.

Address 
Error

CCM-
Adressfehler

Der Hostname oder 
die IP-Adresse des 
CCM zum 
Verbinden ist 
möglicherweise 
falsch. Stellen Sie 
sicher, dass die 
Einstellung korrekt 
ist.

Auth. 
Failed

Fehler beim 
CCM-
Benutzernamen/
Kennwort

Der Benutzername 
oder das Kennwort 
für die Verbindung 
mit dem CCM ist 
möglicherweise 
falsch. Stellen Sie 
sicher, dass die 
Einstellung korrekt 
ist.

No Inet 
Access

Internetverbin-
dungsfehler

Verbindung zum 
Netzwerk kann nicht 
hergestellt werden. Die 
Netzwerkeinstellungen 
sind möglicherweise 
falsch. Prüfen Sie die 
Netzwerkeinstellungen.

Cert. not 
Valid

Fehler: Die 
CCM-
Zertifizierung ist 
nicht gültig

Das CCM-Zertifikat 
ist nicht gültig. 
Möglicherweise ist 
die 
Datumseinstellung 
ungültig. Prüfen Sie 
die 
Datumseinstellung.

Bildschirm „Assignable Button Status“

Bildschirm „Battery Status“

Anzeigeelement Beschreibung
Detected 
Battery

Typ der erkannten Batterie

Remaining Verbleibende Kapazität (%)
Charge Count Anzahl der Ladezyklen
Capacity Verbleibende Kapazität (Ah)
Voltage Spannung
Manufacture 
Date 

Herstellungsdatum der Batterie

Power Source Stromquelle
Supplied 
Voltage 

Spannung der Stromquelle

Bildschirm „Media Status“

Anzeigeelement Beschreibung
SxSA Verbleibende Kapazität 

(Balkendiagramm und Anzeige der 
verbleibenden Zeit) sowie 
Lebensdauer des Mediums in 
Einschub A

SxSB Verbleibende Kapazität 
(Balkendiagramm und Anzeige der 
verbleibenden Zeit) sowie 
Lebensdauer des Mediums in 
Einschub B

SD Proxy Verbleibende Kapazität 
(Balkendiagramm und Anzeige der 
verbleibenden Zeit) sowie 
Lebensdauer (wird nur angezeigt, 
wenn verfügbar) des Mediums im 
SD-Karteneinschub PROXY

SD Utility Verbleibende Kapazität 
(Balkendiagramm und 
verbleibende Kapazität) sowie 
Lebensdauer (wird nur angezeigt, 
wenn verfügbar) des Mediums im 
SD-Karteneinschub UTILITY

Bei geschützten Medien wird das Zeichen  
angezeigt.
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Sucheranzeige

Die Sucheranzeige zeigt während der Aufnahme 
(Aufzeichnung oder Aufzeichnungs-Standby) 
und Wiedergabe Bilder mit eingeblendeten 
Camcorder-Informationen an.
Sie können die Anzeige der Informationen mit 

dem Schalter DISPLAY aktivieren oder deaktivieren.
Die anzuzeigenden Informationen sind mit den 
Einstellungen in „Operation >Super Impose“ im 
Konfigurationsmenü und den Einstellungen der 
entsprechenden Schalter verbunden.

60 FPS

1 2 5 6 843
7

9 1011 12

13 14
15 16
17
19
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23
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2528

29
30
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33
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37

32

2627

34
36

1.	 Konverteranzeige
Zeigt den Status der digitalen Konverterfunktion 
und der Telekonverterfunktion an.
EX: Wird eingeblendet, wenn die Objektiv-

Konverterfunktion aktiviert ist
X2D: Wird eingeblendet, wenn die digitale 

Konverterfunktion (x2) aktiviert ist
X3D: Wird eingeblendet, wenn die digitale 

Konverterfunktion (x3) aktiviert ist
X4D: Wird eingeblendet, wenn die digitale 

Konverterfunktion (x4) aktiviert ist
EX2D: Wird eingeblendet, wenn sowohl die 

Objektiv-Konverterfunktion als auch die 
digitale Konverterfunktion (x2) aktiviert sind

EX3D: Wird eingeblendet, wenn sowohl die 

Objektiv-Konverterfunktion als auch die 
digitale Konverterfunktion (x3) aktiviert sind

EX4D: Wird eingeblendet, wenn sowohl die 
Objektiv-Konverterfunktion als auch die 
digitale Konverterfunktion (x4) aktiviert sind

Schalten Sie den digitalen Konverter mit einem 
belegbaren Schalter, der mit der digitalen 
Konverterfunktion zugewiesen wurde, ein/aus.

[Hinweis]
Der digitale Konverter kann nicht eingeschaltet werden, 
wenn „Slow & Quick Motion“ (Zeitlupe und Zeitraffer) 
aktiviert ist.

2.	 Zoompositionsanzeige (bei angebrachtem 
Objektiv)

Anzeige der Zoomposition des Zoomobjektivs im 

Bereich 0 bis 99.

3.	 Farbtemperaturanzeige
Zeigt die Farbtemperatur des Weißabgleichs an.

4.	 Fokuspositionsanzeige (bei angebrachtem 
Objektiv)

Anzeige der Fokusposition als Entfernung zum 
Motiv (in Metern).

5.	 Blendenpositionsanzeige (bei angebrachtem 
Objektiv)

Zeigt die Blendenpositionseinstellung an.

6.	 Anzeige für elektrischen Farbtemperaturfilter
Wird eingeblendet, wenn die CC5600K-Funktion 
aktiviert ist.

7.	 Schärfentiefenanzeige (Serienobjektiv 
angebracht)

Zeigt die Schärfentiefe anhand eines Balkens 
an. Die Einheiten für die Anzeige werden im 
Konfigurationsmenü unter „Operation >Display 
On/Off >Lens Info“ eingestellt und können in 
Meter oder Fuß angegeben werden.

8.	 Anzeige für Aufzeichnungsmodus
Anzeige der folgenden Betriebszustände des 
Camcorders.

Anzeige Bedeutung

Rec Während der Aufzeichnung

Stby Aufnahmebereitschaft

Cont Rec Clip Continuous Rec-Aufnahme läuft

Cont Stby Aufzeichnungs-Standby im Clip 
Continuous Rec-Modus

S&Q Rec Aufzeichnung läuft im Zeitlupen- & 
Zeitraffermodus

S&Q Stby Aufzeichnungs-Standby im 
Zeitlupen-/Zeitraffermodus

Rec Aufzeichnen im Bildpuffer-
Aufzeichnungsmodus

Cache Aufnahmebereitschaft im Bildpuffer-
Aufzeichnungsmodus

Int Rec Aufzeichnung läuft im Modus 
„Interval Rec“ (Intervallaufnahme)

Anzeige Bedeutung
Int Stby Aufzeichnungs-Standby im „Interval 

Rec“-Modus

Int Stby Aufzeichnung im „Interval Rec“-
Modus unterbrochen (in 
Pausenintervallen)

Sml Rec Aufzeichnung läuft im „Simul 
Rec“-Modus

Sml Stby Aufzeichnungs-Standby im „Simul 
Rec“-Modus

CALL Anruf von angeschlossenem 
externem Gerät empfangen

Grüne Kontrollleuchte wird angezeigt, wenn der 
Camcorder sich in einem der folgenden Zustände 
befindet:
ˎˎ „Maintenance >Camera Config >HD-SDI Remote 
I/F“ im Konfigurationsmenü steht auf „Green 
Tally“ und ein Aufnahmesteuersignal wird am 
Anschluss SDI OUT ausgegeben.
ˎˎ Grünes Kontrollsignal wird empfangen 
(wenn ein Kameraadapter an diesem 
Camcorder angebracht ist und ein Kamera-
Erweiterungsgerät angeschlossen ist)

9.	 Funktionsanzeige des drahtlosen 
Empfängers

Zeigt ein „W“ an, wenn ein Einschubempfänger 
an den Camcorder angeschlossen ist, und zeigt 
für jeden Kanal, der vom Empfänger verwendet 
werden kann, die Empfangsstärke an (1-Kanal, 
2-Kanal oder 4-Kanal).
Normal: Zeigt mit der Anzahl der weißen 

Segmente die Stärke des empfangenen 
Signals an.

Stummschaltung des analogen Empfängers/
Fehlerratenwarnung für digitalen Empfänger: 
Zeigt mit der Anzahl der grauen Segmente die 
Stärke des empfangenen Signals an.

Wenn die Empfangsstärke den Spitzenwert 
überschreitet: Zeigt „P“ anstelle der Anzeige 
an. 1)

Wenn der Transmitter im Energiesparmodus ist: „S“ 
wird angezeigt.

Empfängerbatterie schwach: Die Nummer des 
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entsprechenden Kanals und die Anzeigen 
blinken. 1)

1)	� Bei Verwendung des DWR-S02D

10.	 Bildfrequenzanzeige für S&Q Motion 
(Zeitlupe und Zeitraffer)

Zeigt die Aufnahmebildfrequenz wenn der 
Camcorder im Aufzeichnungsmodus für Zeitlupe 
und Zeitraffer ist.

11.	 GPS-Anzeige (Seite 61)

12.	 Akkukapazität-/Spannungsanzeige
Zeigt entsprechend dem Typ des Akkus die 
folgenden Anzeigen an:

Batterietyp Anzeige
Info Battery Symbol für die verbleibende 

Batteriekapazität und 
verbleibende 
Aufzeichnungszeit

Batteriesystem 
Anton Bauer

Verbleibende Batteriekapazität 
(Anzeige in %)

Andere Batterien Eingangsspannung

13.	 Aufzeichnungsformatanzeige (Bildgröße)
Zeigt die Bildgröße der auf SxS-Speicherkarten 
aufgenommenen Clips an.

14.	 Aufzeichnungsformatanzeige 
(Systemfrequenz und Abtastmethode)

Zeigt die aktuell konfigurierte Camcorder-
Systemfrequenz und die Abtastmethode des 
Aufzeichnungsformats an.

15.	 Aufzeichnungsformatanzeige (Codec)
Zeigt den Formatnamen der auf SxS-
Speicherkarten aufgenommenen Clips an.

16.	 Gamma-Anzeige
Zeigt die Gammaeinstellung an.

Menüeinstellungen Anzeige

Operation 
>Display 
On/Off 
>Gamma

Paint >Gamma setting

Gamma Gamma 
Category

Gamma 
Select

Off — — — —

Menüeinstellungen Anzeige

Operation 
>Display 
On/Off 
>Gamma

Paint >Gamma setting

Gamma Gamma 
Category

Gamma 
Select

On Off — — Gamma 
Off

On STD STD1 DVW STD1

STD2 x4.5 STD2

STD3 x3.5 STD3

STD4 240M STD4

STD5 R709 STD5

STD6 x5.0 STD6

HG HG1 
3250G36

HG1

HG2 
4600G30

HG2

HG3 
3259G40

HG3

HG4 
4609G33

HG4

User User 1 User 1

User 2 User 2

User 3 User 3

User 4 User 4

User 5 User 5

17.	 Anzeige für externe Zeitcodesperre
Zeigt Zeitcodesperre an, wenn der Zeitcode aus 
einer externen Quelle eingegeben wird.

18.	 Anzeige des Verbindungsstatus vom 
verkabelten LAN/Modem

Zeigt Symbole für die Einstellungen/den 
Verbindungsstatus des verkabelten LAN/Modem 
an.

Einstellungen/Verbindungsstatus des verkabelten 
LAN

Status Netzwerkver-
bindungssta-
tus/Symbol

Operation 
>Display On/
Off >Network 
Condition

Maintenance 
>Network  
>Setting

Maintenance 
>Network 
>Wired LAN

Off – – –

On Off – –

On – –

Disable –

Enable Verbinden mit 
LAN

(blinkt)

Verbunden 
mit LAN

LAN-Verbin-
dungsfehler

Einstellungen/Verbindungsstatus des 3G/4G-
Modems

Status Netzwerkver-
bindungssta-
tus/Symbol

Operation 
>Display On/
Off >Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Modem

Off – – –

On Off – –

On – –

Off –

On Verbinden mit 
3G/4G

(blinkt)

Verbunden 
mit 3G/4G

3G/4G-
Verbindungs-
fehler

19.	 Streaming-Anzeige
Zeigt den Streaming-Status mithilfe von Symbolen 
an.

Status Streaming-
Status/
Symbol

Operation 
>Display 
On/Off 
>Streaming 
Status

Maintenance 
>Streaming 
>Setting

Maintenance 
>Network 
Client Mode 
>Setting

Off — — —

On Off Off –

On Off Kein 
Streaming

Streaming

Fehler

Die folgenden Symbole werden bei Streaming-
Übertragungen von einem CCM angezeigt.

Status Streaming-
Status/
Symbol

Operation 
>Display 
On/Off 
>Streaming 
Status

Maintenance 
>Streaming 
>Setting

Maintenance 
>Network 
Client Mode 
>Setting

On Off On Kein 
Streaming

Streaming

[Hinweis]
Bevor der Streaming-Vorgang startet, werden keine Symbole 
angezeigt.
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20.	 Statusanzeige des Wi-Fi-Modus
Zeigt die Netzwerkeinstellung und den 
Verbindungsstatus des WLAN mit Symbolen an.

Status Netzwerkver-
bindungssta-
tus/Symbol

Operation 
>Display On/
Off >Network 
Condition

Maintenance 
>Network 
>Setting

Maintenance 
>Network 
>Wi-Fi Mode

Off – – –

On Off – –

On Wi-Fi Access 
Point

Verbinden mit 
Wi-Fi

(blinkt)

Wi-Fi-Standby 
(verbunden)

Wi-Fi Station Verbinden mit 
Wi-Fi

(blinkt)

Suche nach 
Access Points

Verbinden mit 
Access Point

Symbol 
wechselt je 
nach 
Signalstärke

Accesspoint-
Verbindungs-
fehler

Off –

21.	 Proxy-Kennzeichen
Zeigt „Proxy“ an, wenn die Proxy-Aufzeichnung 
aktiviert ist („Operation >Proxy Recording Mode 
>Setting“ im Konfigurationsmenü ist aktiviert). 
Während der Einrichtung blinkt „Proxy“. „Proxy Rec“ 
wird während der Proxy-Aufzeichnung angezeigt. 
Zeigt das Symbol  und die Übertragungsrate 
(%) bei der Proxydateiübertragung an. Wenn die 
Übertragung beendet ist, wird das Symbol  
ausgeblendet, um den Übertragungsstatus 100% 
anzuzeigen.

22.	 Anzeige für den Netzwerkclientmodus
Zeigt den Status der Verbindung mit dem CCM 
(als Connection Control Manager konfigurierte 
Netzwerk-RX-Station) mithilfe von Symbolen an, 
wenn der Netzwerkclientmodus aktiviert ist.

Status Symbol

Operation 
>Display 
On/Off >NW 
Client Mode 
Status

Maintenance 
>Network 
Client Mode 
>Setting

Status

Off — — —

On Off — —

On CCM 
verbunden

Verbinden mit 
CCM 
(Verbindung 
unterbrochen)

(blinkt)

CCM-Verbin-
dungsbereitschaft

–

CCM-
Verbindungsfehler

Einzelheiten 
zu Fehlern 
siehe 
(Seite 15).

23.	 Videosignalanzeige
Zeigt das Videoausgangssignal in Echtzeit als 
Wellenform, Vektorskop oder Histogramm.

24.	 Anzeige für Speichermedienstatus/
verbleibende Kapazität für jeden 
Medieneinschub

Zeigt den Status und die Kapazität des Mediums 
im SxS-Einschub A, SxS-Einschub B und dem SD-
Karteneinschub PROXY an.
Anzeige für SxS-Einschub-Symbol
*�Beispiel für SxS-Einschub A (SxSA). Die Symbole für SxS-
Einschub B sind mit „SxSB“ beschriftet.

Symbol Medienstatus
– Medium nicht eingesetzt oder 

nicht geladen
Medium geladen

(blinkt)
Medium wird geladen

(orangefarbener 
Balken)

Aufzeichnung (aktiv)

(grüne Anzeige)
Wiedergabe (aktiv)

(orangefarbener 
Balken + grüne 
Anzeige)

Aufzeichnung/Wiedergabe (aktiv)

Anzeige für SD-Kartensymbol (für Aufzeichnung 
von Proxy-Daten)

Symbol Medienstatus
– Medium nicht eingesetzt oder 

nicht geladen
Medium geladen

(blinkt)
Medium wird geladen

(orangefarbener 
Balken)

Aufzeichnung (aktiv)

Die verbleibende Aufzeichnungszeit wird als 
Zahlenwert angezeigt.

25.	 Audiopegelanzeigen
Zeigt die Pegel der Audiokanäle 1 und 2 an.

26.	 Clipnamen-Anzeige
Zeigt bei der Aufzeichnung den Namen des 
gegenwärtig aufgezeichneten Clips bzw. im 
Aufzeichnungs-Standby den Namen des nächsten 
aufgezeichneten Clips an.

27.	 Fokus-Assist-Anzeige
Zeigt einen Erkennungsrahmen 
(Fokusbereichsmarkierung) an, der den Bereich 
angibt, in dem eine bestimmte Fokusstärke erkannt 
wird, sowie eine Leiste (Fokus-Assist-Anzeige), die 
die Fokusstärke in diesem Bereich angibt.

28.	 Zeitdatenanzeige
Zeigt die verbleibende Aufzeichnungs-/
Wiedergabezeit, den Zeitcode, die Benutzerbits 
oder andere mit dem Schalter DISPLAY 
ausgewählten Informationen an (Seite 8).

29.	 SD-Kartenanzeige zum Speichern von 
Konfigurationsdaten

Zeigt den Zustand der SD-Karte zum Speichern 
von Konfigurationsdaten im SD-Karteneinschub 
UTILITY an.

Symbol Medienstatus
— SD-Karte nicht eingesetzt oder nicht 

geladen
SD-Karte geladen

Geladene SD-Karte ist geschützt

(blinkt)

SD-Karte wird geladen

30.	 REC-Triggeranzeige für SDI-Ausgang
Zeigt den Einblendungsstatus des 
Aufzeichnungsbefehls an, der an den SDI-Ausgang 
gesendet wird.
Wird angezeigt, wenn „Maintenance 
>Camera Config >HD SDI Remote I/F“ im 
Konfigurationsmenü auf „Characters“ eingestellt ist.

31.	 ALAC-Anzeige
Zeigt die Meldung „ALAC“ an, wenn die 
automatische automatische Ausführung der ALAC-
Funktion (automatischer Objektiv-Aberrations-
Ausgleich) eingestellt ist.
ALAC wird automatisch ausgeführt, wenn ein 
ALAC-kompatibles Objektiv verwendet wird, 
die ALAC-Funktion aktiviert und „Maintenance 
>Camera Config >ALAC“ im Konfigurationsmenü 
auf „Auto“ gestellt ist.
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32.	 Anzeige für AE-Modus (Blendenautomatik)
Zeigt mit einem Symbol den aktuellen 
Betriebsmodus der Blendenautomatikfunktion und 
den Überschreibpegel der Blendenautomatik an.

Symbol Bedeutung
Gegenlichtmodus

Standardmodus

Punktlicht-Modus

33.	 Anzeige für Autofokus-Modus (nur, wenn ein 
Autofokus-Objektiv angeschlossen ist)

Zeigt den Fokus-Einstellungsmodus des 
Camcorders an.
ˎˎ AF (Autofokus)
ˎˎ MF (manueller Fokus)
ˎˎ MF* (manueller Fokus bei eingeschalteter MF 
Assist-Funktion)
ˎˎ Full MF (vollständig manueller Fokus)

34.	 ND-Filteranzeige
Zeigt die Positionsnummer des aktuell 
ausgewählten ND-Filters an (Seite 5).
Wenn „Electrical CC“ einem belegbaren Schalter 
zugewiesen wurde, wird die Position (A/B/C/D) 
des elektrischen CC-Filters rechts neben der ND-
Filteranzeige (1 bis 4) angezeigt.

35.	 Verstärkungsanzeige
Zeigt die mit dem Schalter GAIN eingestellte 
Verstärkung (dB) des Videoverstärkers an.

36.	 Blendenmodus-/Belichtungszeitanzeige/
Anzeige des Status der Flashband-
Reduzierung

Zeigt den Blendenmodus oder die Belichtungszeit 
an.

„Einstellung der elektronischen Blende“ (Seite 42)

Wenn Flash Band Reduce (Seite 106) im Menü 
„Operation“ auf „On“ gesetzt ist, wird FBR 
angezeigt, wenn der Verschluss nicht in Betrieb ist.

37.	 Anzeige für Weißabgleichmodus

Anzeige des aktuell eingestellten automatischen 
Weißabgleichspeichers.
ATW: ATW-Modus (Automatische 

Weißwertanpassung)
W:A: Speicher-A-Modus
W:B: Speicher-B-Modus
W:C: Speicher-C-Modus
W:P: Voreingestellter Modus
3200K: Wird eingeblendet, wenn ein belegbarer 

Schalter eingeschaltet ist, dem die Funktion 
„Color Temp SW 3200K“ zugewiesen wurde

4300K: Wird eingeblendet, wenn ein belegbarer 
Schalter eingeschaltet ist, dem die Funktion 
„Color Temp SW 4300K“ zugewiesen wurde

5600K: Wird eingeblendet, wenn ein belegbarer 
Schalter eingeschaltet ist, dem die Funktion 
„Color Temp SW 5600K“ zugewiesen wurde

6300K: Wird eingeblendet, wenn ein belegbarer 
Schalter eingeschaltet ist, dem die Funktion 
„Color Temp SW 6300K“ zugewiesen wurde

Im Lieferumfang des PXW-X400KC enthaltenes Objektiv

Der PXW-X400KC wird mit einem Objektiv geliefert.
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1.	 DIP-Schalter (Seite 20)
Für die Shuttle Shot-Funktion.

2.	 Blendenverstärkungs-Abgleichtrimmer 
(Seite 44)

3.	 Blendenautomatik-Druckknopf
Wenn der Blendenmodus-Schalter in der Position 
M (manuell) steht, drücken Sie diese Taste, um die 
Blende sofort automatisch einzustellen. Die Blende 
wird automatisch eingestellt, solange der Schalter 
gedrückt wird.

4.	 Blendenmodus-Schalter
A (automatisch): Die Blende wird automatisch 

eingestellt.
M (manuell): Die Blende wird mit dem Blendenring 

eingestellt.

5.	 Zoom-Wippschalter
Dieser Schalter ist aktiviert, wenn sich der 
Wahlschalter für Motorzoom oder manuellen 

Zoom in der Position SERVO befindet. 
Stellen Sie den Schalter in die Position W für 
Weitwinkelaufnahmen und in die Position T für 
Teleaufnahmen.
Drücken Sie den Schalter stärker, um schneller zu 
zoomen, oder leichter, um langsamer zu zoomen.

6.	 Schalter RET
Solange diese Taste gedrückt wird, werden 
die letzten aufgezeichneten Sekunden auf 
der Sucheranzeige angezeigt (Überprüfen der 
Aufzeichnung) (Seite 21).

7.	 F.B.-Arretierschraube/F.B.-Einstellring 
(Seite 44)

8.	 Positionsstift
Richten Sie diesen Stift beim Anbringen des 
Objektivs an der Vertiefung oben in der Mitte des 
Objektivanschlusses am Camcorder aus.

9.	 Makrotaste/Makroring
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Halten Sie die Taste MACRO gedrückt und drehen 
Sie den Makroring, um den Fokus einzustellen 
(Mindest-Fokusabstand: 10 mm).

10.	Blendenring
Um die Blende manuell einzustellen, stellen Sie 
den Blendenmodus-Schalter in die Position M 
(manuell) und drehen Sie dann diesen Ring.

[Hinweis]
Stellen Sie stets erst den Blendenmodus-Schalter in die 
Position M (manuell) und stellen Sie dann die Blende ein.

11.	 Zoomhebel/Zoomring
Um den Zoom manuell einzustellen, stellen Sie 
den Wahlschalter für Motorzoom oder manuellen 
Zoom in die Position MANU und betätigen Sie 
dann den Hebel bzw. drehen Sie den Ring.

12.	 Fokussierring
Stellen Sie durch Drehen dieses Rings den Fokus 
ein.

13.	 Wahlschalter für Motorzoom oder manuellen 
Zoom

SERVO (Servo): Wählt den Motorzoom. Stellen Sie 
den Zoom mit dem Zoom-Wippschalter ein.

MANU (manuell): Wählt den manuellen Zoom. 
Stellen Sie den Zoom mit dem Zoomhebel/
Zoomring ein.

14.	 Spannungsversorgungs-/ 
Blendensteuerungskabel

Zur Anschließen an den Anschluss LENS des 
Camcorders.

15.	 VTR-Schalter
Mit dieser Taste können Sie die Aufzeichnung 
starten und stoppen. Drücken Sie die Taste einmal, 
um die Aufzeichnung zu starten, und drücken 
Sie ein weiteres Mal, um die Aufzeichnung zu 
stoppen.

16.	 Schalter Shtl (Shuttle) (Seite 20)
Für die Shuttle Shot-Funktion.

17.	 Zoom-Fernbedienungsanschluss
An einen optionalen Zoom-Servo-Controller 
anschließen, um den Zoom fernzusteuern.

18.	 Schalter Memo(Seite 20)
Für die Shuttle Shot-Funktion.

Über Shuttle Shot

Shuttle Shot ist eine Aufnahmefunktion, mit der 
schnell eine vom Benutzer voreingestellte Zoom-
Position eingestellt werden kann.

1	 Stellen Sie den DIP-Schalter 1 auf ON.

2	 Stellen Sie die Zoom-Position ein, die Sie 
speichern möchten.

3	 Halten Sie den Schalter Memo gedrückt, und 
drücken Sie dann den Schalter Shtl (shuttle).
Die Zoom-Position wird als Shuttle-Position 
gespeichert.
Um schnell zur Shuttle-Position zu gelangen, 
halten Sie den Schalter Shtl (Shuttle) gedrückt.
Sobald Sie den Schalter Shtl (shuttle) 
freigeben, kehrt der Zoom schnell zur 
vorhergehenden Zoom-Position zurück.

Aktuelle 
Zoomposition

Schalter Shtl (Shuttle) 
gedrückt halten

Shuttle-Position

Schalter Shtl 
(Shuttle) loslassen

Ursprüngliche 
Zoompositi

Im Lieferumfang des PXW-X400KF enthaltenes Objektiv

Der PXW-X400KF wird mit einem Objektiv geliefert.
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1.	 Taste PUSH AF (Autofokus)
Bei der Scharfstellung im manuellen Modus kann 
durch Drücken dieser Taste das Motiv automatisch 
scharfgestellt werden.
Drücken Sie die Taste, um den Autofokus zu 
aktivieren, und lassen Sie sie los, wenn das Motiv 
scharfgestellt ist.

2.	 Schalter FOCUS (Anpassungsmodus)
A (automatisch): Aktiviert die normale Autofokus-

Funktion. Sie können die Scharfstellung 
auch dann manuell mit dem Fokussierring 
vornehmen, wenn sich der Schalter in der 
Position „A“ befindet.

M (manuell): Wählt den manuellen Modus für die 
Scharfstellung mit dem Fokussierring.

	 Auch die automatische Scharfstellung ist im 
manuellen Modus verfügbar. Dazu muss die 
Taste PUSH AF gedrückt werden.

3.	 Schalter MACRO
Wenn sich dieser Schalter in der Position ON 
befindet, ist der Makromodus aktiviert, der die 
Fokussierung im gesamten Bereich (von 5 cm 1) bis 
∞) ermöglicht, einschließlich des Makrobereichs 
(von 5 cm 1) bis 80 cm von der Vorderseite des 
Objektivs gemessen).
Diese Funktion ist unabhängig davon, ob 
der automatische oder der manuelle Fokus-
Einstellungsmodus aktiv ist.
1)	 In der Weitwinkel-Einstellung

4.	 Blendenring
Um die Blende manuell einzustellen, stellen Sie 
den Schalter IRIS in die Position M (manuell) und 
drehen Sie dann diesen Ring.

5.	 Zoomring
Um den Zoom manuell einzustellen, stellen Sie 
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den Schalter ZOOM in die Position MANUAL und 
drehen Sie dann diesen Ring.

6.	 Fokussierring
Stellen Sie durch Drehen dieses Rings den Fokus 
ein.
Im AF/MF-Modus arbeitet der 
Fokussiermechanismus umso schneller, je 
schneller Sie den Ring drehen, sodass sich die 
Fokussierung durch geringeren Drehaufwand 
erreichen lässt.
Wenn Sie den Fokussierring zum Camcorder 
hin zurückschieben, wird der Modus Full MF 
(vollständig manueller Fokus) aktiviert, in welchem 
alle Fokuseinstellungen manuell erfolgen 
(Seite 45).

7.	 Taste für Auflagemaß-Einstellung
Drücken Sie diese Taste, um das Auflagemaß (den 
Abstand zwischen der Objektivauflageebene und 
der Brennebene) einzustellen (Seite 28).

8.	 Zoomsteuerungsanschluss (8-polig)
An einen optionalen Zoom-Servo-Controller 
anschließen, um den Zoom fernzusteuern.

9.	 Schalter ZOOM
SERVO: Wählt den Motorzoom. Stellen Sie den 

Zoom mit dem Motorzoomhebel ein.
MANUAL: (manuell): Wählt den manuellen Zoom. 

Stellen Sie den Zoom mit dem Zoomring ein.

10.	 Taste PUSH AUTO (Sofort-Blendenautomatik)
Wenn der Schalter IRIS in der Position M (für 
manuelle Einstellung) steht, drücken Sie diese 
Taste, um eine automatische Soforteinstellung 
durchzuführen. Die Blende wird bei gedrückter 
Taste automatisch eingestellt.

11.	 Schalter IRIS (Anpassungsmodus)
A (automatisch): Die Blende wird automatisch 

eingestellt.
M (manuell): Die Blende wird mit dem Blendenring 

eingestellt.
Motorzoomhebel Dieser ist aktiviert, wenn 
sich der Schalter ZOOM in der Position SERVO 
befindet. Stellen Sie den Hebel in die Position W 

für Weitwinkelaufnahmen und in die Position T für 
Teleaufnahmen.
Drücken Sie den Hebel stärker, um schneller zu 
zoomen, oder leichter, um langsamer zu zoomen.

12.	 Taste RET (Rückvideo)
Sie können dieser Taste auch eine Funktion 
zuweisen und sie als belegbaren Schalter 
verwenden (Seite 124).
Wenn dieser Taste die Funktion „Lens RET“ 
zugewiesen wird, können Sie die Taste nach 
der Aufnahme drücken, um die letzten 
aufgezeichneten Sekunden auf der Sucheranzeige 
anzuzeigen (Überprüfen der Aufzeichnung) 
(Seite 50).
Drücken Sie diese Taste (einmal) während 
der Aufzeichnung oder Wiedergabe, um eine 
Markierung Shot-Mark 1, und zweimal, um 
eine Markierung Shot-Mark 2 aufzuzeichnen 
(Seite 52).
Hinweise zum Autofokus
ˎˎ Das Scharfstellen des Motivs kann in den 
folgenden Fällen schwierig sein. Stellen Sie in 
einem solchen Fall manuell scharf.
–	 Wenn das Motiv keinen Kontrast aufweist
–	 Wenn sich das Motiv schnell bewegt
–	 Wenn die Kamera direkt auf Lichtquellen 

oder Straßenlaternen gerichtet wird oder bei 
Nachtaufnahmen

–	 Wenn sich sehr helle Gegenstände in direkter 
Nähe des Motivs befinden

–	 Bei einer Aufnahme durch ein Glasfenster
ˎˎ Wenn mehrere Objekte auf dem Bildschirm zu 
sehen sind, die sich sowohl im Nah- als auch im 
Fernbereich befinden, kann unter Umständen 
nicht auf das gewünschte Motiv scharfgestellt 
werden. Drücken Sie in diesem Fall auf die 
Taste PUSH AF, wobei sich das Motiv, auf 
das Sie scharf stellen wollen, in der Mitte des 
Bildschirms befinden muss.
ˎˎ Nach dem Scharfstellen mit der Taste PUSH 
AF kann unter Umständen die Schärfentiefe 
abnehmen und damit Schärfe verloren gehen, 
wenn der Zoom verwendet oder die Blende 
eingestellt wird. Drücken Sie in solchen Fällen 

erneut die Taste PUSH AF.
ˎˎ Wenn Sie bei Weitwinkeleinstellung 
scharfstellen und dann in die Teleeinstellung 
zoomen, kann das Motiv aus dem Fokus 
geraten.
ˎˎ Bei Verwendung des Modus mit langer 
Verschlusszeit können einige Augenblicke 
vergehen, bis das Bild scharf ist.

13.	 Taste VTR
Mit dieser Taste können Sie die Aufzeichnung 
starten und stoppen. Drücken Sie die Taste einmal, 
um die Aufzeichnung zu starten, und drücken 
Sie ein weiteres Mal, um die Aufzeichnung zu 
stoppen.

Sucher

1
2
3
4

5

6
7
8

9 10 11

15

16

14 13 12

1.	 Anschluss
Zur Anschließen an den Anschluss VF (26-polig) 
des Camcorders.

2.	 Sucherkabel

3.	 Schiebeanschlag
Verhindert, dass sich der Sucher beim Hin- und 
Herschieben vom Camcorder löst.

4.	 Augenlinse

5.	 Dioptrien-Einstellring
Drehen Sie diesen Ring, um das Sucherbild so 
scharf wie möglich zu stellen.

6.	 Okular
Das Okular kann bei Bedarf angehoben werden.

7.	 Sucherzylinder
Sie können ihn hochstellen oder drehen, wenn es 
die Situation erfordert.
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8.	 Anzeige TALLY
Leuchtet, wenn die Aufnahme durch Drücken der 
Taste REC START auf diesem Camcorder, der Taste 
START/STOP auf dem Objektiv oder der Taste VTR 
auf der Fernbedienung gestartet wird.
Wenn eine Störung erkannt wird, blinkt die 
Kontrollanzeige, um Warnsignale anzuzeigen.

9.	 Regler PEAKING
Wenn Sie diesen Regler im Uhrzeigersinn drehen, 
wird die Schärfe des Bildes eingestellt und so die 
Scharfstellung erleichtert. Diese Einstellung hat 
keine Auswirkung auf das Videoausgangssignal 
des Camcorders.

10.	 Regler CONTRAST
Einstellung des Kontrasts des Sucherbildes. 
Diese Einstellung hat keine Auswirkung auf das 
Videoausgangssignal des Camcorders.

11.	 Regler BRIGHT
Einstellung der Helligkeit des Sucherbildes. 
Diese Einstellung hat keine Auswirkung auf das 
Videoausgangssignal des Camcorders.

12.	 Schalter TALLY
Steuert die Kontrollanzeige auf der Vorderseite des 
Suchers.
HIGH: Die Helligkeit der Kontrollanzeige ist auf 

Hoch eingestellt.
OFF: Die Kontrollanzeige ist deaktiviert.
LOW: Die Helligkeit der Kontrollanzeige ist auf 

niedrig eingestellt.

13.	 Schalter ZEBRA (Streifenmuster)
Zur Steuerung der Streifenmusteranzeige.
ON: Streifenmuster wird angezeigt.
OFF: Streifenmuster wird nicht angezeigt.

14.	 Schalter DISPLAY
ON: Textinformationen werden eingeblendet.
OFF: Textinformationen werden nicht 

eingeblendet.

15.	 Schalter MIRROR
Die Bildanzeige auf dem Monitorbildschirm wird 
horizontal oder vertikal umgekehrt, wenn der 
Sucherzylinder hochgestellt oder gedreht wird.

L/R: Bildumkehr horizontal.
OFF: Keine Bildumkehr.
B/T: Bildumkehr vertikal.

16.	 Mikrofonhalter
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Vorbereitung der Stromversorgung
Verwenden Sie zur Sicherheit nur Akkus und 
Netzteile von Sony, die unten aufgelistet sind.
ˎˎ Lithium-Ionen Akkusatz BP-FLX75

[VORSICHT]
Explosionsgefahr bei Verwendung falscher Batterien. 
Batterien nur durch den vom Hersteller empfohlenen oder 
einen gleichwertigen Typ ersetzen.
Wenn Sie die Batterie entsorgen, müssen Sie die Gesetze der 
jeweiligen Region und des jeweiligen Landes befolgen.

Verwendung eines Akkusatzes

Legen Sie den Akkusatz an der Rückseite des 
Camcorders an und bringen Sie dabei den Strich 
an der Seite des Akkusatzes auf Höhe des Strichs 
am Camcorder. Schieben Sie dann den Akkusatz 
nach unten, bis der Pfeil „LOCK“ am Akkusatz an 
dem Strich am Camcorder ausgerichtet ist.
Um den Akkusatz abzunehmen, ziehen Sie den 
Akkusatz nach oben, wobei Sie die Lösetaste 
gedrückt halten.

[Hinweise]
ˎˎ Wenn der Akkusatz nicht richtig eingesetzt wird, können 

die Anschlüsse beschädigt werden.
ˎˎ Nehmen Sie den Akkusatz keinesfalls während der 

Aufzeichnung und Wiedergabe heraus (während 
die Anzeigeleuchte ACCESS auf der rechten Seite 
blau leuchtet und die Anzeigeleuchte ACCESS im 
Speicherkartenbereich orange leuchtet).  
Dies könnte alle auf der Karte aufgezeichneten Daten 
beschädigen.
ˎˎ Stellen Sie sicher, dass der Camcorder abgeschaltet ist, 

bevor Sie den Akkusatz austauschen.

Mit dem Akkusatz BP-FLX75 kann der Camcorder 
etwa 170 Minuten ununterbrochen betrieben 
werden.

[WARNUNG]
Akkus dürfen keinesfalls übermäßiger 
Wärmeeinwirkung ausgesetzt werden, wie z.B. 
Sonneneinstrahlung, Feuer o. ä.

[Hinweis]
Die Betriebszeit des Akkusatzes hängt von der Häufigkeit des 
Gebrauchs und von der Umgebungstemperatur während 
der Benutzung ab.

Laden Sie den Akkusatz vor Gebrauch mit einem 
geeigneten Akkuladegerät.

Weitere Informationen zum Ladevorgang finden Sie in der 
Bedienungsanleitung des Akkuladegeräts.

Hinweis zur Verwendung des Akkusatzes
Ein erwärmter Akkusatz lässt sich möglicherweise 
nicht vollständig aufladen.

Verwendung von Wechselstrom

Bringen Sie das AC-DN2B/DN10 genauso am 
Camcorder an wie einen Akkusatz und schließen 
Sie es dann an eine Netzsteckdose an.
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Einsetzen eines Suchers
Dieser Abschnitt beschreibt den im Lieferumfang 
der Modelle PXW-X400KC/PXW-X400KF 
enthaltenen Sucher.

[ACHTUNG]
Richten Sie die Okularlinse des Camcorders nicht auf die 
Sonne, wenn der Sucher angebracht ist.
Durch die Linse kann direktes Sonnenlicht einfallen, im 
Sucher fokussiert werden und einen Brand verursachen.

[Hinweis]
Im Lieferumfang der Modelle PXW-X400KC/PXW-X400KF 
ist ein Sucher enthalten. Für den PXW-X400 ist ein Sucher 
separat erhältlich.

Einsetzen des mitgelieferten Suchers

[Hinweis]
Beachten Sie beim Einsetzen eines Suchers die folgenden 
Punkte.
ˎˎ Stellen Sie sicher, dass der Camcorder ausgeschaltet 

ist, bevor Sie den Sucheranschluss in den Anschluss VF 
(26-polig) dieses Geräts stecken. Falls Sie ihn anschließen, 
während der Camcorder eingeschaltet ist, funktioniert der 
Sucher möglicherweise nicht richtig.
ˎˎ Stecken Sie den Sucheranschluss fest in den (26-poligen) 

Anschluss VF des Camcorders. Wenn der Anschluss locker 
ist, erscheint möglicherweise Rauschen auf dem Bild oder 
die Kontrollanzeige arbeitet nicht richtig.

1	 [1] Lösen Sie den Querrichtungs-Fixierring des 
Suchers, [2] bringen Sie den Sucher am 
Sucheraufsteckschuh an, und [3] ziehen Sie 
den Querrichtungs-Fixierring des Suchers fest.

[2]
[1]

[3]

Schiebeanschlag

Querrichtungs-Fixierring

2	 Stecken Sie den Sucheranschluss fest in den 
Anschluss VF (26-polig).
Anschluss VF (26-polig)

Nach 
oben

Zum Abnehmen des Suchers führen Sie das 
Einsetzverfahren in umgekehrter Reihenfolge aus. 
Ziehen Sie bei der Abnahme des Suchers vom 
Aufsteckschuh den Anschlag aber nach oben.

Einstellen der Sucherposition

Um die Querrichtung des Suchers einzustellen, 
lösen Sie den Querrichtungs-Fixierring. Um die 
Längsrichtung des Suchers einzustellen, lösen Sie 
den Längsrichtungs-Fixierknopf.

Querrichtungs-
Fixierring des Suchers

Längsrichtungs-Fixierknopf 
des Suchers

Einstellen des Sucherwinkels

Sie können den Winkel des Suchers einstellen.

Vertikale Umkehrung der Anzeige 
(Bild/Text)

Der Sucher kann um 180 Grad in Richtung des 
Motivs gedreht werden.
Hierdurch werden das Bild und andere 
Informationen im Sucher kopfstehend angezeigt.
Um die normale Anzeige wiederherzustellen, 
stellen Sie den Schalter MIRROR auf der Rückseite 
des Suchers in die Position B/T.

Hochstellen des Sucherzylinders und 
Okulars

Sie können den LCD-Bildschirm oder dessen 
Spiegelbild im Sucher betrachten, indem Sie den 
Sucherzylinder oder das Okular hochstellen.

1	 Drücken Sie gegen den Clip auf der Unterseite, 
um den Sucherzylinder freizugeben und 
hochzustellen.

2	 Der Sucherzylinder rastet in der 120-Grad-
Position ein.

2

1

Er sollte normalerweise in eingerasteter Position 
verwendet werden.
Sie können den Sucherzylinder weiter als bis in 
die eingerastete Position öffnen. Bevor Sie ihn 
wieder in der 120-Grad-Neigung einrasten können, 
müssen Sie ihn zurück in die geschlossene Position 
bringen.
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Abnehmen des Sucherzylinders

1	 Drücken Sie gegen den Clip auf der Unterseite, 
um den Sucherzylinder freizugeben.

2	 Klappen Sie den Sucherzylinder hoch.

3	 Schieben Sie den Hebel auf der Oberseite in 
die dem Sucherzylinder entgegengesetzte 
Richtung.

4	 Nehmen Sie den Sucherzylinder ab, indem Sie 
ihn in horizontaler Richtung verschieben.

3 4

2

1

Horizontale Umkehrung der Anzeige 
(Bild/Text)

Wenn Sie den Schalter MIRROR auf der Rückseite 
des Suchers auf L/R stellen, können Sie das 
Bild und die anderen im Sucher angezeigten 
Informationen horizontal spiegeln.

Einstellen des Dioptrien-Einstellrings

Drehen Sie am Dioptrien-Einstellring, bis das 
Sucherbild am schärfsten ist.

Dioptrien-Einstellring

Sie können auch einen handelsüblichen 
Schutzfilter, ein Makroobjektiv usw. mit einem 
Durchmesser von 52 mm aufsetzen.

Einstellen des Bildschirms

Stellen Sie mit den unten dargestellten Reglern 
Helligkeit, Kontrast und Kantenverstärkung des 
Sucherbildschirms ein.
Konturen: Werden mit dem Regler PEAKING 

eingestellt.
Kontrast: Wird mit dem Regler CONTRAST 

eingestellt.
Helligkeit: Wird mit dem Regler BRIGHT eingestellt.

Anbringen des Sucherdreharms 
BKW-401

Wenn Sie den optionalen Sucherdreharm BKW-401 
anbringen, können Sie den Sucher so drehen, dass 
er nicht gegen Ihr rechtes Bein stößt, wenn Sie den 
Camcorder in der Hand tragen.

1	 Lösen Sie die Längsrichtungs-Fixierhebel und 
die Längsrichtungs-Fixierknöpfe. Ziehen Sie 
dann die Sucherschiebeplatte nach vorne.

2	 Benutzen Sie einen Sechskantschlüssel von 
2,5 mm Schlüsselweite, um die 
Sucherschiebeplatte abzunehmen.

Sucherschiebeplatte

Innensechskantschrauben
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3	 Bringen Sie den BKW-401 mit den 
mitgelieferten Schrauben an.

Mit dem BKW-401 mitgelieferte Schrauben

4	 Stellen Sie die Längsrichtung so ein, dass der 
Arm des BKW-401 den Griff nicht berührt, 
wenn er hochgedreht wird.

So einstellen, dass der Arm den Griff 
nicht berührt
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Erstmalige Verwendung des Camcorders
Konfigurieren Sie bei der ersten Verwendung des 
Camcorders die folgenden Einstellungen im Menü.

Einzelheiten zu Menüfunktionen siehe „Grundlegende 
Konfigurationsmenü-Funktionen“ (Seite 92).

Einstellen der Zeitzone

Stellen Sie die Zeitzone für die Region ein, in der 
das Gerät verwendet wird. Der Standardwert ist 
„UTC Greenwich“.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Time Zone >Time Zone“.

2	 Wählen Sie die zu verwendende Zeitzone aus.

Einstellen von Datum und Uhrzeit der 
internen Uhr

Stellen Sie Jahr, Monat, Tag und Wochentag der 
internen Uhr ein.

1	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Clock Set >Date“.
Der Bildschirm „Date“ wird angezeigt.

2	 Drehen Sie am Regler MENU, um das Jahr, den 
Monat oder Tag auszuwählen, und drücken Sie 
dann den Regler.
Das ausgewählte Jahr, der Monat oder Tag 
können bearbeitet werden.

3	 Drehen Sie am Regler MENU, um das Jahr, den 
Monat oder Tag einzustellen, und drücken Sie 
dann den Regler.

4	 Wiederholen Sie die Schritte 2 und 3, um die 
verbleibenden Ziffern festzulegen.

5	 Drücken Sie die Taste SET.
Die interne Uhr wird auf das in den Schritten 2 
bis 4 eingestellte Datum gestellt.
Als nächstes stellen Sie die Uhrzeit ein.

6	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Clock Set >Time“.
Der Bildschirm Time wird angezeigt.

7	 Stellen Sie die Uhrzeit auf die gleiche Weise 
wie das Datum ein.

8	 Drücken Sie die Taste SET.
Die Zeit wird in der internen Uhr registriert.

Zum Abbrechen der Einstellung betätigen Sie die 
Schaltfläche „Cancel“.
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Montage und Einstellung des Objektivs
[Hinweis]
Wenn Sie das Objektivkabel an diesen Anschluss anschließen 
oder davon trennen, schalten Sie bitte zuerst den Camcorder 
aus.

Anbringen eines Objektivs

Dieser Abschnitt beschreibt als Beispiel, wie der im 
Lieferumfang des Modells PXW-X400KF enthaltene 
Sucher angebracht wird.

1	 Drücken Sie den Objektivfeststellhebel nach 
oben und nehmen Sie die Schutzkappe der 
Objektivfassung ab.

2	 Richten Sie den Zentrierstift des Objektivs auf 
die Kerbe der Objektivfassung aus, und setzen 
Sie das Objektiv in die Fassung ein.

1

1
2

3	 Halten Sie das Objektiv fest und drücken Sie 
den Objektivfeststellhebel nach unten, um das 
Objektiv sicher zu befestigen.

	 [Achtung]
Wenn das Objektiv nicht fest sitzt, kann es sich 
beim Betrieb des Camcorders lösen. Dabei 
kann es zu schweren Schäden kommen. 
Achten Sie deshalb darauf, das Objektiv sicher 
zu befestigen. Es empfiehlt sich, den 
Objektivsicherungsgummi wie unten 
abgebildet am Objektivfeststellhebel 
anzubringen.

3

Objektivsicherungsgummi

4	 Schließen Sie das Objektivkabel an den 
Anschluss LENS an.

5	 Sichern Sie das Objektivkabel mit der 
Kabelklemme.

Wenn ein Objektiv mit Bildfehlerkorrektur 
angeschlossen ist

Die Bildfehlerkorrekturfunktion wird automatisch 
aktiviert. 1) Das Starten des Camcorders mit einem 
Objektiv mit Bildfehlerkorrektur könnte durch das 
Laden von Daten während des Starts länger als 
üblich dauern.
Das im Lieferumfang des PXW-X400 enthaltene 
Objektiv ist ein Objektiv mit Bildfehlerkorrektur. 
Wenden Sie sich für Auskünfte über weitere 
Objektive mit Bildfehlerkorrektur an einen Sony-
Vertreter oder Kundendienst.

1)	 Die Bildfehlerkorrekturfunktion ist nicht verfügbar, 
wenn „Maintenance >Camera Config >ALAC“ im 
Konfigurationsmenü auf „Off“ gesetzt ist.

Einstellung des Auflagemaßes

Falls das Objektiv nicht scharfgestellt bleibt, 
wenn Sie vom Teleobjektiv zum Weitwinkel 
zoomen, stellen Sie das Auflagemaß ein (den 
Abstand zwischen der Objektivauflageebene 
und der Oberfläche des Bildwandlers, auch als 
Flanschbrennweite bezeichnet).
Stellen Sie dies einmal ein, wenn Sie das Objektiv 
montieren oder wechseln.
Verwenden Sie als Motiv für die Einstellung eine 
Auflagemaß-Einstellkarte.

Ca. 3 m

[Hinweise]
ˎˎ Wenn Sie ein Motiv mit unzureichendem Kontrast 

verwenden oder den Camcorder oder das Motiv 
während der Einstellung bewegen, bewirkt dies einen 
Einstellungsfehler.
ˎˎ Platzieren Sie das Motiv (die Auflagemaß-Einstellkarte) so, 

dass es in der Mitte des Bildschirms am Teleobjektivende 
erscheint. Stellen Sie so ein, dass keine in der Nähe 
befindlichen Motive (kein Motiv, das sich näher an der 
Kamera als die Karte befindet) auf dem Bildschirm am 
Weitwinkelende erscheinen.

Einstellen des Auflagemaßes für das im 
Lieferumfang des PXW-X400KC enthaltene 
Objektiv

1	 Stellen Sie 3 m vor der Kamera ein Motiv auf 
(zum Beispiel einen Siemensstern).

2	 Öffnen Sie die Blende.
Bei offener Blende ist die Schärfentiefe 
reduziert. Dies erleichtert die Einstellung.

3	 Stellen Sie den Objektivzoom auf T (Tele).

4	 Stellen Sie das Motiv scharf.

5	 Stellen Sie den Objektivzoom auf W 
(Weitwinkel).

6	 Lösen Sie die F.B.-Arretierschraube am Objektiv 
und stellen Sie das Bild durch Drehen des 
F.B.-Einstellrings scharf.

7	 Wiederholen Sie die Schritte 3 bis 6, bis an 
beiden Enden des Zoomrings die korrekte 
Entfernung erreicht ist.

8	 Wenn die optimale Position des 
F.B.-Einstellrings erreicht ist, ziehen Sie die 
F.B.-Arretierschraube fest.

Einstellen des Auflagemaßes für das im 
Lieferumfang des PXW-X400KF enthaltene 
Objektiv

Bei einem Autofokus-Objektiv wird 
das Auflagemaß beim Zoom- und 
Scharfstellbetrieb automatisch eingestellt.

1	 Stellen Sie ca. 3 m vor der Kamera die im 
Lieferumfang enthaltene Auflagemaß-
Einstellkarte auf.
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2	 Öffnen Sie die Blende.
Bei offener Blende ist die Schärfentiefe 
reduziert. Dies erleichtert die Einstellung.

3	 Stellen Sie den Schalter ZOOM in die Position 
SERVO (Motorzoom-Modus).

4	 Halten Sie die Auflagemaß-Einstelltaste 
3 Sekunden lang gedrückt.
Die folgende Meldung wird auf dem 
Sucherbildschirm angezeigt.

Auto FB Adjust
Executing...

Nach erfolgreicher Einstellung wechselt die 
Meldung auf dem Sucherbildschirm zu

Auto FB Adjust
OK

Wenn die Auflagemaß-Einstellung nicht 
erfolgreich ausgeführt wird

Überprüfen Sie das Motiv und die Lichtverhältnisse 
und nehmen Sie die Einstellung erneut vor.

Einstellen des Auflagemaßes für andere manuelle 
Objektive als PXW-X400KC/PXW-X400KF

1	 Stellen Sie die Blende auf manuelle Bedienung.

2	 Stellen Sie ca. 3 m vor der Kamera die im 
Lieferumfang enthaltene Auflagemaß-
Einstellkarte auf.

3	 Öffnen Sie die Blende.
Bei offener Blende ist die Schärfentiefe 
reduziert. Dies erleichtert die Einstellung.

4	 Lösen Sie die Befestigungsschrauben des F.f- 
oder F.B-Rings (Auflagemaß-Anpassungsring).

5	 Stellen Sie das Objektiv mit dem manuellen 
oder dem Motorzoom in die Teleposition.

6	 Richten Sie den Camcorder auf die Karte, 
drehen Sie am Fokussierring, und stellen Sie 
darauf scharf.

7	 Stellen Sie den Zoomring auf Weitwinkel.

8	 Drehen Sie den Auflage- oder F.B-Ring, bis die 
Karte scharfgestellt ist, und achten Sie darauf, 
dabei nicht den Fokussierring zu bewegen.

9	 Wiederholen Sie Schritte 5 bis 8, bis sich die 
Karte über den ganzen Bereich vom 
Weitwinkel bis zum Teleobjektiv im Fokus 
befindet.

10	Ziehen Sie die Befestigungsschrauben des F.f- 
oder F.B-Rings wieder an.
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Vorbereitung des Audioeingabesystems
Anschluss eines Mikrofons an den 
Anschluss MIC IN

Bringen Sie das im Lieferumfang enthaltene 
Mikrofon am Mikrofonhalter des im Lieferumfang 
enthaltenen Suchers an.

1	 Lösen Sie die Schraube und öffnen Sie die 
Mikrofonhalterschelle.

[1]
[2]

Mikrofonhalterschelle

2	 Stecken Sie das Mikrofon in den 
Mikrofonhalter.
[1]	 Positionieren Sie das Mikrofon so, dass die 

Markierung „UP“ nach oben weist.
[2]	 Schließen Sie den Mikrofonhalter.
[3]	 Ziehen Sie die Schraube fest.

[2] [3]

[1]

Einzelheiten zum Anbringen des Mikrofons entnehmen Sie 
bitte der Bedienungsanleitung des Mikrofons.

3	 Stecken Sie das Mikrofonkabel in den 
Anschluss MIC IN, und stellen Sie dann den 
Schalter AUDIO IN für den Kanal, auf dem Sie 
mit diesem Mikrofon aufnehmen möchten, auf 
FRONT ein.

4	 Sichern Sie das Mikrofonkabel mit der 
Kabelklemme.

Anschluss von Mikrofonen an die 
Anschlüsse AUDIO IN

Mit dem optionalen Mikrofonhalter CAC-12 
können bis zu zwei Monomikrofone an die 
Anschlüsse AUDIO IN CH-1/CH-2 angeschlossen 
werden.
Unterstützte Mikrofone: Elektret-

Kondensatormikrofon ECM-674/678

Informationen zum Anbringen des Mikrofonhalters und des 
Mikrofons finden Sie in der Bedienungsanleitung des jeweiligen 
Geräts.

Anbringen eines drahtlosen 
Empfängers

Um ein drahtloses Sony Mikrofonsystem zu 
verwenden, schalten Sie den Camcorder aus und 
schließen Sie einen drahtlosen Empfänger an.
ˎˎ Drahtloser Digitalempfänger DWR-S02D
ˎˎ WRR-855S, URX-S03D UHF-Synthesizer-Tuner

Informationen zum Anbringen eines drahtlosen Empfängers 
finden Sie in der Bedienungsanleitung des Geräts.

Anschluss eines Audiogeräts mit 
Line-Eingang

1	 Schließen Sie den Audioausgangsanschluss 
des Audiogeräts, von dem das Line-
Eingangssignal eingespeist wird, an den 
Anschluss AUDIO IN CH-1 oder CH-2 an.

2	 Stellen Sie den Wahlschalter AUDIO IN für den 
Kanal, dem die Audiosignalquelle 
angeschlossen ist, auf LINE.

Automatische Erkennung einer XLR-Verbindung

ˎˎ Bei ausgeschalteter automatischer Erkennung 
einer XLR-Verbindung (werkseitige 
Standardeinstellung): Stellen Sie den Schalter 
AUDIO IN CH1/CH2 für die Kanäle, an die das 
Audiogerät angeschlossen ist, auf REAR ein.
ˎˎ Bei eingeschalteter automatischer Erkennung 
einer XLR-Verbindung: Wenn ein Kabel an 
den Anschluss AUDIO IN CH-1 oder CH-2 
angeschlossen ist, wird ungeachtet der 
Einstellung des Schalters AUDIO IN CH1/CH2 das 
an dieser Buchse angelegte Signal automatisch 
zur Aufzeichnung von Audio verwendet.

Die Funktion zur automatischen Erkennung eines 

XLR-Anschlusses kann durch „Maintenance >Audio 
>Rear XLR Auto“ im Konfigurationsmenü ein- und 
ausgeschaltet werden.

[2][1] [3]

[4]

[1]	 Schalter AUDIO IN CH1/CH2
[2]	 Zum Anschluss AUDIO IN CH-1 oder CH-2
[3]	 Monomikrofon
[4]	 Wahlschalter AUDIO IN
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Befestigung auf einem Stativ

1	 Bringen Sie den optionalen Stativaufsatz 
VCT-14/U14 am Stativ an.

2	 Montieren Sie den Camcorder auf dem 
Stativaufsatz.

Schieben Sie den Camcorder entlang der 
Aufsatzführung nach vorn, bis er hörbar 
einrastet.

3	 Kontrollieren Sie die sichere Befestigung des 
Camcorders, indem Sie diesen vor- und zurück 
bewegen.

Um den Camcorder vom Stativaufsatz 
abzunehmen, drücken Sie den roten Knopf und 
drücken Sie den Hebel in Pfeilrichtung.

Rote Taste

Hebel

[Hinweis]
Der Stativaufsatzstift steckt eventuell noch nach dem 
Abnehmen des Camcorders fest. Sollte dies der Fall sein, 
drücken Sie die rote Taste und bewegen Sie den Hebel 
wie oben dargestellt, bis der Stift auf seine gelöste Position 
zurückspringt. Sollte der Stift feststecken, können Sie den 
Camcorder nicht auf dem Stativaufsatz montieren.

Anschluss einer Videoleuchte

Sie können für diesen Camcorder die 
Anton Bauer Ultralight 2 oder eine ähnliche 
Videoleuchte (12-V-Betrieb bei einem maximalen 
Energieverbrauch von 50 W) verwenden.
ˎˎ Wenn Sie die Videoleuchte an den Anschluss 
LIGHT des Camcorders anschließen und den 
Schalter LIGHT auf AUTO stellen, wird die 
Leuchte automatisch beim Starten und Stoppen 
der Aufzeichnung auf diesem Camcorder ein- 
und ausgeschaltet.
ˎˎ Der Anschlussausgang LIGHT des Camcorders 
wird auf 12 V heruntergeregelt, selbst wenn der 
Camcorder mit über 12 V versorgt wird (über 
den Anschluss DC IN oder Akkusatz). Helligkeit 
und Farbtemperatur der Leuchte ändern sich 
mit der Spannungserhöhung nicht.

[Hinweise]
ˎˎ Schließen Sie keine Videoleuchte mit einer 

Leistungsaufnahme von 50 W oder mehr an.
ˎˎ Helligkeit bzw. Farbtemperatur der Leuchte ändern sich, 

wenn die Spannung (von dem Anschluss DC IN oder vom 
Akkusatz) auf unter 12 V sinkt.

Um eine Videoleuchte anzubringen, befestigen 
Sie diese am Zubehörschuh des Camcordergriffs 
und schließen Sie das Videoleuchtenkabel an den 
Anschluss LIGHT an.

[Hinweis]
Der Zubehörschuh des Camcorders weist ein 1/4-Zoll-
Gewindeloch auf. Falls Sie dies durch eine Zubehörschiene 
ersetzen möchten, verwenden Sie den Cold Shoe-
Zubehörsatz.

Anbringen des Schulterriemens

1	 Stecken Sie eine der Klammern in einen 
Schulterriemenhalter.

Am Riemen ziehen, bis die 
Spange einrastet.

Clip

2	 Stecken Sie die andere Spange genauso in den 
Schulterriemenhalter auf der anderen Seite des 
Griffs.

Zum Abnehmen des Schulterriemens gehen 
Sie entsprechend dem folgenden Schaubild 
vor.

Zum Lösen hier drücken und in 
Pfeilrichtung ziehen.

Einstellung der 
Schulterpolsterposition

Sie können das Schulterpolster um 40 mm nach 
vorne und hinten verschieben. So lässt sich das 
Gewicht des Camcorders während der Aufnahme 
optimal verteilen, wenn Sie ihn auf der Schulter 
tragen.

1,3

2
Schulterpolster

1	 Lockern Sie das Schulterpolster durch 
Anheben des Hebels in der Mitte des 
Schulterpolsters.

2	 Schieben Sie das Schulterpolster nach hinten 
oder vorne in die für Sie bequemste Position.

3	 Drücken Sie den Hebel herunter, um das 
Schulterpolster in der gewählten Position zu 
fixieren.

Anbringen und Einstellen von Peripheriegeräten
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Verwendung von SxS-Speicherkarten
Dieser Camcorder speichert Audio- und 
Videodaten auf SxS-Speicherkarten 
(optional), die in einem oder beiden seiner 
Speicherkarteneinschübe geladen sind.
Neben SxS-Speicherkarten können Sie für 
Aufzeichnungen mit dem Camcorder auch XQD-
Speicherkarten (nicht im Lieferumfang enthalten) 
unter Verwendung des XQD ExpressCard-Adapters 
QDA-EX1 oder SDXC/SDHC Karten (nicht im 
Lieferumfang enthalten) unter Verwendung 
des Medienadapters MEAD-SD02 (optional) 
verwenden.
Das Dateisystem von den einzelnen Medientypen 
unterstützte Dateisystem wird im Folgenden 
angegeben.

Speicherkarte Dateisystem
exFAT UDF FAT

SxS-Speicherkarten Ja Ja Nein
XQD-Speicherkarten Ja Ja Nein
SDXC-Karten Ja Nein Nein
SDHC-Karten Nein Nein Ja

Übersicht über SxS-Speicherkarten

SxS-Speicherkarten

Verwenden Sie mit diesem Camcorder Sony SxS-
Speicherkarten (SxS PRO+, SxS PRO oder SxS-1).

SxS PRO+ 
SxS PRO 
SxS-1

Die oben aufgeführten Speicherkarten 
entsprechen dem ExpressCard-Standard für 
Speicherkarten.
ˎˎ SxS, SxS PRO+, SxS PRO und SxS-1 sind 
Warenzeichen der Sony Corporation.
ˎˎ Die ExpressCard-Kennzeichnung und das 

ExpressCard-Logo sind Eigentum der Personal 
Computer Memory Card International 
Association (PCMCIA) und werden von der Sony 
Corporation in Lizenz verwendet. Alle anderen 
Marken und Handelsbezeichnungen sind 
Eigentum der jeweiligen Rechteinhaber.

Einsetzen von SxS-Speicherkarten

1	 Schieben Sie die Abdeckung zum Öffnen nach 
links.

2	 Setzen Sie eine SxS-Speicherkarte in einen 
Einschub ein.

Einschub A

Einschub B

	 [Hinweis]
Achten Sie darauf, die SxS-Karte in der richtigen 
Ausrichtung einzulegen. Halten Sie die Karte so, dass der 
Pfeil auf der einen Seite in die im Diagramm dargestellte 
Richtung weist und setzen Sie die Karte ein.

Die Anzeige ACCESS leuchtet zunächst orange 
und dann grün, um anzuzeigen, dass die 
Speicherkarte verwendet werden kann.

3	 Schließen Sie die Abdeckung.

Status der Anzeige ACCESS

Die Karteneinschübe A und B besitzen jeweils eine 
Anzeige ACCESS, die den Einschubstatus anzeigt.

Zugriffsanzeige für Einschub 
A

Zugriffsanzeige für Einschub 
B

Anzeige Einschubstatus
Leuchtet 
orange

Zugriff auf die SxS-Speicherkarte 
(leuchtet während des Lesens und 
Schreibens von Daten)

Leuchtet 
grün

Bereitschaft (die eingesetzte SxS-
Speicherkarte ist bereit zur Aufnahme 
oder Wiedergabe)

Leuchtet 
nicht

Es ist keine SxS-Speicherkarte 
eingesetzt.
Eine unbrauchbare Karte ist 
eingesetzt.
Es ist eine SxS-Speicherkarte 
eingesetzt, jedoch ist ein anderer 
Einschub ausgewählt.

Auswerfen von SxS-Speicherkarten

1	 Öffnen Sie die Abdeckung, drücken Sie dann 
die EJECT-Taste, um die Sperre zu lösen und 
die Taste hervorspringen zu lassen.

Drücken Sie die Taste 
einmal, um die Sperre 
zu lösen.

2	 Drücken Sie die Taste EJECT erneut, um die 
Karte auszuwerfen.

	 [Hinweis]
Achten Sie darauf, die Bewegung der SxS-Speicherkarte 
nicht zu behindern, wenn Sie die Taste EJECT drücken. 
Wenn die Bewegung der SxS Speicherkarte behindert 
wird, wird unter Umständen die Verriegelung nicht 
freigeben.

[Hinweis]
Die Integrität der Daten kann nicht garantiert werden, wenn 
während des Zugriffs auf die Speicherkarte der Camcorder 
ausgeschaltet oder die Karte entnommen wird. In diesem 
Fall können alle auf der Karte gespeicherten Daten verloren 
gehen. Stellen Sie stets sicher, dass die Anzeige ACCESS 
grün leuchtet oder nicht leuchtet, bevor sie den Camcorder 
ausschalten oder eine Speicherkarte entnehmen.
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Auswählen der zu verwendenden 
SxS-Speicherkarte

Wenn sowohl im Einschub A und im Einschub B 
SxS-Speicherkarten eingesetzt sind, können Sie die 
zu verwendende SxS-Speicherkarte durch Drücken 
der Taste SLOT SELECT wählen.
Wenn die verbleibende Aufnahmezeit auf der SxS-
Speicherkarte, auf der aufgezeichnet wird, weniger 
als 60 Sekunden beträgt, blinkt die Anzeige für die 
verbleibende Kapazität für den entsprechenden 
Medieneinschub auf dem Sucherbildschirm 
und zeigt an, dass der Camcorder bald die SxS-
Speicherkarte wechselt.
Der Camcorder schaltet dann automatisch auf die 
andere Karte um, wenn die ausgewählte Karte voll 
wird, und die Aufzeichnung wird fortgesetzt.

[Hinweis]
Die Taste SLOT SELECT ist während der Wiedergabe 
deaktiviert. Die Speicherkarten werden nicht gewechselt, 
selbst wenn Sie die Taste drücken. Die Tastenbefehle werden 
aktiviert, wenn eine Skizzenbilderanzeige (Seite 83) 
angezeigt wird.

Formatieren (Initialisieren) der SxS-
Speicherkarten

Wenn eine unformatierte SxS-Speicherkarte oder 
eine mit einer anderen Spezifikation formatierte 
SxS-Speicherkarte eingesetzt wird, wird eine 
Meldung angezeigt, die besagt, dass das Medium 
ein anderes Dateisystem aufweist. Formatieren 
Sie die Speicherkarte in diesem Fall auf folgende 
Weise.
SxS-Speicherkarten sind in der Werkseinstellung im 
Dateisystem exFAT oder FAT formatiert.

[Hinweis]
SxS-Speicherkarten müssen mit einem das exFAT- oder UDF-
Dateisystem unterstützenden XDCAM-Gerät oder auf diesem 
Camcorder formatiert werden. Es können keine Karten in 
anderen Formaten verwendet werden.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Format Media“.

2	 Wählen Sie „Media(A)“ (Einschub A) oder 
„Media(B)“ (Einschub B).

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm mit der Frage, ob 
die Karte formatiert werden soll, wird 
angezeigt.

4	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.
Die Formatierung wird gestartet.
Während der Formatierung wird eine Meldung 
angezeigt, und die Anzeige ACCESS leuchtet 
orange.
Am Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

Wenn die Formatierung fehlschlägt

Ein Formatiervorgang kann fehlschlagen, weil 
die SxS-Speicherkarte schreibgeschützt ist oder 
weil der Kartentyp nicht für die Verwendung mit 
diesem Camcorder vorgesehen ist.
In diesem Fall erscheint eine Fehlermeldung. 
Befolgen Sie die Anweisungen in der 
Fehlermeldung und ersetzen Sie die Karte durch 
eine SxS-Speicherkarte, die mit diesem Camcorder 
verwendet werden kann.

[Hinweise]
ˎˎ Beim Formatieren einer Speicherkarte werden alle Daten 

gelöscht, einschließlich der aufgezeichneten Videodaten 
und der Konfigurationsdateien. 
ˎˎ Verwenden Sie die Formatierfunktion dieses Camcorders 

zum Formatieren von SxS-Speicherkarten, die mit diesem 
Camcorder verwendet werden sollen. Die Formate von 
mit anderen Geräten formatierten Karten werden nicht als 
gültige Formate anerkannt, weshalb sie erneut mit diesem 
Camcorder formatiert werden müssen.

Formatieren bei der Aufnahme

Die im anderen Steckplatz befindliche SxS-
Speicherkarte kann auch während der Aufnahme 
formatiert werden.

[Hinweis]
ˎˎ Das Formatieren wird während der Wiedergabe und bei 

eingeblendeter Skizzenbilderanzeige nicht unterstützt.
ˎˎ Während dem Formatieren kann keine Aufnahme auf 

eine sich im anderen Karteneinschub befindliche SxS-
Speicherkarte gestartet werden.

Überprüfen der verbleibenden 
Aufzeichnungszeit

Sie können die verbleibende Kapazität auf 
den in den zwei Einschüben eingesetzten 
SxS-Speicherkarten überprüfen, indem Sie 
die Anzeige der verbleibenden Medien-
Aufzeichnungskapazität im Sucher betrachten.
Die verbleibende Aufzeichnungszeit wird auf 
der Grundlage der Restkapazität des Mediums in 
jedem Einschub und des aktuellen Videoformats 
(Aufzeichnungs-Bitrate) berechnet und in Minuten 
angezeigt.
Sie können die verbleibende Kapazität auf 
dem Bildschirm Media Status auf einem 
Balkendiagramm überprüfen (Seite 15).

[Hinweis]
Das  -Zeichen erscheint, wenn eine Speicherkarte 
schreibgeschützt ist.

Austauschen von SxS-Speicherkarten

ˎˎ Wenn die gesamte verbleibende 
Aufzeichnungszeit beider Speicherkarten 
während der Aufzeichnung weniger als fünf 
Minuten beträgt, erscheint die Warnmeldung 
„Media Near Full“, die WARNING-Anzeige und 
die REC-Anzeige auf der Sucheranzeige blinken, 
und der Summer ertönt.  
Ersetzen Sie eine der Karten durch ein Medium 
mit verfügbarer Aufzeichnungskapazität.
ˎˎ Wenn Sie die Aufzeichnung fortsetzen, erscheint 
die Meldung „Media Full“ und die Aufzeichnung 
stoppt, wenn die Gesamtaufzeichnungszeit 0 
unterschreitet.

[Hinweis]
Auf einer SxS-Speicherkarte können bis zu ca. 600 Clips 
gespeichert werden.
Die Anzeige der verbleibenden Aufzeichnungszeit wird zu 
„0“ und die Meldung „Media Full“ erscheint, wenn die Clip-
Grenze erreicht wird.

Wiederherstellen von SxS-
Speicherkarten

Sollte aus jeglichem Grund ein Fehler in einer 
Speicherkarte auftreten, muss die Karte vor der 
Verwendung wiederhergestellt werden.
Wenn Sie eine SxS-Speicherkarte einsetzen, die 
wiederhergestellt werden muss, erscheint eine 
Meldung im Sucher, um Sie zu fragen, ob Sie sie 
wiederherstellen wollen.

Um die Wiederherstellung auszuführen, drehen Sie 
am Regler MENU, um [Execute] auszuwählen, und 
drücken Sie dann den Regler MENU.
Die Wiederherstellung beginnt.
Während der Wiederherstellung wird eine 
Meldung angezeigt, und die Anzeige ACCESS 
leuchtet orange.
Am Ende der Wiederherstellung wird eine 
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Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

Wenn die Wiederherstellung fehlschlägt

ˎˎ Schreibgeschützte SxS-Speicherkarten und 
Karten, auf denen Speicherfehler aufgetreten 
sind, können nicht wiederhergestellt werden. 
Bei solchen Karten erscheint eine Warnmeldung. 
Befolgen Sie die Anweisungen in der Meldung 
und heben Sie den Schreibschutz der Karte auf 
oder ersetzen Sie sie durch eine andere Karte.
ˎˎ SxS-Speicherkarten, auf denen Speicherfehler 
aufgetreten sind können durch Wieder-
Formatierung eventuell wieder funktionsfähig 
werden.
ˎˎ In manchen Fällen können einige Clips 
wiederhergestellt werden und andere nicht. 
Die wiederhergestellten Clips können normal 
wiedergegeben werden.
ˎˎ Falls auch nach wiederholten 
Wiederherstellungsversuchen die Meldung 
„Could not Restore Some Clips“ erscheint, 
kann die SxS-Speicherkarte eventuell mit dem 
folgenden Verfahren wiederhergestellt werden.

[1]	 Verwenden Sie die Anwendungssoftware 
(Seite 172) zum Kopieren der 
erforderlichen Clips auf eine andere 
SxS-Speicherkarte.

[2]	 Formatieren Sie die unbrauchbare SxS-
Speicherkarte am Camcorder.

[3]	 Kopieren Sie die benötigten Clips zurück 
auf die neuformatierte SxS-Speicherkarte.
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Die folgenden SD-Karten können zum Speichern 
von Konfigurationsdaten verwendet werden.

SDHC-Speicherkarten* (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 4 GB bis 32 GB)
*	 In diesem Handbuch als „SD-Karten“ bezeichnet.

Formatieren (Initialisieren) von SD-
Karten

SD-Karten müssen bei der erstmaligen 
Verwendung im Camcorder formatiert werden.
SD-Karten für die Verwendung im Camcorder 
müssen mit der Formatierungsfunktion des 
Camcorders formatiert werden. Wenn beim 
Einsetzen einer SD-Karte eine entsprechende 
Meldung angezeigt wird, formatieren Sie die SD-
Karte.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Format Media >SD Card (Utility)“.
Ein Bestätigungsbildschirm mit der Frage, ob 
die Karte formatiert werden soll, wird 
angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Die Formatierung wird gestartet.
Während der Formatierung wird eine Meldung 
angezeigt, und die Anzeige ACCESS leuchtet 
orange.
Am Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

[Hinweis]
Beim Formatieren einer SD-Karte werden alle Daten auf 
der Karte gelöscht. Die Daten auf der Karte können nicht 
wiederhergestellt werden.

Überprüfen der verbleibenden 
Kapazität

Sie können die verbleibende Kapazität auf 
einer SD-Karte auf dem Bildschirm Media Status 
überprüfen (Seite 15).
Um eine im Camcorder formatierte SD-Karte im 
Einschub eines anderen Geräts zu verwenden, 
erstellen Sie eine Sicherungskopie der Karte und 
formatieren Sie dann die Speicherkarte in dem 
anderen Gerät.

Umgang mit SD-Karten zum Speichern von Konfigurationsdaten
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[Hinweise]
ˎˎ Für professionelle Anwendungen bietet die Nutzung 

anderer Medien nicht die gleiche hohe Zuverlässigkeit 
und Haltbarkeit wie die Nutzung von SxS-Speicherkarten.
ˎˎ Die Funktion mit diesem Camcorder ist nicht für alle 

Speicherkarten garantiert. Informationen zu kompatiblen 
Speicherkarten erhalten Sie von Ihrem Sony-Händler.

XQD-Speicherkarten

Wenn Sie einen optionalen XQD ExpressCard-
Adapter QDA-EX1 verwenden, können Sie eine 
XQD-Speicherkarte in den SxS-Karteneinschub 
einsetzen und anstelle einer SxS-Speicherkarte 
verwenden.

Einzelheiten zum Verwenden eines XQD ExpressCard-Adapters 
QDA-EX1 finden Sie im Handbuch des Adapters.

[Hinweis]
Die folgenden Funktionen sind je nach Typ der verwendeten 
XQD-Speicherkarten möglicherweise nicht verfügbar.
ˎˎ Wiedergabe mit hoher Geschwindigkeit
ˎˎ Aufnahme in Zeitlupe/Zeitraffer

Formatieren (Initialisieren)

XQD-Speicherkarten müssen bei der erstmaligen 
Verwendung im Camcorder formatiert werden.
XQD-Speicherkarten für die Verwendung im 
Camcorder müssen mit der Formatierungsfunktion 
des Camcorders formatiert werden. Wenn 
beim Einsetzen einer XQD-Speicherkarte eine 
entsprechende Meldung angezeigt wird, 
formatieren Sie die XQD-Speicherkarte.
Wenn eine unformatierte XQD-Speicherkarte oder 
eine mit einer anderen Spezifikation formatierte 
XQD-Speicherkarte eingesetzt wird, wird eine 
Bestätigungsabfrage zur Formatierung angezeigt, 
oder es wird eine Meldung angezeigt, die besagt, 
dass das Medium ein anderes Dateisystem besitzt.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Format Media“.

2	 Wählen Sie „Media(A)“ (Einschub A) oder 
„Media(B)“ (Einschub B).

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm mit der Frage, ob 
die Karte formatiert werden soll, wird 
angezeigt.

4	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.
Die Formatierung wird gestartet.
Während der Formatierung wird eine Meldung 
angezeigt, und die Anzeige ACCESS leuchtet 
orange.
Am Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

[Hinweis]
Beim Formatieren einer XQD-Speicherkarte werden alle 
Daten auf der Karte, einschließlich geschützter Videos, 
gelöscht. Die Daten können nicht wiederhergestellt werden.

Verbindung zwischen dem Camcorder und einem 
Computer

Setzen Sie die XQD-Speicherkarte mit der 
Aufnahme in den Steckplatz im Camcorder ein 
und schließen Sie den Camcorder über ein USB-
Kabel an einen Computer an.

Um eine im Camcorder formatierte Speicherkarte 
im Einschub eines anderen Geräts zu verwenden

Erstellen Sie zunächst eine Sicherungskopie der 
Karte und formatieren Sie dann die Speicherkarte 
in dem anderen Gerät.

SD-Karten

Wenn Sie einen optionalen Medienadapter  
MEAD-SD02 verwenden, können Sie eine SD-Karte 
in einen SxS-Karteneinschub einsetzen und zur 
Aufzeichnung und Wiedergabe verwenden.

[Hinweis]
Falls eine SD-Karte und eine andere Karte gleichzeitig 
verwendet werden, schaltet der Camcorder nicht zwischen 
den Karten um, wenn das Medium voll wird. Stattdessen 
wird die Aufnahme gestoppt.

Die folgenden SD-Karten werden unterstützt.
SDXC Speicherkarten (SD-Geschwindigkeitsklasse: 
Class 10) 1)

SDHC Speicherkarten (SD-Geschwindigkeitsklasse: 
Class 10) 2)

1)	 Beim Dateisystem exFAT unterstützt.
2)	 Beim Dateisystem FAT unterstützt.

Einzelheiten zum Verwenden eines Medienadapters MEAD-SD02 
finden Sie im des Adapters.

[Hinweise]
ˎˎ Bei Verwendung einer SD-Karte ist eine korrekte 

Hochgeschwindigkeitswiedergabe unter Umständen 
nicht möglich.
ˎˎ Bei Aufnahmen im XAVC-I-Format wird die Aufnahme und 

Wiedergabe mit SD-Karten nicht unterstützt.
ˎˎ Mit einer SDXC-Karte kann die Zeitlupenaufzeichnung der 

Funktion Zeitlupe und Zeitraffer nicht verwendet werden.

Formatieren (Initialisieren)

SD-Karten müssen bei der erstmaligen 
Verwendung im Camcorder formatiert werden.
SD-Karten für die Verwendung im Camcorder 
müssen mit der Formatierungsfunktion des 
Camcorders formatiert werden. Wenn beim 
Einsetzen einer SD-Karte eine entsprechende 
Meldung angezeigt wird, formatieren Sie die  
SD-Karte.
Wenn eine unformatierte SD-Speicherkarte oder 
eine mit einer anderen Spezifikation formatierte 
SD-Speicherkarte eingesetzt wird, wird eine 
Bestätigungsabfrage zur Formatierung angezeigt, 

oder es wird eine Meldung angezeigt, die besagt, 
dass das Medium ein anderes Dateisystem besitzt.
Formatieren Sie die Karte wie folgt:

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Format Media“.

2	 Wählen Sie „Media(A)“ (Einschub A) oder 
„Media(B)“ (Einschub B).

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm mit der Frage, ob 
die Karte formatiert werden soll, wird angezeigt.

4	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.
Die Formatierung wird gestartet.
Während der Formatierung wird eine Meldung 
angezeigt, und die Anzeige ACCESS leuchtet 
orange.
Am Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

[Hinweis]
Beim Formatieren einer SD-Karte werden alle Daten auf der 
Karte, einschließlich geschützter Videos, gelöscht. Die Daten 
können nicht wiederhergestellt werden.

Verbindung zwischen dem Camcorder und einem 
Computer

Setzen Sie die SD-Karte mit der Aufnahme in 
den Steckplatz im Camcorder ein und schließen 
Sie den Camcorder über ein USB-Kabel an einen 
Computer an.

Um eine im Camcorder formatierte Speicherkarte 
im Einschub eines anderen Geräts zu verwenden
Erstellen Sie zunächst eine Sicherungskopie der 
Karte und formatieren Sie dann die Speicherkarte 
in dem anderen Gerät.

Verwenden eines Medienadapters
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Formateinstellungen
Mit der Befehlsfolge „Operation >Format“ im Konfigurationsmenü können Sie das Dateisystem, die 
Systemfrequenz und das Videoformat festlegen.

Einzelheiten zu Menüfunktionen siehe „Grundlegende Konfigurationsmenü-Funktionen“ (Seite 92).

Wahl des Dateisystems

Sie können das Dateisystem auswählen.

1	 Wählen Sie im Konfigurationsmenü „Operation >Format >File System“.

2	 Drehen Sie den Regler MENU, um ein Dateisystem auszuwählen, und drücken Sie dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Wählen Sie [Execute] zum Ausführen oder [Cancel] zum Abbrechen, und drücken Sie den Regler 
MENU.
Der Camcorder startet nach dem Befehl [Execute] automatisch neu.

[Hinweis]
Das Dateisystem kann nicht während der Aufnahme/Wiedergabe und bei eingeblendeter Skizzenbilderanzeige geändert 
werden.

Umschalten der Systemfrequenz

Sie können die Systemfrequenz nach Bedarf umschalten.

[Hinweise]
ˎˎ Die Systemfrequenz kann während der Aufzeichnung bzw. Wiedergabe und während der Anzeige der Skizzenbilderanzeige 

nicht geändert werden.
ˎˎ Wenn Sie zwischen 29.97 und 59.94 oder zwischen 25 und 40 gewechselt haben, wird der Camcorder nicht automatisch 

neu gestartet.

1	 Wählen Sie im Konfigurationsmenü „Operation >Format >Frequency“.

2	 Drehen Sie am Regler MENU, um die Systemfrequenz auszuwählen, und drücken Sie den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Wählen Sie [Execute] zum Ausführen oder [Cancel] zum Abbrechen, und drücken Sie den Regler 
MENU.
Der Camcorder startet nach dem Befehl [Execute] automatisch neu.

Umschalten des Videoformats

Beim Umschalten des Videoformats beachten Sie nach Bedarf die Hinweise im Abschnitt „Videoformate“ 
(Seite 37).

1	 Wählen Sie im Konfigurationsmenü „Operation >Format >Rec Format“.

2	 Drehen Sie am Regler MENU, um das Videoformat zu ändern, und drücken Sie den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Wählen Sie [Execute] zum Ausführen oder [Cancel] zum Abbrechen, und drücken Sie den Regler 
MENU.

Videoformate

Die folgenden Aufzeichnungsformate können für unterschiedliche Kombinationen von Videoauflösung 
und Systemfrequenz gewählt werden.

Systemfrequenz 
(„Operation >Format 
>Frequency“ im 
Konfigurationsmenü)

Dateisystem 
(„Operation >Format 
>File System“ im 
Konfigurationsmenü)

Videoformat  
(„Operation >Format >Rec 
Format“ im 
Konfigurationsmenü)

Bildformat

exFAT UDF FAT
59.94/50 Ja – – XAVC-I 1920×1080P 1920×1080

Ja – – XAVC-I 1920×1080i
Ja – – XAVC-I 1280×720P 1280×720
Ja – – XAVC-L 50 1920×1080P 1920×1080
Ja – – XAVC-L 50 1920×1080i
Ja – – XAVC-L 50 1280×720P 1280×720
Ja – – XAVC-L 35 1080P 1920×1080
Ja – – XAVC-L 35 1080i
Ja – – XAVC-L 25 1080i
Ja Ja – HD422 50 1080i 1920×1080
Ja Ja – HD422 50 720P 1280×720
Ja Ja Ja HQ 1920×1080i 1920×1080
Ja Ja Ja HQ 1440×1080i 1440×1080
Ja Ja Ja HQ 1280×720P 1280×720
– – Ja SP 1440×1080i 1440×1080
Ja Ja – MPEG IMX 50 720×486/720×576
Ja Ja – DVCAM 720×480/720×576
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Systemfrequenz 
(„Operation >Format 
>Frequency“ im 
Konfigurationsmenü)

Dateisystem 
(„Operation >Format 
>File System“ im 
Konfigurationsmenü)

Videoformat  
(„Operation >Format >Rec 
Format“ im 
Konfigurationsmenü)

Bildformat

exFAT UDF FAT
29.97/25/23.98 Ja – – XAVC-I 1920×1080P 1920×1080

Ja – – XAVC-L 50 1920×1080P 1920×1080
Ja – – XAVC-L 35 1080P
Ja Ja – HD422 50 1080P 1920×1080
Ja Ja – HD422 50 720P 1280×720
Ja Ja Ja HQ 1920×1080P 1920×1080

Ausgabeformate des Anschlusses SDI OUT und des HDMI-Ausgangs

Die Signale, die an den Anschlüssen SDI OUT und an der HDMI-Ausgangsbuchse ausgegeben werden 
können, sind in der folgenden Tabelle in Abhängigkeit von der Einstellung „Operation >Format“ im 
Konfigurationsmenü aufgeführt.

Menü „Operation“

Format Input/Output

Frequency Rec Format (ohne Codec) Output Format

SDI HDMI

59.94 1920×1080P 1920×1080P (Level A) 1920×1080P

1920×1080P (Level B) Kein Signal

1920×1080i 1920×1080i

720×486i 720×480i

1920×1080i 1920×1080i 1920×1080i

720×486i 720×480i

1440×1080i 1920×1080i 1920×1080i

720×486i a) 720×480i a)

1280×720P 1280×720P 1280×720P

720×486i 720×480i

720×480i 720×486i 720×480i

Kein Signal 720×480P

Menü „Operation“

Format Input/Output

Frequency Rec Format (ohne Codec) Output Format

SDI HDMI

29.97 1920×1080P 1920×1080PsF 1920×1080i

720×486i 720×480i

1280×720P 1280×720P 1280×720P

720×486i 720×480i

23.98 1920×1080P 1920×1080PsF Kein Signal

1920×1080i (2-3PD) 1920×1080i (2-3PD)

720×486i (2-3PD) 720×480i (2-3PD)

1280×720P 1280×720P (2-3PD) 1280×720P (2-3PD)

720×486i (2-3PD) 720×480i (2-3PD)

50 1920×1080P 1920×1080P (Level A) 1920×1080P

1920×1080P (Level B) Kein Signal

1920×1080i 1920×1080i

720×576i 720×576i

1920×1080i 1920×1080i 1920×1080i

720×576i 720×576i

1440×1080i 1920×1080i 1920×1080i

720×576i a) 720×576i a)

1280×720P 1280×720P 1280×720P

720×576i 720×576i

720×576i 720×576i 720×576i

Kein Signal 720×576P

25 1920×1080P 1920×1080PsF 1920×1080i

720×576i 720×576i

1280×720P 1280×720P 1280×720P

720×576i 720×576i
a)	 Wechselt zu 1920×1080i, wenn Proxy-Aufzeichnung oder WLAN-Verbindungsfunktion aktiviert ist.
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Ausgabeformate des Anschlusses VIDEO 

Die Signale, die am Anschluss VIDEO ausgegeben werden können, sind in der folgenden Tabelle in 
Abhängigkeit von der Einstellung „Operation >Format“ im Konfigurationsmenü aufgeführt.

Menü „Operation“ VIDEO OUT-Signalformat

Format

Frequency Rec Format (ohne Codec) Proxy-Aufzeichnung/WLAN-Verbindungsfunktion

OFF ON

59.94 1920×1080P HD-Y HD-Y

HD-Y HD-Y

HD-Y HD-Y

Composite Composite c)

1920×1080i HD-Y HD-Y

Composite Composite c)

1440×1080i HD-Y HD-Y

Composite –

1280×720P HD Sync a) HD Sync a)

Composite Composite c)

720×480i Composite Composite c)

Composite HD-Y

29.97 1920×1080P HD-Y HD-Y

Composite Composite c)

1280×720P HD-Y b) HD-Y b)

Composite Composite c)

23.98 1920×1080P HD-Y HD-Y

HD-Y HD-Y

Composite Composite c)

1280×720P HD-Y b) HD-Y b)

Composite Composite c)

Menü „Operation“ VIDEO OUT-Signalformat

Format

Frequency Rec Format (ohne Codec) Proxy-Aufzeichnung/WLAN-Verbindungsfunktion

OFF ON

50 1920×1080P HD-Y HD-Y

HD-Y HD-Y

HD-Y HD-Y

Composite Composite c)

1920×1080i HD-Y HD-Y

Composite Composite c)

1440×1080i HD-Y HD-Y

Composite –

1280×720P HD Sync a) HD Sync a)

Composite Composite c)

720×576i Composite Composite c)

Composite HD-Y

25 1920×1080P HD-Y HD-Y 

Composite Composite c)

1280×720P HD-Y b) HD-Y b) 

Composite Composite c)

a)	 Ausgabe eines 1080i-Synchronisationssignals.
b)	Ausgabe eines 1080PsF-Signals.
c)	 Textinformationen (eingeblendet) werden synchron mit der SDI OUT2/HDMI-Textinformationsanzeige aktiviert/deaktiviert.
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Einstellung des Schwarz- und Weißabgleichs
Damit bei der Aufzeichnung mit dem Camcorder 
eine optimale Bildqualität garantiert ist, 
müssen auf Grund der äußeren Verhältnisse 
gegebenenfalls der Schwarz- und der Weißwert 
eingestellt werden.
Die automatisch vom Camcorder eingestellten 
Werte für den Schwarz- und Weißabgleich 
sowie andere Einstellungen werden im 
Camcorder gespeichert und bleiben auch bei 
ausgeschaltetem Gerät erhalten.

Einstellung des Schwarzabgleichs

Der Schwarzabgleich muss in folgenden Fällen 
eingestellt werden.
ˎˎ Bei erstmaliger Verwendung des Camcorders
ˎˎ Wenn der Camcorder länger nicht verwendet 
wurde
ˎˎ Wenn der Camcorder starken 
Temperaturschwankungen ausgesetzt war
ˎˎ Wenn die Werte des Wahlschalters GAIN 
(L/M/H/Turbo) mit Hilfe von „Operation >Gain 
Switch“ im Konfigurationsmenü geändert 
wurden.

Normalerweise muss der Schwarzabgleich nicht 
bei jeder Verwendung des Camcorders erneut 
eingestellt werden.

Im Modus für den automatischen Schwarzabgleich 
werden die Einstellungen in der folgenden 
Reihenfolge ausgeführt: Schwarzeinstellung und 
Schwarzabgleich. Im Konfigurationsmenü kann 
auch ein manueller Schwarzabgleich gewählt 
werden.

Der automatische Schwarzabgleich ist in 
folgenden Fällen deaktiviert.
ˎˎ Während der Aufzeichnung
ˎˎ In speziellen Aufnahmemodi
ˎˎ Beim SLS-Belichtungsmodus

1	 Stellen Sie den Schalter OUTPUT/DCC auf CAM.

2	 Drücken Sie den Schalter AUTO W/B BAL zu 
BLACK hin und lassen Sie ihn wieder los.
Die Meldung „Executing...“ erscheint während 
der Ausführung und wechselt zu „OK“, wenn 
die Einstellungen abgeschlossen sind.
Einstellwerte werden automatisch 
abgespeichert.

[Hinweise]
ˎˎ Die Blende wird während der Einstellung des 

Schwarzabgleichs automatisch geschlossen.
ˎˎ Der Schaltkreis für die Verstärkungsauswahl wird während 

der Einstellung des Schwarzabgleichs automatisch 
aktiviert. Dadurch kann es zu einem Flimmern auf der 
Sucheranzeige kommen. Dies ist keine Fehlfunktion.

Wenn die Einstellung des automatischen 
Schwarzabgleichs nicht möglich ist

Wenn der Schwarzabgleich nicht normal 
abgeschlossen werden kann, erscheint auf der 
Sucheranzeige etwa drei Sekunden lang eine 
Fehlermeldung.

Fehlermeldung Bedeutung

NG: Iris not Closed Die Objektivblende hat sich 
nicht geschlossen; 
Einstellung war unmöglich.

NG: Timeout Die Einstellung konnte nicht 
in der Standardanzahl an 
Versuchen abgeschlossen 
werden.

Versuchen Sie den Schwarzabgleich erneut 
einzustellen, falls eine der oben stehenden 
Fehlermeldungen angezeigt wird.
Sollte die Fehlermeldung erneut vorkommen, ist 
eine interne Überprüfung notwendig.

Einzelheiten zur internen Überprüfung finden Sie im 
Wartungshandbuch (optional).

[Hinweis]
Wenn das Objektivkabel nicht fest im Anschluss LENS steckt, 
könnte sich die Objektivblende nicht einstellen lassen. 
Sollte dies der Fall sein, wird ein falscher Schwarzabgleich 
eingestellt.

Einstellung des Weißabgleichs

Stellen Sie den Weißabgleich stets dann neu ein, 
wenn sich die Lichtverhältnisse ändern.

1	 Stellen Sie die Schalter und Wahlschalter wie 
folgend dargestellt ein.
ˎˎ Schalter GAIN: L (auf möglichst kleinen 
Verstärkungswert einstellen)
ˎˎ Schalter OUTPUT/DCC: CAM
ˎˎ Schalter WHITE BAL: A oder B 1)

1)	 Die Einstellwerte werden nur dann in Speicher B 
abgespeichert, wenn „Operation >White Setting 
>White Switch <B>“ im Konfigurationsmenü auf 
„Memory“ steht.

2	 Stellen Sie den Regler FILTER folgendermaßen 
entsprechend den Lichtverhältnissen ein.

3	 Richten Sie den Camcorder bei denselben 
Lichtverhältnissen wie bei der beabsichtigten 
Aufnahme auf eine weiße Testkarte, und 
stellen Sie den Zoom auf diese ein.
Sie können den Camcorder auch auf ein 
weißes Tuch oder eine weiße Wand richten.
Im Folgenden wird die Mindestgröße der 
weißen Fläche beschrieben.

Rechteck in der Mitte der Sucheranzeige
Die Seitenlängen müssen mindestens 70% der 
Länge bzw. Breite der Sucheranzeige betragen. 
Mindestens 10% der Oberfläche des Bildes 
innerhalb des rechteckigen Bereiches müssen 
weiß sein.

[Hinweis]
Innerhalb des Rechtecks dürfen sich keine hellen 
Lichtpunkte befinden.

4	 Stellen Sie die Objektivblende ein.
Manuell eingestellte Blende: Blende 

entsprechend einstellen.
Mit Auto Iris eingestellte Blende: Stellen Sie 

den Schalter zur automatischen/
manuellen Blendeneinstellung am 
Objektiv auf Automatik ein.

5	 Drücken Sie den Schalter AUTO W/B BAL zu 
WHITE hin und lassen Sie ihn wieder los.
Die Meldung „Executing...“ wird während der 
Ausführung angezeigt und wechselt zu „OK: 
(color temperature of subject)“ wenn die 
Einstellung beendet ist.
Die Einstellwerte werden automatisch im 
Speicher abgespeichert, der in Schritt 1 
gewählt wurde (A oder B).

[Hinweis]
Die Blende kann während der Einstellung 
Helligkeitsschwankungen 1) verursachen. Stellen Sie, um 
dies zu vermeiden, den Blendenverstärkungsregler (als 
IG, IS oder S bezeichnet) am Objektiv ein.

1)	 Helligkeitsschwankungen: Wiederholtes Aufhellen 
und Abdunkeln eines Bildes auf Grund der 
wiederholten Einstellvorgänge im Rahmen der 
automatischen Blendensteuerung.

Einzelheiten dazu finden Sie in der Bedienungsanleitung des 
Objektivs.
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Wenn die Einstellung des automatischen 
Weißabgleichs nicht möglich ist

Wenn der Weißabgleich nicht normal 
abgeschlossen werden kann, erscheint auf der 
Sucheranzeige etwa drei Sekunden lang eine 
Fehlermeldung.

Fehlermeldung Bedeutung
NG: Low Light Der Videosignalpegel für Weiß 

ist zu niedrig. Öffnen Sie die 
Objektivblende oder erhöhen 
Sie die Verstärkung.

NG: High Light Der Videosignalpegel für Weiß 
ist zu hoch. Schließen Sie die 
Objektivblende oder ändern 
Sie den ND-Filter.

NG: Color Temp. 
High

Die Farbtemperatur der 
Motivbeleuchtung ist zu hoch 
und konnte nicht angepasst 
werden. Stellen Sie die 
Farbtemperatur der 
Beleuchtung ein und 
aktualisieren Sie den Speicher.

NG: Color Temp. 
Low

Die Farbtemperatur der 
Motivbeleuchtung ist zu 
niedrig und konnte nicht 
angepasst werden. Stellen Sie 
die Farbtemperatur der 
Beleuchtung ein und 
aktualisieren Sie den Speicher.

NG: Out of Range Wert konnte nicht angepasst 
werden, da die Differenz 
zwischen dem Zeitwert und 
dem Referenzwert den 
Einstellungsbereich 
überschreitet.

NG: Poor White 
Area

Die weiße Oberfläche des 
Motivs ist zu klein und konnte 
nicht angepasst werden.

NG: Timeout Die Einstellung konnte nicht in 
der angegebenen Zeit 
abgeschlossen werden.

Versuchen Sie einen erneuten Weißabgleich, 
falls eine der oben stehenden Fehlermeldungen 
erscheint. Sollte die Fehlermeldung erneut 
vorkommen, ist eine interne Überprüfung 
notwendig.

Einzelheiten zur internen Überprüfung finden Sie im 
Wartungshandbuch.

Wenn keine Zeit für den Weißabgleich vorhanden 
ist

Stellen Sie den Schalter WHITE BAL auf PRST.

Ändern der Farbtemperatur bei Umschalten des 
ND-Filters

Sie können ND-Filtern elektrische CC 
(Farbkorrektur)-Filter zuweisen (Seite 5), sodass 
die Farbtemperatur automatisch geändert wird, 
wenn der ND-Filter umgeschaltet wird.

1	 Setzen Sie „Maintenance >White Filter >ND 
Filter C.Temp“ im Konfigurationsmenü auf „On“ 
(Seite 116).

2	 Um der Position 1 des Reglers FILTER einen 
elektrischen CC-Filter zuzuweisen, wählen Sie 
[ND FLT C.Temp<1>]. Um ihn den Positionen 2 
bis 4 zuzuweisen, wählen Sie [ND FLT C.
Temp<2-4>].

3	 Drehen Sie am Regler MENU, um die 
gewünschte Farbtemperatur zu wählen.

4	 Wiederholen Sie Schritte 2 und 3 so oft wie 
notwendig.

Umschalten zwischen elektrischen CC-Filtern mit 
Hilfe eines belegbaren Schalters

Sie können die Funktion, die es ermöglicht 
zwischen elektrischen CC-Filtern umzuschalten, 
einem belegbaren Schalter zuweisen. So können 
Sie mit jedem Tastendruck des belegbaren 
Schalters zwischen Farbtemperaturen 
(3200K/4300K/5600K/6300K) umschalten, die bis 
zu vier Positionen (A bis D) zugewiesen wurden.

1	 Wählen Sie im Konfigurationsmenü 
„Maintenance >White Filter“.

2	 Wählen Sie die Position, der ein CC-Filter 
zugewiesen werden soll, indem Sie eine Wahl 
der elektrischen Farbkorrekturfilter [Electrical 
CC <A>] bis [Electrical CC <D>] treffen, und 
drehen Sie dann den Regler MENU, um die 
gewünschte Farbtemperatur zu wählen.
Wählen Sie „-----“, während Electrical CC <C> 
oder <D> gewählt ist.
Wenn der belegbare Schalter gedrückt ist, wird 
die Einstellung für diese Position nicht 
angezeigt. Wenn beispielsweise „-----“ für eine 
Position eingestellt ist, erfolgt das Umschalten 
zwischen den anderen drei Positionen.

3	 Wiederholen Sie Schritt 2 nach Bedarf.

4	 Weisen Sie die Umschaltfunktion zwischen 
den elektrischen CC-Filtern (ELECTRICAL CC) 
einem belegbaren Schalter zu (Seite 126).

Weißwertspeicher

Die Werte bleiben auch dann bis zum nächsten 
Weißabgleich gespeichert, wenn der Camcorder 
ausgeschaltet wird.
Der Camcorder hat zwei Weißwertspeicher A 
und B. Sie können die Einstellwerte für jeden 
ND-Filter im Speicher entsprechend der aktuellen 
Einstellung des Schalters WHITE BAL (A oder B) 
abspeichern. Der Camcorder verfügt über vier 
integrierte ND-Filter, die Ihnen ermöglichen, 
insgesamt acht Einstellwerte (4×2) zu speichern. 
Im folgenden Fall ist der Speicherinhalt jedoch 
nicht mit den ND-Filtereinstellungen verknüpft.
ˎˎ Wenn die Anzahl der in A und B belegten 
Speicherplätze durch die Einstellung von 
„Operation >White Setting >Filter White 
Memory“ im Konfigurationsmenü auf „Off“ auf 
einen Speicherplatz eingeschränkt wurde.

Außerdem wird, wenn „Operation >White Setting 
>White Switch<B>“ im Konfigurationsmenü auf 
[ATW (Auto Tracing White Balance)] steht und der 
Schalter WHITE BAL auf B steht, die Funktion ATW 
aktiviert, um den Weißwert des aufgenommenen 
Bildes automatisch auf wechselhafte 
Lichtverhältnisse abzustimmen.
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Blendenmodi

Im Folgenden werden die Blendenmodi der 
elektronischen Blende und die wählbaren 
Belichtungszeiten aufgeführt.

[Hinweis]
Wenn eine Fernbedienung wie z. B. die RM-B170 
angeschlossen ist, kann nur der Standardmodus 
(Geschwindigkeit) ausgewählt werden.

Standardmodus

Wählen Sie diesen Modus für Aufnahmen von 
sich schnell bewegenden Motiven mit wenig 
Unschärfe.
Sie können für die Belichtungszeit einen der zwei 
Blenden-Modi setzen: Speed-Modus, bei dem die 
Geschwindigkeit in Sekunden festgelegt ist, und 
Angle-Modus, bei dem die Geschwindigkeit in 
Graden festgelegt ist.

Speed-Modus

Systemfrequenz Belichtungszeit (Einheit: 
Sekunden)

59.94i 
59.94P
50i
50P

1/60, 1/100, 1/120, 1/125, 1/250, 
1/500, 1/1000, 1/2000

29.97P 1/40 a), 1/50 a), 1/60, 1/100, 1/120, 
1/125, 1/250, 1/500, 1/1000, 
1/2000

25P 1/33 a), 1/50 a), 1/60, 1/100, 1/120, 
1/125, 1/250, 1/500, 1/1000, 
1/2000

23.98P 1/32 a), 1/48 a), 1/50 a), 1/60, 1/96, 
1/100, 1/120, 1/125, 1/250, 1/500, 
1/1000, 1/2000

a)	 Diese Geschwindigkeit kann nicht ausgewählt werden, 
wenn der Camcorder im Zeitlupen- & Zeitraffermodus 
ist und „Operation >Rec Function >Frame Rate“ im 
Konfigurationsmenü auf einen Wert eingestellt ist, der 
größer als die Systemfrequenz ist.

Winkel-Modus

180°, 90°, 45°, 22,5°, 11,25°

ECS-Modus (erweiterte klare Abtastung)

Wählen Sie diesen Modus für Bilder ohne 
horizontale Störstreifen bei der Aufnahme von 
Motiven wie z. B. Monitorbildschirmen.
Wie in folgenden Tabellen dargestellt, der 
Belichtungszeitenbereich, der eingestellt werden 
kann, variiert abhängig davon, ob die Zeitlupen- & 
Zeitrafferfunktion (S&Q) an oder aus ist.

Systemfrequenz Belichtungszeit (Einheit: Hz)
S&Q: Aus S&Q: Ein

59.94i 60,00 bis 7000 —
59.94P 60,00 bis 8000 60,00 bis 8000
29.97P 30,00 bis 8000 30,00 bis 8000
23.98P 23,99 bis 6000 30,03 bis 6000
50i 50,00 bis 7000 —
50P 50,00 bis 7000 50,00 bis 7000
25P 25,02 bis 7000 30,00 bis 7000

SLS-Modus (lange Verschlusszeit)

Dieser Modus wird zum Aufnehmen von 
Motiven bei geringer Beleuchtung verwendet. 
Die Anzahl der akkumulierten Einzelbilder, die 
im SLS-Modus aufgenommen wurden, kann in 
„Operation >Slow Shutter >Number of Frames“ 
im Konfigurationsmenü auf 2, 3, 4, 5, 6, 7, 8, 16 
eingestellt werden.

[Hinweise]
ˎˎ Der SLS-Modus kann nicht verwendet werden, wenn 

sich der Camcorder im Zeitlupen- und Zeitraffermodus 
befindet.
ˎˎ Während der Aufzeichnung kann der SLS-Modus nicht 

ein- oder ausgeschaltet und die Anzahl der akkumulierten 
Einzelbilder nicht geändert werden.

Auswählen des Blendenmodus und 
der Belichtungszeit

[Hinweise]
ˎˎ Wenn die Blendenautomatik verwendet wird, öffnet sich 

die Blende bei kürzerer Belichtungszeit immer weiter. 
Dadurch wird die Schärfentiefe verringert.
ˎˎ Die einstellbaren Belichtungszeiten hängen von der 

aktuellen Systemfrequenz ab.

Umschalten zwischen Geschwindigkeits-Modus 
und Winkel-Modus

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Shutter >Mode“.

2	 Drehen Sie am Regler MENU, um [Speed] oder 
[Angle] auszuwählen und drücken Sie dann 
den Regler.

Auswählen des Blendenmodus und der 
Belichtungszeit (Standardmodus)

Wenn die Belichtungszeit ausgewählt wurde, 
bleibt sie auch bei ausgeschaltetem Camcorder 
gespeichert.

1	 Drücken Sie den Schalter SHUTTER von ON zu 
SELECT hin.
Die aktuelle Blendeneinstellungsanzeige wird 
etwa drei Sekunden lang im Sucher angezeigt.

2	 Bevor die Verschlusseinstellung in Schritt 1 
ausgeblendet wird, drücken Sie den Schalter 
SHUTTER noch einmal nach unten zu SELECT. 
Wiederholen Sie diesen Schritt, bis der 
gewünschte Modus bzw. die gewünschte 
Belichtungszeit eingeblendet wird.
Wenn alle Modi und Belichtungszeiten 
angezeigt werden, ändert sich die Anzeige in 
folgender Reihenfolge.

Speed-Modus (bei Systemfrequenz 59.94i)

ECS-Modus

[Hinweis]
Bei bestimmten Einstellungen der Bildrate (Seite 54) 
stehen einige Belichtungszeiten im Zeitlupen- & Zeitraffer-
Modus nicht zur Verfügung. Die Belichtungszeit wird dann 
auf die langsamste wählbare Belichtungszeit eingestellt.

Beispiel für Aufnahme mit XAVC-I 1080P/29.97P, 
Bildfrequenz 60 und Zeitlupe & Zeitraffer:
Die Belichtungszeit wird wie folgt angezeigt.
ˎˎ Zeitlupen-/Zeitraffer-Modus: Off 
1/401/501/601/100…
ˎˎ Zeitlupen-/Zeitraffer-Modus: On 
1/601/100…

Einstellen der Belichtungszeit (ECS-Modus)

1	 Stellen Sie den Belichtungszeitmodus auf ECS 
(siehe den vorherigen Punkt).

2	 Zur Wahl der gewünschten Frequenz oder der 
Anzahl der Einzelbilder drehen Sie den Regler 
MENU.

Einstellen der Belichtungszeit (SLS-Modus)

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Slow Shutter >Setting“ und stellen Sie den 
Blendenmodus auf „On“.

2	 Wählen Sie im Konfigurationsmenü „Operation 
>Slow Shutter >Number of Frames“ und 
wählen Sie die gewünschte Anzahl von 
Einzelbildern aus.

Einstellung der elektronischen Blende
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Einstellen der Blendenautomatik
Der Bezugswert der automatischen 
Blendeneinstellung kann geändert werden, um 
Gegenlichtaufnahmen von guter Qualität zu 
erzielen oder eine Überbelichtung zu verhindern.

Einstellen der Betriebsart für die 
Blendenautomatik

Stellen Sie die Betriebsart ein, die bei 
der Einstellung der Bellichtung mit der 
Blendenautomatik verwendet werden soll.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Auto Iris >Mode“.

2	 Drehen Sie am Regler MENU, um die 
Betriebsart auszuwählen, und drücken Sie den 
Regler.

Betriebsart Beschreibung
Backlight Betriebsart für Aufnahmen bei 

Gegenlicht.
Standard Standardmodus
Spotlight Betriebsart zur Verringerung 

von Überbelichtungen, wenn 
ein Motiv von Strahlern 
beleuchtet wird.

Stellen Sie den Ziel-Konvergenzwert 
für die Blendenautomatik ein

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Auto Iris >Level“.

2	 Drehen Sie am Regler MENU, um einen Wert 
zwischen –99 und +99 auszuwählen, und 
drücken Sie dann den Regler.

Konvergenzwert Beschreibung
–99 Stellt die Blende um 

mindestens 2 Blendenstufen 
dunkler

±0 Referenzwert
+99 Stellt die Blende um 

mindestens 2 Blendenstufen 
heller

Einstellen der Blendenautomatik-
Geschwindigkeit

Stellen Sie die Geschwindigkeit ein, mit der die 
Belichtung mit der Blendenautomatik eingestellt 
werden soll.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Auto Iris >Speed“.

2	 Drehen Sie am Regler MENU, um eine 
Geschwindigkeit zwischen –99 (am 
langsamsten) und +99 (am schnellsten) 
auszuwählen, und drücken Sie dann den 
Regler.

Ändern des Referenzwerts der 
Objektivblende

Der Bezugswert der Objektivblende kann in 
Hinsicht auf den Standardwert innerhalb des 
folgenden Bereichs eingestellt werden.
ˎˎ +0,25 bis +1 (Schrittweite 0,25): Ca. 0,25 bis 1 
Stufe weiter geöffnet
ˎˎ –0,25 bis –1 (Schrittweite 0,25): Ca. 0,25 bis 1 
Stufe weiter geschlossen

Man kann auch den Bereich zur Lichtmessung 
einstellen.

1	 Stellen Sie „Operation >Auto Iris >Iris Override“ 
im Konfigurationsmenü auf „On“.

2	 Stellen Sie den Schalter MENU ON/OFF auf 
OFF.

3	 Drehen Sie am Regler MENU, um den 
Bezugswert zu ändern.

[Hinweis]
Achten Sie darauf, nicht ECS als Blendenmodus 
einzustellen.

Der aktuellen Referenzwert wird in der 
Blendenpositionsanzeige (Seite 16) auf dem 
Sucher angezeigt.
ˎˎ Um die Blende etwas weiter zu öffnen, 
drehen Sie den Regler MENU von der 
Vorderseite des Camcorders gesehen gegen 
den Uhrzeigersinn.  
Wählen Sie +0,25, +0,5, +0,75 oder +1.
ˎˎ Um die Blende etwas weiter zu schließen, 
drehen Sie den Regler MENU von der 
Vorderseite des Camcorders gesehen im 
Uhrzeigersinn.  
Wählen Sie –0,25, –0,5, –0,75 oder –1.

Der geänderte Bezugswert bleibt erhalten, bis 
der Camcorder ausgeschaltet wird. Auch wenn 
der Bezugswert geändert wurde, wird er mit 
jedem Einschalten des Camcorders wieder auf 
den Standardwert zurückgesetzt.

Einstellungen für das 
Erkennungsfenster für die 
Blendenautomatik

1	 Stellen Sie „Operation >Auto Iris >Detect 
Window Indication“ im Konfigurationsmenü 
auf „On“.

Das aktuelle automatische Blendenfenster 
erscheint auf der Sucheranzeige.
Sollte die Anzeige des automatischen 
Blendenfensters nicht erwünscht sein, stellen 
Sie dies auf Off.

2	 Wählen Sie im Konfigurationsmenü „Operation 
>Auto Iris >Detect Window“.

3	 Drehen Sie am Regler MENU, bis das 
gewünschte automatische Blendenfenster 
erscheint, und drücken Sie dann den Regler.

Die schattierten Teile zeigen den 
Bereich der Lichtmessung an.

Wenn Sie „Var“ auswählen, werden die 
folgenden Punkte wirksam und Sie können das 
Fenster auf die gewünschte Größe einstellen. 
Stellen Sie „Operation >Auto Iris >Iris Var 
Width“, „Iris Var Height“, „Iris Var“, „Iris Var H 
Position“, und „Iris Var V Position“ im 
Konfigurationsmenü ein.

Menüpunkt Einstellung
Iris Var Width Breite des Fensters
Iris Var Height Höhe des Fensters
Iris Var H 
Position

Horizontale Position des 
Fensters

Iris Var V 
Position

Vertikale Position des 
Fensters.

Wenn Sie das Menü verlassen, erscheint das 
automatische Blendenfenster, das in Schritt 3 
gewählt wurde.
Solange Sie dieses Fenster nicht benötigen, 
stellen Sie „Operation >Auto Iris >Detect Window 
Indication“ im Konfigurationsmenü auf „Off“.
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Verringern des Effekts großer 
Überbelichtung

Falls das Motiv zu hell ist, könnte sich die Blende 
zu sehr schließen und das gesamte Bild zu 
dunkel werden. Dieser Zustand wird als „Clipped 
Blacks“ (Reinschwarzübergang) bezeichnet. In 
solchen Fällen begrenzt die Aktivierung der Clip-
Überbelichtungsfunktion das Signal ab einem 
bestimmten Pegel und reduziert damit die Effekte 
der Blendenautomatik.
Stellen Sie „Operation >Auto Iris >Clip High Light“ 
im Konfigurationsmenü auf „On“.

Einstellen der Blendenverstärkung für 
das im Lieferumfang des PXW-X400KC 
enthaltene Objektiv

1	 Stellen Sie den Blendenmodus-Schalter in die 
Position A (Automatik).

2	 Öffnen Sie die Gummiabdeckung des 
Blendenverstärkungs-Abgleichtrimmers.

3	 Stellen Sie durch Drehen des 
Blendenverstärkungs-Abgleichtrimmers mit 
einem Schraubendreher o. ä. die Verstärkung 
ein.
Drehen im Uhrzeigersinn erhöht die 
Verstärkung. Drehen gegen den Uhrzeigersinn 
verringert die Verstärkung.
Beobachten Sie bei der Einstellung den 
Blendenring am Objektiv.

4	 Bringen Sie die Gummiabdeckung wieder an.
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Einstellen des Fokus
Dieser Abschnitt beschreibt die Scharfstellung bei 
Verwendung des im Lieferumfang des  
PXW-X400KF enthaltenen Objektivs.

[Hinweis]
Das Objektiv verfügt über einen Reservebereich in der 
Position „Unendlich“ (∞), um ein Driften des Fokus bei 
Temperaturschwankungen auszugleichen. Wenn Sie 
ein Motiv im Modus MF oder Full MF mit der Einstellung 
„Unendlich“ aufnehmen, überprüfen Sie beim Scharfstellen 
das Bild im Sucher.

Einstellung im Modus Full MF

Wenn Sie den Fokussierring zum Camcorder 
hin zurückschieben, wird der Modus Full MF 
(vollständig manueller Fokus) aktiviert.

[Hinweis]
Wenn Sie den Fokussierring wieder in die Ausgangsposition 
schieben, wird sofort die Markierungsposition scharfgestellt.

Stellen Sie das Bild durch Drehen des 
Fokussierrings scharf, während Sie die Anzeige im 
Sucher beobachten.
Die Entfernungsangaben auf dem Ring gelten 
im Modus Full MF. Die Entfernungen, bei denen 
das Bild scharf ist, entsprechen den absoluten 
Positionen des Fokussierrings.

Peaking

Drehen Sie am Regler PEAKING am Sucher, um die 
Peaking-Funktion zu verwenden. Im Monitorbild 
werden die Kanten betont, was die manuelle 
Fokussierung erleichtert.
Auf die aufgezeichneten Videosignale hat diese 
Einstellung keine Auswirkung.

Verwenden des Fokussierrings

Stellen Sie das Bild durch Drehen des 
Fokussierrings scharf, während Sie die Anzeige im 
Sucher beobachten.
Die Entfernungsangaben auf dem Ring sind im 
Modus MF ungültig.

Autofokus auf Knopfdruck

Drücken Sie die Taste PUSH AF. Der Autofokus wird 
vorübergehend aktiviert.
Der Autofokus auf Knopfdruck wird beendet, wenn 
das Motiv scharf gestellt ist.

MF-Assistent

Wenn MF-Assistent aktiviert ist (Seite 125), wird 
der Autofokus aktiviert, wenn Sie nicht mehr 
mit dem Fokussierring scharfstellen, und führt 
eine Feineinstellung des Motivs in der Mitte des 
Bildschirms (Fokus-Nachverfolgung) aus.
Wenn die Feineinstellung abgeschlossen ist, wird 
die Autofokus-Funktion mit MF-Assistent beendet.

Einstellung im Modus AF

Wenn Sie den Fokussierring nach vorne schieben 
und den Schalter FOCUS auf A (Auto) stellen, wird 
der Fokus in den AF-Modus umgeschaltet, in dem 
Autofokus ununterbrochen verfügbar ist.
Die Entfernungsangaben am Ring sind im AF-
Modus nicht gültig.

Verwenden des Makromodus

Wenn der Fokusmodus MF oder AF aktiviert ist, 
stellen Sie den Schalter MACRO in die Position 
ON, um den Makromodus zu aktivieren. Der 
Makromodus ermöglicht die Scharfstellung 
innerhalb eines Bereichs, der den Makrobereich 
enthält.
Der Makromodus ist im Modus Full MF deaktiviert.
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Einstellen des Audiopegels
Wenn Sie den Schalter AUDIO SELECT auf 
AUTO stellen, die Eingangspegel der analogen 
Audiosignale, die auf jedem Kanal aufgezeichnet 
sind, werden automatisch eingestellt. Sie können 
auch manuelle Einstellungen vornehmen.

[Hinweis]
Auch wenn Sie den Schalter AUDIO SELECT auf AUTO stellen, 
werden die Eingangspegel der digitalen Audiosignale nicht 
automatisch eingestellt.

Grenzaudiopegel für die manuelle 
Einstellung

Verwenden Sie –20 dB als Grenzpegel für die 
Einstellung.
Wenn auf der Audiopegelanzeige ein Höchstpegel 
von 0 dB erscheint, bedeutet das, dass der 
Audioeingangspegel zu hoch ist.

Zu hoher Eingangspegel

Grenzeingangspegel

Manuelle Einstellung der 
Eingangspegel der Audiosignale von 
den Anschlüssen AUDIO IN CH-1/
CH-2

1	 Stellen Sie zur Einstellung des am Anschluss 
AUDIO IN CH-1 oder CH-2 eingespeisten 
Signals den Schalter AUDIO IN CH1 oder CH2 
auf REAR.
Stellen Sie zur Einstellung beider 
Eingangssignale beide Schalter auf REAR.

2	 Stellen Sie die/den Schalter AUDIO SELECT 
entsprechend des/der in Schritt 1 
ausgewählten Audiokanals/-kanäle auf 
MANUAL.

3	 Stellen Sie die/den LEVEL-Regler für den/die in 
Schritt 1 gewählten Kanal/Kanäle so ein, dass 
die Audiopegelanzeige für die normale 
Eingangslautstärke bis zu –20 dB anzeigt.

Auswählen des zum Einstellen des 
Aufzeichnungspegels verwendeten Reglers

Unter „Maintenance >Audio“ im 
Konfigurationsmenü können Sie einstellen, 
von welchem Audiopegelregler der in die 
Anschlüsse AUDIO IN CH-1/CH-2 eingespeiste 
Audioaufzeichnungspegel gesteuert wird. Es 
besteht folgendes Verhältnis zwischen den 
Reglern und den Einstellungen der Menüpunkte.

[Hinweis]
Wenn ein digitales AES/EBU-Audiosignal zugeführt wird, 
kann der Aufnahmepegel nicht mit dem Camcorder 
eingestellt werden.

Rear1/WRR Level: Aufzeichnungspegel Kanal 1

Einstellung Regler
Side1 Regler LEVEL (CH1)
Front Regler MIC LEVEL
Front+Side1 Regler LEVEL (CH1) und MIC 

LEVEL (abgestimmter Betrieb)

Rear2/WRR Level: Aufzeichnungspegel Kanal 2

Einstellungen Regler
Side2 Regler LEVEL (CH2)
Front Regler MIC LEVEL
Front+Side2 Regler LEVEL (CH2) und MIC 

LEVEL (abgestimmter Betrieb)

[Hinweis]
Wenn der Betrieb der Regler LEVEL (CH1/CH2) mit dem 
Regler MIC LEVEL verknüpft ist und der Regler MIC LEVEL auf 
0 steht, können auf den Kanälen 1 und 2 keine Audiosignale 
aufgezeichnet werden. Überprüfen Sie daher die Einstellung 
des Reglers MIC LEVEL, bevor Sie die Regler LEVEL (CH1/CH2) 
einstellen.

Manuelle Einstellung des 
Audiopegels des Anschlusses MIC IN

1	 Stellen Sie folgendermaßen einen oder beide 
Schalter AUDIO IN auf FRONT.

2	 Stellen Sie die/den Schalter AUDIO SELECT 
des/der in Schritt 1 ausgewählten Kanals/
Kanäle auf MANUAL.

3	 Stellen Sie den Regler MIC LEVEL durch Drehen 
so ein, dass die Audiopegelanzeige für die 
normale Eingangslautstärke bis zu –20 dB 
anzeigt.

Auswählen des zum Einstellen des 
Aufzeichnungspegels verwendeten Reglers

Unter „Maintenance >Audio“ im 
Konfigurationsmenü können Sie 
einstellen, von welchem Audiopegelregler 
der Audioaufzeichnungspegel des 
Frontmikrofoneingangs gesteuert wird. Es besteht 
folgendes Verhältnis zwischen den Reglern und 
den Einstellungen der Menüpunkte.
MIC CH1 Level: Aufzeichnungspegel Kanal 1

Einstellungen Regler
Side1 Regler LEVEL (CH1)
Front Regler MIC LEVEL
Front+Side1 Regler LEVEL (CH1) und MIC 

LEVEL (abgestimmter Betrieb)

MIC CH2 Level: Aufzeichnungspegel Kanal 2

Einstellungen Regler
Side2 Regler LEVEL (CH2)
Front Regler MIC LEVEL
Front+Side2 Regler LEVEL (CH2) und MIC 

LEVEL (abgestimmter Betrieb)

[Hinweis]
Wenn der Betrieb der Regler LEVEL (CH1/CH2) mit dem 
Regler MIC LEVEL verknüpft ist und die Regler LEVEL (CH1/
CH2) auf 0 stehen, können auf den Kanälen 1 und 2 keine 
Audiosignale aufgezeichnet werden. Überprüfen Sie daher 
die Einstellung der Regler LEVEL (CH1/CH2), bevor Sie den 
Regler MIC LEVEL einstellen.
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Aufzeichnung auf den Audiokanälen 
3 und 4

1	 Sie können die auf den Audiokanälen 3 und 4 
aufgezeichneten Audiosignale manuell über 
die Schalter AUDIO IN CH3/CH4 wählen.

Schalter CH3 Kanal 3 Aufzeichnungsziel
FRONT Frontmikrofon
REAR Audiosignaleingang zum 

Anschluss AUDIO IN CH1
WIRELESS Drahtloses Mikrofon Audio

Schalter CH4 Kanal 4 Aufzeichnungsziel
FRONT Frontmikrofon
REAR Audiosignaleingang zum 

Anschluss AUDIO IN CH2
WIRELESS Drahtloses Mikrofon Audio

2	 Für die automatische Einstellung setzen Sie 
den Schalter AUDIO SELECT CH 3-4 auf AUTO.
Für die manuelle Einstellung setzen Sie den 
Schalter AUDIO SELECT CH 3-4 auf MANUAL.

3	 Wählen Sie die Regler, die die Audiopegel 
einstellen, mit den Punkten Audio CH3 Level 
und Audio CH4 Level unter Maintenance 
>Audio im Konfigurationsmenü.

Audio CH3 Level: Aufzeichnungspegel Kanal 3

Einstellungen Regler
Side3 Regler LEVEL (CH3)
Front Regler MIC LEVEL
Front+Side3 Regler LEVEL (CH3) und Regler 

MIC LEVEL (abgestimmter 
Betrieb)

Audio CH4 Level: Aufzeichnungspegel Kanal 4

Einstellung Regler
Side4 Regler LEVEL (CH4)

Einstellung Regler
Front Regler MIC LEVEL
Front+Side4 Regler LEVEL (CH4) und Regler 

MIC LEVEL (abgestimmter 
Betrieb)

Sie können jetzt die Pegel der Audiokanäle 3 
und 4 mit den hier ausgewählten Reglern 
einstellen.
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Einstellung der Zeitdaten
Einstellung des Zeitcodes

Der Einstellungsbereich für den Zeitcode liegt 
zwischen 00:00:00:00 und 23:59:59:29 (Stunden:Mi
nuten:Sekunden:Einzelbilder).

1	 Drücken Sie die Taste DISP SEL/EXPAND, um 
den LCD-Monitor auf Statusanzeige zu stellen.

2	 Stellen Sie den Schalter DISPLAY auf TC.

3	 Stellen Sie den Schalter PRESET/REGEN/CLOCK 
auf PRESET.

4	 Stellen Sie den Schalter F-RUN/SET/R-RUN auf 
SET.
Die erste Stelle (ganz links) des Zeitcodes 
blinkt.

5	 Ändern Sie die Werte mit den Hoch-/Herunter-
Pfeiltasten und verschieben Sie die blinkende 
Stelle mit den Rechts-/Links-Pfeiltasten. 
Wiederholen Sie den Vorgang, bis alle Stellen 
eingestellt sind.
Um den Wert auf 00:00:00:00 zurückzusetzen, 
drücken Sie die Taste RESET/RETURN.

6	 Stellen Sie den Schalter F-RUN/SET/R-RUN auf 
F-RUN oder R-RUN.
F-RUN: Freilauf (der Zeitcodegenerator zählt 

normal weiter)
R-RUN: Aufzeichnungsbetrieb (der 

Zeitcodegenerator läuft nur während der 
Aufzeichnung)

[Hinweis]
Wenn der Bildpuffer-Aufzeichnungsmodus aktiviert 
ist, können die Zeitdaten nicht durch Umschalten des 
Schalters F-RUN/SET/R-RUN auf SET festgelegt werden. 
Schalten Sie zum Festlegen der Zeitdaten den Bildpuffer-
Aufzeichnungsmodus aus.

Umschalten zwischen DF und NDF

Sie können den Drop-Frame-Modus (DF) oder den 
Non-Drop-Frame-Modus (NDF) mit „Maintenance 
>Timecode >DF/NDF“ im Konfigurationsmenü 
einstellen.

Festlegung eines kontinuierlichen Zeitcodes

Wenn der Schalter F-RUN/SET/R-RUN auf R-RUN 
steht und mehrere Szenen auf dem Medium 
aufgezeichnet werden, wird normalerweise ein 
kontinuierlicher Zeitcode erstellt. Wenn Sie das 
Medium jedoch herausnehmen und dessen 
Inhalt auf einem anderen Medium aufzeichnen, 
ist der Zeitcode bei erneuter Verwendung des 
ersten Mediums zur Aufzeichnung nicht mehr 
kontinuierlich.
Stellen Sie in diesem Fall zur Erstellung eines 
kontinuierlichen Zeitcodes den Schalter PRESET/
REGEN/CLOCK auf REGEN.

Speichern der Echtzeit im Zeitcode

Wenn Sie den Schalter PRESET/REGEN/CLOCK auf 
CLOCK stellen, wird die echte Uhrzeit im Zeitcode 
gespeichert. Die Zeit der internen Uhr des 
Camcorders wird als Echtzeit angewendet.

Einzelheiten zum Einstellen der internen Uhr siehe „Einstellen von 
Datum und Uhrzeit der internen Uhr“ (Seite 27).

Einstellung der Benutzerbits

Durch die Einstellung der Benutzerbits 
(Hexadezimalzahl mit bis zu 8 Stellen) können Sie 
Benutzerinformationen wie Datum, Uhrzeit oder 
Szenennummer auf der Zeitcodespur aufzeichnen.

1	 Drücken Sie die Taste DISP SEL/EXPAND, um 
den LCD-Monitor auf Statusanzeige zu stellen.

2	 Stellen Sie den Schalter DISPLAY auf U-BIT.

3	 Stellen Sie den Schalter F-RUN/SET/R-RUN auf 
SET.
Die erste Stelle (ganz links) blinkt.

4	 Ändern Sie die Werte mit den Hoch-/Herunter-
Pfeiltasten und verschieben Sie die blinkende 
Stelle mit den Rechts-/Links-Pfeiltasten. 
Wiederholen Sie den Vorgang, bis alle Stellen 
eingestellt sind.
Um den Wert auf 00 00 00 00 zurückzusetzen, 
drücken Sie die Taste RESET/RETURN.

5	 Stellen Sie den Schalter F-RUN/SET/R-RUN je 
nach gewünschtem Betriebsmodus für den 
Zeitcodegenerator auf F-RUN oder R-RUN ein.

Benutzerbit-Speicherfunktion

Die Benutzerbiteinstellung wird (neben der 
Echtzeit) automatisch gespeichert und bleibt auch 
bei ausgeschaltetem Gerät erhalten.

Synchronisieren des Zeitcodes mit 
einer externen Quelle

Sie können den internen Zeitcodegenerator 
dieses Camcorders mit einem externen 
Generator synchronisieren. Sie können auch 
die Zeitcodegeneratoren anderer Camcorder/
Videorecorder mit dem internen Generator dieses 
Camcorders synchronisieren.

1	 Schließen Sie das Referenz-Videosignal und 
den externen Zeitcode wie unten dargestellt 
an.
Beispiel 1: Synchronisierung mit einem 
externen Signal

[2][1] Externer Zeitcode

Referenz-Videosignal

[1]	 Anschluss GENLOCK IN
[2]	 Anschluss TC IN

Beispiel 2: Zusammenschalten mehrerer 
Camcorder mit einem Camcorder als 
Referenzgerät

Zum nächsten Camcorder

[1]	 Anschluss VIDEO OUT
[2]	 Anschluss TC OUT
[3]	 Anschluss TC IN
[4]	 Anschluss GENLOCK IN
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2	 Schalten Sie den Schalter POWER ein.

3	 Stellen Sie den Schalter PRESET/REGEN/CLOCK 
auf PRESET.

4	 Stellen Sie den Schalter F-RUN/SET/R-RUN auf 
F-RUN.

5	 Stellen Sie den Schalter DISPLAY auf TC.

6	 Legen Sie am Anschluss TC IN sowie am 
Anschluss GENLOCK IN ein Zeitcodesignal und 
ein Referenzvideosignal an, das dem Standard 
SMPTE entspricht und ein geeignetes 
Phasenverhältnis aufweist.
Dadurch wird der interne Zeitcodegenerator 
mit dem externen Zeitcode synchronisiert. 
Wenn etwa 10 Sekunden nach dem 
Synchronisieren des Zeitcodes abgelaufen 
sind, bleibt der externe 
Synchronisierungszustand erhalten, selbst 
wenn die Verbindung zur externen 
Referenzzeitcodequelle unterbrochen wird.

Um die externe Synchronisierung aufzuheben, 
stoppen Sie Sie zunächst den externen 
Zeitcodeeingang und stellen Sie dann den 
Schalter F-RUN/SET/R-RUN auf R-RUN.

[Hinweise]
ˎˎ Wenn Sie diese Schritte ausgeführt haben, wird der 

interne Zeitcode sofort mit dem externen Zeitcode 
synchronisiert und auf der Zeitdatenanzeige erscheint 
der Wert des externen Zeitcodes. Warten Sie einige 
Sekunden mit dem Start der Aufzeichnung, bis sich der 
Synchronisierungsgenerator stabilisiert hat.
ˎˎ Wenn die Frequenz des Referenzvideosignals nicht 

derjenigen des Camcorders entspricht, kann der 
Camcorder nicht korrekt taktsynchronisiert werden. In 
diesem Fall wird der Zeitcode nicht erfolgreich mit dem 
externen Zeitcode synchronisiert.

Benutzerbiteinstellungen während der 
Synchronisierung

Wenn der Zeitcode mit einem externen Signal 
synchronisiert wird, werden nur die Zeitdaten mit 
dem externen Zeitcodewert synchronisiert.

Hinweis zum Wechseln von der Stromversorgung 
mit dem Akkusatz auf eine externe Stromquelle 
während der externen Synchronisierung

Damit die Stromversorgung nicht unterbrochen 
wird, schließen Sie die externe Stromquelle an 
den Anschluss DC IN an, bevor Sie den Akkusatz 
abnehmen. Die externe Zeitcodesynchronisierung 
wird möglicherweise unterbrochen, wenn Sie den 
Akkusatz zuerst abnehmen.

Camcorder-Genlock während der externen 
Synchronisierung

Während der externen Synchronisierung erfolgt 
die Taktsynchronisierung des Camcorders mit dem 
Referenzvideosignal, das am Anschluss GENLOCK 
IN eingespeist wird.
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Grundfunktionen
Dieser Abschnitt beschreibt die grundlegenden 
Verfahren für Aufnahmen und Aufzeichnungen.
Prüfen Sie vor dem Aufnahmebeginn das 
Kamerasystem um zu bestätigen, dass es richtig 
arbeitet.

1	 Bringen Sie einen vollständig geladenen 
Akkusatz an (Seite 23).

2	 Setzen Sie eine oder zwei SxS-Speicherkarten 
ein (Seite 32).
Wenn zwei Karten eingesetzt sind, schaltet der 
Camcorder automatisch auf die zweite Karte 
um, wenn die gewählte Karte während der 
Aufzeichnung voll wird.

3	 Stellen Sie den Schalter POWER des 
Camcorders (Seite 3) auf ON.

4	 Nehmen Sie die folgenden Einstellungen vor.
Markierungsanzeige: On (Seite 100)
Blende: Auto (Seite 43)
Zoom: Auto
Kameraausgabe: Wählen Sie das aktuell 

aufgenommene Bild (Kamerabild) aus und 
schalten Sie die DCC-Funktion ein 
(Seite 6)

Zeitcode-Weiterlauf-Modus: F-RUN 
(Dauerbetrieb) oder R-RUN 
(Aufzeichnungsbetrieb) (Seite 48)

Wahl des Audioeingangskanals: Auto 
(Seite 9)

5	 Drücken Sie zur Einstellung des 
Schwarzabgleichs den Schalter AUTO W/B BAL 
in die Stellung BLACK (Seite 40).

6	 Wählen Sie einen Filter entsprechend den 
Lichtverhältnissen und stellen Sie den 
Weißabgleich ein (Seite 40).

7	 Richten Sie den Camcorder auf das Motiv und 
stellen Sie Schärfe und Zoom ein.

8	 Wenn Sie die elektronische Blende verwenden, 
wählen Sie einen angebrachten 
Blendenmodus und die Belichtungszeit 
(Seite 42).

9	 Gehen Sie folgendermaßen vor, um mit der 
Aufzeichnung zu beginnen.

–– Drücken Sie die Taste REC START 
(Seite 4).

–– Drücken Sie die Taste VTR auf dem Objektiv.
–– Schalten Sie den belegbaren Schalter ein, 

dem die Rec-Funktion zugewiesen wurde 
(Seite 124).

Während der Aufzeichnung leuchten die 
TALLY-Anzeigen, die Kontrollanzeige auf der 
Vorderseite des Suchers und die REC-Anzeige 
des Suchers. Stellen Sie den Zoom und den 
Fokus wie gewünscht ein.

	 [Hinweise]
ˎˎ Entfernen Sie niemals während der Aufzeichnung 

des Camcorders den Akkusatz (während die Anzeige 
ACCESS auf der rechten Seite blau leuchtet und die 
Anzeige ACCESS im Speicherkartenbereich orange 
leuchtet). Wenn dies geschieht besteht die Gefahr 
des Verlustes von mehreren Sekunden Daten vor 
Beendigung der Aufzeichnung, da die interne 
Bearbeitung nicht normal beendet wird.
ˎˎ Während der Aufzeichnung sind die 

Wiedergabefunktionstasten (EJECT, F REV, F FWD, 
NEXT, PREV, PLAY/PAUSE, STOP) deaktiviert.

10	Zum Beenden der Aufzeichnung führen Sie 
eine der in Schritt 9 aufgelisteten Funktionen 
aus.
Die TALLY-Anzeigen, die Kontrollanzeige auf 
der Vorderseite des Suchers und die REC-
Anzeige des Suchers erlöschen, und der 
Camcorder geht auf Aufzeichnungs-Standby 
(Stby)-Modus.
Es wird ein Video von den Audio- und 
Videodaten erstellt und die Metadaten 
zwischen den Schritten 9 und 10 
aufgenommen.

Überprüfen der Aufzeichnung 
(Aufzeichnungskontrolle)

Drücken Sie einen belegbaren Schalter, dem 
die Rec Review-Funktion zugewiesen wurde, 
um die letzten zwei Sekunden des Clips in 
normaler Geschwindigkeit wiederzugeben, 
während sich der Camcorder im 
Aufzeichnungs-Standby-Modus befindet. 
Halten Sie einen belegbaren Schalter, dem die 
Rec Review-Funktion zugewiesen wurde, 
länger als eine Sekunde gedrückt, um die 
Wiedergabe von dem zwei Sekunden vor dem 
letzten Einzelbild befindlichen Einzelbild an 
mit vierfacher Geschwindigkeit rückwärts zu 
starten. Lassen Sie die Taste dann los, um den 
Clip von diesem Punkt an mit normaler 
Geschwindigkeit wiederzugeben. Der Clip wird 
bis zum Ende wiedergegeben, die Funktion 
Rec Review wird beendet, und der Camcorder 
kehrt in den Standby-Modus zurück.
Wenn die Rec Review-Funktion der Taste RET 
auf dem Objektiv zugewiesen ist, können Sie 
auch mit der Taste RET eine Überprüfung 
durchführen.

11	Wiederholen Sie die Schritte 9 und 10 zum 
Fortsetzen der Aufzeichnung.
Bei jeder Wiederholung wird ein anderer Clip 
auf der Speicherkarte erstellt.

Clip 1 Clip 2 Clip 3

[Hinweise]
ˎˎ Sie können die Aufzeichnung nach dem Stoppen der 

Aufzeichnung eine Sekunde lang nicht fortsetzen.
ˎˎ Auf einer Speicherkarte können bis zu 600 Clips 

aufgezeichnet werden. Auch wenn die Speicherkarte über 
ausreichend freie Kapazität zur Aufzeichnung weiterer 
Clips verfügt, kann nicht mehr aufgezeichnet werden, 
wenn 600 Clips aufgenommen wurden.
ˎˎ Die längste durchgehende Aufnahmedauer über mehrere 

Speicherkarten hinweg beträgt 24 Stunden. Wenn 
24 Stunden verstrichen sind, stoppt die Aufnahme.

Clipnamen

Acht-Schriftzeichen-Clipnamen (bestehend 
aus einem Vier-Schriftzeichen-Präfix und einer 
vierstelligen Zahl) werden automatisch für Clips, 
die mit diesem Camcorder aufgenommen wurden, 
erstellt.
Beispiel: ABCD0001
Sie können auch über „Operation >Clip >Title 
Prefix“ im Konfigurationsmenü das Präfix 
des Clipnamens auf eine benutzerdefinierte 
Zeichenfolge einstellen (mit einer Länge von vier 
bis 46 Zeichen). (Ein benutzerdefiniertes Präfix 
kann nach der Aufnahme nicht mehr geändert 
werden.)
Die vierstellige Zahl am Ende der Clipnamen wird 
automatisch erzeugt, ansteigend mit der Anzahl 
der aufgenommenen Clips.

Abspielen der aufgezeichneten Clips

Wenn sich der Camcorder im Bereitschaftsmodus 
(Stby) befindet, können Sie den gesamten 
oder Teile des zuletzt aufgezeichneten Clips 
wiedergeben (Seite 50).

1	 Setzen Sie die SxS-Speicherkarte für die 
Wiedergabe ein (Seite 32).

2	 Drücken Sie die Taste PREV (Seite 8) oder 
die Taste F REV (Seite 8) zum Aufrufen des 
Clips für die Wiedergabe.

3	 Drücken Sie die Taste PLAY/PAUSE.
Die Anzeige PLAY/PAUSE leuchtet und das 
Wiedergabebild erscheint im Sucher.

Unterbrechen der Wiedergabe

Drücken Sie die Taste PLAY/PAUSE.
Die Anzeige PLAY/PAUSE blinkt, während die 
Wiedergabe unterbrochen ist.
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Drücken Sie erneut die Taste, um in den 
Wiedergabe-Modus zurückzukehren.

Hochgeschwindigkeitswiedergabe

Drücken Sie die Taste F FWD (Seite 8) oder die 
Taste F REV (Seite 8).
Zur Rückkehr zur Wiedergabe in 
Normalgeschwindigkeit drücken Sie die PLAY/
PAUSE-Taste.

Anhalten der Wiedergabe

Drücken Sie die Taste STOP: Die Wiedergabe wird 
angehalten und der Camcorder wechselt in 
den E-E-Modus.

Drücken Sie die Taste THUMBNAIL: Die 
Wiedergabe wird beendet und die 
Skizzenbilderanzeige (Seite 83) erscheint im 
Sucher.

Die Wiedergabe wird ebenfalls angehalten und 
der Zeitcodebildschirm erscheint im Sucher, wenn 
Sie während der Wiedergabe die Aufzeichnung 
beginnen und wenn Sie eine SxS-Speicherkarte 
auswerfen.

Umschalten zwischen Speicherkarten

Wenn zwei Speicherkarten eingelegt sind, drücken 
Sie die Taste SLOT SELECT, (Seite 33) um den 
aktiven Einschub zu wählen.
Bei der Wiedergabe ist es nicht möglich, zwischen 
den Speicherkarten hin- und herzuschalten.
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Aufzeichnen von 
Szenenmarkierungen

Bei diesem Camcorder stehen zwei Arten von 
Szenenmarkierungen zur Verfügung. Sie können 
sie an benutzerdefinierten Positionen aufzeichnen, 
um Bearbeitern das Aufrufen dieser Positionen zu 
erleichtern.
Pro Clip können maximal 999 
Szenenmarkierungen verwendet werden.

Sie können auch das Menü „Thumbnail“ zum Hinzufügen 
und Löschen von Szenenmarkierungen in Clips 
verwenden. Einzelheiten siehe „Hinzufügen/Löschen von 
Inhaltsmarkierungen in Clips“ (Seite 87).

Um Szenenmarkierungen aufzuzeichnen, 
schalten Sie einen belegbaren Schalter ein, 
dem die Funktion Shot Mark 1 oder Shot Mark 2 
zugewiesen wurde.
Wenn eine Szenenmarkierung aufgezeichnet wird, 
erscheint die Anzeige „Shot Mark 1“ oder „Shot 
Mark 2“ ca. drei Sekunden lang im Sucher in der 
Nähe der Zeitcode-Angabe.

[Hinweis]
Unter Verwendung des Medienadapters MEAD-SD02 
(Option) in einen SxS-Kartensteckplatz eingesetzte SD-Karten 
können nicht für Aufzeichnungen verwendet werden.

Setzen von Clipmarkierungen

Um Bearbeitern die Wahl guter Clips zu 
erleichtern, können Sie in aufgezeichnete Clips 
Clipmarkierungen setzen.
Clipmarkierungen werden im Menü „Thumbnail“ 
eingestellt. Ausführliche Informationen finden Sie 
unter „Hinzufügen von Clipmarkierungen zu Clips“ 
(Seite 87) und „Löschen einer Clipmarkierung“ 
(Seite 87).

[Hinweis]
Unter Verwendung des Medienadapters MEAD-SD02 
(Option) in einen SxS-Kartensteckplatz eingesetzte SD-Karten 
können nicht für Aufzeichnungen verwendet werden.

Aufzeichnen retroaktiver Bilder 
(Bildpuffer-Aufzeichnungsfunktion)

Im internen Speicher des Camcorders ist beim 
Aufnehmen immer ein Puffer für Video- und 
Audiodaten für einen bestimmten Zeitraum 
(maximal 15 Sekunden) verfügbar, sodass 
Sie schon vor dem eigentlichen Beginn 
der Aufzeichnung mehrere Sekunden lang 
aufzeichnen können.
Einzelheiten zu den bei dieser Funktion 
unterstützten Videoformaten finden Sie im 
Abschnitt „Spezialaufnahmenunterstützung der 
Aufzeichnungsformate“ (Seite 164).

Zum Aufzeichnen im Bildpuffer-
Aufzeichnungsmodus müssen der Bildpuffer-
Aufzeichnungsmodus und die Speicherzeit von 
Bildern im Speicher (Bildpuffer-Aufzeichnungszeit) 
im Voraus im Menü „Operation“ festgelegt werden.
Beim Starten einer Aufnahme ist die Dauer des 
Bildmaterials, das retroaktiv aufgezeichnet werden 
kann, durch die Bildpuffer-Aufzeichnungszeit 
bestimmt. Der Zeitraum für die retroaktive 
Aufnahme kann unter einigen, im folgenden 
Abschnitt [Hinweise] beschriebenen, Umständen 
kürzer sein:

[Hinweise]
ˎˎ Die Speicherung von Videodaten im Arbeitsspeicher 

beginnt, wenn der Bildpuffer-Aufzeichnungsmodus 
ausgewählt wird. Wenn allerdings die Aufzeichnung sofort 
nach dem Auswählen dieses Modus gestartet wird, wird 
ein Teil der Bilder, die unmittelbar vor dem Auswählen des 
Bildpuffer-Aufzeichnungsmodus aufgenommen wurden, 
nicht aufgezeichnet.
ˎˎ Während einer Wiedergabe, Aufnahmekontrolle oder 

Skizzenbildanzeige werden Bilder nicht im Speicher 
gespeichert, deshalb wird die Aufzeichnung von Bildern 
in diesem Zeitraum nicht unterstützt.

Einstellen der Bildpuffer-Aufzeichnungszeit

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Picture Cache Rec“ aus.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.

3	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Cache Rec Time“ aus.

4	 Drehen Sie am Regler MENU, um die 
Einstellung für die Bildpuffer-
Aufzeichnungszeit auszuwählen, und drücken 
Sie den Regler.
Die Optionen hängen von der Einstellung für 
Aufzeichnungsformat und Systemfrequenz ab. 
Siehe „Aufzeichnung im Bildpuffermodus“ 
(Seite 165) im Anhang.

Der Bildpuffer-Aufzeichnungsmodus bleibt 
ausgewählt, bis die Einstellungen geändert 
werden.
Anstatt mit den Schritten 1 und 2 können Sie den 
Bildpuffer-Aufzeichnungsmodus auch über einen 
belegbaren Schalter (Seite 124) auswählen, der 
der Bildpuffer-Aufzeichnungsfunktion zugewiesen 
wurde.

[Hinweise]
ˎˎ Es kann gleichzeitig nur eine Spezial-

Aufzeichnungsfunktion, z. B. Bildpuffer-Aufzeichnung, 
verwendet werden.  
Wenn eine andere Spezial-Aufzeichnungsfunktion 
aktiviert wird, während die Bildpuffer-Aufzeichnung 
verwendet wird, wird die Bildpuffer-Aufzeichnung 
automatisch deaktiviert.
ˎˎ Beim Ändern der Systemeinstellungen (z. B. Videoformat) 

werden alle Bilder im Speicher gelöscht. Deshalb können 
Bilder, die unmittelbar vor dem Ändern von Einstellungen 
aufgenommen wurden, nicht aufgezeichnet werden, 
wenn die Aufzeichnung sofort nach dem Ändern 
der Einstellungen gestartet wird. Der Bildpuffer-
Aufzeichnungsmodus wird automatisch deaktiviert.
ˎˎ Die Bildpuffer-Aufzeichnungszeit kann nicht während 

einer Aufzeichnung eingestellt werden.

Starten der Bildpuffer-Aufzeichnung

Führen Sie die Aufnahme wie unter 
„Grundfunktionen“ (Seite 50) beschrieben durch.

Wenn die Aufzeichnung startet, ändert sich die 
Anzeige „Cache“ im Sucher zu „Rec“. Die 
TALLY-Anzeigen und die Kontrollanzeige auf der 
Vorderseite des Suchers leuchten wie bei einer 
normalen Aufzeichnung.

Zum Beenden des Bildpuffermodus beenden Sie 
die Aufzeichnung.

Beenden des Bildpuffer-Aufzeichnungsmodus

Stellen Sie im Aufzeichnungs-Standby-Modus im 
Konfigurationsmenü „Operation >Rec Function 
>Picture Cache Rec“ auf „Off“.

Bedienung des Geräts bei Aufzeichnung im 
Bildpuffer-Aufzeichnungsmodus

Das Aufzeichnungsverfahren unterscheidet 
sich nur in den folgende Punkten vom 
Standardverfahren:
ˎˎ Wenn die Aufzeichnung gestartet wird, 
während auf einen Datenträger zugegriffen 
wird, wird der tatsächliche Startpunkt der 
Aufzeichnung möglicherweise sogar länger als 
die festgelegte Bildpuffer-Aufzeichnungszeit 
verzögert. Die Verzögerung wächst mit 
der Anzahl der aufgezeichneten Clips, 
deshalb sollte das Stoppen und schnelle 
Neustarten einer Aufzeichnung im Bildpuffer-
Aufzeichnungsmodus vermieden werden.
ˎˎ Der Camcorder läuft ungeachtet der Einstellung 
des Schalters F-RUN/SET/R-RUN im Modus 
F-RUN.
ˎˎ Im Bildpuffer-Aufzeichnungsmodus können die 
Zeitdaten nicht durch Umschalten des Schalters 
F-RUN/SET/R-RUN auf SET festgelegt werden.  
Beenden Sie zum Einstellen von Zeitdaten 
zunächst den Bildpuffer-Aufzeichnungsmodus.

Fortgeschrittene Funktionen
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ˎˎ Falls die verbleibende Aufzeichnungszeit auf 
dem Medium im aktuell gewählten Einschub 
kürzer als die Bildpuffer-Aufzeichnungszeit ist, 
werden die Bilder auf dem Medium im nicht 
ausgewählten Einschub gespeichert (sofern 
auf diesem ausreichend Aufzeichnungszeit 
vorhanden ist).   
Es werden jedoch keine Bilder aufgezeichnet, 
wenn sich kein Medium im nicht ausgewählten 
Einschub befindet oder wenn auf dem 
Medium in dem Einschub nicht ausreichend 
verbleibende Aufzeichnungszeit vorhanden 
ist. (Auf dem Sucherbildschirm wird die 
Meldung eingeblendet, dass die verbleibende 
Aufnahmezeit nicht ausreicht.)
ˎˎ Szenenmarkierungen werden nicht 
aufgezeichnet, selbst wenn sie vor dem Start der 
Aufzeichnung festgelegt werden.

Wenn der Camcorder während der Aufzeichnung 
ausgeschaltet wird

ˎˎ Wenn der Schalter POWER am Camcorder auf 
die Position OFF gesetzt wird, wird mehrere 
Sekunden lang auf das Medium zugegriffen, 
um die im Speicher gespeicherten Bilder bis zu 
diesem Moment aufzuzeichnen, und dann wird 
das Gerät automatisch ausgeschaltet.
ˎˎ Wenn während der Aufzeichnung der Akku 
entfernt, das Gleichstromkabel getrennt oder 
das Netzteil ausgeschaltet wird, werden die im 
Speicher gespeicherten Video- und Audiodaten 
gelöscht, und die Bilder bis zu dieser Stelle 
werden nicht aufgezeichnet. Gehen Sie beim 
Austauschen des Akkus mit Sorgfalt vor.

Aufzeichnen von Zeitraffer-
Videodaten (Interval Rec-Funktion)

Mit der Interval Rec-Funktion des Camcorders 
können Sie Zeitraffer-Videodaten auf dem internen 

Speicher des Camcorders aufnehmen. Diese 
Funktion ist besonders gut zur Aufnahme von sich 
langsam bewegenden Motiven geeignet.  
Wenn Sie mit der Aufzeichnung beginnen, 
zeichnet der Camcorder automatisch eine 
festgelegte Anzahl von Einzelbildern im 
festgelegten Zeitintervall auf.
Diese Funktion ist aktiviert, wenn der Camcorder 
auf eines der folgenden Videoformate eingestellt 
ist (Seite 37):

XAVC-I
XAVC-L
MPEG HD 422

Aufzeichnungsintervall (Intervallzeit)

Anzahl der Bilder in einer Aufnahme
(Number of Frames)

Wenn die Funktion „Intervall Rec“ aktiviert ist, ist 
eine Vorbeleuchtungsfunktion verfügbar. Diese 
Funktion schaltet automatisch die Videoleuchte 
ein, bevor die Aufzeichnung gestartet wird, sodass 
Sie Bilder unter stabilen Beleuchtungs- und 
Farbtemperaturbedingungen aufzeichnen können.

[Hinweise]
ˎˎ Es kann gleichzeitig nur eine Spezial-

Aufzeichnungsfunktion, z. B. Aufzeichnung im „Interval 
Rec“-Modus, verwendet werden.  
Wenn eine andere Spezial-Aufzeichnungsfunktion 
aktiviert wird, während „Interval Rec“ verwendet wird, wird 
„Interval Rec“ automatisch deaktiviert.
ˎˎ Die Einstellungen der Funktion „Interval Rec“ können 

während der Aufzeichnung nicht geändert werden.

Einstellungen für den „Interval Rec“-Modus

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Interval Rec“ aus.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.
Der Camcorder wechselt in den 
Intervallaufzeichnungs-Modus und an der 
Position der REC-Anzeige im Sucher erscheint 
die Meldung „Int Stby“. (Die grüne 
Kontrollanzeige im Sucher der HDVF-Serie 
blinkt ebenfalls.)

3	 Wählen Sie [Number of Frames] aus, drehen 
Sie am Regler MENU, um die Anzahl der in 
einer Aufnahme aufzuzeichnenden Bilder 
auszuwählen, und drücken Sie dann den 
Regler.
Sie können beim Format 50P oder 59.9P den 
Wert 2, 6 oder 12 auswählen.
Sie können beim Format 23.98P, 25P, 29.97P, 
50i oder 59.94i den Wert 1, 3, 6 oder 9 
auswählen.

4	 Wählen Sie [Interval Time], drehen Sie den 
Regler MENU zur Wahl des gewünschten 
Intervalls und drücken Sie den Regler.
Sie können 1 bis 10/15/20/30/40/50 Sek., 1 bis 
10/15/20/30/40/50 Min. oder 1 bis 4/6/12/24 
Std. auswählen.

5	 Wählen Sie bei Bedarf [Pre-Lighting] aus, 
drehen Sie am Regler MENU zum Auswählen 
der Länge der Beleuchtungszeit vor dem 
Starten der Aufzeichnung und drücken Sie 
dann den Regler.
Sie können 2, 5, 10 Sekunden oder „Off“ 
auswählen.

	 [Hinweise]
ˎˎ Wenn Sie die Videoleuchte vor dem Starten der 

Aufzeichnung einschalten möchten, setzen Sie 
den Schalter LIGHT des Camcorders auf AUTO. 
Der Schalter der Videoleuchte muss ebenfalls 
eingeschaltet werden. Danach schaltet sich 
die Videoleuchte automatisch ein und aus. Die 
Videoleuchte schaltet sich allerdings nicht aus, wenn 
sie nur maximal fünf Sekunden ausgeschaltet wäre.
ˎˎ Wenn Sie den Schalter LIGHT auf MANUAL stellen 

und den Schalter der Videoleuchte einschalten, 
leuchtet diese ständig. (Die Videoleuchte schaltet 
sich nicht automatisch ein und aus.)

Der Camcorder verlässt beim Ausschalten den 
„Interval Rec“-Modus, aber die Einstellungen für 
die Anzahl der Bilder, das Zeitintervall und die 
Vorbeleuchtung bleiben gespeichert. Bei der 
nächsten Aufnahme im „Interval Rec“-Modus 
brauchen sie nicht erneut eingestellt zu werden.

Starten der Aufzeichnung im „Interval Rec“-
Modus

Nehmen Sie die in „Grundfunktionen“ (Seite 50) 
beschriebenen Einstellungen vor, treffen Sie die 
entsprechenden Vorbereitungen, befestigen Sie 
den Camcorder so, dass er sich nicht bewegt und 
beginnen Sie dann mit der Aufnahme.

Wenn der „Interval Rec“-Modus auf „On“ 
eingestellt ist, wird an der REC-Position in der 
Sucheranzeige „Int Stby“ angezeigt. Wenn Sie mit 
der Aufzeichnung beginnen, werden abwechselnd 
„Int Rec“ und „Int Stby“ angezeigt. Die 
TALLY-Anzeigen und die Kontrollanzeige auf 
der Vorderseite des Suchers leuchten wie bei 
einer normalen Aufzeichnung. (Die grüne 
Kontrollanzeige im Sucher der HDVF-Serie blinkt 
sehr schnell.)
Wenn Sie die Vorbeleuchtungsfunktion 
verwenden, schaltet sich die Videoleuchte vor 
dem Start der Aufnahme ein.

Zum Beenden des Bildpuffermodus beenden Sie 
die Aufzeichnung.
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Nach Beendigung der Aufnahme werden die 
bis zu dieser Stelle im Speicher gespeicherten 
Videodaten auf das Speichermedium kopiert.

Abbrechen des „Interval Rec“-Modus

Gehen Sie folgendermaßen vor.
ˎˎ Stellen Sie den Schalter POWER auf OFF.
ˎˎ Stellen Sie im Aufzeichnungs-Standby-Modus 
im Konfigurationsmenü „Operation >Rec 
Function >Interval Rec“ auf „Off“.

[Hinweis]
Durch Neustarten des Camcorders wird der „Interval Rec“-
Modus automatisch deaktiviert.

Beschränkungen während der Aufzeichnung

ˎˎ Der interne Zeitcodegenerator läuft unabhängig 
von der Einstellung des Schalters F-RUN/SET/R-
RUN immer im R-RUN-Betrieb weiter.
ˎˎ Es wird kein Ton aufgezeichnet.
ˎˎ Überprüfen der Aufzeichnung (Rec Review) ist 
nicht möglich.
ˎˎ Genlock ist nicht möglich.

Wenn der Camcorder während der Aufzeichnung 
ausgeschaltet wird

ˎˎ Wenn der Schalter POWER am Camcorder auf 
die Position OFF gesetzt wird, wird mehrere 
Sekunden lang auf das Medium zugegriffen, 
um die im Speicher gespeicherten Bilder bis zu 
diesem Moment aufzuzeichnen, und dann wird 
das Gerät automatisch ausgeschaltet.
ˎˎ Wenn die Stromversorgung unterbrochen 
wird, weil die Batterie entfernt wurde, das 
Gleichspannungsnetzkabel herausgezogen 
oder die Stromversorgung am Netzteil 
ausgeschaltet wurde, gehen die bis zu dieser 
Stelle aufgenommenen Video- und Audiodaten 
(maximal 10 Sekunden) möglicherweise 
verloren. Gehen Sie beim Austauschen des 
Akkus mit Sorgfalt vor.

Zeitlupen- und Zeitrafferaufnahme

Sie können eine Aufzeichnungsbildrate 
angeben, die sich von der Wiedergabebildrate 
unterscheidet.

[Hinweis]
Verwenden Sie zum Aufnehmen im XAVC-
Aufzeichnungsformat SxS-Speicherkarten vom Typ SxS Pro+.

Aufzeichnungs-
format

Systemfrequenz Zeitlupen-/
Zeitraffer-
Bildfrequenz

XAVC-I 1080P 59.94P/50P/ 
29.97P/23.98P/ 
25P

1 FPS bis 
60 FPS (in 
Einheiten von 
1 FPS)XAVC-L 50 1080P 59.94P/50P/ 

29.97P/23.98P/ 
25P

XAVC-L 35 1080P 59.94P/50P/ 
29.97P/23.98P/ 
25P

HD422 50 1080P a) 29.97P 1 FPS bis 
30 FPS (in 
Einheiten von 
1 FPS)

23.98P

25P 1 FPS bis 
25 FPS (in 
Einheiten von 
1 FPS)

a)	 exFAT- und UDF-Dateisysteme werden unterstützt. Für 
andere Aufnahmeformate wird nur exFAT unterstützt.

Durch die Aufnahme mit einer Bildfrequenz, 
die sich von der Wiedergabebildfrequenz 
unterscheidet, können Sie Zeitlupen- und 
Zeitraffereffekte erzielen, die sanfter sind als die 
langsame oder schnelle Wiedergabe von Material, 
das mit der normalen Bildfrequenz aufgezeichnet 
wurde.

Einstellungen für Zeitlupen- und 
Zeitrafferaufnahmen

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Slow & Quick Motion“.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.
Die Zeitlupen- und Zeitrafferfunktion wird 
gestartet und im Sucher wird im 
Anzeigebereich für den Aufnahmestatus „S&Q 
Stby“ angezeigt.
Als nächstes stellen Sie die Bildfrequenz ein.

3	 Wählen Sie im Konfigurationsmenü Operation 
Rec >Function >Slow & Quick Motion >Frame 
Rate aus.

4	 Drehen Sie am Regler MENU, um die 
Bildfrequenz auszuwählen, und drücken Sie 
den Regler.

Nach der Vornahme der Einstellungen erscheinen 
die Systemfrequenz und die Bildfrequenz oben auf 
der Sucheranzeige. Sie können die Bildfrequenz 
durch Drehen am Regler MENU ändern, während 
Sie die Anzeige im Sucher verfolgen.
Die Einstellungen des Zeitlupen- & 
Zeitraffermodus und die Bildfrequenz werden 
auch dann gespeichert, wenn der Camcorder 
ausgeschaltet wird.

[Hinweise]
ˎˎ Es kann gleichzeitig nur eine Spezial-

Aufzeichnungsfunktion, z. B. Zeitlupe und Zeitraffer, 
verwendet werden.
ˎˎ Wenn eine andere Spezial-Aufzeichnungsfunktion 

aktiviert wird, während Zeitlupe und Zeitraffer verwendet 
werden, werden Zeitlupe und Zeitraffer automatisch 
deaktiviert.
ˎˎ Zeitlupe und Zeitraffer können nicht während der 

Aufzeichnung bzw. Wiedergabe oder während der 
Anzeige der Skizzenbilderanzeige geändert werden.

ˎˎ Zeitlupe und Zeitraffer können nicht festgelegt werden, 
wenn der langsame Blendenverschluss aktiviert ist.

Starten von Zeitlupen- und Zeitrafferaufnahmen

Führen Sie die Aufnahme wie unter 
„Grundfunktionen“ (Seite 50) beschrieben durch.

Wenn die Aufzeichnung beginnt, ändert sich die 
Anzeige „S&Q Stby“ im Sucher zu „S&Q Rec“. Die 
TALLY-Anzeigen und die Kontrollanzeige auf der 
Vorderseite des Suchers leuchten wie bei einer 
normalen Aufzeichnung.

Zum Beenden des Bildpuffermodus beenden Sie 
die Aufzeichnung.

[Hinweis]
Das Beenden der Aufzeichnung dauert länger als 
gewöhnlich, wenn die Bildfrequenz auf einen niedrigen Wert 
(eine niedrige Bildfrequenz) eingestellt ist.

Abbrechen des Zeitlupen-/Zeitraffer-Modus

Stellen Sie „Operation >Rec Function >Slow & 
Quick“ im Konfigurationsmenü auf [Off], während 
sich der Camcorder im Aufzeichnungs-Standby-
Modus befindet.

Beschränkungen während der Aufzeichnung

ˎˎ Der interne Zeitcodegenerator läuft unabhängig 
von der Einstellung des Schalters F-RUN/SET/R-
RUN immer im R-RUN-Betrieb weiter.
ˎˎ Es kann kein Audio aufgezeichnet werden 
wenn die Bildfrequenz für Aufzeichnung und 
Wiedergabe unterschiedlich sind.
ˎˎ Überprüfen der Aufzeichnung (Rec Review) ist 
nicht möglich.
ˎˎ Wenn Sie die Aufzeichnungsbildfrequenz 
auf einen schnelleren Wert als die aktuelle 
Belichtungszeit einstellen, wird die 
Belichtungszeit zum langsamsten Wert geändert, 
bei dem die Aufzeichnung möglich ist.  
Beispiel: Wenn die Bildfrequenz 32 und 
die Belichtungszeit 1/40 beträgt, und Sie 
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die Bildfrequenz auf 55 ändern, wird die 
Belichtungszeit auf 1/60 geändert.  
Es ist nicht möglich, eine Belichtungszeit 
zu wählen, die langsamer als die 
Aufzeichnungsbildfrequenz ist.
ˎˎ Genlock ist nicht möglich.

Aufnahme mit der Clip Continuous 
Rec-Funktion

Normalerweise wird mit jedem Starten und 
Stoppen der Aufnahme ein Clip in Form einer 
unabhängigen Datei erstellt. Diese Funktion 
ermöglicht jedoch, die Aufnahme zu starten und 
zu stoppen und dabei ein und denselben Clip 
fortlaufend aufzuzeichnen, so lange diese Funktion 
aktiviert ist. Dies ist von großem Nutzen, wenn Sie 
keine große Menge kurzer Clips erstellen möchten 
und wenn Sie aufnehmen möchten, ohne Gefahr 
zu laufen, die Clip-Grenze zu überschreiten.
Dabei kann man dennoch bequem die 
Aufzeichnungs-Startpunkte auffinden, da bei 
jedem erneuten Start der Aufnahme eine Rec 
Start-Inhaltsmarkierung aufgezeichnet wird.
Diese Funktion ist aktiviert, wenn der Camcorder 
auf eines der folgenden Videoformate eingestellt 
ist (Seite 37):

XAVC-I
XAVC-L
MPEG HD 422

Einstellungen für Clip Continuous Rec

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Clip Continuous Rec“.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.

Im Sucher erscheint „Cont Stby“ und die 
Funktion wird aktiviert.

[Hinweise]
ˎˎ Es kann gleichzeitig nur eine Spezial-

Aufzeichnungsfunktion, z. B. Clip Continuous Rec, 
verwendet werden.
ˎˎ Wenn eine andere Spezial-Aufzeichnungsfunktion 

aktiviert wird, während Clip Continuous Rec verwendet 
werden, wird der ausgewählte Modus automatisch 
deaktiviert.

Sie können die Clip Continuous Rec-Funktion Ein/
Aus einem der Schalter ASSIGN. 1/2/3, ASSIGNABLE 
4/5 und der Taste Online zuweisen.

Einzelheiten siehe „Zuweisung der Funktionen belegbarer 
Schalter“ (Seite 124).

Starten der Aufzeichnung im „Clip Continuous 
Rec“-Modus

Führen Sie die Aufnahme wie unter 
„Grundfunktionen“ (Seite 50) beschrieben durch.
Wenn die Aufzeichnung beginnt, ändert sich die 
Anzeige „Cont Stby“ im Sucher zu „Cont Rec“.
Die TALLY-Anzeigen und die Kontrollanzeige auf 
der Vorderseite des Suchers leuchten wie bei einer 
normalen Aufzeichnung.

[Hinweis]
Wenn Sie während der Aufzeichnung oder im 
Aufzeichnungs-Standby-Modus (wenn die Anzeige „Cont 
Stby“ angezeigt wird), das Medium, die Batterie oder die 
Stromquelle entfernen, muss das Medium wiederhergestellt 
werden. Medien können nicht mit einem anderen 
Camcorder als mit diesem wiederhergestellt werden.
Verlassen Sie den Clip Continuous Rec-Modus (Seite 55) 
und entfernen Sie das Medium.
Wenn die Anzeige „Cont Stby“ blinkt (ein Mal pro Sekunde), 
können Sie das Medium entfernen.

Zum Beenden des Bildpuffermodus beenden Sie 
die Aufzeichnung.

[Hinweis]
Beenden Sie die Aufzeichnung nach Aufzeichnung von mehr 
als zwei Sekunden.

Abbrechen des „Clip Continuous Rec“-Modus

Stellen Sie „Operation >Rec Function >Clip 
Continuous Rec“ im Konfigurationsmenü auf „Off“, 
während sich der Camcorder im Aufzeichnungs-
Standby-Modus befindet.

Beschränkungen während der Aufzeichnung

Es kann kein fortlaufender Clip erstellt werden, 
wenn Sie eine der folgenden Funktionen nutzen, 
während der Camcorder sich im Aufzeichnungs- 
oder im Aufzeichnungs-Standby-Modus 
befindet. (Es wird dann beim nächsten Start einer 
Aufzeichnung ein neuer Clip erstellt.)
ˎˎ Arbeit mit einem Clip (Sperren, Löschen oder 
Umbenennen eines Clips)
ˎˎ Wechsel der Einschübe
ˎˎ Änderung des Aufzeichnungsformats
ˎˎ Den Schalter POWER ausschalten
ˎˎ Wiedergabe
ˎˎ Zur Skizzenbilderanzeige wechseln

Aufzeichnung von Video auf zwei 
SxS-Speicherkarten gleichzeitig 
(Simul Rec)

Wenn für das Videoformat (Seite 37) eine 
der in der folgenden Tabelle aufgeführten 
Optionen festgelegt wurde, können Sie das 
gleiche Videosignal auf zwei SxS-Speicherkarten 
aufzeichnen. Diese Funktion ist zum Anfertigen 
einer Video-Sicherheitskopie während der 
Aufnahme nützlich.

[Hinweise]
ˎˎ Es wird empfohlen, beide SxS-Speicherkarten vor 

dem Gebrauch mit dem Camcorder zu formatieren 
(initialisieren).
ˎˎ Die gleichzeitige Aufzeichnung wird nicht unterstützt, 

wenn das Dateisystem UDF ist.
ˎˎ SD-Karten können nicht verwendet werden.

„Operation >Format 
>Rec Format“ im 
Konfigurationsmenü

„Operation >Format 
>Frequency“ im 
Konfigurationsmenü

XAVC-I 1920×1080P 59.94/59/29.97/25/23.98
XAVC-I 1920×1080i 59.94/50
XAVC-I 1280×720P 59.94/50
XAVC-L 50 
1920×1080P

59.94/50/29.97/25/23.98

XAVC-L 50 
1920×1080i

59.94/50

XAVC-L 50 1280×720P 59.94/50
XAVC-L 35 1080P 59.94/50/29.97/25/23.98
XAVC-L 35 1080i 59.94/50
XAVC-L 25 1080i 59.94/50
HD 422 50 1080P 29.97/25/23.98
HD 422 50 1080i 59.94/50
HD 422 50 720P 59.94/50/29.97/25/23.98
HQ 1920×1080P 29.97/25/23.98
HQ 1920×1080i 59.94/50
HQ 1440×1080i 59.94/50
HQ 1280×720P 59.94/50

Einstellungen für den „Simul Rec“-Modus

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Rec Function >Simul Rec“.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.

[Hinweise]
ˎˎ Es kann gleichzeitig nur eine Spezial-

Aufzeichnungsfunktion, z. B. Simul Rec, verwendet 
werden.
ˎˎ Wenn ein anderer Spezial-Aufzeichnungsmodus aktiviert 

wird, während Simul Rec verwendet wird, wird Simul Rec 
automatisch deaktiviert.
ˎˎ Simul Rec kann nicht während der Aufzeichnung 

bzw. Wiedergabe oder während der Anzeige der 
Skizzenbilderanzeige geändert werden.
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Starten der Aufzeichnung im „Simul Rec“-Modus

1	 Setzen Sie SxS-Speicherkarten in die Einschübe 
A und B ein.
Die Anzeigen ACCESS für die SxS-Einschübe A 
und B leuchten auf. Außerdem werden im 
Sucher Symbole für die SxS-Einschübe A und B 
angezeigt (Seite 18).

2	 Führen Sie die Aufnahme wie unter 
„Grundfunktionen“ (Seite 50) beschrieben 
durch.

[Hinweise]
ˎˎ Gleichzeitige Aufzeichnung ist nicht möglich, wenn 

eines der Medien defekt ist oder wenn das Medium 
schreibgeschützt ist.
ˎˎ Wenn bei gleichzeitiger Aufzeichnung eines der Medien 

vollständig beschrieben wird oder ein Fehler auftritt und 
die Aufzeichnung nicht fortgesetzt werden kann, wird die 
Aufzeichnung auf diesem Medium gestoppt, aber jene auf 
dem anderen Medium fortgesetzt.

Zum Beenden des Bildpuffermodus beenden Sie 
die Aufzeichnung.

Abbrechen des „Simul Rec“-Modus

Stellen Sie im Aufzeichnungs-Standby-Modus im 
Konfigurationsmenü „Operation >Rec Function 
>Simul Rec“ auf „Off“.
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Proxy-Daten bestehen aus Videodaten mit 
niedrigerer Auflösung (H.264) und Audiodaten 
(AAC-LC). Diese kleineren Proxy-Daten können auf 
dieselbe Weise wie die Originaldaten verwendet 
werden, sie können jedoch schneller übertragen 
werden und ermöglichen somit effizienteres 
Anzeigen und Bearbeiten.
Während der Aufzeichnung von Clips werden 
auf der SD-Karte im Proxy SD-Karteneinschub die 
Proxy-Daten aufgezeichnet. 

SD-Karteneinschub PROXY

Durch das Importieren der auf der SD-Karte 
aufgezeichneten Proxy-Daten auf einen Computer 
können Sie schnell den aufgezeichneten Inhalt 
überprüfen oder schnelle Offline-Bearbeitungen 
durchführen.
Sie könne Proxy-Daten nicht nur gleichzeitig mit 
der Aufnahme auf SxS-Speicherkarten aufnehmen, 
sondern auch unabhängig davon.

Proxy-Aufzeichnung mit dem 
Camcorder

ˎˎ Bei der gleichzeitigen Aufnahme wird die Proxy-
Aufzeichnung nur gestartet, wenn eine SxS-
Speicherkarte eingesetzt ist.
ˎˎ Ca. 35 Sekunden nach dem Einschalten des 
Camcorders ist im LCD-Monitor und in der 
Sucheranzeige das Symbol  (Medien-
Statusanzeige für Proxy-SD-Karteneinschub) zu 

sehen, das anzeigt, dass die Proxy-Aufzeichnung 
aktiviert ist.  
Wenn Sie mit der Aufzeichnung beginnen, 
während das Symbol  blinkt oder 
nicht leuchtet, werden keine Proxy-Dateien 
aufgezeichnet.
ˎˎ Bevor Sie eine SD-Karte aus dem Camcorder 
entnehmen, stellen Sie stets sicher, dass die 
Anzeige ACCESS für den SD-Karteneinschub 
PROXY nicht leuchtet. Schalten Sie dann 
den Camcorder oder die Funktion Proxy-
Aufzeichnung/WLAN-Verbindung aus.  
Um die Funktion Proxy-Aufzeichnung/WLAN-
Anschluss zu deaktivieren, nehmen Sie im 
Konfigurationsmenü folgende Einstellungen vor.

–– 	Setzen Sie „Operation >Proxy Recording 
Mode >Setting“ auf „Off“.

–– 	Setzen Sie „Maintenance >Network >Setting“ 
auf „Off“.

ˎˎ Beim Versuch, die SD-Karte zu entfernen, 
während die Proxy-Aufzeichnung oder 
WLAN-Verbindungsfunktion aktiviert ist, wird 
in einigen Fällen ein Warnhinweis (E91-1C0) 
angezeigt. Wenn die Warnung während einer 
Aufzeichnung eingeblendet wird, werden die 
Daten nach wie vor ordnungsgemäß auf den 
SxS-Speicherkarten aufgezeichnet, es werden 
aber keine Proxy-Dateien aufgezeichnet. Die 
Warnmeldung kann durch Aus- und Einschalten 
des Camcorders gelöscht werden.
ˎˎ Die Proxy-Aufzeichnung wird nicht gestartet, 
wenn Picture Cache Rec, Interval Rec, Zeitlupe 
oder Zeitraffer bzw. Streaming aktiviert ist.

SD-Karten

Für das Speichern von Proxy-Daten unterstützte 
SD-Karten

ˎˎ SDHC-Speicherkarten* (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 4 GB bis 

32 GB)
ˎˎ SDXC-Speicherkarten* (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 64 GB bis 
256 GB)

*	 In diesem Handbuch als „SD-Karten“ bezeichnet.

Formatieren (Initialisieren) von SD-Karten

SD-Karten müssen bei der erstmaligen 
Verwendung im Camcorder formatiert werden.
SD-Karten für die Verwendung im Camcorder 
müssen mit der Formatierungsfunktion des 
Camcorders formatiert werden. Wenn beim 
Einsetzen einer SD-Karte eine entsprechende 
Meldung angezeigt wird, formatieren Sie die SD-
Karte.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Proxy Recording Mode >Setting“.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.

3	 Wählen Sie im Konfigurationsmenü „Operation 
>Format Media >SD Card (Proxy)“.

4	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler.
Ein Bestätigungsbildschirm mit der Frage, ob 
die Karte formatiert werden soll, wird 
angezeigt.

5	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Die Formatierung wird gestartet.
Während der Formatierung wird eine Meldung 
und der Fortschritt (in %) angezeigt. Die 
Anzeige ACCESS leuchtet orange.
Am Ende der Formatierung wird eine 
Abschlussmeldung angezeigt. Drücken Sie den 
Regler MENU, um die Meldung zu verwerfen.

[Hinweis]
Beim Formatieren einer SD-Karte werden alle Daten auf 
der Karte gelöscht. Die Daten auf der Karte können nicht 
wiederhergestellt werden.

Überprüfen der verbleibenden 
Aufzeichnungskapazität

Sie können die verbleibende Kapazität auf 
einer SD-Karte auf dem Bildschirm Media Status 
überprüfen (Seite 15).

Um eine im Camcorder formatierte SD-Karte im 
Einschub eines anderen Geräts zu verwenden

Erstellen Sie zunächst eine Sicherungskopie der 
Karte und formatieren Sie dann die Speicherkarte 
in dem anderen Gerät.

Aufzeichnung von Proxy-Daten

Gleichzeitige Aufzeichnung von Proxy-Daten

Gleichzeitig mit der Aufzeichnung auf SxS-
Speicherkarten können Sie Proxy-Daten auf eine 
SD-Karte aufzeichnen.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Proxy Recording Mode >Setting“.

2	 Drehen Sie den Regler MENU, um [On] 
auszuwählen und drücken Sie dann den Regler 
MENU.

3	 Legen Sie eine SD-Karte zur Aufzeichnung von 
Proxy-Daten in den SD-Karteneinschub PROXY 
ein.

4	 Beginnen Sie mit der Aufzeichnung.
Die Proxydaten-Datei wird im Verzeichnis  
„/PRIVATE/PXROOT/Clip“ der SD-Karte 

Proxy-Daten
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gespeichert, während die Originaldaten auf 
einer SxS-Speicherkarte aufgezeichnet werden.
Die Aufzeichnung von Proxy-Daten wird beim 
Beenden einer Aufzeichnung automatisch 
beendet.

Aufzeichnen von Proxydaten Getrennt von der 
Aufzeichnung der Originaldaten 

Unabhängig von den SxS-Speicherkarten können 
Sie Proxy-Daten auf eine SD-Karte aufzeichnen.

[Hinweise]
ˎˎ Wenn die gleichzeitige Proxy-Aufzeichnung gestartet 

wird, während die unabhängige Proxy-Aufzeichnung 
ausgeführt wird, wird die Proxy-Aufzeichnung ohne 
Unterbrechung fortgesetzt. Wenn anschließend die 
gleichzeitige Aufnahme gestoppt wird, wird auch die 
Aufzeichnung von Proxy-Daten gestoppt.
ˎˎ Während der gleichzeitigen Proxy-Aufnahme kann die 

Proxy-Aufnahme nicht unabhängig gestoppt werden.

Einschränkungen bei der Proxy-Aufzeichnung

Die Proxy-Aufzeichnung wird in den folgenden 
Fällen nicht unterstützt.
ˎˎ Wenn Streaming aktiviert ist („Maintenance 
>Streaming >Setting“ im Konfigurationsmenü 
ist auf „On“ eingestellt).
ˎˎ Während Interval Rec aktiviert ist 
(„Operation >Rec Function >Interval Rec“ im 
Konfigurationsmenü ist auf „On“ eingestellt)
ˎˎ Wenn Picture Cache Rec aktiviert ist („Operation 
>Rec Function >Picture Cache Rec“ im 
Konfigurationsmenü ist auf „On“ eingestellt)
ˎˎ Bei Zeitlupe und Zeitraffer („Operation 
>Rec Function >Slow & Quick Motion“ im 
Konfigurationsmenü ist auf „On“ eingestellt)
ˎˎ Wenn der Netzwerkclientmodus aktiviert ist 
(„Maintenance >Network Client Mode >Setting“ 
im Konfigurationsmenü auf „On“ eingestellt) und 
„Maintenance >Network Client Mode >Preset 
1, Preset 2 oder Preset 3 >NCM with Proxy“ im 
Konfigurationsmenü auf „Disable“ eingestellt ist.
ˎˎ Wenn „Operation >Format >Frequency“ im 
Konfigurationsmenü auf „23.98P“ eingestellt ist 

und „Operation >Proxy Recording Mode >Size“ 
auf „HD Auto(9Mbps)“ oder „HD Auto(6Mbps)“ 
eingestellt ist
ˎˎ Proxy-Aufzeichnung ist nicht möglich, wenn am 
Anschluss für externe Geräte Spannung anliegt 
(„Operation >USB“ im Konfigurationsmenü).

Aufgezeichnete Dateien

ˎˎ Die Dateinamenserweiterung ist „.mp4“.
ˎˎ Gleichzeitig wird auch der Zeitcode 
aufgezeichnet.
ˎˎ Gleichzeitig wird auch ein Standbild des ersten 
Einzelbilds aufgezeichnet.
ˎˎ Ortsangaben und eine Protokolldatei werden 
gleichzeitig aufgezeichnet, wenn die GPS-
Funktion aktiviert ist. Die Protokolldatei wird in 
„Root/PRIVATE/SONY/GPS“ gespeichert.

Abbrechen der Aufzeichnung von Proxy-Daten

Setzen Sie „Operation >Proxy Recording Mode 
>Setting“ im Konfigurationsmenü auf „Off“.

Wenn die verbleibende Kapazität auf einer 
SD-Karte nicht ausreicht

Eine Warnung, dass nicht genug freier 
Speicherplatz vorhanden ist, wird angezeigt.

Ändern der Einstellungen für die Proxy-
Aufzeichnung

Wählen Sie im Konfigurationsmenü Operation 
Proxy Recording Mode >Size und Audio Channel 
aus, um die Einstellungen für die Größe des Proxy-
Aufzeichnungsformats bzw. den Audiokanal für 
die Proxy-Aufzeichnung zu ändern.

[Hinweis]
Wenn „Operation >Proxy Recording Mode >Size“ im 
Konfigurationsmenü auf „HD Auto(9Mbps)“ oder „HD 
Auto(6Mbps)“ und die Systemfrequenz auf 29.97, 25 oder 
23.98 eingestellt ist, wird die Bildgröße der Proxydaten 
auf 1920×1080 eingestellt, auch wenn die Bildgröße des 
Videoaufzeichnungsformats auf 1280×720 eingestellt ist.

Prüfen der Einstellungen für die Proxy-
Aufzeichnung

Wählen Sie im Konfigurationsmenü „Operation 
>Proxy Recording Mode >Frame Rate und Bit 
Rate“ aus, um die Einstellungen für die Video-
Bildfrequenz bzw. die Video-Bitrate anzuzeigen.
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Planungsmetadaten sind Informationen zu 
Aufnahme- und Aufzeichnungsplänen, die in einer 
XML-Datei gespeichert werden.
Sie können Aufnahmen machen unter 
Verwendung von Clipnamen und Namen von Shot 
Marks, die im Voraus in einer Planungsmetadaten-
Datei definiert wurden.
Sie können mithilfe der Anwendung „Content 
Browser Mobile“ Planungsmetadaten senden und 
empfangen.

[Hinweis]
Verwenden Sie eine Schriftart, die mit der beim Definieren 
der Clipnamen und Szenenmarkierungsnamen über 
„Maintenance >Language“ im Konfigurationsmenü 
eingestellten Sprache kompatibel ist. Wenn Schriftarten 
für eine Sprache verwendet werden, die nicht zur 
Spracheinstellung des Camcorders passen, können Zeichen 
fehlerhaft angezeigt werden.

Laden einer Planungsmetadaten-
Datei in den internen Speicher des 
Camcorders bei der Aufzeichnung 
eines Clips

1	 Speichern Sie im Voraus die 
Planungsmetadaten-Datei auf einer SxS-
Speicherkarte.
Planungsmetadaten-Dateien werden im 
Verzeichnis „General/Sony/Planning“ 
gespeichert.

2	 Setzen Sie eine SxS-Speicherkarte in den 
Einschub A oder B ein.

3	 Wählen Sie im Konfigurationsmenü „Operation 
>Planning Metadata >Load Media (A)“ oder 
„Load Media (B)“.
Ein Bildschirm mit einer Dateiliste wird 
angezeigt.

In der Liste werden bis zu 64 Planungs-
Metadatendateien angezeigt.

4	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler MENU.

5	 Drehen Sie am Regler MENU, um [Load] 
auszuwählen, und drücken Sie dann den 
Regler MENU. Wählen Sie dann [Execute] und 
drücken Sie den Regler MENU erneut.

[Hinweis]
Planungsmetadaten-Dateien können mithilfe eines 
optionalen Medienadapters MEAD-SD02 von SDXC-Karten 
geladen werden. Daten können jedoch nicht von SDHC-/SD-
Karten geladen werden.

Anzeigen genauerer Informationen in 
den Planning Metadata

Nach dem Laden der Planungsmetadaten in den 
Camcorder können Sie genauere Informationen, 
die sie enthalten, aufrufen, wie etwa Dateinamen, 
Erstellungsdatum und -uhrzeit und Titel.

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Planning Metadata >Properties“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen und drücken Sie dann den Regler 
MENU.
Die Planungs-Metadateninformationen 
werden angezeigt.

Menüpunkt Information
File Name Dateiname
Assign ID Identifikation zuweisen
Created Erstellungsdatum und -uhrzeit
Modified Datum und Uhrzeit der letzten 

Änderung

Menüpunkt Information
Modified by Name der Person, von der die 

Datei geändert wurde
Title In der Datei festgelegter Titel 1 

(Clipname im ASCII-Format)

Title2 In der Datei festgelegter Titel 2 
(Clipname im UTF-8-Format)

Material Group Anzahl der Materialgruppen a)

Shot Mark0 bis 
Shot Mark9

In der Datei definierte Namen 
für Shot Mark 0 bis Shot Mark 9

a)	 Materialgruppe: Eine Gruppe der mit denselben 
Planungsmetadaten aufgezeichneten Clips.

Drehen Sie am Regler MENU, um durch die 
Liste zu blättern.

Löschen der geladenen 
Planungsmetadaten

1	 Wählen Sie im Konfigurationsmenü „Operation 
>Planning Metadata >Clear Memory“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen und drücken Sie dann den Regler 
MENU.
Der Löschvorgang beginnt.  
Die Meldung „Clear Planning Metadata File OK“ 
wird angezeigt, wenn der Löschvorgang 
beendet ist.

Definieren von Clipnamen in 
Planungsmetadaten

Die zwei folgenden Arten von Zeichenfolgen für 
Clip-Namen können in eine Planungsmetadaten-

Datei eingetragen werden.
ˎˎ Der im Sucher erscheinende Name im ASCII-
Format
ˎˎ Der Name im UTF-8-Format, der tatsächlich als 
Name des Clips registriert wird

Unter „Operation >Planning Metadata >Clip 
Name Disp“ im Konfigurationsmenü können Sie 
auswählen, welche Art von Clipnamen angezeigt 
werden.
Wenn ein Clipname mit Planungsmetadaten 
besetzt wird, wird der Clipname angezeigt.

[Hinweis]
Wenn Sie beide Namen im ASCII- oder UTF-8-Format mit 
Planungsmetadaten besetzen, wird die Zeichenfolge 
im UTF-8-Format als Zeichenfolge für den Clipnamen 
verwendet. Wenn Sie entweder Namen im ASCII- oder 
UTF-8-Format mit Planungsmetadaten besetzen, wird der 
definierte Formatname angezeigt, obwohl er nicht durch die 
Menüeinstellungen ausgewählt ist.

Beispiel für die Zeichenfolge eines Clipnamens

Ändern Sie in einem Text-Editor die zwei Felder 
im Tag <Title>, welche die Zeichenfolgen des 
Clipnamens enthalten.
Die grau markierten Felder im Beispiel sind 
Zeichenfolgen eines Clipnamens. „Typhoon“ wird 
im ASCII-Format beschrieben (bis zu 44 Zeichen). 
„Typhoon_Strikes_Tokyo“ wird im UTF-8-Format 
beschrieben (bis zu 44 Bytes).
„sp“ stellt ein Leerzeichen und  eine 
Zeilenumschaltung dar.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2016-11-30T17:00:00+09:00"sp

lastUpdate="
2016-12-06T17:00:00+09:00"sp

version="1.00">
<PropertiessppropertyId="

Planungsmetadaten
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assignment"spupdate="
2016-12-06T17:00:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhoon"sp

xml:lang="de">Typhoon_Strikes_Tokyo
</Title>
</Properties>

</PlanningMetadata>

[Hinweise]
ˎˎ Geben Sie beim Erstellen einer Datei jede Anweisung 

als einzelne Zeile ein mit einem CRLF erst nach dem 
letzten Zeichen in der Anweisungszeile, und geben Sie 
Leerzeichen nur an den dafür vorgesehenen Stellen ein.
ˎˎ Als Clipname kann eine Zeichenfolge von bis zu 44 Bytes 

(oder Zeichen) eingegeben werden.  
Wenn die Zeichenfolge im UTF-8-Format länger als 
44 Bytes ist, werden die ersten 44 Bytes als Clipname 
verwendet.  
Wenn nur ein Name im ASCII-Format angegeben wird, 
wird eine Zeichenfolge von 44 Zeichen für den Clipnamen 
verwendet.  
Wenn weder eine Zeichenfolge für einen Namen im 
ASCII-Format noch im UTF-8-Format verwendet werden 
kann, wird der Clipname im Standardformat verwendet.

Einstellungen für Clipnamen

1	 Laden Sie eine Planungsmetadaten-Datei mit 
Clipnamen in den Camcorder-Speicher 
(Seite 105).

2	 Stellen Sie „Operation >Clip >Clip Naming“ im 
Konfigurationsmenü auf „Plan“.
Bei jeder Aufzeichnung eines Clips erstellt der 
Camcorder automatisch einen Namen, der aus 
dem in der Planungsmetadaten-Datei 
definierten Clipnamen besteht, mit der 
Ergänzung eines Unterstrichs (_) und einer 
fünfstelligen laufenden Nummer (00001 bis 
99999).  
Beispiele: Typhoon_Strikes_Tokyo_00001, 
Typhoon_Strikes_Tokyo_00002,… Wenn die 
Zahl 99999 erreicht ist, wird beim nächsten 
Clip wieder 00001 verwendet.

[Hinweis]
Wenn Sie eine andere Planungsmetadaten-Datei laden, 
wird die laufende Nummer weiter erhöht. Sie können die 
Nummerierung mithilfe von „Operation >Clip >Number Set“ 
im Konfigurationsmenü ändern.

Auswählen des Anzeigeformats für den 
Clipnamen

Wenn Namen sowohl im ASCII- als auch im UTF-
8-Format definiert werden, können Sie „Operation 
>Planning Metadata >Clip Name Disp“ im 
Konfigurationsmenü verwenden, um auszuwählen, 
welche der Namen auf dem LCD-Monitor und auf 
der Sucheranzeige angezeigt werden sollen.
Namen im ASCII-Format anzeigen: 

Wählen Sie Title1(ASCII).  
Der Clipname wird zu „Typhoon_Strikes_
Tokyo_SerialNumber“, aber „Typhoon_
SerialNumber“ erscheint auf den Anzeigen.

Namen im UTF-8-Format anzeigen: 
Wählen Sie Title2(UTF-8).  
Der Clipname wird zu „Typhoon_Strikes_
Tokyo_SerialNumber“, und derselbe Name 
erscheint auf der Anzeige.

Definieren von Namen von Shot 
Marks in Planungsmetadaten

Wenn Sie Planungsmetadaten verwenden, um 
Szenenmarkierungen zu setzen, können Sie 
Namen für Shot Mark 0 bis Shot Mark 9 definieren.
Wenn Sie Szenenmarkierungen aufzeichnen, 
können Sie die in den Planungsmetadaten 
definierten Zeichenfolgen der 
Szenenmarkierungen hinzufügen.

[Hinweis]
Nur Shot Mark 1 und Shot Mark 2 können auf dem 
Camcorder aufgezeichnet werden.

Beispiel für die Zeichenfolge eines Shot Marks

Ändern Sie in einem Text-Editor die Felder im Tag 
<Meta name>.
Die grau markierten Felder im Beispiel sind 
Zeichenfolgen einer Inhaltsmarkierung. Namen 
können entweder im ASCII-Format (bis zu 32 
Zeichen) oder im UTF-8-Format (bis zu 16 Zeichen) 
sein.
„sp“ stellt ein Leerzeichen und  eine 
Zeilenumschaltung dar.

[Hinweis]
Wenn die Zeichenfolge für einen Namen auch nur ein 
Nicht-ASCII-Zeichen enthält, beträgt die maximale Länge der 
Zeichenfolge 16 Zeichen.

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2016-11-30T08:00:00Z"splastUpdate="
2016-11-30T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2016-11-30T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="de">
Football Game 30/11/2016</
Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
<Metaspname="_ShotMark3"sp

content="Corner Kick"/>
<Metaspname="_ShotMark4"sp

content="Free Kick"/>
<Metaspname="_ShotMark5"sp

content="Goal Kick"/>
<Metaspname="_ShotMark6"sp

content="Foul"/>

<Metaspname="_ShotMark7"sp

content="PK"/>
<Metaspname="_ShotMark8"sp

content="1st Half"/>
<Metaspname="_ShotMark9"sp

content="2nd Half"/>
<Metaspname="_ShotMark0"sp

content="Kick Off"/>
</Properties>

</PlanningMetadata>

[Hinweis]
Geben Sie beim Erstellen einer Definitionsdatei jede 
Anweisung als einzelne Zeile ein mit einem CRLF erst nach 
dem letzten Zeichen in der Anweisungszeile, und geben 
Sie Leerzeichen nur an den dafür vorgesehenen Stellen 
ein, außer innerhalb von Zeichenfolgen des Namens von 
Inhaltsmarkierungen.
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Wenn die Positionsbestimmung aktiviert ist, 
werden vom Camcorder Ort- und Zeitdaten des 
aufgenommenen Videos aufgezeichnet.
Die GPS-Funktion ist werkseitig auf „Off“ gesetzt.

Unterstützte Formate für GPS-Aufnahme

GPS-Aufnahme wird in den Aufnahmeformaten 
XAVC-I und XAVC-L unterstützt.
Wenn ein Aufnahmeformat festgelegt wird, das 
GPS-Aufnahme nicht unterstützt, können dennoch 
Standortinformationen an einem SDI-Ausgang 
abgenommen werden, wenn die SDI-Ausgabe auf 
On eingestellt wurde (Operation >Input/Output 
>SDI Out1 Output oder SDI Out2 Output auf On 
gesetzt).

[Hinweis]
Standortinformationen werden nicht ausgegeben, wenn das 
Format SD SDI ist. Sie werden ebenfalls nicht während der 
Wiedergabe ausgegeben.

1	 Überprüfen Sie, dass sich der Camcorder im 
Ruhezustand befindet.

2	 Stellen Sie „Operation >GPS“ im 
Einstellungsmenü auf „On“.

 wird im Sucher angezeigt, wenn der 
Camcorder GPS-Satelliten sucht. Wenn die 
Positionsbestimmung abgeschlossen ist, 
werden beim Aufnehmen von Videos die 
Ortsinformationen aufgezeichnet.

Das im Sucher angezeigte Symbol variiert in 
Abhängigkeit vom Signalempfang von den GPS-
Satelliten.

Status der 
Positionsbe-
stimmung

Anzeige GPS-Empfangsstatus

Off Keine 
Anzeige.

GPS ist auf „Off“ gesetzt 
oder ein Fehler ist 
aufgetreten.

Status der 
Positionsbe-
stimmung

Anzeige GPS-Empfangsstatus

Positionsbe-
stimmung 
nicht verfügbar

Standortinformationen 
konnten nicht ermittelt 
werden, da kein 
GPS-Signal nicht 
empfangen wurde. 
Begeben Sie sich an 
einen Ort mit freiem 
Blick auf den Himmel.

Suche nach 
Satelliten

Suche nach GPS-
Satelliten. Es können 
mehrere Minuten 
vergehen, bis die 
Satelliten gefunden 
werden.

Positionsbe-
stimmung

Ein schwaches GPS-
Signal wird empfangen.
Ein GPS-Signal wird 
empfangen. 
Ortsinformationen 
können abgerufen 
werden.
Ein starkes GPS-Signal 
wird empfangen. 
Ortsinformationen 
können abgerufen 
werden.

ˎˎ Nach dem Einschalten des Camcorders 
kann eine gewisse Zeit vergehen, bis die 
Ortsinformationen abgerufen werden.
ˎˎ Wenn nach mehreren Minuten kein 
Positionsbestimmungssymbol angezeigt wird, 
ist möglicherweise der Signalempfang gestört. 
Beginnen Sie in diesem Fall die Aufnahmen 
ohne Ortsinformationen oder begeben Sie sich 
an einen Ort mit freiem Blick auf den Himmel. 
Wenn kein Positionsbestimmungssymbol 
angezeigt wird, werden bei der Aufnahme keine 
Ortsinformationen aufgezeichnet.
ˎˎ In Gebäuden oder in der Nähe hoher Bauwerke 
kann unter Umständen kein GPS-Signal 
empfangen werden. Begeben Sie sich an einen 
Ort mit freiem Blick auf den Himmel.

ˎˎ Auch wenn ein Positionsbestimmungssymbol 
angezeigt wird, sind in Abhängigkeit 
von der Stärke des empfangenen Signals 
Unterbrechungen bei der Aufzeichnung von 
Ortsinformationen möglich.

Abrufen von Ortsinformationen (GPS)
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Vom Camcorder unterstützte Netzwerkfunktionen
Der Camcorder unterstützt verschiedene 
Netzwerkfunktionen. Dieser Abschnitt enthält 
eine Übersicht und ausführliche Beschreibung der 
Netzwerkverbindungen und -funktionen.

Übersicht über die 
Netzwerkverbindungen

Anschluss von Geräten über WLAN

Wenn das mitgelieferte USB-WLAN-Modul 
IFU-WLM3 oder der optionale WLAN-Adapter 
CBK-WA02 mit dem Camcorder verwendet wird, 
kann dieser über WLAN mit Smartphones, Tablet-
Computern und anderen Geräten verbunden 
werden.

1	 Wählen Sie das für die WLAN-Verbindung 
verwendete Gerät.
USB-WLAN-Modul IFU-WLM3 (im Lieferumfang 
enthalten)  (Seite 63)
WLAN-Adapter CBK-WA02 (Option)  
(Seite 63)

2	 Wählen Sie den WLAN-Zugriffsmodus.
Wi-Fi-Access-Point-Modus  (Seite 64)
Wi-Fi-Stationsmodus  (Seite 65)

Herstellen der Verbindung zum Internet mit 
einem LAN-Kabel.

Verbinden Sie den Camcorder über einen Router 
unter Verwendung des Netzwerk-Anschlusses mit 
dem Internet.

1	 Verbinden Sie den Camcorder und den Router 
mit einem LAN-Kabel.
 (Seite 67)

Herstellen der Verbindung zum Internet unter 
Verwendung eines WLANs.

Stellen Sie die Verbindung zum Internet mit dem 
(mitgelieferten) USB-WLAN-Modul IFU-WLM3, 
einem optionalen WLAN-Adapter CBK-WA02 oder 
einem optionalen Modem her.

[Hinweis]
Der optionale Netzwerkadaptersatz CBK-NA1 wird benötigt, 
wenn Sie die Verbindung mit einem optionalen WLAN-
Adapter CBK-WA02 oder einem optionalen Modem 
herstellen.

Bei Verwendung des IFU-WLM3 (im Lieferumfang 
enthalten)

1	 Schließen Sie das IFU-WLM3 an den 
Camcorder an.
 (Seite 63)

2	 Stellen Sie als WLAN-Zugriffsmodus den 
Wi-Fi-Stationsmodus ein und stellen Sie die 
Verbindung zum Internet her.
 (Seite 69)

Bei Verwendung des CBK-WA02 (Option)

1	 Schließen Sie das CBK-WA02 an den 
Camcorder an.
 (Seite 63)

2	 Stellen Sie als WLAN-Zugriffsmodus den 
Wi-Fi-Stationsmodus ein und stellen Sie die 
Verbindung zum Internet her.
 (Seite 69)

Unter Verwendung eines Modems

1	 Bringen Sie den USB-Erweiterungsadapter des 
CBK-NA1 (Option) an.
 (Seite 68)

2	 Schließen Sie das Modem an.
 (Seite 68)

Übersicht über die 
Netzwerkfunktionen

Übertragen von auf dem Camcorder 
gespeicherten Dateien auf einen Server im 
Internet

Sie können auf einer SD-Karte aufgezeichnete 
Proxy-Dateien und auf SxS-Speicherkarten 
aufgezeichnete Originaldateien auf einen Server 
im Internet übertragen, falls Sie über ein 3G/4G/
LTE-Netzwerk, einen Access-Point oder einen 
kabelbasierten LAN-Router mit dem Internet 
verbunden sind.
 (Seite 71)

Übertragen von Streaming Video und Audio

Sie können die mit dem Camcorder 
aufgenommenen/wiedergegebenen Video- und 
Audiodaten über das Internet oder ein lokales 
Netzwerk übertragen.

Streaming unter Verwendung der Streaming-Einstellungen 
am Camcorder
 (Seite 73)

Streaming mit hoher Qualität mithilfe einer Sony Network 
RX Station (optional) als Connection Control Manager 
(CCM) oder unter Verwendung von XDCAM air
 (Seite 74)

Verwenden der Wi-Fi-Fernbedienung

Sie können von einem Smartphone, Tablet-
Computer oder einem anderen Gerät über eine 
WLAN-Verbindung auf die in den Camcorder 
integrierte Wi-Fi-Fernbedienung zugreifen.
 (Seite 75)

Durchführen der Konfiguration mit dem 
Webmenü

Das Webmenü des Camcorders wird angezeigt, 
wenn mit einem Browser auf einem über eine 
WLAN-Verbindung verbundenen Gerät auf den 
Camcorder zugegriffen wird.
 (Seite 77)

Unterstützte Netzwerkfunktionen und 
Funktionseinschränkungen

 (Seite 82)



000 5. Netzwerkkonfiguration63

Wenn das mitgelieferte USB-WLAN-Modul IFU-
WLM3 oder der optionale WLAN-Adapter CBK-WA02 
mit dem Camcorder verbunden wird, kann dieser 
über WLAN mit Smartphones, Tablet-Computern 
und anderen Geräten verbunden werden.
Zwischen dem Camcorder und den über WLAN 
verbundenen Geräten können die folgenden 
Funktionen ausgeführt werden.

[Hinweis]
Sie können keine anderen USB-WLAN-Module/Adapter als 
das IFU-WLM3 oder den CBK-WA02 verwenden.

Fernbedienung über WLAN
Der Camcorder kann über ein per WLAN 
angeschlossenes Smartphone, einen Tablet-
Computer oder Computer ferngesteuert werden.

Datenübertragung WLAN
Auf der SD-Karte des Camcorders gespeicherte 
Proxydateien (Dateien mit niedriger Auflösung) 
und auf dem Camcorder aufgezeichnete 
Originaldateien (hochauflösende Dateien) können 
über WLAN auf einen Server übertragen werden.

Überwachung des Videos über WLAN
Mit der Anwendung „Content Browser Mobile“ 
können Sie einen Stream (H.264) des Kamerabilds 
oder Wiedergabebilds des Camcorders zur 
Überwachung von einem Gerät aus über WLAN 
erstellen.

„Content Browser Mobile“ ist eine Anwendung, mit 
der der Camcorder während des Streamens von 
Inhalten aus der Ferne vom Bildschirm des Geräts 
aus bedient und konfiguriert werden kann.
Sie können auch einen ausgeschnittenen Teil einer 
Datei übertragen, indem Sie in In-/Out-Punkte in 
der Proxydatei festlegen (Seite 71).
Stellen Sie sicher, dass Sie stets die neueste 
Version der Anwendung „Content Browser Mobile“ 
verwenden.

Ausführliche Informationen über die Anwendung „Content 
Browser Mobile“ erhalten Sie von Ihrem örtlichen Sony-Vertreter 
oder Kundendienst.

[Hinweise]
ˎˎ Auf der SD-Karte des Camcorders aufgezeichnete 

Proxydateien (Dateien mit niedriger Auflösung) können 
über WLAN gestreamt werden.
ˎˎ Streaming wird nicht unterstützt, wenn das Videoformat 

auf MPEG-IMX oder DVCAM eingestellt ist.
ˎˎ Hindernisse und elektromagnetische Störeinflüsse 

zwischen dem Camcorder und dem WLAN-
Zugangspunkt oder Endgerät oder die Umgebung (etwa 
Wandmaterialien) können die Übertragungsreichweite 
verkürzen oder eine Verbindung sogar unmöglich 
machen. Wenn diese Probleme auftreten, bringen Sie 
den Camcorder an einen anderen Ort oder bringen Sie 
den Camcorder und den Zugangspunkt/das Endgerät 
näher zueinander und prüfen Sie dann den Verbindungs-/
Kommunikationsstatus.

Kompatible Geräte

Zur Bedienung und Konfiguration des Camcorders 
können Sie ein Smartphone, einen Tablet-
Computer oder einen Computer verwenden. In 
der folgenden Tabelle werden die unterstützten 
Geräte, Betriebssysteme und Browser angezeigt.

Gerät Betriebssystem Browser
Smartphone Android 

4.4/5.x/6.x/7.x/8.0
Chrome

iOS 9.x/10.x/11 Safari
Tablet-Computer Android 

4.4/5.x/6.x/7.x/8.0
Chrome

iOS 9.x/10.x/11 Safari
Computer Microsoft 

Windows 7/
Microsoft 
Windows 8/
Microsoft 
Windows 10

Chrome

Mac OS X 
10.10/10.11/
macOS 
10.12/10.13

Safari

[Hinweis]
Je nach dem Betriebssystem des verwendeten Endgeräts 
und der Version des Browsers wird die Wiedergabe unter 
Umständen nicht unterstützt. Verwenden Sie in diesem Fall 
die Anwendung „Content Browser Mobile“.

Anbringen der IFU-WLM3

1	 Öffnen Sie die Abdeckung über dem 
Anschluss für das USB-WLAN-Modul.

Schutzvorrichtung 
(mitgeliefert)

2	 Bringen Sie die Schutzkappe am IFU-WLM3 an.

3	 Stecken Sie das IFU-WLM3 in den Anschluss.

[Hinweise]
ˎˎ Schalten Sie den Camcorder vor dem Anschließen oder 

Entfernen des IFU-WLM3 stets aus.
ˎˎ Wenden Sie sich zum Anbringen der Schutzvorrichtung 

an eine Sony-Kundendienstvertretung.

Wenn das IFU-WLM3 nicht benutzt wird

Lösen Sie die zwei Schrauben, entfernen Sie 
die Schutzvorrichtung und schließen Sie die 
Abdeckung des Anschlusses.

Anbringen des CBK-WA02

1	 Befestigen Sie die Halterung an der im 
folgenden Diagramm dargestellten Position 
am Griff.
Wenden Sie sich zum Anbringen der 
Halterung (Zubehörteilenummer A-2092-367-) 
an eine Sony- Kundendienstvertretung.

Halterung

2	 Befestigen Sie den USB-Erweiterungsadapter, 
der mit dem optionalen CBK-WA02 geliefert 
wurde, an der Halterung.

3	 Drehen Sie die Befestigungsschraube im 
Uhrzeigersinn, um den USB-
Erweiterungsadapter festzuschrauben.

Anschluss von Geräten über WLAN
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Befestigungsschraube

USB-Erweiterungsadapter

Sie können die Position des USB-
Erweiterungsadapters in dem im folgenden 
Diagramm dargestellten Bereich ändern.

4	 Setzen Sie die mitgelieferte Schutzkappe auf 
den USB-Stecker des USB-
Erweiterungsadapters.

5	 Öffnen Sie die Abdeckung über dem 
Anschluss für das USB-WLAN-Modul.
Wenden Sie sich zum Anbringen der 
Schutzvorrichtung an eine Sony-
Kundendienstvertretung.

Schutzvorrichtung (mitgeliefert)

6	 Stecken Sie den USB-Stecker des USB-
Erweiterungsadapters in den Anschluss des 
USB-WLAN-Moduls.

7	 Stecken Sie den CBK-WA02 in den USB-
Anschluss des USB-Erweiterungsadapters.

8	 Legen Sie den WLAN-Kanal unter 
„Maintenance >Network >Channel“ im 
Konfigurationsmenü fest (Seite 117).

Ausführliche Informationen zur Verwendung des CBK-
WA02 finden Sie in der mit dem CBK-WA02 gelieferten 
Bedienungsanleitung.

[Hinweise]
ˎˎ Schalten Sie den Camcorder vor dem Anschließen oder 

Entfernen des CBK-WA02 stets aus.
ˎˎ Nach dem Anbringen eines CBK-WA02 und Auswählen 

von „Wi-Fi Station“ unter „Maintenance >Network 
>Wi-Fi Mode“ im Konfigurationsmenü können Sie eine 
Verbindung mit einem 5-GHz-Accesspoint herstellen.
ˎˎ Die Einstellung „Auto(5GHz)“ im Wi-Fi-Access-Point-

Modus kann abhängig vom verwendeten CBK-WA02 
nicht angezeigt werden.
ˎˎ „Auto(5GHz)“ wird im Menü nicht angezeigt, wenn die 

Verwendung des CBK-WA02 im 5-GHz-Band im Freien 
in Ihrem Land oder Ihrer Region untersagt ist. Prüfen Sie, 
ob die Nutzung des CBK-WA02 in Ihrem Land oder Ihrer 
Region zugelassen ist. Einzelheiten dazu finden Sie in der 
Bedienungsanleitung des CBK-WA02.

Wenn das CBK-WA02 nicht verwendet wird

Lösen Sie die zwei Schrauben, entfernen Sie 
die Schutzvorrichtung und schließen Sie die 
Abdeckung des Anschlusses.

Herstellen von Verbindungen unter 
Verwendung eines WLAN-Access-
Points (Wi-Fi-Access-Point-Modus)

Der Camcorder kann Verbindungen zu Geräten 
herstellen, die als Access Point eingerichtet sind.

Smartphone/
Tablet-Computer

Computer

Installieren Sie „Content Browser Mobile“ auf 
dem anzuschließenden Gerät, bevor Sie die 
Verbindungskonfiguration vornehmen.

One-Touch-Verbindung mit NFC-Geräten

NFC-fähige Geräte können mithilfe der 
Nahfelderkennung durch eine Berührung 
verbunden werden.

1	 Wählen Sie auf dem Gerät die Option 
[Settings] und aktivieren Sie die Funktion 
[NFC].
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2	 Schalten Sie den Camcorder ein und setzen Sie 
„Maintenance >Network >Setting“ auf „On“.

3	 Setzen Sie „Maintenance >Network >Wi-Fi 
Mode“ auf „Wi-Fi Access Point“.

4	 Aktivieren Sie die NFC-Funktion.
Stellen Sie den NFC-Verbindungsmodus ein, 
indem Sie im Konfigurationsmenü 
„Maintenance >Network >NFC“ ausführen 
oder drei Sekunden lang einen belegbaren 
Schalter gedrückt halten, dem die NFC-
Funktion zugewiesen wurde.
Die NFC-Funktion kann nur dann verwendet 
werden, wenn auf dem Bildschirm das Symbol 

 angezeigt wird.

[Hinweis]
Bis das Symbol  angezeigt wird, können 30 bis 
90 Sekunden vergehen. Warten Sie, bis die WLAN-
Netzwerkanzeige „AP“ (Access Point) (Seite 18) in der 
Sucheranzeige aufhört zu blinken.

5	 Halten Sie das Gerät an den Camcorder.
Das Gerät stellt eine Verbindung mit dem 
Camcorder her und „Content Browser Mobile“ 
wird gestartet.

[Hinweise]
ˎˎ Ein Gerät im Ruhezustand muss zuvor aktiviert werden 

und der Sperrbildschirm muss entsperrt werden.
ˎˎ Halten Sie das Gerät weiter an den Camcorder, ohne es zu 

bewegen, bis „Content Browser Mobile“ gestartet wird (1 
bis 2 Sekunden).
ˎˎ Wenn bereits ein Gerät mit einer identischen SSID 

registriert wurde, kann das Gerät abhängig von der OS-

Version des Geräts möglicherweise nicht angeschlossen 
werden. In diesem Fall können Sie das Gerät anschließen, 
indem Sie die gespeicherte SSID vom Gerät löschen.

Herstellen einer Verbindung unter Verwendung 
von Geräten mit WPS

Geräte, die WPS unterstützen, können mithilfe von 
WPS angeschlossen werden.

1	 Setzen Sie „Maintenance >Network >Setting“ 
auf „On“.

2	 Setzen Sie „Maintenance >Network >Wi-Fi 
Mode“ auf „Wi-Fi Access Point“.

[Hinweis]
Bis zur Aktivierung des Access-Point-Modus können 30 bis 
90 Sekunden vergehen. Warten Sie, bis die Netzwerkanzeige 
„AP“ (Access Point) (Seite 18) auf dem LCD-Monitor oder 
im Sucher aufhört zu blinken.

3	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Network >WPS“.

4	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

5	 Öffnen Sie die Netzwerkeinstellungen oder 
Wi-Fi-Einstellungen des Geräts und aktivieren 
Sie Wi-Fi.

6	 Wählen Sie in der Liste der Wi-Fi-Netzwerk-
SSIDs die SSID des Camcorders, zeigen Sie die 
Optionen an und drücken Sie die Taste „WPS 
Push Button“.

[Hinweis]
Die genaue Schrittfolge hängt vom verwendetem Gerät ab.

Herstellen einer Verbindung unter Verwendung 
der SSID und des Kennworts auf dem Gerät

So stellen Sie die Verbindung durch Eingabe der 
SSID und des Passwort am Gerät her.

1	 Setzen Sie „Maintenance >Network >Setting“ 
auf „On“.

2	 Setzen Sie „Maintenance >Network >Wi-Fi 
Mode“ auf „Wi-Fi Access Point“.

[Hinweis]
Bis zur Aktivierung des Access-Point-Modus können 30 bis 
90 Sekunden vergehen. Warten Sie, bis die Netzwerkanzeige 
„AP“ (Access Point) (Seite 18) auf dem LCD-Monitor oder 
im Sucher aufhört zu blinken.

3	 Öffnen Sie die Netzwerkeinstellungen oder 
Wi-Fi-Einstellungen des Geräts und aktivieren 
Sie Wi-Fi.

4	 Wählen Sie in der Liste der Wi-Fi-Netzwerk-
SSIDs die SSID des Camcorders und geben Sie 
dann das Kennwort für die Verbindung ein.
Zum Einstellen der SSID des Camcorders und 
des Kennworts verwenden Sie „Maintenance 
>Network >SSID & Password“ (Seite 117) im 
Konfigurationsmenü.

[Hinweis]
Die genaue Schrittfolge hängt vom verwendetem Gerät ab.

Herstellen einer Verbindung im 
WLAN-Stationsmodus (Wi-Fi-
Stationsmodus)

Der Camcorder kann als Client Verbindungen 
zu einem bestehenden WLAN-Access Point 
herstellen.
Das Gerät stellt die Verbindung über den Access 
Point her.
Die Verbindung kann mit dem 
Konfigurationsmenü oder dem Webmenü 
geändert werden. Dieser Abschnitt beschreibt die 
Vorgehensweise unter Verwendung der WPS-
Funktion im Konfigurationsmenü.

Informationen zum Herstellen der Verbindung 
unter Verwendung des Webmenüs finden Sie 
im Abschnitt „Herstellen einer Verbindung mit 
einem Access Point im Stationsmodus ohne WPS“ 
(Seite 79).
Informationen zum Herstellen der Verbindung 
unter Verwendung der automatischen 
Netzwerkerkennung oder durch manuelle 
Eingabe finden Sie im Abschnitt „Herstellen 
einer Verbindung mit einem Access Point 
unter Verwendung des Konfigurationsmenüs“ 
(Seite 69).

Smartphone/
Tablet-Computer

Computer

Access 
Point

Herstellen einer Verbindung mit einem Access 
Point über WPS

Wenn ein Access Point die WPS-Funktion 
unterstützt, können Sie die Verbindung mithilfe 
einer einfachen Einstellung herstellen.
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1	 Schalten Sie den Access Point ein.

2	 Schalten Sie den Camcorder ein.

3	 Setzen Sie „Maintenance >Network >Setting“ 
auf „On“.

4	 Setzen Sie „Maintenance >Network >Wi-Fi 
Mode“ auf „Wi-Fi Station“.

[Hinweis]
Bis zur Aktivierung des Stationsmodus können 30 Sekunden 
bis 1 Minute vergehen. Warten Sie, bis das Symbol für die 
Anzeige der Netzwerksignalstärke (Seite 18) auf dem LCD-
Monitor oder im Sucher aufhört zu blinken.

5	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Network >WPS“.

6	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

7	 Drücken Sie die WPS-Taste des Access Points.
Weitere Informationen zur Bedienung der 
WPS-Taste finden Sie in der 
Bedienungsanleitung des Access Points.
Wenn die Verbindung erfolgreich hergestellt 
wurde, zeigt das Symbol für die Anzeige der 
Netzwerksignalstärke (Seite 18) auf dem 
LCD-Monitor oder im Sucher eine Stärke von 1 
oder höher an.

[Hinweis]
Wenn die Verbindung fehlschlägt, beginnen Sie erneut bei 
Schritt1.

8	 Verbinden Sie das Gerät mit dem Access Point.
Informationen zum Herstellen der Verbindung 
finden Sie in der Betriebsanleitung des 
jeweiligen Geräts.
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Sie können eine Verbindung zum Internet unter 
Verwendung eines kabelbasierten LAN oder eines 
WLAN herstellen.
Bei einem kabelbasierten LAN schließen Sie ein 
LAN-Kabel (nicht im Lieferumfang enthalten) an 
den Netzwerkanschluss am Camcorder an, und 
verbinden Sie dieses über einen Router mit dem 
Internet.
Bei einem WLAN stellen Sie die Verbindung zum 
Internet mit dem mitgelieferten USB-WLAN-Modul 
IFU-WLM3, einem optionalen WLAN-Adapter CBK-
WA02 oder einem optionalen Modem her.

Für die Netzwerkverbindung erforderliche Geräte

WLAN-Verbindung
Eines der folgenden Geräte wird benötigt:
ˎˎ USB-WLAN-Modul IFU-WLM3 (im Lieferumfang 
enthalten)
ˎˎ WLAN-Adapter CBK-WA02 (Option) 
+ im Lieferumfang des optionalen 
Netzwerkadaptersatzes CBK-NA1 enthaltener 
USB-Erweiterungsadapter CBK-NA1E
ˎˎ Optionales Modem + im Lieferumfang des 
optionalen Netzwerkadaptersatzes CBK-NA1 
enthaltener USB-Erweiterungsadapter CBK-NA1E

Kabelbasierte LAN-Verbindung
ˎˎ LAN-Kabel (nicht im Lieferumfang enthalten)

[Hinweise]
ˎˎ Das WLAN-Modul ist möglicherweise nicht in allen 

Ländern/Regionen erhältlich.
ˎˎ Der Frequenzbereich des WLAN-Moduls wird 

von verschiedenen Geräten genutzt. Je nach der 
Betriebsumgebung verringern sich möglicherweise die 
Übertragungsgeschwindigkeit und die Reichweite oder 
die Kommunikationsverbindung wird getrennt, wenn Sie 
andere Geräte verwenden.
ˎˎ Wenn Sie 3G/4G/LTE-Dienste nutzen wollen, müssen 

Sie einen Vertrag mit einem Mobilfunkunternehmen 
abschließen.
ˎˎ Einzelheiten zu den kompatiblen Geräten, die für 

die Netzwerkverbindung benötigt werden, erhalten 
Sie bei Ihrem Sony-Händler oder einem Sony- 
Kundendienstmitarbeiter.

Einschränkungen der gleichzeitigen Verwendung 
von Netzwerkverbindungsfunktionen

Der Camcorder kann Verbindungen zu einem 
Netzwerk über WLAN oder kabelbasiertes LAN 
herstellen.
Es bestehen jedoch Einschränkungen 
der gleichzeitigen Verwendung dieser 
Verbindungsfunktionen.
Einzelheiten siehe „Einschränkungen 
der gleichzeitigen Verwendung von 
Netzwerkfunktionen“ (Seite 82).

Herstellen der Verbindung mit einem 
LAN-Kabel (kabelbasierte LAN-
Verbindung)

Sie können eine Verbindung zum Internet unter 
Verwendung eines kabelbasierten LAN über einen 
mit dem Netzwerkanschluss des Camcorders 
Verbundenen Router herstellen.

[Hinweise]
ˎˎ Aus Sicherheitsgründen nicht mit einem Peripheriegerät-

Anschluss verbinden, der zu starke Spannung für diese 
Buchse haben könnte. Folgen Sie den Anweisungen für 
diese Buchse.
ˎˎ Verwenden Sie beim Anschließen des LAN-Kabels des 

Geräts an ein Peripheriegerät ein abgeschirmtes Kabel, um 
Fehlfunktionen aufgrund von Störungen zu vermeiden.

Internet

Router

Computer

1	 Verbinden Sie den Netzwerkanschluss des 
Camcorders und den Router mit einem 
LAN-Kabel.

2	 Setzen Sie „Maintenance >Network >Setting“ 
auf „On“.

3	 Setzen Sie „Maintenance >Network >Wired 
LAN“ auf „Enable“.

Dem Camcorder wird automatisch eine 
IP-Adresse zugewiesen.

[Hinweise]
ˎˎ Bis zur Aktivierung der kabelbasierten LAN-Verbindung 

können 30 Sekunden bis 1 Minute vergehen. Warten Sie, 
bis das LAN-Symbol der Netzwerkstatusanzeigesymbol 
(Seite 18) auf dem LCD-Bildschirm oder im Sucher 
aufhört zu blinken.
ˎˎ Um auf dem Camcorder aufgezeichnete Originaldateien/

Proxydateien zu übertragen, die Wi-Fi-Fernbedienung 
oder das Webmenü zu verwenden oder die Ausgabe 
mit der Anwendung „Content Browser Mobile“ zu 
überwachen, setzen Sie „Maintenance >Network 
>Wired LAN Remote“ im Konfigurationsmenü auf „On“ 
(Seite 118).
ˎˎ Wenn Sie mit einem LAN-Kabel, das nicht für den 

Anschluss an das Internet verwendet wird, mit einem 
Netzwerk verbunden sind, wird empfohlen, die Option 
„Wired LAN Remote“ auf „On“ zu setzen, um einen 
unberechtigten Zugriff vom Internet aus zu verhindern. 
Wenn Sie eine Verbindung mit dem Internet herstellen, 
stellen Sie zuerst sicher, dass die Netzwerkverbindung 
gesichert ist.
ˎˎ Eine kabelbasierte LAN-Verbindung ist nicht möglich, 

wenn ein Modem (Option) mit dem Anschluss für das 
USB-WLAN-Modul verbunden ist. Zum Herstellen einer 
kabelbasierten LAN-Verbindung entfernen Sie zunächst 
das Modem (Option).
ˎˎ Wenn Sie im Wi-Fi-Stationsmodus mit dem Internet 

verbunden sind und das kabelbasierte LAN nicht mit dem 
Internet verbunden ist, kann ein Netzwerkfehler auftreten, 
sodass internetbasierte Funktionen unter Umständen 
nicht genutzt werden können. Setzen Sie in diesem 
Fall die Option „Wired LAN“ auf „Disable“ und stellen 
Sie die Verbindung zum Internet unter ausschließlicher 
Verwendung des Wi-Fi-Stationsmodus her.

Herstellen der Verbindung zum Internet
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Vorbereitung der Verbindung zum 
Internet unter Verwendung eines 
Modems.

Bringen Sie den im Lieferumfang des optionalen 
Netzwerkadaptersatzes CBK-NA1 enthaltenen 
USB-Erweiterungsadapter CBK-NA1E am Anschluss 
für das USB-WLAN-Modul am Camcorder an, wenn 
Sie die Verbindung zum Internet über ein 3G/4G-
Netzwerk unter Verwendung des Anschlusses für 
ein USB-WLAN-Modul herstellen möchten.

1	 Befestigen Sie die Halterung an der im 
folgenden Diagramm dargestellten Position 
am Griff.
Wenden Sie sich zum Anbringen der 
Halterung (Zubehörteilenummer A-2092-367-) 
an eine Sony- Kundendienstvertretung.

Halterung

2	 Befestigen Sie den USB-Erweiterungsadapter 
an der Halterung.

3	 Drehen Sie die Befestigungsschraube im 
Uhrzeigersinn, um den USB-
Erweiterungsadapter festzuschrauben.

Befestigungsschraube

USB-Erweiterungsadapter

Sie können die Position des USB-
Erweiterungsadapters in dem im folgenden 
Diagramm dargestellten Bereich ändern.

4	 Setzen Sie die mitgelieferte Schutzkappe auf 
den USB-Stecker des USB-
Erweiterungsadapters.

5	 Öffnen Sie die Abdeckung über dem 
Anschluss für das USB-WLAN-Modul.
Wenden Sie sich zum Anbringen der 
Schutzvorrichtung an eine Sony-
Kundendienstvertretung.

Schutzvorrichtung (mitgeliefert)

6	 Stecken Sie den USB-Stecker des USB-
Erweiterungsadapters in den Anschluss des 
USB-WLAN-Moduls.

Verbinden mithilfe eines Modems

Sie können den Camcorder über ein 3G/4G-
Netzwerk mit dem Internet verbinden, indem Sie 
ein optionales Modem mithilfe des optionalen 
Netzwerkadaptersatzes CBK-NA1 am Camcorder 
anbringen.

Internet

CBK-NA1
+
Modem

Anschluss

1	 Verbinden Sie das Modem (optional) mit dem 
USB-Anschluss des USB-Erweiterungsadapters 
CBK-NA1E.

Ausführliche Informationen zum Anschließen eines Modems 
finden Sie in der Bedienungsanleitung des Modems.

2	 Setzen Sie „Maintenance >Network >Setting“ 
auf „On“.

3	 Setzen Sie „Maintenance >Network >Modem“ 
auf „On“.
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[Hinweise]
ˎˎ Schalten Sie den Camcorder vor dem Anschließen oder 

Entfernen des CBK-NA1 und des Modems stets aus.
ˎˎ Bis zur Aktivierung des Modem-Modus können 30 

Sekunden bis 1 Minute vergehen. Warten Sie, bis die 
Netzwerkstatusanzeige „3G/4G“ (Seite 18) auf dem LCD-
Bildschirm oder im Sucher aufhört zu blinken.

Herstellen einer Verbindung im 
WLAN-Stationsmodus (Wi-Fi-
Stationsmodus)

Sie können im Wi-Fi-Stationsmodus eine 
Verbindung mit dem Internet herstellen, indem 
Sie das mitgelieferte USB-WLAN-Modul IFU-WLM3 
oder den optionalen WLAN-Adapter CBK-WA02 
am Camcorder anbringen und einen optionalen 
3G/4G/LTE-kompatiblen Access-Point oder Geräte-
Tethering verwenden.
Ausführliche Informationen zum Anbringen der 
Geräte finden Sie unter „Anbringen der IFU-WLM3“ 
(Seite 63) und „Anbringen des CBK-WA02“ 
(Seite 63).

Internet

Internet

Access 
Point

Smartphone/
Tablet-Computer

Smartphone/
Tablet-
Computer

Computer

Anschließen unter Verwendung eines 
Geräts

Wenn der Access Point und das Gerät WPS 
unterstützen, stellen Sie die Verbindung mithilfe 
des Verfahrens in „Herstellen einer Verbindung mit 
einem Access Point über WPS“ (Seite 65) her. 
Wenn WPS nicht unterstützt wird, stellen Sie die 

Verbindung mithilfe des Verfahrens in „Herstellen 
einer Verbindung mit einem Access Point im 
Stationsmodus ohne WPS“ (Seite 79) her.
Schalten Sie zunächst den Access Point und das 
Gerät ein und konfigurieren Sie die Tethering-
Funktion des Geräts, wenn Sie Tethering 
verwenden möchten.

Herstellen einer Verbindung mit 
einem Access Point unter 
Verwendung des 
Konfigurationsmenüs

Die können die Verbindung zu einem Access Point 
unter Verwendung des Konfigurationsmenüs 
herstellen.
Die Verbindung kann unter Verwendung der 
automatischen Netzwerkerkennung oder durch 
manuelle Eingabe hergestellt werden.

Herstellen der Verbindung unter Verwendung der 
automatischen Netzwerkerkennung

1	 Führen Sie die Schritte 1 bis 4 von „Herstellen 
einer Verbindung mit einem Access Point über 
WPS“ (Seite 65) aus.

2	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Network >Wi-Fi Station Detail 
Settings >Scan Networks“ und dann [Execute].
Der Camcorder startet die Erkennung von 
Anschlusszielen. Die erkannten Anschlussziele 
werden in der Ergebnisliste „Scan Networks“ 
angezeigt.

3	 Drehen Sie den Regler MENU, um ein 
Verbindungsziel auszuwählen, und drücken Sie 
dann den Regler.

Wenn die Verbindung hergestellt ist, wird der 
Bildschirm zur Kennworteingabe angezeigt.

4	 Legen Sie im Bildschirm zur Kennworteingabe 
das Kennworts fest.
Wenn im Geräteverlauf Informationen über ein 
zuvor verbundenes Ziel gespeichert sind, wird 
bei Auswahl der SSID für dieses Ziel das 
Kennworteingabefeld für diese SSID angezeigt.

5	 Konfigurieren Sie im Bildschirm „Wi-Fi Station 
Detail Settings“ die folgenden Einstellungen.

Menüpunkt Menüpunkt Beschreibung
DHCP Aktiviert/deaktiviert DHCP.

Wenn diese Option auf On 
gesetzt ist, wird dem 
Camcorder automatisch eine 
IP-Adresse zugewiesen.
Um die IP-Adresse des 
Camcorders manuell 
einzugeben, setzen Sie diese 
Option auf Off.

IP Address Geben Sie die IP-Adresse des 
Camcorders ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

Subnet mask Geben Sie die Subnetzmaske 
des Camcorders ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

Gateway Geben Sie das Gateway für 
den Access Point ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

DNS Auto DNS-Adresse wird 
automatisch abgerufen.
Wenn diese Option auf „On“ 
gesetzt ist, wird die Adresse 
des DNS-Servers automatisch 
ermittelt.
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Menüpunkt Menüpunkt Beschreibung
Primary DNS 
Server

Geben Sie den primären 
DNS-Server für den Access 
Point ein.
Nur aktiviert, wenn „DNS 
Auto“ auf [Off] gesetzt ist.

Secondary DNS 
Server

Geben Sie den sekundären 
DNS-Server für den Access 
Point ein.
Nur aktiviert, wenn „DNS 
Auto“ auf [Off] gesetzt ist.

6	 Wählen Sie zum Abschluss „Set >Execute“, um 
die Einstellungen anzuwenden.

	 [Hinweise]
ˎˎ Wenn die Verbindungseinstellungen geändert 

werden, wählen Sie stets „Set >Execute“. Wenn die 
Option „Execute“ nicht ausgewählt wird, werden die 
konfigurierten Einstellungen nicht angewendet.
ˎˎ Bis zur Aktivierung des Stationsmodus können 

30 Sekunden bis 1 Minute vergehen. Warten Sie, bis 
das Symbol für die Anzeige der Netzwerksignalstärke 
(Seite 18) auf dem LCD-Monitor oder im Sucher 
aufhört zu blinken.
ˎˎ Die Einrichtungsinformationen der 

Verbindungsstation werden im Verlauf gespeichert. 
Der Verlauf kann mithilfe von ALL Reset und Network 
Reset gelöscht werden.

Herstellen der Verbindung durch manuelle 
Eingabe

1	 Führen Sie die Schritte 1 bis 4 von „Herstellen 
einer Verbindung mit einem Access Point über 
WPS“ (Seite 65) aus.

2	 Konfigurieren Sie im Konfigurationsmenü mit 
„Maintenance >Network >Wi-Fi Station Detail 
Settings“ die folgenden 
Verbindungseinstellungen.

Menüpunkt Menüpunkt Beschreibung
SSID Geben Sie die SSID für das 

Verbindungsziel ein.

Menüpunkt Menüpunkt Beschreibung
Password Geben Sie das Kennwort für 

das Verbindungsziel ein.
DHCP Aktiviert/deaktiviert DHCP.

Wenn diese Option auf On 
gesetzt ist, wird dem 
Camcorder automatisch eine 
IP-Adresse zugewiesen.
Um die IP-Adresse des 
Camcorders manuell 
einzugeben, setzen Sie diese 
Option auf Off.

IP Address Geben Sie die IP-Adresse des 
Camcorders ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

Subnet mask Geben Sie die Subnetzmaske 
des Camcorders ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

Gateway Geben Sie das Gateway für 
den Access Point ein.
Nur aktiviert, wenn DHCP auf 
[Off] gesetzt ist.

DNS Auto DNS-Adresse wird 
automatisch abgerufen.
Wenn diese Option auf „On“ 
gesetzt ist, wird die Adresse 
des DNS-Servers automatisch 
ermittelt.

Primary DNS 
Server

Geben Sie den primären 
DNS-Server für den Access 
Point ein.
Nur aktiviert, wenn „DNS 
Auto“ auf [Off] gesetzt ist.

Secondary DNS 
Server

Geben Sie den sekundären 
DNS-Server für den Access 
Point ein.
Nur aktiviert, wenn „DNS 
Auto“ auf [Off] gesetzt ist.

3	 Wählen Sie zum Abschluss „Set >Execute“, um 
die Einstellungen anzuwenden.

[Hinweise]
ˎˎ Wenn die Verbindungseinstellungen geändert 

werden, wählen Sie stets „Set >Execute“. Wenn die 
Option „Execute“ nicht ausgewählt wird, werden die 
konfigurierten Einstellungen nicht angewendet.
ˎˎ Bis zur Aktivierung des Stationsmodus können 

30 Sekunden bis 1 Minute vergehen. Warten Sie, bis 
das Symbol für die Anzeige der Netzwerksignalstärke 
(Seite 18) auf dem LCD-Monitor oder im Sucher aufhört 
zu blinken.
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Sie können auf einer SD-Karte aufgezeichnete 
Proxy-Dateien und auf SxS-Speicherkarten 
aufgezeichnete Originaldateien auf einen Server 
im Internet übertragen, falls Sie über ein 3G/4G/
LTE-Netzwerk, einen Access-Point oder einen 
kabelbasierten LAN-Router mit dem Internet 
verbunden sind.

Vorbereitung für die Übertragung

1	 Verbinden Sie den Camcorder mithilfe des 
Verfahrens in „Anschluss von Geräten über 
WLAN“ (Seite 63) und „Herstellen der 
Verbindung zum Internet“ (Seite 67) mit 
dem Internet.

2	 Sie müssen zuerst einen Server registrieren, an 
den die Dateien übertragen werden sollen.
Einzelheiten zum Registrieren eines Servers 
finden Sie unter „Registrieren eines neuen 
Zielservers“ (Seite 80).

Übertragen von Dateien

Sie können die Proxy-Dateien auf einer SD-Karte 
oder die Originaldateien auf SxS-Karten zur 
Übertragung auf einen Server auswählen.

Übertragen von Proxy-Dateien auf einer SD-Karte

1	 Verbinden Sie den Camcorder und das Gerät 
über eine LAN-Verbindung und öffnen Sie auf 
dem Gerät einen Browser, um auf den 
Camcorder zuzugreifen.

2	 Zeigen Sie einen Bildschirm mit einer Dateiliste 
zum Auswählen der Dateien an.

3	 Tippen Sie auf  und wählen Sie [Media Info] 
und tippen Sie dann auf [SD Card].
Der Bildschirm SD Card wird angezeigt.

Mit der Anwendung „Content Browser Mobile“, 
Version 2.0 oder höher, können Sie schnell ein 
Skizzenbild für eine Proxydatei auf einer 
SD-Karte anzeigen, indem Sie das Standbild 
des ersten Einzelbilds verwenden.

4	 Wählen Sie die Dateien aus, die Sie übertragen 
möchten.
Tippen Sie zum Auswählen auf eine Datei. 
Tippen Sie ein zweites Mal auf eine Datei, um 
die Auswahl aufzuheben. Sie können doppelt 
auf eine Datei tippen, um diese 
wiederzugeben und ihren Inhalt zu 
überprüfen.

5	 Tippen Sie auf [Transfer].
Der in [Default Setting] angegebene Standard-
Zielserver wird angezeigt (siehe „Registrieren 
eines neuen Zielservers“ (Seite 80)).
Wenn Sie den Zielserver ändern möchten, 
tippen Sie auf den Zielserver, um eine Liste 
anzuzeigen, und wählen dann einen anderen 
Server aus. Geben Sie bei Bedarf auf dem 
Zielserver das Verzeichnis ein.

6	 Tippen Sie auf [Transfer].
Die Übertragung der ausgewählten Dateien 
beginnt. Um die Dateiübertragung 
abzubrechen, tippen Sie auf [Cancel].

Automatisches Übertragen bei Aufnahmeende

Wenn „Maintenance >File Transfer >Auto Upload 
(Proxy)“ im Konfigurationsmenü zuerst auf „On“ 
eingestellt wird, wird die Datei automatisch auf 
den angegebenen Server hochgeladen, wenn die 
Proxy-Aufzeichnung abgeschlossen ist.
Wenn eine zur Originaldatei gleich lange Proxy-
Datei auf Grundlage von Planungsmetadaten 
aufgenommen wird und die Daten von 
dieser übernimmt, so wird ein Ordner am 
Übertragungsziel erstellt. Der Ordnername 
wird durch den Inhalt des <Title>-Tags der 
Planungsmetadaten-Datei bestimmt. Die Proxy-
Datei wird in diesen Ordner übertragen.
Bei der Übertragung wird die ID des 
Aufnahmemediums automatisch an den Namen 
der Planungsmetadaten-Datei angehängt.

Übertragen von Teilen von Proxydateien

Mit der Anwendung „Content Browser Mobile“, 
Version 2.0 oder höher, können Sie in Proxydateien 
In-/Out-Punkte für Ausschnitte festlegen und die 
ausgeschnittenen Teile übertragen.
Sie können auch die ausgeschnittenen Teile 
mehrerer Dateien unter Verwendung des 
Storyboards übertragen.

[Hinweise]
ˎˎ In der erstellten Datei werden Ränder von bis zu 15 

Einzelbildern vor und nach dem Ausschnittsbereich 
hinzugefügt.
ˎˎ Dateien, die mit Ausschnitten aus Proxydateien erstellt 

wurden, die mit Netzwerkfunktionssoftware (V. 1.25 oder 
früher) aufgezeichnet wurden, werden möglicherweise 
nicht in nicht-lineare Editoren importiert.
ˎˎ Wenn Teile von Dateien mit dem Storyboard übertragen 

werden, wird in der Auftragsliste (Job List) die Datei 
angezeigt, mit der Storyboard-Informationen an ein 
nichtlineares Bearbeitungssystem gesendet werden.
ˎˎ Bei der Übertragung wird auf der SD-Karte automatisch 

der Ordner „General/Sony/tmp“ erstellt. Die Datei wird 
in diesem Ordner zwischengespeichert und nach dem 
Abschluss der Übertragung automatisch gelöscht.

Übertragen von Originaldateien auf SxS-
Speicherkarten

1	 Verbinden Sie den Camcorder und das Gerät 
über eine LAN-Verbindung und öffnen Sie auf 
dem Gerät einen Browser, um die Verbindung 
zum Camcorder herzustellen „Anschluss von 
Geräten über WLAN“ (Seite 63).

2	 Wählen Sie im Konfigurationsmenü 
„Maintenance >File Transfer >File Transfer“.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Dateiübertragungsmodus wird initiiert.

4	 Zeigen Sie einen Bildschirm mit einer Dateiliste 
zum Auswählen der Dateien im Browser auf 
dem Gerät an.

5	 Tippen Sie auf  und wählen Sie [Media Info], 
tippen Sie dann auf „Slot A“ (für Dateien auf 
Medien im Einschub A) oder auf „Slot B“ (für 
Dateien auf Medien in Einschub B).
Der Bildschirm mit Einschub A oder Einschub B 
wird angezeigt.
Beispiel: Bildschirm Einschub A

6	 Wählen Sie die Dateien aus, die Sie übertragen 
möchten.

Übertragen von Dateien
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Tippen Sie zum Auswählen auf eine Datei. 
Tippen Sie ein zweites Mal auf eine Datei, um 
die Auswahl aufzuheben.

7	 Tippen Sie auf [Transfer].
Der in [Default Setting] angegebene Standard-
Zielserver wird angezeigt (siehe „Registrieren 
eines neuen Zielservers“ (Seite 80)).
Wenn Sie den Zielserver ändern möchten, 
tippen Sie auf den Zielserver, um eine Liste 
anzuzeigen, und wählen dann einen anderen 
Server aus.
Geben Sie in [Directory] das Verzeichnis auf 
dem Zielserver ein.

8	 Tippen Sie auf [Transfer].
Die Übertragung der ausgewählten Dateien 
beginnt. Um die Dateiübertragung 
abzubrechen, tippen Sie auf [Cancel].
Wenn die Übertragung aller Dateien 
abgeschlossen ist, wird der 
Übertragungsmodus automatisch beendet 
und der Kamera-Aufzeichnungsbildschirm 
wird wieder angezeigt.

Wenn „Maintenance >File Transfer >Remote 
File Transfer“ im Konfigurationsmenü 
zuerst auf „Enable“ gesetzt wird, wird der 
Dateiübertragungsmodus automatisch initiiert, 
ohne Schritte 2 und 3 durchzuführen.

[Hinweis]
Unter den folgenden Bedingungen können keine Dateien 
übertragen werden.
ˎˎ Während der Aufnahme, Wiedergabe, oder beim 

Anzeigen der Skizzenbilderanzeige
ˎˎ Wenn „Maintenance >Network >Wi-Fi Mode > 

Wi-Fi Access Point“ und „Wired LAN >Disable“ im 
Konfigurationsmenü werden auf „Disable“ gesetzt sind
ˎˎ Wenn die Streaming-Funktion aktiviert ist („Maintenance 

>Streaming >Setting“ ist auf „On“ eingestellt)

Übertragen von Teilen von Originaldateien

Mit der Anwendung „Content Browser Mobile“, 
Version 2.0 oder höher, können Sie in den vom 
Camcorder aufgezeichneten Originaldateien In-/
Out-Punkte für Ausschnitte festlegen und die 
ausgeschnittenen Teile übertragen.
Sie können auch die ausgeschnittenen Teile 
mehrerer Dateien unter Verwendung des 
Storyboards übertragen.
Die folgenden Formate von Originaldateien 
werden unterstützt.
ˎˎ XAVC-I
ˎˎ XAVC-L
ˎˎ HD422 (exFAT/UDF)
ˎˎ HD420HQ (exFAT/UDF)

[Hinweis]
Um einen Teil einer Originaldatei mit „Content Browser 
Mobile“ zu übertragen, wird eine Proxydatei benötigt, die 
den gleichen Namen wie die Originaldatei hat.
Aktivieren Sie vor Beginn der Aufzeichnung die Erstellung 
von Proxydateien.
Die relevanten Einstellungen werden im Folgenden 
angegeben.
ˎˎ Setzen Sie „Operation >Proxy Recording Mode >Setting“ 

im Konfigurationsmenü auf „Off“.
ˎˎ Wenn der Netzwerkclientmodus aktiviert ist, setzen 

Sie die Option „Maintenance >Network Client Mode 
>Preset 1, Preset 2 oder Preset 3 >NCM with Proxy“ im 
Konfigurationsmenü auf „Enable“.

Überwachen der Dateiübertragung

Tippen Sie im Bildschirm der SD Card, Slot A oder 
B auf [Job List], um den Bildschirm Job List zum 
Überprüfen des Status der Dateiübertragung 
anzuzeigen (Seite 81).
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Sie können die mit dem Camcorder 
aufgenommenen/wiedergegebenen Video- und 
Audiodaten über das Internet oder ein lokales 
Netzwerk übertragen.

Vorbereitung für die Streaming-
Übertragung

1	 Verbinden Sie den Camcorder mithilfe des 
Verfahrens in „Anschluss von Geräten über 
WLAN“ (Seite 63) und „Herstellen der 
Verbindung zum Internet“ (Seite 67) mit 
dem Internet.

2	 Wählen Sie im Konfigurationsmenü unter 
„Maintenance >Streaming“ die Option 
„Preset1“ (oder „Preset2“, „Preset3“) aus.
Der Bildschirm zum Einrichten des Ziels der 
Streaming-Verbindung wird eingeblendet.

3	 Legen Sie „Size, Bit Rate, Type“ und andere 
Optionen entsprechend dem Type auf dem 
Bildschirm fest.
Weitere Informationen hierzu und zu den 
Einschränkungen der Einstellungen finden Sie 
im Abschnitt „Streaming-Einstellungen“ 
(Seite 78).

4	 Wählen Sie im Konfigurationsmenü unter 
„Maintenance >Streaming >Preset Select“ die 
Option „Preset1“ (oder „Preset2“, „Preset3“) 
gemäß der Einstellung in den Schritten 1 und 2 
aus.

Starten des Streaming-Vorgangs

1	 Setzen Sie „Maintenance >Streaming >Setting“ 
im Konfigurationsmenü auf „On“.
Der Streaming-Vorgang wird gemäß den 
Einstellungen gestartet.
Sie können einem belegbaren Schalter die 
Funktion „Streaming“ zuweisen. Einzelheiten 
zur Zuweisung siehe „Zuweisung der 
Funktionen belegbarer Schalter“ (Seite 124).

[Hinweise]
ˎˎ Unter den folgenden Menüeinstellungen kann der 

Streaming-Vorgang nicht gestartet werden.
–– Wenn „Maintenance >Network >Setting“ im 

Konfigurationsmenü auf „Off“ eingestellt ist
–– Wenn „Maintenance >Network Client Mode >Setting“ 

im Konfigurationsmenü auf „On“ eingestellt ist
–– Wenn „Maintenance >Network >Setting“ im 

Konfigurationsmenü auf „On“, jedoch „Maintenance 
>Network >Wi-Fi Mode“ auf „Off“ und „Maintenance 
>Network >Wired LAN“ auf „Disable“ gesetzt ist 

ˎˎ Nach dem Starten des Streaming-Vorgangs kann es 
einige zig Sekunden dauern, bis Video- oder Audiodaten 
übertragen werden.
ˎˎ Sie können einen Streaming-Vorgang nicht starten, 

während Sie einen Clip im SD-Format wiedergeben.
ˎˎ Wenn Sie das Streaming-Übertragungsziel falsch festlegen 

oder der Camcorder nicht mit dem Netzwerk verbunden 
wird, wird „×“ auf dem Bildschirm als Streaming-
Statusanzeige eingeblendet.
ˎˎ Streaming im Netzwerkclientmodus (Seite 74), 

Überwachen, Proxy-Aufzeichnung und Dateiübertragung 
sind nach dem Wechseln in den Streaming-Modus nicht 
mehr verfügbar.
ˎˎ Wenn Sie beim Überwachen, während einer Proxy-

Aufzeichnung oder beim Übertragen von Dateien einen 
Streaming-Vorgang starten, wird die entsprechende 
Funktion deaktiviert.

Beenden eines Streaming-Vorgangs

Setzen Sie „Maintenance >Streaming >Setting“ auf 
„Off“, um den Streaming-Vorgang zu stoppen.
Wenn die Streaming-Funktion aktiviert ist, kann 
ein Streaming-Vorgang auch durch Drücken des 

belegbaren Schalters, dem die Streaming-Funktion 
zugewiesen wurde, beendet werden.

Wenn der Camcorder über ein WLAN mit einem 
Gerät verbunden ist (Seite 63) oder im WLAN-
Stationsmodus mit dem Internet verbunden ist 
(Seite 65), können Sie auch über das Webmenü 
das Streaming-Übertragungsziel festlegen und 
den Streaming-Vorgang starten bzw. beenden 
(Seite 77).

Übertragen von Streaming-Video- und Audiodaten
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Streaming mit hoher Qualität unter Verwendung 
von QoS-Technologie von Sony wird unterstützt, 
indem der Netzwerkclientmodus aktiviert und 
eine Verbindung zu einer Sony Network RX 
Station (optional) als Connection Control Manager 
(CCM) oder zu XDCAM air hergestellt wird. Durch 
Verwendung von mehreren Netzwerken kann 
stabiles Streaming von höherer Qualität erzielt 
werden.

[Hinweise]
ˎˎ Verwenden Sie für jedes Netzwerk eine eigene 

Dienstanbieterleitung, um stabil mithilfe von mehreren 
Netzwerken zu streamen.
ˎˎ Bei Verwendung von mehreren Netzwerken kann die 

Zielbitrate je nach aufgenommener Szene überschritten 
werden.
ˎˎ XDCAM air ist ein Cloud-Dienst, der von Sony 

bereitgestellt wird. 
Wenn Sie diesen Dienst nutzen wollen, ist eine 
Registrierung erforderlich. 
XDCAM air wird in einigen Regionen nicht bereitgestellt. 
Ausführliche Informationen zu den Gebieten, in denen der 
Dienst bereitgestellt wird, finden Sie auf der folgenden 
Website. 
https://www.xdcam-air.com 
Einzelheiten zu der XDCAM air-Datenschutzrichtlinie 
finden Sie auf den folgenden Seiten.

–– Geschäftsbedingungen 
https://www.xdcam-air.com/site/tos_eu.html

–– XDCAM air-Datenschutzrichtlinie 
https://sony-imaging-products-solutions.co.jp/pp/sips/
en/index.html

–– Professional ID-Datenschutzrichtlinie 
https://www.pro-id.sony.net/#/privacyPolicy

ˎˎ Für weitere Informationen wenden Sie sich an 
Vertriebsmitarbeiter von Sony Professional.

1	 Verbinden Sie den Camcorder mit dem 
Netzwerk.
Ausführliche Informationen finden Sie unter 
„Anschluss von Geräten über WLAN“ 
(Seite 63) und „Herstellen der Verbindung 
zum Internet“ (Seite 67).

2	 Konfigurieren Sie im Konfigurationsmenü mit 
„Maintenance >Network Client Mode >Preset 
1, Preset 2 oder Preset 3“ die 
Netzwerkeinstellungen des Verbindungsziels.
Sie können die Netzwerkeinstellungen eines 

Verbindungsziels als Voreinstellung unter 
Preset 1, Preset 2 oder Preset 3 speichern.

Menüpunkt Beschreibung
CCM Address Geben Sie die IP-Adresse des 

zu verbindenden CCM ein. 
(Hostname oder IP-Adresse)

CCM Port Geben Sie die Portnummer 
des zu verbindenden CCM 
ein.

User Name Geben Sie den 
Benutzernamen ein.

Password Geben Sie das Kennwort ein.
NCM with Proxy Aktiviert/deaktiviert bei einer 

Verbindung mit einem CCM 
die Proxy-Aufzeichnung.

Camera Control Aktivieren/Deaktivieren der 
Kamerasteuerung, wenn ein 
CCM angeschlossen ist.

Camera Setting Aktivieren/Deaktivieren der 
Verarbeitung von ALL-
Dateien, wenn ein CCM 
angeschlossen ist.

[Hinweise]
ˎˎ Der Netzwerkclientmodus kann nur aktiviert werden, 

wenn für alle Elemente Werte eingegeben werden.
ˎˎ Wenn Sie „Maintenance >Network Client Mode 

>Preset 1, Preset 2 oder Preset 3 >NCM with Proxy“ 
im Konfigurationsmenü auf „Enable“ setzen, ist 
die Proxy-Aufzeichnung auch bei aktiviertem 
Netzwerkclientmodus aktiviert. Um die Einstellung 
„NCM with Proxy“ zu aktivieren, stellen Sie 
„Operation >Proxy Recording Mode >Setting“ im 
Konfigurationsmenü auf „On“.
ˎˎ Wenn „Maintenance >Network Client Mode >Preset 

1, Preset 2 oder Preset 3 >NCM with Proxy“ im 
Konfigurationsmenü auf „Disable“ gesetzt ist, wird 
die Proxy-Aufzeichnung angehalten, wenn der 
Netzwerkclientmodus während der Aufzeichnung 
auf „On“ gesetzt wird.  
Wenn die Aufzeichnung der Originaldatei fortgesetzt 
wird, setzen Sie beide Optionen auf „Off“, um die 
Proxy-Aufzeichnung neu zu starten.
ˎˎ Wenn „Operation >Proxy Recording Mode >Proxy 

File >Size“ im Konfigurationsmenü auf „HD 
Auto(9Mbps)“ oder „HD Auto(6Mbps)“ gesetzt ist, 
kann „NCM with Proxy“ nicht aktiviert werden.  
Wenn „HD Auto(9Mbps)“ oder „HD Auto(6Mbps)“ 
eingestellt wird, nachdem „NCM with Proxy“ auf 

„Enable“ eingestellt wird, bleibt die Einstellung 
erhalten, die Proxy-Aufzeichnung wird jedoch nicht 
ausgeführt.

3	 Wählen Sie im Konfigurationsmenü mit 
„Maintenance >Network Client Mode >Preset 
Select“ eine der in Schritt 1 eingestellte 
Voreinstellung aus.

4	 Setzen Sie „Maintenance >Network Client 
Mode >Setting“ im Konfigurationsmenü auf 
„On“.
Der Netzwerkclientmodus wird aktiviert, und 
der Camcorder stellt eine Verbindung zur 
Network RX Station oder zu XDCAM air her.
Der Live-Streaming-Vorgang wird als Reaktion 
auf die Bedienung der Netzwerk-RX-Station 
gestartet. Eine ALL-Datei kann auch per 
Fernbedienung des Geräts mithilfe der 
Network RX Station gespeichert/geladen 
werden.
Einzelheiten zum Betrieb entnehmen Sie der 
Gebrauchsanweisung für die Network RX 
Station oder der Hilfe zu XDCAM air.
Sie können „Setting (On/Off)“ für „Network 
Client Mode“ einem belegbaren Schalter 
zuweisen. Einzelheiten zur Zuweisung siehe 
„Zuweisung der Funktionen belegbarer 
Schalter“ (Seite 124).

[Hinweise]
ˎˎ Der Netzwerkclientmodus kann während des normalen 

Streamings (Seite 73) nicht geändert werden.
ˎˎ Nach dem Aktivieren des Netzwerkclientmodus sind das 

normale Streaming (Seite 73) und die Überwachung 
nicht verfügbar.
ˎˎ Wenn Sie beim Überwachen in den Netzwerkclientmodus 

wechseln, wird die Überwachung deaktiviert.
ˎˎ Während des Streamings im Netzwerkclientmodus 

wird die Dateiübertragung nicht unterstützt. Nach der 
Beendigung des Streamings wird die Dateiübertragung 
unterstützt.
ˎˎ Wenn das Streaming im Netzwerkclientmodus während 

einer Dateiübertragung gestartet wird, wird die 
Dateiübertragung angehalten. Nach der Beendigung des 
Streamings wird die Dateiübertragung neu gestartet.
ˎˎ Die möglichen Streaming-Bitraten, die über die Netzwerk-

RX-Station eingestellt werden können, sind abhängig 

vom Proxy-Aufnahmeformat auf folgende Einstellungen 
beschränkt.

–– Falls das Proxy-Aufnahmeformat 1280×720  
9 Mbit/s/6 Mbit/s beträgt, wird die Streaming-Bitrate 
auf 1 Mbit/s oder weniger festgelegt.

–– Falls das Proxy-Aufnahmeformat 640×360 3 Mbit/s 
beträgt, wird die Streaming-Bitrate auf 3 Mbit/s oder 
weniger festgelegt.

ˎˎ Das Proxy-Format kann im Netzwerkclientmodus nicht 
geändert werden. Um das Format zu ändern, setzen Sie 
zunächst die Option „Network Client Mode“ auf „Off“.

Übertragen von Dateien im Netzwerkclientmodus

Sie können Dateien auf einen vom CCM 
festgelegten Server übertragen, indem Sie eine als 
CCM verwendete Netzwerk-RX-Station und den 
Camcorder im Netzwerkclientmodus anschließen. 

1	 Wählen Sie die Dateien aus, die Sie übertragen 
möchten.
ˎˎ Zum Übertragen einer Proxy-Aufnahme: 
Führen Sie die Schritte 1 bis 4 der Anleitung 
„Übertragen von Proxy-Dateien auf einer 
SD-Karte“ (Seite 71) aus.
ˎˎ Zum Übertragen von Originaldateien: 
Führen Sie die Schritte 1 bis 6 der Anleitung 
„Übertragen von Originaldateien auf SxS-
Speicherkarten“ (Seite 71) aus.

2	 Tippen Sie auf [Transfer].
„NCM: RX Server“ wird als Ziel angezeigt.
Geben Sie „NCM: RX Server“ als Ziel an.

3	 Tippen Sie auf [Transfer].
Die Übertragung der ausgewählten Dateien 
auf den im CCM angegebenen Server wird 
gestartet.

[Hinweis]
Als Ziel kann auch „NCM: RX Server“ eingestellt werden, 
wenn sich der Camcorder nicht im Netzwerkclientmodus 
befindet.
In diesem Fall wird die Dateiübertragung angehalten. 
Die Übertragung auf den im CCM angegebenen Server 
beginnt nach dem Herstellen der Verbindung zum CCM im 
Netzwerkclientmodus.

Streaming von Video in hoher Qualität
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Sie können von einem Smartphone, Tablet-
Computer oder einem anderen Gerät über eine 
WLAN-Verbindung auf die in den Camcorder 
integrierte Wi-Fi-Fernbedienung zugreifen.
Mit der Wi-Fi-Fernbedienung können Sie den 
Camcorder von fern bedienen. Auf diese Weise 
können Sie von fern Aufnahmen starten oder 
stoppen oder Einstellungen konfigurieren. Dies 
ist nützlich bei Anwendungen, bei denen der 
Camcorder fest an einem entfernten Standort oder 
zum Beispiel auf einem Kran angebracht ist.

Anzeigen der Wi-Fi-Fernbedienung

Der Bildschirm Wi-Fi Remote wird automatisch an 
die Bildschirmgröße des angeschlossenen Geräts 
angepasst.

1	 Verbinden Sie den Camcorder mithilfe des 
Verfahrens in „Anschluss von Geräten über 
WLAN“ (Seite 63) und „Herstellen der 
Verbindung zum Internet“ (Seite 67) mit 
dem Internet.

2	 Öffnen Sie auf dem Gerät einen Webbrowser 
und geben Sie in die Adressleiste die Adresse 
„http://<IP_address>/rm.html“ ein, wobei 
„<IP_address>“ die IP-Adresse des Camcorders 
ist („Maintenance >Network >IP Address 
(Wireless)“ im Konfigurationsmenü).
Ist die IP-Adresse dieses Geräts beispielsweise 
„192.168.1.1“, geben Sie in die URL-Adressleiste 
„http://192.168.1.1/rm.html“ ein.

3	 Geben Sie auf dem Browser-Bildschirm den 
Benutzernamen und das Kennwort ein 
(„Maintenance >Basic Authentication“) 
(Seite 117) im Konfigurationsmenü.
Wenn die Verbindung erfolgreich hergestellt 
wurde, wird auf dem Gerät der Bildschirm 
Wi-Fi Remote angezeigt.

Sie verwenden den Bildschirm der Wi-Fi-
Fernbedienung, um den Camcorder zu 
bedienen.
Sie können die Funktion der Taste REC 
deaktivieren, indem Sie den Regler Lock nach 
rechts schieben.
Sie können die Wi-Fi-Fernbedienung auch mit 
der Option [Cam Remote Control] (Seite 77) 
des Webmenüs anzeigen.

[Hinweise]
ˎˎ Um die Seite für ein Smartphone anzuzeigen, ändern Sie 

die Zeichenfolge „rm.html“ in der URL zu „rms.html“. Um 
die Seite für einen Tablet-Computer anzuzeigen, ändern 
Sie die Zeichenfolge „rm.html“ in der URL zu „rmt.html“. 
Wenn „rm.html“ eingegeben wird, schaltet die Seite 
automatisch zur Anzeige für das entsprechende Gerät 
um. Je nach dem verwendeten Gerät wird jedoch unter 
Umständen nicht die entsprechende Seite angezeigt.
ˎˎ Der Bildschirm Wi-Fi Remote entspricht unter den 

folgenden Umständen möglicherweise nicht den 
Camcorder-Einstellungen. Laden Sie in diesem Fall das 
Browserfenster neu.

–– Der Camcorder wurde während der Verbindung neu 
gestartet.

–– Der Camcorder wurde während der Verbindung direkt 
bedient.

–– Das Gerät wurde erneut angeschlossen.
–– Die Tasten Forward/Back des Browsers wurden 

verwendet.
ˎˎ Die Wi-Fi-Fernbedienung funktioniert unter Umständen 

nicht, wenn sich die WLAN-Signalstärke verschlechtert.

Bildschirm der Wi-Fi-Fernbedienung 
(Smartphone)

Main-Bildschirm

ˎˎ Statusanzeige
ˎˎ Aufnahmeeinstellungen 

Iris, Focus, Zoom, S&Q FPS, 
Shutter, White, Gamma, Auto 
Iris, Gain, ATW, Color Bars, Auto 
Black, Auto White

Playback-Bildschirm

ˎˎ Statusanzeige
ˎˎ Schaltflächen zur Steuerung 

der Wiedergabe 
Schnellrücklauf, Wiedergabe/
Pause, Schnellvorlauf, Zurück, 
Stopp, Nächste

Cursor-Bildschirm

ˎˎ Statusanzeigen
ˎˎ Navigationstasten, Menü/

Statusanzeige 
Nach oben, Nach links, Set, 
Nach rechts, Nach unten, 
Cancel/Back, Menü, Status, 
Thumbnail, Option (SHIFT + 
SET)

Assign-Bildschirm

ˎˎ Statusanzeige
ˎˎ Belegbare Schalter 

Belegbarer Schalter 0, 1, 3, 4, 5

Verwenden der Wi-Fi-Fernbedienung
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Bildschirm der Wi-Fi-Fernbedienung 
(Tablet-Computer)

Main-Bildschirm

ˎˎ Statusanzeige
ˎˎ Belegbare Schalter 

Belegbarer Schalter 0, 1, 3, 4, 5
ˎˎ Aufnahmeeinstellungen 

S&Q FPS, Shutter, White, Gamma, Auto Iris, Gain, ATW, 
Color Bars, Auto Black, Auto White

Playback-Bildschirm

ˎˎ Statusanzeige
ˎˎ Schaltflächen zur Steuerung der Wiedergabe 

Schnellrücklauf, Wiedergabe/Pause, Schnellvorlauf, 
Zurück, Stopp, Nächste

Cursor-Bildschirm

ˎˎ Statusanzeige
ˎˎ Navigationstasten, Menü/Statusanzeige 

Nach oben, Nach links, Set, Nach rechts, Nach unten, 
Cancel/Back, Menü, Status, Thumbnail, Option (SHIFT + 
SET)

Assign-Bildschirm

ˎˎ Belegbare Schalter 
Belegbarer Schalter 0, 1, 3, 4, 5



000 5. Netzwerkkonfiguration77

Das Webmenü des Camcorders wird angezeigt, 
wenn mit einem Browser auf einem über eine 
WLAN-Verbindung verbundenen Gerät auf den 
Camcorder zugegriffen wird. Mit dem Webmenü 
können Sie Einstellungen für drahtlose Funktionen 
konfigurieren, Dateien übertragen und andere 
Aktionen ausführen.

Anzeigen des Webmenüs

1	 Verbinden Sie den Camcorder mithilfe des 
Verfahrens in „Anschluss von Geräten über 
WLAN“ (Seite 63) und „Herstellen der 
Verbindung zum Internet“ (Seite 67) mit 
dem Internet.

2	 Öffnen Sie auf dem Gerät einen Webbrowser 
und geben Sie in das Adressfeld die Adresse 
„http://192.168.1.1:8080/index.html“ ein.
Der Bildschirm zur Eingabe des 
Benutzernamens („User name“) und des 
Kennworts („Password“) wird angezeigt.

3	 Geben Sie einen Benutzernamen und ein 
Kennwort ein und wählen Sie [OK].
Zum Einstellen des Benutzernamens und des 
Kennworts für die Authentifizierung 
verwenden Sie „Maintenance >Basic 
Authentication“ (Seite 117) im 
Konfigurationsmenü.

Konfigurationsmenü

Öffnen Sie auf dem Gerät einen Webbrowser 
und geben Sie in die Adressleiste die Adresse 
„http://<IP_address>:8080“ ein, wobei „<IP_
address>“ die IP-Adresse des Camcorders 
ist („Maintenance >Network >IP Address im 

Konfigurationsmenü“), um den Bildschirm „Media 
Info >SD Card“ des Camcorders anzuzeigen
Wenn Sie oben links im Webmenü auf  tippen, 
werden die Konfigurationsmenüs angezeigt. 
Tippen Sie auf den Menüpunkt, den Sie 
konfigurieren möchten.
Das Menü enthält die folgenden Menüpunkte: 
Settings, Media Info, Job List und Cam Remote 
Control (Einstellungen, Medieninformationen, 
Auftragsliste, Kamerafernbedienung).

Einstellungen

Zum Konfigurieren des Camcorders. Dieser 
Bildschirm enthält die folgenden Menüpunkte.

Menüpunkt Beschreibung Siehe
Wireless 
Module 
>Streaming 
Format

Einstellungen 
für das 
Streaming-
Format

Einstellungen für das 
Streaming-Format 
(Seite 77)

Wireless 
Module 
>Proxy 
Format

Proxyforma-
teinstellungen

Proxyformateinstellungen 
(Seite 78)

Wireless LAN 
>Station 
Settings

WLAN-
Einstellungen

WLAN-
Stationseinstellungen 
(Seite 78)

Wireless LAN 
>Status

Status der 
WLAN-
Einstellungen

Überprüfen der 
WLAN-Einstellungen 
(Seite 79)

Wired LAN 
>Wired LAN 
Settings

Einstellungen 
für 
kabelbasiertes 
LAN

Einstellungen für 
kabelbasiertes LAN 
(Seite 79)

Wired LAN 
>Status

Status der 
Einstellungen 
für 
kabelbasiertes 
LAN

Überprüfen der 
Einstellungen für 
kabelbasiertes LAN 
(Seite 80)

Upload-
Einstellungen

Übertragungs-
einstellungen

Übertragungseinstellungen 
(Upload) (Seite 80)

Media Info

Zeigt Medieninformationen an und dient 
zum Auswählen der Dateien, die von Medien 
übertragen werden sollen.
ˎˎ SD Card: In den SD-Karteneinschub PROXY des 
Camcorders eingelegtes Medium. 
Durch einen Doppelklick auf eine Datei wird die 
Wiedergabe der ausgewählten Datei gestartet.

	 [Hinweis]
Je nach dem Betriebssystem des verwendeten Endgeräts 
und der Version des Browsers wird die Wiedergabe unter 
Umständen nicht unterstützt. Verwenden Sie in diesem 
Fall die Anwendung „Content Browser Mobile“.

ˎˎ Slot A: In den Karteneinschub A des Camcorders 
eingelegtes Medium
ˎˎ Slot B: In den Karteneinschub B des Camcorders 
eingelegtes Medium

Job List

Zeigt den Bildschirm Job List zur Verwaltung der 
Dateiübertragungen an (Seite 81).

Cam Remote Control

Zeigt den Bildschirm der Wi-Fi-Fernbedienung an 
(Seite 75).

OSS-Information

Zeigt Urheberrechtsinformationen an.

Einstellungen für das Streaming-
Format

Sie können den Stream für die Überwachung 
nach Geräten konfigurieren und das Format und 
Übertragungsziel des Streams für das Streaming 
über das Internet oder lokale Netzwerk festlegen.

Video

ˎˎ AVC/H.264 Hauptprofil 4:2:0 Long GOP
ˎˎ Das Format wird in den folgenden Einstellungen 
ausgewählt.

Audio

ˎˎ AAC-LC-Komprimierung
ˎˎ Abtastfrequenz: 48 kHz
ˎˎ Bitrate: 128 kbit/s für Stereo

Überwachungseinstellungen

Sie können das Format zum Überwachen nach 
Geräten festlegen.

Menüpunkt Beschreibung Einstellung
Monitoring 
Size

Zum Einstellen 
des Videoformats 
und der Bitrate für 
die Überwachung.

480×270(1Mbps)/ 
480×270(0.5Mbps)

Monitoring 
Frame Rate

Zeigt die Video-
Bildfrequenz für 
die Überwachung 
an.

23.98fps/25fps/ 
29.97fps/50fps/ 
59.94fps

Monitoring 
Bit Rate

Zeigt die Video-
Bitrate für die 
Überwachung an.

1Mbps(VBR)/ 
0.5Mbps(VBR)

[Hinweise]
ˎˎ Die Bitrate ist ein Mittelwert, der natürlich manchmal 

überschritten werden kann.
ˎˎ Eine Video-Bildrate von 24 fps wird nicht unterstützt.
ˎˎ 640×360 (3Mbps (VBR)) wird bei „Monitoring Size“ nicht 

unterstützt.

Durchführen der Konfiguration mit dem Webmenü
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Streaming-Einstellungen

Sie können das Streaming-Format und 
-Übertragungsziel festlegen. Sie können bis zu drei 
Einstellungen im Voraus festlegen.

Menüpunkt Beschreibung Einstellung
On/Off Schaltet die 

Streaming-
Übertragung ein/
aus.

On/Off

Preset Zur Auswahl der 
Voreinstellung: 
Preset 1 bis Preset 
3. Sie können die 
Voreinstellung 
durch Antippen 
von „Edit“ 
bearbeiten.

Preset1/Preset2/
Preset3

Type Zum Auswählen 
der Art der zu 
streamenden 
Videodaten.

MPEG-2 TS/UDP/ 
MPEG-2 TS/ 
RTP

Size Zum Festlegen des 
Formats der zu 
streamenden 
Videodaten.
Wenn „HD Auto“ 
ausgewählt ist, ist 
das Format auf 
1920×1080 oder 
1280×720 
festgelegt, je nach 
der Einstellung des 
Formats der 
Aufnahme auf der 
SxS-Speicherkarte 
oder des Formats 
des 
wiederzugebenden 
Clips.

HD Auto/ 
1280×720/ 
640×360/ 
480×270/
320×180

Menüpunkt Beschreibung Einstellung
Bit Rate Zum Festlegen der 

Bitrate der zu 
streamenden 
Videodaten.
Die auswählbare 
Bitrate hängt von 
der Einstellung des 
Formats (Size) ab.

9Mbps/6Mbps/ 
3Mbps/2Mbps/ 
1Mbps/0.5Mbps/ 
0.3Mbps(Mono L)/ 
0.3Mbps(Mono R)/ 
0.2Mbps(Mono L)/ 
0.2Mbps(Mono R)

Destination 
Address

Geben Sie hier die 
Adresse des 
Übertragungsziel-
Servers zum 
Streamen von 
Daten ein.

Hostname oder 
IP-Adresse

Destination 
Port

Geben Sie hier die 
Portnummer des 
zum Streamen 
verwendeten 
Übertragungsziel-
Servers ein.

1 bis 65535

Audio 
Channel 
Select

Auswahl der 
Audiokanäle für die 
Streaming-
Ausgabe.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

[Hinweise]
ˎˎ Wenn „Streaming“ auf „On“ gesetzt ist, kann die 

Überwachungsfunktion nicht verwendet werden.
ˎˎ Audio-/Videodaten werden unverändert über das Internet 

übertragen.  
Möglicherweise können Dritte Zugriff auf die Daten 
erhalten.  
Prüfen Sie stets, ob das Übertragungsziel die Streaming-
Daten empfangen kann.  
Die Daten werden möglicherweise an unbeabsichtigte 
Dritte gesendet, wenn die Adresse oder andere 
Einstellungen falsch konfiguriert sind.
ˎˎ Je nach dem Status des Netzwerks werden 

möglicherweise nicht alle Einzelbilder wiedergegeben.
ˎˎ Die Bildqualität verringert sich möglicherweise in Szenen 

mit übermäßiger Bewegung.
ˎˎ Wenn für den Datenstrom ein großes Format und eine 

kleine Bitrate festgelegt wurden, werden möglicherweise 
nicht alle Einzelbilder wiedergegeben.  
Wählen Sie, um diesen Effekt zu verringern, ein kleineres 
Format für die Einstellung „Size“ aus.
ˎˎ Wenn ein Netzwerk mit einer Bandbreite von weniger 

als 500 Kbit/s verwendet wird, sind Size und Bit Rate 

folgendermaßen eingestellt.
–– Wenn „Size“ auf 480×270 eingestellt wird, wird 

„Bit Rate“ auf 0.3Mbps(Mono L), 0.3Mbps(Mono R), 
0.2Mbps(Mono L) oder 0.2Mbps(Mono R) gesetzt.

–– Wenn „Size“ auf 320×180 eingestellt wird, wird „Bit 
Rate“ auf 0.2Mbps(Mono L) oder 0.2Mbps(Mono R) 
gesetzt. 

In diesem Fall wird Video auf eine Bildrate von 10 fps und 
Audio auf eine Sampling-Frequenz von 48 kHz und eine 
Bitrate von 56 Kbit/s eingestellt.
ˎˎ Wenn „Bit Rate“ auf 0.3Mbps(Mono L) oder 0.2Mbps(Mono 

L) gesetzt ist, wird „Audio Channel Select >Ch-1 & Ch-2“ 
auf „Ch-1“ oder „Ch-3 & Ch-4“ auf „Ch-3“ gesetzt.  
Wenn „Bit Rate“ auf 0.3Mbps(Mono R) oder 0.2Mbps(Mono 
R) gesetzt ist, wird „Audio Channel Select >Ch-1 & Ch-2“ 
auf „Ch-2“ oder „Ch-3 & Ch-4“ auf „Ch-4“ gesetzt.

Proxyformateinstellungen

Sie können das Format der auf der SD-Karte des 
Camcorders aufgezeichneten Proxydatei festlegen.

Video

ˎˎ XAVC Proxy (AVC/H.264 Main Profile, 4:2:0 Long 
GOP)
ˎˎ Das Format wird in den folgenden Einstellungen 
ausgewählt.

Audio

ˎˎ AAC-LC-Komprimierung
ˎˎ Abtastfrequenz: 48 kHz
ˎˎ Bitrate: 128 kbit/s für Stereo

Menüpunkt Beschreibung Einstellung
Proxy File 
recording 
>Size

Zum Einstellen des 
Videoformats und 
der Bitrate für 
Proxy-Dateien.

HD Auto(9Mbps)/ 
HD Auto(6Mbps)/ 
1280×720(9Mbps)/ 
1280×720(6Mbps)/ 
640×360(3Mbps)/ 
480×270(1Mbps)/ 
480×270(0.5Mbps)

Proxy File 
recording 
>Frame 
Rate

Zeigt die Video-
Bildfrequenz für 
Proxy-Dateien.

23.98fps/ 
25fps/ 
29.97fps/ 
50fps/ 
59.94fps

Proxy File 
recording 
>Bit Rate

Zeigt die Video-
Bitrate für Proxy-
Dateien.

9Mbps(VBR)/ 
6Mbps(VBR)/ 
3Mbps(VBR)/ 
1Mbps(VBR)/ 
0.5Mbps(VBR)

Proxy File 
recording 
>Audio 
Channel 
Select

Zum Einstellen des 
Audiokanals für die 
Aufzeichnung der 
Proxy-Daten.

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

[Hinweise]
ˎˎ Die Bitrate ist ein Mittelwert, der natürlich manchmal 

überschritten werden kann.
ˎˎ 24 fps (Bilder pro Sekunde) wird nicht unterstützt.
ˎˎ Wenn in den Proxyformateinstellungen für „Size“ die 

Option „HD Auto“ ausgewählt wird, wird das Proxyformat 
entsprechend der Einstellung des Formats der Aufnahme 
auf der SxS-Speicherkarte oder des Formats des 
wiederzugebenden Clips eingestellt.
ˎˎ Proxydateien, die aufgezeichnet werden, wenn die Option 

„Size“ in den Proxyformateinstellungen auf „HD Auto“ 
gesetzt wurde, können möglicherweise nicht in einem 
Browser oder in Content Browser Mobile wiedergegeben 
werden. Legen Sie SD-Karten mit aufgezeichneten 
Proxydateien zur Wiedergabe der Dateien in einen 
Computer ein.

WLAN-Stationseinstellungen

Verwenden Sie diesen Bildschirm, um 
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Einstellungen für die Verbindung des Camcorders 
mit einem WLAN vorzunehmen.

Menüpunkt Beschreibung
Host Name Name des Camcorders (kann 

geändert werden)
SSID Zeigt die in [Access Point] 

ausgewählte SSID an.
Key Geben Sie das Kennwort für den 

Access Point ein.
DHCP Aktiviert/deaktiviert DHCP.

Wenn diese Option auf [On] 
gesetzt ist, wird dem Camcorder 
automatisch eine IP-Adresse 
zugewiesen.
Um die IP-Adresse des 
Camcorders manuell 
einzugeben, setzen Sie diese 
Option auf [Off].

IP Address Geben Sie die IP-Adresse des 
Camcorders ein. Nur aktiviert, 
wenn „DHCP“ auf [Off] gesetzt 
ist.

Subnet mask Geben Sie die Subnetzmaske 
des Camcorders ein.
Nur aktiviert, wenn „DHCP“ auf 
[Off] gesetzt ist.

Gateway Geben Sie das Gateway für den 
Access Point ein.
Nur aktiviert, wenn „DHCP“ auf 
[Off] gesetzt ist.

DNS Auto DNS-Adresse wird automatisch 
abgerufen.
Wenn diese Option auf „On“ 
gesetzt ist, wird die Adresse des 
DNS-Servers automatisch 
ermittelt.

Menüpunkt Beschreibung
Primary DNS 
Server

Geben Sie den primären DNS-
Server für den Access Point ein.
Nur aktiviert, wenn „DNS Auto“ 
auf [Off] gesetzt ist.

Secondary DNS 
Server

Geben Sie den sekundären DNS-
Server für den Access Point ein.
Nur aktiviert, wenn „DNS Auto“ 
auf [Off] gesetzt ist.

Submit Wendet die WLAN-
Einstellungen an.

Herstellen einer Verbindung mit einem Access 
Point im Stationsmodus ohne WPS

1	 Verbinden Sie den Camcorder und das Gerät 
im Access-Point-Modus (Seite 64).

2	 Konfigurieren Sie die Einstellungen auf dem 
Einstellungsbildschirm.
Konfigurieren Sie die Einstellungen 
entsprechend den Einstellungen der Access-
Point-Verbindung.

Weitere Informationen über Access-Point-Einstellungen 
finden Sie in der Bedienungsanleitung des Access Points.

3	 Tippen Sie auf [Submit].
Die angegebenen Einstellungen werden 
angewendet.

4	 Wählen Sie im Konfigurationsmenü 
„Maintenance >Network >Wi-Fi Mode“.

5	 Drehen Sie am Regler MENU, um [Wi-Fi 
Station] zu wählen, und drücken Sie dann den 
Regler MENU.
Dieser Schritt verbindet den Camcorder mit 
dem Access Point im Stationsmodus. Gehen 
Sie zu Schritt 9 in „Herstellen einer Verbindung 
mit einem Access Point über WPS“ (Seite 65), 
um vom Gerät auf den Camcorder zuzugreifen.

Überprüfen der WLAN-Einstellungen

Verwenden Sie die Registerkarte „Wireless LAN 
>Status“, um den WLAN-Status zu überwachen.
Die angezeigten Einstellungen variieren je nach 
dem WLAN-Modus des Camcorders.

Access-Point-Modus

Stationsmodus

Einstellungen für kabelbasiertes LAN

Verwenden Sie diesen Bildschirm, um 
Einstellungen für die Verbindung des Camcorders 
mit einem kabelbasierten LAN vorzunehmen.

Menüpunkt Beschreibung
DHCP Aktiviert/deaktiviert DHCP.

Wenn diese Option auf [On] 
gesetzt ist, wird dem Camcorder 
automatisch eine IP-Adresse 
zugewiesen.
Um die IP-Adresse des 
Camcorders manuell 
einzugeben, setzen Sie diese 
Option auf [Off].

IP Address Geben Sie die IP-Adresse des 
Camcorders ein.
Aktiviert, wenn „DHCP“ auf [Off] 
gesetzt ist.

Subnet mask Geben Sie die Subnetzmaske 
des Camcorders ein. Aktiviert, 
wenn „DHCP“ auf [Off] gesetzt 
ist.

Gateway Geben Sie das Gateway für den 
Access Point ein.
Aktiviert, wenn „DHCP“ auf [Off] 
gesetzt ist.

DNS Auto DNS-Adresse wird automatisch 
abgerufen.
Wenn diese Option auf „On“ 
gesetzt ist, wird die Adresse des 
DNS-Servers automatisch 
ermittelt.

Primary DNS 
Server

Geben Sie den primären 
DNS-Server des Routers ein.
Aktiviert, wenn „DNS Auto“ auf 
[Off] gesetzt ist.

Secondary DNS 
Server

Geben Sie den sekundären DNS-
Server des Routers ein.
Aktiviert, wenn „DNS Auto“ auf 
[Off] gesetzt ist.

Web/Cam 
Remote

Aktiviert/deaktiviert den Zugriff 
auf das Webmenü und die 
Wi-Fi-Fernbedienung des 
Camcorders.
Wenn diese Option auf „On“ 
gesetzt ist, ist der Zugriff 
aktiviert.
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Menüpunkt Beschreibung
Submit Zum Vornehmen der 

Einstellungen für kabelbasiertes 
LAN.

[Hinweis]
Um den nicht autorisiertem Zugriff vom Internet auf das 
Gerät zu verhindern, wird empfohlen, die Option „Web/Cam 
Remote“ nur dann auf „On“ zusetzen, wenn das kabelbasierte 
LAN nicht mit dem Internet verbunden ist. Wenn Sie eine 
Verbindung mit dem Internet herstellen, stellen Sie zuerst 
sicher, dass die Netzwerkverbindung gesichert ist.

Überprüfen der Einstellungen für kabelbasiertes 
LAN

Verwenden Sie die Registerkarte „Wired LAN 
>Status“, um den Status des kabelbasierten LAN zu 
überwachen.

Übertragungseinstellungen (Upload)

Sie können Server für die Übertragung von auf 
dem Camcorder gespeicherten Proxy-Dateien 
oder Originaldateien einstellen und registrieren.

Aktivieren/Deaktivieren der automatischen 
Übertragung

Wenn [Auto Upload] auf [On] gesetzt ist und eine 
Internetverbindung besteht, werden die Proxy-
Dateien nach der Aufzeichnung automatisch auf 
den Standard-Server hochgeladen, der auf der 
Registerkarte Upload Settings angegeben ist.
Als Standardserver ist werkseitig „Sony Ci“ 
festgelegt.
„Sony Ci“ ist der Medien-Cloud-Dienst von Sony. 
Sie können Dateien mit dem Cloud-Dienst „Sony 
Ci“ übertragen.

[Hinweise]
ˎˎ Der Dienst ist möglicherweise nicht in allen Regionen 

verfügbar.
ˎˎ Um den „Sony Ci“ Cloud-Dienst verwenden zu können, 

ist ein Abonnement erforderlich. Weitere Informationen 
finden Sie auf www.SonyMCS.com/wireless. 
Einzelheiten zu der Sony Ci-Datenschutzrichtlinie finden 
Sie auf den folgenden Seiten.

–– Geschäftsbedingungen 
https://www.sonymcs.com/terms/

–– Nutzungsrichtlinien 
https://www.sonymcs.com/use/

–– Datenschutzrichtlinie 
https://www.sonymcs.com/privacy/

ˎˎ Der Name des Übertragungs-Zielordners wird in 
[Destination Directory] angegeben. Wenn dieser nicht 
angegeben wird, wird das aktuelle Datum als Ordnername 
verwendet. Informationen zum Ändern dieser Einstellung 
finden Sie unter „Andern der Einstellungen registrierter 
Server“ (Seite 81).

Gehen Sie folgendermaßen vor, um sich bei „Sony 
Ci“ anzumelden.

1	 Stellen Sie sicher, dass auf der Registerkarte 
[Upload Einstellungen] „Sony Ci“ angezeigt 
wird, und klicken Sie auf [Edit].
Der Bildschirm für die Einrichtung von „Sony 
Ci“ wird angezeigt.

2	 Geben Sie einen Benutzernamen und ein 
Kennwort ein.
Weitere Informationen finden Sie auf www.
SonyMCS.com/wireless.

3	 Tippen Sie auf [Link].
Nach kurzer Zeit wird eine Abschlussmeldung 
angezeigt.
Mit der Option [Link] wird der Benutzer dem 
Camcorder zugeordnet. Um [Link] 
auszuführen, wird eine Internetverbindung 
benötigt.

4	 Tippen Sie auf [OK].
Nach der Registrierung bei „Sony Ci“ wird auf 
dem Einstellungsbildschirm die Option 
[Unlink] angezeigt. Wenn Sie auf [Unlink] 
tippen, wird die Zuordnung des 
Benutzerkontos aufgehoben, sodass ihm 
andere Benutzerkonten zugeordnet werden 
können.

Registrieren eines neuen Zielservers

Tippen Sie auf [Create New], um einen 
Konfigurationsbildschirm anzuzeigen.

Tippen Sie zum Abschluss auf [OK], um die 
Einstellungen zu übernehmen. Tippen auf [Cancel] 
verwirft die Einstellungen.

Menüpunkt Beschreibung
Default Server Setzen Sie diese Option auf 

[On], um den Server als 
Standarddateizielserver 
festzulegen. (Über der 
Serverliste für 
Dateiübertragungen 
angezeigt.)

Menüpunkt Beschreibung
Display Name Geben Sie in dieses Feld den 

Namen ein, unter dem der 
Server in der Liste angezeigt 
wird.

Service Zeigt den Typ des Servers an.
FTP: FTP-Server

Host Name Geben Sie die Adresse des 
Servers ein.

[Hinweis]
Wenn eine andere Portnummer 
als die Standardnummer 21 
verwendet wird, fügen Sie 
am Ende der Adresse einen 
Doppelpunkt und die Portnummer 
an (z. B. „:123“).

User Geben Sie den 
Benutzernamen ein.

Password Geben Sie das Kennwort ein.
PASV Mode PASV-Modus aktivieren/

deaktivieren
Destination 
Directory

Geben Sie das Zielverzeichnis 
ein.

[Hinweis]
Wenn ein ungültiges Zeichen im 
Verzeichnisnamen eingegeben 
wird, wird das Verzeichnis nicht 
erstellt und die Dateien werden 
in der obersten Ebene des 
Standard-Zielverzeichnisses der 
Übertragung gespeichert.

Using Secure 
Protocol

Legen Sie fest, ob Secure FTP 
verwendet werden soll.
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Menüpunkt Beschreibung
Load Certification Zwischen-CA-Zertifikat laden.

Wird angezeigt, wenn „Using 
Secure Protocol“ auf ON 
gestellt ist.

[Hinweise]
ˎˎ Der Datenaustausch mithilfe 

von FTP ist nicht verschlüsselt. 
Die Verwendung von FTPS wird 
empfohlen.
ˎˎ Ein Zwischen-CA-Zertifikat, das 

ein Wurzelzertifikat enthält, wird 
benötigt.
ˎˎ Das zu ladende Zertifikat muss 

im PEM-Format vorliegen 
und im Stammverzeichnis der 
SD-Karte mit dem Dateinamen 
„certification.pem“ gespeichert 
sein.

[Hinweis]
Der Datenaustausch mithilfe von FTP ist nicht verschlüsselt. 
Die Verwendung von FTPS wird empfohlen.

Andern der Einstellungen registrierter Server

Wählen Sie den Server, dessen Einstellungen 
Sie ändern möchten, im Bildschirm Upload 
Settings aus und tippen Sie auf [Edit]. Ändern 
Sie die Einstellung auf dem angezeigten 
Konfigurationsbildschirm.
Einzelheiten zu den Menüpunkten siehe 
„Registrieren eines neuen Zielservers“.

Löschen eines registrierten Servers

Wählen Sie den Server, den Sie löschen 
möchten, im Bildschirm Upload Settings aus 
und tippen Sie auf [Delete]. Es erscheint eine 
Bestätigungsmeldung. Tippen Sie auf [OK], um den 
Server löschen und zum vorherigen Bildschirm 
zurückzukehren.

Überwachen von Dateiübertragungen 
(Auftragsliste)

Sie können den Status der Dateiübertragung 
überwachen, Dateien in der 
Dateiübertragungsliste verwalten und 
Dateiübertragungen starten bzw. stoppen.
Der Camcorder unterstützt die FTP-Resume-
Funktion (für die Fortsetzung unterbrochener 
Dateiübertragungen).

Menüpunkt Beschreibung
Total Fortschrittsanzeige der 

Übertragung aller Dateien
Status Fortschrittsanzeige der 

übertragenen Datei
Remain time Prognostizierte verbleibende 

Übertragungsdauer
Transfer data rate Übertragungsrate

Stoppen/Neustarten der Dateiübertragung oder 
Löschen einer Datei aus der Übertragungsliste

1	 Wählen Sie eine Datei aus.

2	 Tippen Sie oben rechts auf dem Bildschirm auf 
.

Wählen Sie einen Menüpunkt.
ˎˎ Abort selected: Dateiübertragung stoppen.
ˎˎ Delete from list: Datei in der 
Übertragungsliste löschen.
ˎˎ Start selected: Dateiübertragung starten.

ˎˎ Select All: Alle Dateien in der Liste 
auswählen.
ˎˎ Clear completed: Alle übertragenen Dateien 
in der Liste löschen.
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Netzwerkfunktionen und Netzwerkverbindungseinstellungen

Die unterstützten Netzwerkfunktionen und die entsprechenden Netzwerkverbindungseinstellungen 
(„Maintenance >Network >Wi-Fi Mode, Modem, und Wired LAN-Einstellungen“) werden nachfolgend 
aufgeführt.
Setzen Sie „Maintenance >Network >Setting“ im Konfigurationsmenü auf „On“.

Netzwerkfunktion Maintenance >Network >Wi-Fi Mode Maintenance 
>Network 
>Modem

Maintenance >Network 
>Wired LAN im 
Konfigurationsmenü

Wi-Fi Access 
Point

Wi-Fi Station Off On Off Enable Disable

Proxy-Aufzeichnung 1)

(Seite 57)
Ja Ja Ja Ja Ja Ja Ja

Proxy-Wiedergabe
(Seite 77)

Ja 2) Ja 2) Nein Nein Nein Ja 2) Nein

Dateiübertragung
(Seite 71)

Nein Ja 2) Nein Ja 2) Nein Ja 2) Nein

Streaming-Übertragung
(Seite 73)

Nein Ja Nein Ja Nein Ja Nein

Überwachungseinstellungen
(Seite 77)

Ja 2) Ja 2) Nein Nein Nein Ja 2) Nein

Netzwerkclientmodus
(Seite 74)

Nein Ja Nein Ja Nein Ja Nein

Camcorder-
Fernbedienung
(Seite 75)

Ja 2) Ja 2) Nein Nein Nein Ja 2) Nein

1)	 Proxy-Aufzeichnung ist aktiviert, wenn „Operation >Proxy Recording Mode >Setting“ im Konfigurationsmenü auf „On“ 
gesetzt ist.

2)	 Unterstützt Funktionen von Camcorder und von über das Netzwerk verbundenen Geräten.

Einschränkungen der gleichzeitigen Verwendung von Netzwerkfunktionen

Für die gleichzeitige Verwendung von Netzwerkfunktionen gelten die folgenden Einschränkungen.

WLAN-Verbindung Kabelbasierte 
LAN-Verbindung

Operation

Keine Deaktiviert Netzwerkfunktion angehalten
USB-WLAN-Modul Deaktiviert USB-WLAN-Modul in Betrieb
3G/4G/LTE-USB-Modem Deaktiviert 3G/4G/LTE-USB-Modem in Betrieb
Keine Aktiviert Kabelbasiertes LAN in Betrieb
USB-WLAN-Modul Aktiviert USB-WLAN-Modul und kabelbasiertes LAN in Betrieb 1)

1)	 Für Streaming und Dateiübertragung wird kabelbasiertes LAN verwendet. Das USB-WLAN-Modul ist für die Wi-Fi-
Fernbedienungsfunktion reserviert.

[Hinweis]
Eine kabelbasierte LAN-Verbindung ist nicht möglich, wenn der USB-Erweiterungsadapter des im Lieferumfang des optionalen 
CBK-NA1 enthaltenen Ethernet-Adapters CBK-NA1R am USB-WLAN-Modul des Camcorders angeschlossen ist.

Unterstützte Netzwerkfunktionen und Funktionseinschränkungen
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Clipfunktionen in der Skizzenbilderanzeige
Skizzenbilderanzeige

OK S

1 2 3 4

9 10 11 12 13

65 7 8

Cursor 
(gelb)

Die Skizzenbilderanzeige erscheint, 
wenn Sie die Taste THUMBNAIL im E-E- 
oder im Wiedergabemodus drücken. 
Skizzenbilderanzeigen zeigen Listen der auf SxS-
Speicherkarten gespeicherten Clips in Form von 
Indexbildern an.
Sie können jeden beliebigen Clip (Seite 84) 
in einer Skizzenbilderanzeige wählen und die 
Wiedergabe des Clips starten (Seite 84).
Sie können auch jedem beliebigen Clip in der 
Skizzenbilderanzeige eine Clipmarkierung 
hinzufügen, um Clips nach Markierungen zu filtern. 
Sie können auch von der Skizzenbilderanzeige zur 
Inhaltsmarkierungs-Skizzenbilderanzeige wechseln 

und jedem beliebigen Einzelbild in einem Clip 
Inhaltsmarkierungen (z. B. Szenenmarkierungen) 
hinzufügen.

Zum Ausblenden der Skizzenbilderanzeige 
drücken Sie die Taste THUMBNAIL.

1.	 Skizzenbild (Indexbild)
Wenn ein Clip aufgezeichnet wird, wird sein erstes 
Einzelbild automatisch als Indexbild angezeigt. 
Sie können jedes Einzelbild zum Indexbild ändern 
(Seite 88).

2.	 Symbol für ausgewählte Medien/
Medienstatus

Bei geschützten Medien wird das Zeichen  
angezeigt.
Wenn zwei SxS-Speicherkarten in den Camcorder 
eingesetzt werden, können Sie mit der Taste SLOT 
SELECT zwischen ihnen umschalten.

3.	 Clip-Nummer/Gesamtclipzahl

4.	 Batterie-/Spannungsstatus

5.	 Anzeige „Wiedergabe deaktiviert“

6.	 Clipstatus
Zeigt den Status des Clips mit einem Symbol an.

Symbol Bedeutung
Symbole S, OK, 
NG, KP

Inhaltsmarkierung oder 
Clipmarkierung eines Clips

Sperr-Symbol Der ausgewählte Clip ist gesperrt 
(geschützt)

7.	 Kontrollkästchen zur Clipauswahl
Aktivieren Sie das Kontrollkästchen, um einen Clip 
auszuwählen (Skizzenbild).
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8.	 Skizzenbildinformationen
Zeigt Skizzenbildinformationen an. Die Anzeige 
variiert je nach Einstellung für „Customize View“ 
(Seite 89).

9.	 Clipname/Titel
Zeigt Namen oder Titel des ausgewählten Clips an.

10.	 Aufzeichnungs-Videoformat

11.	 Spezielle Aufzeichnungsinformationen
Zeigt den Aufzeichnungsmodus an, wenn der 
Clip in einem Spezial-Aufzeichnungsmodus 
aufgezeichnet wurde (Zeitlupe und Zeitraffer).
Bei Zeitlupen- und Zeitrafferclips wird
rechts die [Recording frame rate/Playback frame 
rate] angezeigt.

12.	 Cliplänge

13.	 Erstellungsdatum

Auswählen von Clips

Um ein Clip-Skizzenbild auszuwählen, führen Sie 
einen der folgenden Schritte aus, um den gelben 
Cursor zu dem Skizzenbild zu bewegen, das Sie 
auswählen möchten.
ˎˎ Drücken Sie die Tasten , , , .
ˎˎ Drehen Sie den Regler MENU.
ˎˎ Drücken Sie die Taste PREV oder NEXT.

Auswählen des ersten Skizzenbildes

Halten Sie die Taste F REV gedrückt und drücken 
Sie die Taste PREV.

Auswählen des letzten Skizzenbildes

Halten Sie die Taste F FWD gedrückt und drücken 
Sie die Taste NEXT.

Abspielen von Clips nacheinander 
ausgehend vom gewählten Clip

1	 Wählen Sie das Skizzenbild des Clips, den Sie 
zuerst abspielen wollen.

2	 Drücken Sie die Taste PLAY/PAUSE.
Die Wiedergabe beginnt am Anfang des 
ausgewählten Clips.

Die Clips werden nacheinander ausgehend vom 
gewählten Clip wiedergegeben.
Wenn die Wiedergabe des letzten Clips endet, 
schaltet der Camcorder auf das Kamerabild oder 
das externe Eingangssignal.
Drücken Sie die Taste THUMBNAIL, um zur 
Skizzenbilderanzeige zurückzukehren.

[Hinweise]
ˎˎ Es können nicht alle Clips nacheinander wiedergegeben 

werden, wenn die Clips auf den SxS-Speicherkarten mit 
verschiedenen Aufzeichnungsformaten aufgenommen 
wurden.
ˎˎ Clips, für die in der Skizzenbilderanzeige ein „Wiedergabe 

deaktiviert“-Symbol (Seite 83) angezeigt wird, werden 
nicht wiedergegeben. Die entsprechenden Clips werden 
übersprungen, und die Wiedergabereihenfolge wird 
fortgesetzt.
ˎˎ An der Grenze zwischen Clips kann es zu 

einem kurzzeitigen Bildabbruch oder zu einer 
Standbildanzeige kommen. Während dieser Zeit sind 
die Wiedergabesteuerungen und die Taste THUMBNAIL 
deaktiviert.
ˎˎ Wenn Sie einen Clip in der Skizzenbilderanzeige 

wählen und die Wiedergabe starten, kann es zu einem 
kurzzeitigen Bildabbruch am Anfang des Clips kommen. 
Um den Anfang des Clips ohne Bildabbruch anzusehen, 
stellen Sie den Camcorder in den Wiedergabemodus 

und dann auf Pause, kehren Sie mit der Taste PREV zum 
Anfang des Clips zurück und starten Sie die Wiedergabe 
erneut.

Unterbrechen der Wiedergabe

Drücken Sie die Taste PLAY/PAUSE.
Die Anzeige PLAY/PAUSE blinkt, während die 
Wiedergabe angehalten ist.
Drücken Sie erneut die Taste, um in den 
Wiedergabe-Modus zurückzukehren.

Wiedergeben mit hoher 
Geschwindigkeit

Drücken Sie die Taste F FWD (Seite 8) oder die 
Taste F REV (Seite 8).
Zur Rückkehr zur Wiedergabe in 
Normalgeschwindigkeit drücken Sie die PLAY/
PAUSE-Taste.

Zum Anfang des aktuellen Clips 
zurückkehren

Drücken Sie die Taste PREV.
ˎˎ Während der Wiedergabe wird dadurch der 
Anfang des aktuellen Clips aufgerufen und die 
Wiedergabe startet.
ˎˎ Während F FWD wird dadurch der Anfang des 
aktuellen Clips aufgerufen und die Wiedergabe 
angehalten.
ˎˎ Während F REV oder der Pause wird dadurch der 
Anfang des aktuellen Clips aufgerufen und ein 
Standbild angezeigt.
ˎˎ Jedes nachfolgende Drücken der Taste ruft die 
vorherigen Clips auf.

Wiedergabe vom Anfang des ersten 
Clips starten

Drücken Sie gleichzeitig die Tasten PREV und F 
REV. Dadurch springen Sie zum Anfang des ersten 
Clips auf der SxS-Speicherkarte.

Zum Anfang des nächsten Clips 
springen

Drücken Sie die Taste NEXT.
ˎˎ Während der Wiedergabe wird dadurch der 
Anfang des nächsten Clips aufgerufen und die 
Wiedergabe startet.
ˎˎ Während F FWD wird dadurch der Anfang des 
nächsten Clips aufgerufen und die Wiedergabe 
angehalten. Während der Wiedergabe des 
letzten Clips wird dadurch das Ende des Clips 
aufgerufen und die Wiedergabe angehalten.
ˎˎ Während F REV oder Pause wird dadurch der 
Anfang des nächsten Clips aufgerufen und ein 
Standbild angezeigt.
ˎˎ Bei jedem nachfolgenden Tastendruck gelangen 
Sie zum nächsten Clip.

Zum letzten Clip springen

Drücken Sie gleichzeitig die Tasten F FWD 
und NEXT. Dadurch springen Sie zum letzten 
Einzelbild des letzten auf der SxS-Speicherkarte 
aufgezeichneten Clips.
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Hinzufügen einer Szenenmarkierung 
während der Wiedergabe

Sie können während der Wiedergabe die 
Szenenmarkierungen zu den Clips auf die gleiche 
Weise wie während der Aufzeichnung hinzufügen 
(Seite 52).

[Hinweis]
Es ist keine Aufzeichnung von Szenenmarkierungen möglich, 
wenn die SxS-Speicherkarte schreibgeschützt ist.

Anhalten der Wiedergabe

Drücken Sie die Taste STOP: Die Wiedergabe wird 
angehalten und der Camcorder wechselt in 
den E-E-Modus.

Drücken Sie die Taste THUMBNAIL: Die 
Wiedergabe wird beendet und die 
Skizzenbilderanzeige (Seite 83) erscheint im 
Sucher.

Die Wiedergabe wird auch dann beendet, wenn 
Sie die Speicherkarte entfernen. In diesem Fall 
erscheint das Kamerabild im Sucher.

Grundlegende Funktionen des Menüs 
„Thumbnail“

Das Menü „Thumbnail“ wird verwendet, um Clips 
zu schützen/zu löschen, Eigenschaften zu prüfen, 
Clipmarkierungen und Inhaltsmarkierungen zu 
Einzelbildern in Clips hinzuzufügen/zu löschen 
und andere Aufgaben auszuführen.

1	 Drücken Sie die Taste THUMBNAIL.
Die Skizzenbilderanzeige wird angezeigt.

2	 Stellen Sie den Schalter MENU ON/OFF auf ON 
oder drücken Sie die Taste MENU.
Der Menübildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Thumbnail] 
zu wählen, und drücken Sie dann den Regler 
MENU.
Oder drücken Sie die Tasten  oder , um 
[Thumbnail] auszuwählen, und drücken Sie 
dann die Taste SET.

Zum Ausblenden des Menüs „Thumbnail“ drücken 
Sie erneut die Taste MENU.

Gehen Sie folgendermaßen vor, um einen 
Menüpunkt/Unterpunkt.
ˎˎ Drehen Sie den Regler MENU zur Auswahl des 
Punktes oder Unterpunktes und drücken Sie 
dann den Regler.
ˎˎ Drücken Sie die Pfeiltasten (, , , ) zum 
Auswählen des Punktes oder Unterpunktes und 
drücken Sie dann die Taste SET.

Entsprechend dem ausgewählten Punkt oder 
Unterpunkt wird eine Auswahlliste oder ein 
Bildschirm mit Clipeigenschaften angezeigt 
(Seite 87).
Drücken Sie zur Rückkehr zum vorherigen 
Bildschirm den Schalter MENU CANCEL/PRST/
ESCAPE nach unten in die Position ESCAPE.

[Hinweise]
ˎˎ Wenn eine SxS-Speicherkarte schreibgeschützt ist, 

können keine Clips kopiert, gelöscht oder geteilt, 
Indexbilder gewechselt und oder Clipmarkierungen und 
Szenenmarkierungen hinzugefügt oder gelöscht werden.
ˎˎ Einige Punkte können nicht gewählt werden, abhängig 

davon, in welchem Status des Camcorders das Menü 
angezeigt wurde.

Weitere Einzelheiten zum Aufbau der 
Skizzenbilderanzeige siehe „Menü „Thumbnail““ 
(Seite 89).

Schützen von Clips

Sie können einen bestimmten Clip oder alle Clips 
davor schützen, gelöscht zu werden.

 kennzeichnet die Skizzenbilder geschützter 
Clips.
Clips können in der Skizzenbilderanzeige oder in 
der gefilterten Clip-Skizzenbilderanzeige geschützt 
werden (Seite 87).

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf 
FAT eingestellt ist.

Schützen eines bestimmten Clips

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Lock/Unlock Clip >Select Clip“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Bildschirm zur Clipauswahl wird angezeigt.

3	 Drehen Sie am Regler MENU, um einen zu 
schützenden Clip auszuwählen, und drücken 
Sie dann den Regler.
Dem ausgewählten Clip wird eine Markierung 
hinzugefügt.

4	 Drücken Sie gleichzeitig die Taste SET und die 
Taste SHIFT.
Ein Bestätigungsbildschirm wird angezeigt.

5	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Der Clip wird geschützt, und es wird eine 
Abschlussmeldung angezeigt.

6	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

Schützen aller Clips

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Lock/Unlock Clip >Lock All Clips“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Alle Clips werden geschützt, und es wird eine 
Abschlussmeldung angezeigt.

4	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

Den Schutz aller Clips aufheben

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Lock/Unlock Clip >Unlock All 
Clips“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Alle Clips werden entsperrt, und es wird eine 
Abschlussmeldung angezeigt.
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4	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

Kopieren von Clips

Sie können Clips auf eine andere SxS-Speicherkarte 
kopieren.
Clips werden mit den Namen der Originalclips auf 
SxS-Zielspeicherkarten kopiert.

[Hinweise]

ˎˎ Wenn bereits ein Clip mit gleichem Namen auf 
der als Kopierziel gewählten SxS-Speicherkarte 
vorhanden ist, wird in Klammern eine einstellige 
Zahl zum ursprünglichen Namen hinzugefügt.  
Die Zahl in Klammern ist die kleinste, am 
Kopierziel noch nicht vorhandene Zahl.  
Beispiel: 
ABCD0002ABCD0002(1) 
ABCD0002(1)ABCD0002(2) 
ABCD0005(3)ABCD0005(4)
ˎˎ Wenn die Zahlen in Klammern (1) bis (999) am 
Kopierziel schon existieren, da ein Clip bereits 
öfter als 1000 mal kopiert wurde, können keine 
weiteren Clips unter diesem Namen kopiert 
werden.
ˎˎ Wenn auf der SxS-Speicherkarte des Kopierziels 
nicht genug freier Speicherplatz verfügbar ist, 
wird eine entsprechende Meldung angezeigt. 
Ersetzen Sie die Karte durch eine mit mehr 
freiem Speicherplatz.
ˎˎ Wenn auf der SxS-Speicherkarte der Quelle 
mehrere Clips aufgezeichnet sind, können Sie je 
nach den Speichermerkmalen und der Nutzung 
der Speicherkarten möglicherweise nicht alle 
Clips kopieren, auch wenn die Quell- und 
Zielspeicherkarten dieselbe Kapazität aufweisen.

Kopieren eines bestimmten Clips

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Copy Clip >Select Clip“ aus.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Bildschirm zur Clipauswahl wird angezeigt.

3	 Drehen Sie am Regler MENU, um den zu 
kopierenden Clip auszuwählen, und drücken 
Sie dann den Regler.
Dem ausgewählten Clip wird eine Markierung 
hinzugefügt.

4	 Drücken Sie gleichzeitig die Taste SET und die 
Taste SHIFT.
Ein Bestätigungsbildschirm wird angezeigt.

5	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Clip wird kopiert, und es wird eine 
Abschlussmeldung angezeigt.

6	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

Kopieren aller Clips

Sie können alle auf derselben SxS-Speicherkarte 
gespeicherten Clips gleichzeitig auf eine andere 
SxS-Speicherkarte kopieren.

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Copy Clip >All Clips“ aus.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Alle Clips werden kopiert, und es wird eine 
Abschlussmeldung angezeigt.

4	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

Löschen von Clips

Sie können Clips von SxS-Speicherkarten löschen. 
Clips können in der Skizzenbilderanzeige oder in 
der gefilterten Clip-Skizzenbilderanzeige gelöscht 
werden (Seite 87).

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Delete Clip >Select Clip“ aus.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Bildschirm zur Clipauswahl wird angezeigt.

3	 Drehen Sie am Regler MENU, um einen zu 
löschenden Clip auszuwählen, und drücken 
Sie dann den Regler.
Dem ausgewählten Clip wird eine Markierung 
hinzugefügt.

4	 Drücken Sie gleichzeitig die Taste SET und die 
Taste SHIFT.
Ein Bestätigungsbildschirm wird angezeigt.

5	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Der Clip wird gelöscht, und es wird eine 
Abschlussmeldung angezeigt.

6	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.

In der Skizzenbilderanzeige rücken die Clips nach 
dem gelöschten Clip um eine Position nach oben.

Löschen aller Clips

Sie können alle auf derselben SxS-Speicherkarte 
gespeicherte Clips gleichzeitig löschen.

[Hinweise]
ˎˎ Gelöschte Clips können nicht wiederhergestellt werden.
ˎˎ Wenn das Medium oder der Clip geschützt sind, ist diese 

Funktion deaktiviert.

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Delete Clip >All Clips“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Alle Clips werden gelöscht, und es wird eine 
Abschlussmeldung angezeigt.

4	 Drücken Sie den Regler MENU, um die 
Meldung zu verwerfen.
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Anzeige der Clip-Eigenschaften

Der Clip-Eigenschaftenbildschirm für den ausgewählten Clip wird angezeigt, wenn Sie im 
Konfigurationsmenü „Thumbnail >Display Clip Properties“ auswählen.

1

2

3

4

5

6
7

OK S

1.	 Bild des aktuellen Clips
Zeigt Indexbild und Status des ausgewählten Clips 
an.

2.	 Anzeige des Zeitcodes
TC Index: Zeitcode des angezeigten Bildes
Start: Zeitcode des Aufzeichnungsstartpunktes
End: Zeitcode des Aufzeichnungsendpunktes
Duration: Dauer zwischen Beginn und Endpunkt

3.	 Erstellungsdatum und Datum der Änderung

4.	 Clipname

5.	 Aufzeichnungsformat
Video Codec: Videocodec
Size: Bildformat
FPS: Bildrate
Audio Codec: Audiocodec
Ch/Bit: Kanal der Audioaufzeichnung/Anzahl der 

Bits für die Audioaufzeichnung

6.	 Spezielle Aufzeichnungsinformationen

7.	 Name des Aufzeichnungsgeräts

Gehen Sie folgendermaßen vor, um den Bildschirm 

mit den Clipeigenschaften auszublenden.
Drücken Sie die Taste RESET/RETURN: Damit 

kehren Sie zum Menübildschirm „Thumbnail“ 
zurück.

Drücken Sie die Taste THUMBNAIL: Der Camcorder 
wechselt in den E-E-Modus und das 
Kamerabild wird angezeigt.

Drücken Sie die Taste PLAY/PAUSE: Die 
Wiedergabe des ausgewählten Clips beginnt.

Hinzufügen von Clipmarkierungen zu 
Clips

Sie können Clipmarkierungen (OK-, NG- oder 
KP-Markierungen) zu Clips hinzufügen, 
um Clips anhand der Clipmarkierungen zu 
filtern. Sie können diesen Vorgang in der 
Skizzenbilderanzeige oder der gefilterten Clip-
Skizzenbilderanzeige ausführen (Seite 87).

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf 
FAT eingestellt ist.

1	 Wählen Sie das Skizzenbild des Clips, dem Sie 
eine Clipmarkierung hinzufügen möchten, und 
wählen Sie dann im Konfigurationsmenü 
„Thumbnail >Set Clip Flag“.

2	 Drehen Sie am Regler MENU, um eine 
Clipmarkierung auszuwählen, und drücken Sie 
dann den Regler MENU.

Einstellung Hinzugefügte Clipmarkierung
Add OK OK
Add NG NG
Add KEEP KP

Die Clipmarkierung wird dem Skizzenbild des 
ausgewählten Clips hinzugefügt.

Sie können einen belegbaren Schalter verwenden, 
dem die Clipmarkierungsfunktion zugewiesen 
wurde, um Clipmarkierungen hinzuzufügen 
(Seite 124).

Löschen einer Clipmarkierung

1	 Wählen Sie das Skizzenbild des Clips, bei dem 
Sie eine Clipmarkierung löschen möchten, und 
wählen Sie dann im Konfigurationsmenü 
„Thumbnail >Set Clip Flag >Delete Clip Flag“.
Die Clipmarkierung wird gelöscht.

Filtern der angezeigten Clips unter 
Verwendung des gefilterten Clip-
Bildschirms

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf 
FAT eingestellt ist.

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Filter Clips“.

2	 Drehen Sie am Regler MENU, um eine 
Clipmarkierung auszuwählen, die zum Filtern 
von Clips verwendet wird, und drücken Sie 
dann den Regler MENU.

Einstellung Filter clip flag
OK OK
NG NG
KEEP KP
None (Clips werden nicht gefiltert)

Der Clip-Bildschirm wird mit den nach der 
ausgewählten Clipmarkierung gefilterten Clips 
angezeigt. Dieser Bildschirm wird als gefilterter 
Clip-Bildschirm bezeichnet.

Um die Filterung abzubrechen, gehen Sie 
folgendermaßen vor.
ˎˎ Drücken Sie die Taste RESET/RETURN.
ˎˎ Wählen Sie im Konfigurationsmenü „Thumbnail 
>Thumbnail View >All“.

Hinzufügen/Löschen von 
Inhaltsmarkierungen in Clips

Sie können jedem beliebigen Einzelbild in einem 
Clip Inhaltsmarkierungen (Szenenmarkierungen, 
Aufzeichnungs-Startmarkierungen) 
hinzufügen und aus diesem Einzelbild 
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löschen. Inhaltsmarkierungen können Sie in 
der Inhaltsmarkierungs-Skizzenbilderanzeige 
hinzufügen/löschen.

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf 
FAT eingestellt ist.

Hinzufügen einer Szenenmarkierung

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail > Thumbnail View > Essence Mark 
Thumbnail“.

2	 Drehen Sie den Regler MENU zur Wahl von 
[All], und drücken Sie den Regler.

3	 Wählen Sie in der Inhaltsmarkierungs-
Skizzenbilderanzeige das Skizzenbild für das 
Einzelbild, dem Sie eine Inhaltsmarkierung 
hinzufügen möchten, und wählen Sie dann im 
Konfigurationsmenü „Thumbnail >Set Shot 
Mark“.

4	 Drehen Sie am Regler MENU, um eine der 
folgenden Optionen auszuwählen, und 
drücken Sie dann den Regler MENU.

Einstellung Operation

Add Shot Mark1 Fügt Szenenmarkierung 
1 hinzu

Add Shot Mark2 Fügt Szenenmarkierung 
2 hinzu

Die Szenenmarkierung wurde dem 
ausgewählten Einzelbild hinzugefügt.

Löschen einer Szenenmarkierung

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail > Thumbnail View > Essence Mark 
Thumbnail“.

2	 Wählen Sie den Typ der zu löschenden 
Szenenmarkierung.

3	 Wählen Sie in der Inhaltsmarkierungs-
Skizzenbilderanzeige das Skizzenbild für das 
Einzelbild, bei dem Sie eine Szenenmarkierung 
löschen möchten, und wählen Sie dann im 
Konfigurationsmenü „Thumbnail >Set Shot 
Mark“.

4	 Drehen Sie am Regler MENU, um eine der 
folgenden Optionen auszuwählen, und 
drücken Sie dann den Regler MENU.

Einstellung Operation

Delete Shot Mark1 Löscht 
Szenenmarkierung 1

Delete Shot Mark2 Löscht 
Szenenmarkierung 2

Die Szenenmarkierung wurde dem 
ausgewählten Einzelbild gelöscht.

Filtern von Clips (Einzelbildern) unter 
Verwendung der 
Inhaltsmarkierungs-
Skizzenbilderanzeige

In der Inhaltsmarkierungs-Skizzenbilderanzeige 
werden nur jene Einzelbilder eines Clips 
angezeigt, für die in der Skizzenbilderansicht eine 
Inhaltsmarkierung aufgezeichnet wurde. Rufen 
Sie die Skizzenbilderanzeige auf, und drücken 
Sie dann entweder die Taste ESSENCE MARK 
(Seite 9), oder gehen Sie wie nachfolgend 
beschrieben vor, um die Inhaltsmarkierungs-
Skizzenbilderanzeige aufzurufen.

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf 
FAT eingestellt ist.

1	 Wählen Sie im Konfigurationsmenü 
„Thumbnail >Thumbnail View >Essence Mark 
Thumbnail“.

2	 Drehen Sie am Regler MENU, um eine 
Inhaltsmarkierung auszuwählen, die zum 
Filtern von Einzelbildern verwendet wird, und 
drücken Sie dann den Regler MENU.

Einstellung Beschreibung

All Anzeige aller Einzelbilder mit 
Inhaltsmarkierungen

Rec Start Einzelbilder mit einer 
Aufzeichnungsbeginn-
Markierung und das erste 
Einzelbild von Clips, die keine 
Aufzeichnungsbeginn-
Markierung enthalten

Shot Mark0 bis 
Shot Mark9

Einzelbilder mit jeder 
Szenenmarkierung

Die Inhaltsmarkierungs-Skizzenbilderanzeige 
wird nach der ausgewählten Inhaltsmarkierung 
gefiltert angezeigt.

Wenn ein Clip mit Planungsmetadaten 
aufgezeichnet wird, die die Namen für die 
Szenenmarkierungen 0 bis 9 definieren, werden 
die Auswahloptionen in der Liste anhand der 
definierten Namen angezeigt.

Ändern des Indexbildbilds eines Clips

Sie können das in der Inhaltsmarkierungs-
Skizzenbilderanzeige ausgewählte Einzelbild als 
Indexbild für den Clip festlegen.
Wählen Sie das Skizzenbild des Einzelbildes, das Sie 
als das Indexbild für den Clip verwenden möchten, 
und wählen Sie dann im Konfigurationsmenü 
„Thumbnail >Set Index Picture“.
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Menü „Thumbnail“
Standardwerte sind unterstrichen und fett formatiert.

Menüpunkt Unterpunkteinstellung Beschreibung
Display Clip Properties – Zeigt Clip-Eigenschaften an (Seite 87).
Set Index Picture – Einstellen/Ändern des Indexbildbilds eines Clips 

(Seite 88).
Thumbnail View
Änderungen der 
angezeigten 
Skizzenbilderanzeige.

Essence Mark Thumbnail
All/Rec Start/Shot Mark1/ 
Shot Mark2/Shot Mark3/ 
Shot Mark4/Shot Mark5/ 
Shot Mark6/Shot Mark7/ 
Shot Mark8/Shot Mark9/ 
Shot Mark0

Zeigt die Inhaltsmarkierungs-
Skizzenbilderanzeige mit nach 
Inhaltsmarkierung gefilterten Clips an 
(Seite 88).

Clip Thumbnail Zeigt die Skizzenbilderanzeige (Clip-
Skizzenbilderanzeige) an.(Seite 83)

Set Shot Mark
Hinzufügen/Löschen von 
Szenenmarkierungen.

Add Shot Mark1 Fügt einem Einzelbild Szenenmarkierung 1 
hinzu (Seite 88).

Delete Shot Mark1 Löscht Szenenmarkierung 1 (Seite 88).
Add Shot Mark2 Fügt einem Einzelbild Szenenmarkierung 2 

hinzu (Seite 88).
Delete Shot Mark2 Löscht Szenenmarkierung 2 (Seite 88).

Set Clip Flag
Hinzufügen/Löschen von 
Clipmarkierungen.

Add OK Fügt einem Clip eine OK-Markierung hinzu 
(Seite 87).

Add NG Fügt einem Clip eine NG-Markierung hinzu 
(Seite 87).

Add KEEP Fügt einem Clip eine KP-Markierung (Keep) 
hinzu (Seite 87).

Delete Clip Flag Löscht eine Clipmarkierung (Seite 87).
Lock/Unlock Clip
Schützt/entsperrt einen 
Clip.

Select Clip Wahl des zu schützenden Videoclips 
(Seite 85).

Lock All Clips Schützt alle Clips auf dem Medium (Seite 85).
Unlock All Clips Hebt den Schutz aller Clips auf dem Medium auf 

(Seite 85).
Copy Clip
Kopiert Clips.

Select Clip Wahl des zu kopierenden Clips (Seite 86).
All Clips Kopiert alle Clips auf dem Speichermedium 

(Seite 86).
Delete Clip
Löscht Clips.

Select Clip Wahl des zu löschenden Videoclips (Seite 86).
All Clips Löscht alle Clips auf dem Medium (Seite 86).

Menüpunkt Unterpunkteinstellung Beschreibung
Filter Clips
Filtert die Anzeige der 
Clips nach der 
Clipmarkierung.

OK Filtert die Anzeige der Clips nach der OK-
Markierung (Seite 87).

NG Filtert die Anzeige der Clips nach der NG-
Markierung (Seite 87).

KEEP Filtert die Anzeige der Clips nach KP-
Markierungen (Keep) (Seite 87).

None Clips werden nicht gefiltert (Seite 87).
Customize View Thumbnail Caption

Date Time/Time Code/
Duration/Sequential 
Number

Wählt die unter den Skizzenbildern angezeigten 
Informationen.
Date Time: Zeigt Datum und Uhrzeit an.
Time Code: Zeigt den Zeitcode an.
Duration: Zeigt die Dauer des Clips an.
Sequential Number: Zeigt eine fortlaufende 

Nummer für jeden Clip an.
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Konfigurationsmenüstruktur
Auf diesem Camcorder werden die Einstellungen 
für die Aufnahme und die Wiedergabe im 
Konfigurationsmenü vorgenommen, das im 
Sucher erscheint.
Dieses Konfigurationsmenü kann auch auf 
einem externen Videomonitor angezeigt werden 
(Seite 139).

Menüstruktur

Menü „User“
Menü, in dem die Elemente des 
Konfigurationsmenüs in jeder gewünschten 
Reihenfolge angeordnet werden können 
(Seite 95).

Menü „Operation“
Menü für Aufnahmeeinstellungen (jedoch 
nicht für die Bildqualität).

Menü „Paint“
Menü für Einstellungen im Zusammenhang 
mit der Bildqualität.

Menü „Thumbnail“
Menü für Einstellungen im Zusammenhang 
mit Clip-Skizzenbildern (Seite 89).

	 [Hinweis]
Das Menü „Thumbnail“ kann nur benutzt werden, wenn 
eine Skizzenbilderanzeige (Seite 83) angezeigt wird. 
Es ist deaktiviert, wenn die Skizzenbilderanzeige nicht 
angezeigt wird.

Menü „Maintenance“
Menü für Einstellungen im Zusammenhang 
mit der Wartung des Camcorders und das 
Systemmanagement.

Menü „File“
Menü für Dateioperationen.

Menüpunkte

Menü „Operation“

Menüpunkt Beschreibung Seite

Format Systemeinstellungen 97
Format Media Medienformateinstellungen 98

Input/Output Einstellungen für 
Eingangs-/Ausgangssignale

98

Super Impose Einstellungen für 
Einblendungen

98

LCD LCD-Monitoreinstellungen 99
Rec Function Einstellungen für den 

Spezial-
Aufzeichnungsmodus

99

Proxy Recording 
Mode

Einstellungen für Proxy-
Daten

99

Assignable 
Switch

Zuweisen von Funktionen 
zu belegbaren Schaltern

100

VF Setting Sucher-Einstellungen 100

Marker Marker-Einstellungen 100
Gain Switch Verstärkungswert-

Einstellungen
101

Auto Iris Blendenautomatikeinstellungen 101
Zebra Streifenmustereinstellungen 102
Display On/Off Anzeigeelementeinstellungen für 

Sucher
102

“!” LED „!“-Einstellungen für Sucher 103

White Setting Weißabgleicheinstellungen 103

Offset White Offset White-Einstellungen 104
Shutter Verschlusseinstellungen 104
Slow Shutter Einstellungen für 

langsamen Verschluss
104

Time Zone Zeiteinstellungen 104
Clip Clip-Einstellungen 105
Update Media Medienverwaltungsinformationen 

aktualisieren
105

Menüpunkt Beschreibung Seite

GPS Einstellungen zu 
Ortsinformationen (GPS)

105

Planning 
Metadata

Einstellungen zu 
Planungsmetadaten

105

USB Einstellungen für das 
Kopieren auf USB-Medien 

105

Flash Band 
Reduce

Flashbandkorrektureinstellungen 106

Menü „Paint“

Menüpunkt Beschreibung Seite

Switch Status Einstellungen zum Ein- 
bzw. Ausschalten der 
Korrekturfunktionen und 
des Testsignals

106

White Farbtemperatureinstellungen 106
Black Schwarzpegeleinstellungen 107
Flare Streulichtkorrektureinstellungen 107
Gamma Gammakorrektureinstellungen 107
Black Gamma Schwarzgammakorrektureinstellungen 108

Knee Kniekorrektureinstellungen 108
White Clip Einstellungen für Weiß-

Amplitudenbegrenzung
108

Detail Detaileinstellungen 108
Detail(SD) Detaileinstellungen 108
Aperture Blendenkorrektureinstellungen 109

Skin Detail Einstellungen für 
Oberflächenfarbdetailkorrektur

109

Matrix Matrixkorrektureinstellungen 109
Multi Matrix Multimatrixkorrektureinstellungen 110

V Modulation Einstellungen für 
V-Modulations-
Schattierungskorrektur

110

Low Key 
Saturation

Einstellungen für die 
Korrektur der Low Key-
Sättigung

110

Saturation 
Mode

Einstellungen für die 
Sättigungskorrektur

110
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Menüpunkt Beschreibung Seite

Noise 
Suppression

Rauschunterdrükkungseinstellungen 111

Wartungsmenü

Menüpunkt Beschreibung Seite

White Shading Einstellungen für 
Weißschattierungskorrektur

111

Black Shading Einstellungen für 
Schwarzschattierungskorrektur

111

Battery Akkueinstellungen 112
DC Voltage 
Alarm

Alarmeinstellungen für 
externe 
Gleichspannungsquelle

112

Audio Audioeinstellungen 112
WRR Setting Einstellungen für 

drahtlosen Tuner
113

Time Code Zeitcode-Einstellungen 114
Essence Mark Einstellungen für 

Inhaltsmarkierungen
114

Camera Config Camcorder-
Betriebseinstellungen
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Preset White Einstellungen für 
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DCC Adjust DCC-Einstellungen 116
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APR APR-Einstellungen 117
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Mode

Einstellungen für den 
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Anzeigen des Konfigurationsmenüs

Stellen Sie den Schalter MENU ON/OFF auf ON 
oder drücken Sie die Taste MENU.
Der Camcorder schaltet in den Menü-Modus, und 
auf der Anzeige erscheint die Menüliste.

Im folgenden Beispiel befindet sich der Cursor auf 
dem Menü „Operation“

Menüliste

Wahlbereich für Menüpunkte

[Hinweis]
Das Konfigurationsmenü kann nicht benutzt werden, 
wenn der Camcorder im Fokusvergrößerungsmodus läuft. 
Verlassen Sie den Fokusvergrößerungsmodus durch Drücken 
des belegbaren Schalters, dem die Fokusvergrößerungs-
Funktion zugeordnet wurde.

Vornehmen von Menüeinstellungen

1	 Drehen Sie am Regler MENU oder drücken Sie 
die Taste  oder , um den Cursor auf das 
gewünschte Menü zu bewegen.
Die zur Auswahl stehenden Menüpunkte 
werden im Wahlbereich rechts neben der 
Menüliste angezeigt.

2	 Drücken Sie den Regler MENU oder die SET-
Taste.
Der Bildschirm zur Auswahl der Menüpunkte 
wird angezeigt.  

Sie können den Bildschirm zur Auswahl der 
Menüpunkte auch durch Drücken der Taste 
 anzeigen.
ˎˎ Im Wahlbereich für Menüpunkte werden 
höchstens sieben Zeilen angezeigt. Sie 
können durch Menüs mit mehr als sieben 
Zeilen blättern, indem Sie den Cursor nach 
oben und unten bewegen.

Wahlbereich für Menüpunkte
ˎˎ Wenn zum ausgewählten Punkt 
Unterpunkte gehören, werden diese auf 
der rechten Seite angezeigt.
ˎˎ Wenn keine Unterpunkte vorhanden sind, 
wird auf der rechten Seite die aktuelle 
Einstellung angezeigt.
ˎˎ Wählen Sie [Back], um zur vorherigen 
Ebene zurückzukehren.

Wird angezeigt, wenn unten weitere 
Menüpunkte vorhanden sind.

3	 Drehen Sie am Regler MENU oder drücken Sie 
die Taste  oder , um den Cursor auf den 
Menüpunkt zu bewegen, den Sie einstellen 
möchten. Bestätigen Sie die Auswahl durch 
Drücken des Reglers MENU oder der SET-Taste.
Rechts neben dem Wahlbereich für 
Menüpunkte werden die Unterpunkte 
angezeigt, und der Cursor bewegt sich zum 
ersten Unterpunkt.

Bereich für  
Einstellungen
ˎˎ Anzeige der Unterpunkte und ihrer 
aktuellen Einstellungen.
ˎˎ Um zu der vorigen Ebene zurückzukehren, 
wählen Sie [Back], drücken die Taste  
oder drücken den Schalter MENU CANCEL/
PRST/ESCAPE nach unten in die Stellung 
ESCAPE.

4	 Drehen Sie am Regler MENU oder drücken Sie 
die Taste  oder , um den Cursor auf den 
Unterpunkt zu bewegen, den Sie einstellen 
möchten. Bestätigen Sie die Auswahl durch 
Drücken des Reglers MENU oder der SET-Taste.
Die Einstellungen des ausgewählten 
Unterpunkts erscheinen, und der Cursor zeigt 
den aktuell eingestellten Wert an.

Bereich für Einstellungen

ˎˎ Im Einstellungsbereich werden bis zu neun 
Zeilen angezeigt. Sie können durch Menüs 
mit mehr als neun Unterpunkten blättern, 
indem Sie den Cursor nach oben oder unten 
bewegen.
ˎˎ Bei Unterpunkten mit einem großen 
Einstellbereich (z. B. –99 bis +99) wird 
der Einstellbereich nicht angezeigt. Die 
aktuelle Einstellung ist hervorgehoben, um 
anzuzeigen, dass der Wert geändert werden 
kann.

5	 Drehen Sie am Regler MENU oder drücken Sie 
die Taste  oder , um den Wert einzustellen. 
Bestätigen Sie die Auswahl durch Drücken des 
Reglers MENU oder der SET-Taste.
Die Einstellung wird geändert, und in der 
Anzeige erscheint die neue Einstellung.
Wenn Sie [Execute] als Befehlsoption 
auswählen, wird die entsprechende Funktion 
ausgeführt.

Wenn ein Punkt vor der Ausführung bestätigt 
werden muss, wird durch die Auswahl des Punkts 
in Schritt 3 das Menü ausgeblendet und eine 
Bestätigungsmeldung angezeigt. Folgen Sie den 
Anweisungen in der Meldung zum Ausführen oder 
Abbrechen des Vorgangs.

Eingeben von Text

Wenn Sie ein Element, z. B. einen Dateinamen 
auswählen, der eine Zeicheneingabe erfordert, 
wird der Bildschirm zur Zeicheneingabe angezeigt.

1

2 3

1	 Drehen Sie den Regler MENU, um den Typ des 
einzugebenden Zeichens auszuwählen, und 
drücken Sie dann den Regler MENU oder die 
Taste SET.
ABC: Großbuchstaben
abc: Kleinbuchstaben
123: Numerische Zeichen
!#$: Sonderzeichen

Grundlegende Konfigurationsmenü-Funktionen
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2	 Wählen Sie ein Zeichen aus dem 
ausgewählten Zeichentyp aus, und drücken 
Sie den Regler.
Der Cursor springt zum nächsten Feld.
Space: Gibt an der Cursorposition ein 

Leerzeichen ein.
/: Bewegt den Cursor.
BS: Löscht das Zeichen links vom Cursor 

(Rücktaste).

3	 Wählen Sie zum Abschluss [Done] und 
drücken Sie das Wahlrad.
Die Zeichenfolge wird bestätigt und der 
Bildschirm zur Zeicheneingabe wird 
ausgeblendet.

Abbrechen der Änderungen an den 
Einstellungen

1	 Drücken Sie den Schalter MENU CANCEL/
PRST/ESCAPE nach unten in die Stellung 
ESCAPE.

Verlassen des Menüs

1	 Stellen Sie den Schalter MENU ON/OFF auf 
OFF, oder drücken Sie die MENU-Taste.
Das normale Kamerabild erscheint wieder.

Sperren/Entsperren des Menüs

Sie können das Konfigurationsmenü sperren, 
sodass nur das Menü „User“ angezeigt wird.

Sperren des Menüs

1	 Halten Sie den Regler MENU gedrückt und 
drücken Sie den Schalter MENU ON/OFF 
herunter, um das Konfigurationsmenü 
anzuzeigen.

2	 Zeigen Sie „Maintenance >Camera Config 
>User Menu with Lock“ im 
Konfigurationsmenü an.

	 [Hinweise]
ˎˎ Wenn Sie den Regler MENU gedrückt halten und den 

Schalter MENU ON/OFF herunter drücken, ändert 
sich die Option „Camera Config >User Menu Only“ zu 
„User Menu with Lock“.
ˎˎ Wenn Sie den Schalter MENU ON/OFF herunter 

drücken, ohne den Regler MENU zu drücken, oder 
wenn Sie die Taste MENU drücken, um das Menü 
anzuzeigen, wird „Camera Config >User Menu with 
Lock“ nicht angezeigt.

3	 Wählen Sie „On“ und drücken Sie den Regler 
MENU.
Die Sucheranzeige wechselt zum 
Eingabebildschirm für die Passcode-Nummer.

4	 Geben Sie eine beliebige Passcode-Nummer 
ein.
Der gültige Eingabebereich geht von 0000 bis 
9999. Der Standardwert ist 0000.
Geben Sie eine Zahl ein und drücken Sie den 
Regler MENU, um den Cursor auf die nächste 
Stelle zu bewegen.
Wenn alle Ziffern eingegeben wurden, 
bewegen Sie den Cursor auf [Set].

5	 Wenn [Set] ausgewählt ist, drücken Sie den 
Regler MENU.
Die Eingabe wird angewendet.
Es erscheint eine Bestätigungsmeldung. 
Danach wird nur das Menü „User“ angezeigt.

[Hinweise]
ˎˎ Wenn das Menü gesperrt wird, ohne dass die 

folgenden Optionen des Konfigurationsmenüs im 
Menü „User“ registriert werden, ist es nicht möglich, die 
Menüfunktion einem belegbaren Schalter zuzuweisen.

ˎˎ Wenn einige der folgenden Optionen des 
Konfigurationsmenüs einem belegbaren Schalter 
zugewiesen sind, wird die Einstellung für die den 
belegbaren Schaltern zugewiesenen Funktionen 
zwangsweise auf „Off“ gesetzt, wenn das Menü gesperrt 
wird.

Konfigurationsmenü Funktionen, die 
belegbaren 
Schaltern 
zugewiesen werden 
können

Operation >Rec Function 
>Picture Cache Rec

Picture Cache Rec

Operation >Rec Function 
>Clip Continuous Rec

Clip Continuous Rec

Operation >Rec Function 
>Slow & Quick Motion

Slow & Quick Motion

Operation >VF Setting 
>Color Mode

VF Mode

Operation >Display On/
Off >Video Signal 
Monitor

Video Signal Monitor

Operation >Display On/
Off >Lens Info

Lens Info

Operation >Auto Iris 
>Mode

Spotlight
Backlight

Operation >Marker 
>Setting

Marker

Maintenance >Audio 
>Front MIC Select

Front MIC

Maintenance >Network 
Client Mode >Setting

Network Client 
Mode

Maintenance >File 
Transfer >Auto Upload 
(Proxy)

Auto Upload(Proxy)

Entsperren des Menüs

1	 Halten Sie den Regler MENU gedrückt und 
drücken Sie den Schalter MENU ON/OFF 
herunter, um das Konfigurationsmenü 
anzuzeigen.

2	 Zeigen Sie „Display User >Camera Config 
>User Menu with Lock“ im 
Konfigurationsmenü an.

	 [Hinweise]
ˎˎ Wenn Sie den Regler MENU gedrückt halten und den 

Schalter MENU ON/OFF herunter drücken, ändert 
sich die Option „Camera Config >User Menu Only“ zu 
„User Menu with Lock“.
ˎˎ Wenn Sie den Schalter MENU ON/OFF herunter 

drücken, ohne den Regler MENU zu drücken, oder 
wenn Sie die Taste MENU drücken, um das Menü 
anzuzeigen, wird „Camera Config >User Menu with 
Lock“ nicht angezeigt.

3	 Wählen Sie „Off“ und drücken Sie den Regler 
MENU.
Die Sucheranzeige wechselt zum 
Eingabebildschirm für die Passcode-Nummer.

4	 Geben Sie die Passcode-Nummer ein, mit der 
das Menü gesperrt wurde.
Der gültige Eingabebereich geht von 0000 bis 
9999.
Geben Sie eine Zahl ein und drücken Sie den 
Regler MENU, um den Cursor auf die nächste 
Stelle zu bewegen.
Wenn alle Ziffern eingegeben wurden, 
bewegen Sie den Cursor auf [Set].

5	 Wenn [Set] ausgewählt ist, drücken Sie den 
Regler MENU.
Die Eingabe wird angewendet.
Wenn die eingegebene Passcode-Nummer 
mit der zum Sperren des Menüs verwendeten 
übereinstimmt, wird eine 
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Bestätigungsnachricht angezeigt und die 
Anzeige aller Menüs aktiviert.

	 [Hinweise]
ˎˎ Wenn die eingegebene Passcode-Nummer nicht 

mit der zum Sperren des Menüs verwendeten 
übereinstimmt, wird das Menü nicht entsperrt.
ˎˎ Es empfiehlt sich, den Passcode für den Fall zu 

notieren, dass er vergessen wird. Wenn Sie die 
Passcode-Nummer vergessen haben, wenden Sie 
sich an Ihren Sony Handelsvertreter.
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Mit der Funktion Edit User Menu können Sie 
das Menü „User“ bearbeiten, indem Sie zum 
Beispiel Menüpunkte hinzufügen, löschen und 
neu anordnen, um das auf Ihre Bedürfnisse 
abzustimmen.
Sie können die Optionen in den Menüs 
„Operation“, „Paint“ und „Maintenance“ sowie 
einige Gegenstände im Menü „File“ auswählen 
und zum Menü „User“ hinzufügen.
Bis zu 20 Elemente können im Menü „User“ 
registriert werden. In der Standardeinstellung sind 
bereits 6 Menüpunkte im Menü „User“ registriert, 
von denen einer stets vorhanden sein muss. Sie 
können also bis zu 19 neue Elemente hinzufügen.

[Hinweis]
Wenn das Menü gesperrt ist, sind keine 
Bearbeitungsfunktionen verfügbar.

Anzeigen des Bildschirms „Edit User 
Menu“

Sie bearbeiten das Menü „User“ im Bildschirm „Edit 
User Menu“.

1	 Drehen Sie den Regler MENU, um „User >Edit 
User Menu“ auszuwählen, und drücken Sie 
dann den Regler MENU.

Der Bildschirm „Edit User Menu“ wird 
angezeigt.

Hinzufügen von Menüpunkten und 
Unterpunkten

1	 Drehen Sie den Regler MENU, um „Edit User 
Menu >Add Item“ auszuwählen, und drücken 
Sie dann den Regler.
Die Menüpunkte, die hinzugefügt werden 
können, werden angezeigt.

2	 Drehen Sie den Regler MENU zur Auswahl 
eines Menüpunkts und drücken Sie dann den 
Regler.
Ein Bildschirm zur Auswahl der 
hinzuzufügenden Unterpunkte wird angezeigt.

3	 Drehen Sie am Regler MENU, um einen 
Unterpunkt auszuwählen, und drücken Sie 
dann den Regler MENU.
Markieren Sie das Kontrollkästchen „All“, um 
alle Unterpunkte hinzuzufügen.
Markieren Sie einzelne Kontrollkästchen, um 
anzugeben, welche Unterpunkte hinzugefügt 
werden sollen.

4	 Drehen Sie am Regler MENU, um [OK] zu 
wählen, und drücken Sie dann den Regler 
MENU.
Die Menüpunkte bzw. Unterpunkte werden 
hinzugefügt.

[Hinweis]
Derselbe Menüpunkt oder Unterpunkt kann nicht zweimal 
registriert werden. Ebenso kann der Name des Menüpunkts 
oder Unterpunkts nicht geändert werden.

Bearbeiten von Unterpunkten

Hier können Sie die anzuzeigenden Unterpunkte 
angeben.

1	 Zeigen Sie den Bildschirm „Edit User Menu“ an.

2	 Drehen Sie den Regler MENU zur Auswahl des 
zu bearbeitenden Punkts und drücken Sie 
dann den Regler.
Die Liste zum Bearbeiten von Funktionen wird 
angezeigt.

3	 Drehen Sie am Regler MENU, um die Option 
„Edit Sub Item“ auszuwählen, und drücken Sie 
dann den Regler.

Der Menübildschirm „Edit Sub Item“ wird 
angezeigt.

Beim ersten Öffnen des Bildschirms sind alle 
Unterpunkte ausgewählt (alle Unterpunkte 
werden angezeigt).
Deaktivieren Sie die Kontrollkästchen der 
Unterpunkte, die nicht im Menü „User“ 
angezeigt werden sollen.

4	 Drehen Sie am Regler MENU, um [OK] zu 
wählen, und drücken Sie dann den Regler 
MENU.
Die Bearbeitung ist abgeschlossen.

Löschen von Menüpunkten

1	 Zeigen Sie den Bildschirm „Edit User Menu“ an.

2	 Drehen Sie den Regler MENU zur Auswahl des 
zu bearbeitenden Punkts und drücken Sie 
dann den Regler.
Die Liste zum Bearbeiten von Funktionen wird 
angezeigt.

3	 Drehen Sie am Regler MENU, um in der Liste 
zum Bearbeiten der Funktionen die Option 
„Delete“ auszuwählen, und drücken Sie den 
Regler.

Der Menüpunkt wird gelöscht.

Bearbeiten des Menüs „User“
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Verschieben von Menüpunkten

1	 Zeigen Sie den Bildschirm „Edit User Menu“ an.

2	 Drehen Sie den Regler MENU zur Auswahl des 
zu verschiebenden Menüpunkts und drücken 
Sie dann den Regler.
Die Liste zum Bearbeiten von Funktionen wird 
angezeigt.

3	 Drehen Sie am Regler MENU, um in der Liste 
zum Bearbeiten der Funktionen die Option 
„Move“ auszuwählen, und drücken Sie den 
Regler.

Der zu verschiebende Menüpunkt wird 
markiert, und ein Dreieck sowie eine Linie 
geben die Zielposition an.

Dreieck und Linie geben Ziel an

4	 Drehen Sie am Regler MENU, um das Dreieck 
und die Linie zum gewünschten Ziel zu 
bewegen, und drücken Sie dann den Regler 
MENU.
Der Menüpunkt wird verschoben.

Wiederherstellen des Menüs „User“ 
auf die werkseitige 
Standardeinstellung

1	 Drehen Sie den Regler MENU, um „Edit User 
Menu >Customize Reset“ auszuwählen, und 
drücken Sie dann den Regler MENU.
Der Bildschirm „Customize Reset“ wird 
angezeigt.

2	 Drehen Sie am Regler MENU, um [Reset] zu 
wählen, und drücken Sie dann den Regler 
MENU.
Ein Bestätigungsdialogfeld wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Das Menü [User] wird auf die werkseitige 
Standardeinstellung zurückgesetzt.
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Menü „User“ (werkseitige Standardeinstellung)

Das Menü „User“ besteht in der werkseitigen Standardeinstellung aus den folgenden Punkten.
ˎˎ Format Media (Seite 98)
ˎˎ Rec Function (Seite 99)
ˎˎ Input/Output (Seite 98)
ˎˎ Clip (Seite 105)
ˎˎ Assignable Switch 1) (Seite 100)
ˎˎ Camera Config 2) (Seite 115)

1)	 ausgenommen Unterpunkt 0
2)	 enthält nur „User Menu Only“ als Unterpunkt

Einzelheiten zum Bearbeiten des Menüs „User“ finden Sie unter „Bearbeiten des Menüs „User““ 
(Seite 95).

Menü „Operation“

Standardwerte sind unterstrichen und fett formatiert.

Operation >Format
Zum Einstellen der Systemfrequenz, des Dateisystems, des Aufzeichnungsformats und des 
Seitenverhältnisses für Aufzeichnungen.

Menüpunkt Einstellung Beschreibung

Frequency 59.94/50/29.97/25/23.98 Wahl der Systemfrequenz (Ausführung durch 
Wahl von „Execute“).

File System exFAT/UDF/FAT Schaltet das Dateisystem um (ausführen durch 
Auswählen von „Execute“).

Operation >Format
Zum Einstellen der Systemfrequenz, des Dateisystems, des Aufzeichnungsformats und des 
Seitenverhältnisses für Aufzeichnungen.

Menüpunkt Einstellung Beschreibung

Rec Format Einstellungen variieren je nach 
Einstellung der Systemfrequenz.

Wahl des Aufnahmeformats (Ausführen durch 
Wahl von „Execute“).

XAVC-I 1920×1080P
XAVC-I 1920×1080i
XAVC-I 1280×720P
XAVC-L 50 1920×1080P
XAVC-L 50 1920×1080i
XAVC-L 50 1280×720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P
MPEG IMX 50
DVCAM

Wenn das Dateisystem exFAT ist und die 
Systemfrequenz 59.94 oder 50 beträgt.

XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

Wenn das Dateisystem exFAT ist und die 
Systemfrequenz 29.97, 25 oder 23.98 beträgt.

HD422 50 1080i
HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P
MPEG IMX 50
DVCAM

Wenn das Dateisystem UDF ist und die 
Systemfrequenz 59.94 oder 50 beträgt.

HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

Wenn das Dateisystem UDF ist und die 
Systemfrequenz 29.97, 25 oder 23.98 beträgt.

HQ 1920×1080i
HQ 1440×1080i 
HQ 1280×720P 
SP 1440×1080i

Wenn das Dateisystem FAT ist und die 
Systemfrequenz 59.94 oder 50 beträgt.

HQ 1920×1080P Wenn das Dateisystem FAT ist und die 
Systemfrequenz 29.97, 25 oder 23.98 beträgt.

Menüliste
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Operation >Format
Zum Einstellen der Systemfrequenz, des Dateisystems, des Aufzeichnungsformats und des 
Seitenverhältnisses für Aufzeichnungen.

Menüpunkt Einstellung Beschreibung

Aspect Ratio (SD) 16:9/4:3 Wahl des Seitenverhältnisses für den SD-Modus.

Audio Length 24bit/16bit Wahl der Audio-Bitrate für die Aufzeichnung im 
IMX-Format.

Operation >Format Media
Formatiert das Medium.

Menüpunkt Einstellung Beschreibung

Media (A) Execute/Cancel Initialisiert die SxS-Speicherkarte in Einschub A 
(Ausführen durch Wahl von „Execute“).

Media (B) Execute/Cancel Initialisiert die SxS-Speicherkarte in Einschub B 
(Ausführen durch Wahl von „Execute“).

SD Card(Utility) Execute/Cancel Initialisiert die SD-Karte im SD-Karteneinschub 
UTILITY (ausführen durch Wahl von „Execute“).

SD Card(Proxy) Execute/Cancel Initialisiert die SD-Karte im SD-Karteneinschub 
PROXY (ausführen durch Wahl von „Execute“).

Operation >Input/Output
Zum Einstellen von Eingangs-/Ausgangs-Signalen.

Menüpunkt Einstellung Beschreibung

Output Format Einstellungen variieren je nach 
Einstellung der Systemfrequenz.

Wahl des Ausgabeformats (ausführen durch Wahl 
von [Execute]).
Einstellungen variieren je nach der Einstellung für 
das Aufzeichnungsformat (Seite 38).

Source Select Camera/External Auswahl des Kamerabildes (Camera) oder des 
Eingangssignals des Anschlusses SDI IN für die 
Videoeingabequelle.

SDI Out1 Output On/Off Schaltet das Ausgangssignal des Anschlusses SDI 
OUT1 ein bzw. aus.

SDI Out2 Output On/Off Schaltet das Ausgangssignal des Anschlusses SDI 
OUT2 ein bzw. aus.

HDMI Output On/Off Schaltet das Ausgangssignal des Anschlusses 
HDMI ein bzw. aus.

SDI Out2/HDMI Super Off/On Schaltet eingeblendete Textinformationen der 
Anschlüsse SDI OUT2 und HDMI ein bzw. aus.

Video Out Super Off/On Schaltet (eingeblendete) Textinformationen des 
Anschlusses VIDEO OUT ein bzw. aus.

Operation >Input/Output
Zum Einstellen von Eingangs-/Ausgangs-Signalen.

Menüpunkt Einstellung Beschreibung

Down Converter Edge Crop/Letter Box/Squeeze Hier wird der Signalkonvertierungsmodus für die 
Ausgabe von SD-Signalen bestimmt.
Edge Crop: Beschneidet die Ränder des 

16:9-Bildes für die Ausgabe als 4:3-Bild.
Letter Box: Maskiert den oberen und unteren 

Bereich des 4:3-Bildes und zeigt ein 16:9-Bild 
in der Mitte des Bildschirms an.

Squeeze: Staucht das 16:9-Bild horizontal für die 
Ausgabe als 4:3-Bild.

Wide ID Through/Auto Stellen Sie ein, ob ein Breitbild-ID-Signal zum 
SD-Ausgabesignal hinzugefügt werden sollen.
Through: Gibt das Video ohne Breitbild-ID-Signal 

aus.
Auto: Fügt dem Videosignal ein Breitbild-ID-Signal 

hinzu und gibt dieses aus, wenn das Breitbild-
ID-Signal auf „Squeeze“ gesetzt ist.

Wide Mode(Ext.) Auto/16:9 Legt bei einem SD-Eingangssignal die Methode 
fest, mit der Breitbild-Bildschirmdaten bestimmt 
werden.
Auto: Aufzeichnung mit dem Bildformat 16:9, 

wenn die Breitbild-Bildschirmdaten des 
Eingangssignals auf „Squeeze“ gesetzt sind. 
Anderenfalls wird im Bildformat 4:3 
aufgezeichnet.

16:9: Aufzeichnung im Bildformat 16:9.

Operation >Super Impose
Legt die einzublendenden Textinformationen/Marker fest.

Menüpunkt Einstellung Beschreibung

Super(VF Display) On/Off Wenn „Input/Output >SDI Out2/HDMI Super“ 
oder „Input/Output >Video Out Super“ aktiviert 
ist, können Sie hier einstellen, ob 
Zeicheninformationen bei der Ausgabe über den 
SDI OUT-Anschluss oder VIDEO OUT-Anschluss 
eingeblendet werden.

Super(Menu) On/Off

Super(Marker) On/Off Wenn „Input/Output >SDI Out2/HDMI Super“ 
oder „Input/Output >Video Out Super“ aktiviert 
ist, können Sie hier einstellen, ob Markierungen 
bei der Ausgabe über den SDI OUT-Anschluss 
oder VIDEO OUT-Anschluss eingeblendet werden.
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Operation >LCD
Zum Einstellen des LCD-Monitors.

Menüpunkt Einstellung Beschreibung

LCD Color –99 bis ±0 bis +99 Zum Einstellen der Farbtiefe des LCD-Monitors.

LCD Marker&Zebra On/Off Ein- bzw. Ausschalten von Markierungsanzeige 
und Streifenmustern auf dem LCD-Monitor.

Operation >Rec Function
Zum Einstellen des Spezial-Aufzeichnungsmodus.

Menüpunkt Einstellung Beschreibung

Slow & Quick Motion On/Off Schaltet Zeitlupen und Zeitraffer ein bzw. aus. 
(Wenn diese Option auf On steht, sind die 
Einstellungen für die anderen Spezial-
Aufnahmemodi auf Off gestellt.)

Frame Rate Einstellungen variieren je nach 
der Einstellung für das 
Aufzeichnungsformat.

Wenn die Einstellung Slow & Quick Motion 
aktiviert ist, kann die Bildfrequenz für die 
Zeitlupen- und Zeitrafferaufnahmen eingestellt 
werden.

1 bis 60 Wenn das Dateisystem exFAT und das 
Aufzeichnungsformat XAVC Intra oder XAVC Long 
ist.

1 bis 50 Wenn das Dateisystem UDF und das 
Aufzeichnungsformat MPEG HD 422 50M 
(1280×720), 50P/25P ist.

1 bis 30 Wenn das Dateisystem exFAT oder UDF und das 
Aufzeichnungsformat MPEG HD 422 50M 
(1920×1080), 29.97P/23.98P ist.

1 bis 25 Wenn das Dateisystem exFAT oder UDF und das 
Aufzeichnungsformat MPEG HD 422 50M 
(1920×1080), 25P ist.

Clip Continuous Rec On/Off Schaltet den Continuous-Rec-Modus des Clips ein 
bzw. aus. (Wenn diese Option auf On steht, sind 
die Einstellungen für die anderen Spezial-
Aufnahmemodi auf Off gestellt.)

Picture Cache Rec On/Off Schaltet den Bildpuffer-Aufzeichnungsmodus ein 
bzw. aus. (Wenn diese Option auf On steht, sind 
die Einstellungen für die anderen Spezial-
Aufnahmemodi auf Off gestellt.)

Cache Rec Time Einstellungen variieren je nach 
der Einstellung für das 
Aufzeichnungsformat.

Stellt die Bildpuffer-Aufzeichnungszeit ein, wenn 
„Picture Cache Rec“ auf „On“ gesetzt ist.

Weitere Informationen hierzu finden Sie im Abschnitt 
„Aufzeichnung im Bildpuffermodus“ (Seite 165) im Anhang.

Operation >Rec Function
Zum Einstellen des Spezial-Aufzeichnungsmodus.

Menüpunkt Einstellung Beschreibung

Interval Rec On/Off Schaltet den Modus „Interval Rec“ ein bzw. aus. 
(Wenn diese Option auf On steht, sind die 
Einstellungen für die anderen Spezial-
Aufnahmemodi auf Off gestellt.)

Number of Frames Die verfügbaren Einstellungen 
hängen von der Einstellung für 
„Format >Frequency“ ab.

Wenn „Interval Rec“ auf „On“ gesetzt ist, wird 
damit die Anzahl der in einer Interval-Rec-
Aufnahme aufzunehmenden Einzelbilder 
festgelegt.

2frames/6frames/12frames Wenn 50P oder 59.94P als Bildfrequenz des 
Aufzeichnungsformats festgelegt ist.

1frame/3frames/6frames/ 
9frames

Wenn 23.98P, 25P, 29.97P, 50i oder 59.94i als 
Bildfrequenz des Aufzeichnungsformats 
festgelegt ist.

Interval Time 1/2/3/4/5/6/7/8/9/10/15/20/30/
40/50 (sec) 
1/2/3/4/5/6/7/8/9/10/15/20/30/
40/50/ (min) 
1/2/3/4/6/12/24 (hour)

Wenn „Interval Rec“ auf „On“ gesetzt ist, wird 
damit das Intervall für die Interval-Rec-Aufnahme 
festgelegt.

Pre-Lighting Off/2sec/5sec/10sec Damit wird die Anzahl der Sekunden eingestellt, 
die die Videoleuchte vor dem Start der Interval-
Rec-Aufnahme eingeschaltet wird. Wenn die 
Videoleuchte nicht eingeschaltet werden soll, 
wählen Sie „Off“ aus.

Simul Rec On/Off Schaltet die gleichzeitige Aufnahme in den 
Einschüben A und B ein bzw. aus.

Operation >Proxy Recording Mode
Zum Einstellen der Proxy-Aufzeichnung.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die Proxy-Aufzeichnung ein bzw. aus

Size HD Auto(9Mbps)/
HD Auto(6Mbps)/
1280×720(9Mbps)/ 
1280×720(6Mbps)/ 
640×360(3Mbps)/ 
480×270(1Mbps)/ 
480×270(0.5Mbps)

Wahl der Größe für das Proxy-
Aufzeichnungsformat.

Frame Rate 23.98fps/25fps/29.97fps/50fps/ 
59.94fps

Wahl der Bildfrequenz für das Proxy-
Aufzeichnungsformat.

Bit Rate 9Mbps/6Mbps/3Mbps/1Mbps/ 
0.5Mbps

Wahl der Bitrate für das Proxy-
Aufzeichnungsformat.
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Operation >Proxy Recording Mode
Zum Einstellen der Proxy-Aufzeichnung.

Menüpunkt Einstellung Beschreibung

Audio Channel CH1/CH2/CH3/CH4 Wahl des Audiokanals für die Aufzeichnung der 
Proxy-Daten.

Operation >Assignable Switch
Zuweisung von Funktionen für die belegbaren Schalter.

Einzelheiten zum Zuweisen von Funktionen siehe „Zuweisung der Funktionen belegbarer Schalter“ (Seite 124).

Menüpunkt Einstellung Beschreibung

<0> Seite 124 Weist dem Schalter ASSIGN. 0 eine Funktion zu.

<1> Seite 125 Weist dem Schalter ASSIGN. 1 eine Funktion zu.

<2> Seite 124 Weist dem Schalter ASSIGN. 2 eine Funktion zu.

<3> Seite 125 Weist dem Schalter ASSIGN. 3 eine Funktion zu.

<4> Seite 125 Weist dem Schalter ASSIGNABLE 4 eine Funktion 
zu.

<5> Seite 125 Weist dem Schalter ASSIGNABLE 5 eine Funktion 
zu.

Lens RET Seite 127 Weist der RET-Taste am Objektiv eine Funktion zu.

Online Seite 125 Weist der Taste ONLINE eine Funktion zu.

Zoom Speed 0 bis 20 bis 99 Wenn der Zoom dem Schalter ASSIGNABLE 4 
oder 5 zugeordnet wurde, wird hier die 
Zoomgeschwindigkeit eingestellt.

Operation >VF Setting
Zum Einstellen der Sucheranzeige.

Menüpunkt Einstellung Beschreibung

Color –99 bis ±0 bis +99 Zum Einstellen der Farbtiefe des Sucherbilds.

Color Mode Color/B&W Wahl des Sucher-Anzeigemodus (bei 
Verwendung von CBK-VF02).
Color: Farbe
B&W: Schwarzweiß

Peaking Type Normal/Color Wahl der Art der Konturverstärkung (bei 
Verwendung von CBK-VF02).
Normal: Normale Konturverstärkung
Color: Konturverstärkung in Farbe

Peaking Frequency Normal/High Wenn „Peaking Type“ auf „Normal“ gesetzt ist, 
wird damit die Spitzenfrequenz (Peaking 
Frequency) „Normal“ oder „High“ ausgewählt (bei 
Verwendung des CBK-VF02).

Operation >VF Setting
Zum Einstellen der Sucheranzeige.

Menüpunkt Einstellung Beschreibung

Peaking Color B&W/Red/Yellow/Blue Wahl der Konturverstärkungsfarbe, wenn Peaking 
Type auf Color gesetzt ist (bei Verwendung von 
CBK-VF02).
B&W: Schwarzweiß
Red: Rot
Yellow: Gelb
Blue: Blau

VF Detail Level –99 bis ±0 bis +99 Zum Einstellen des (am Camcorder eingestellten) 
Detailpegels des Suchers (bei Verwendung von 
HDVF-20A).

Operation >Marker
Zum Einstellen der Markierungsanzeige im Sucher.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die Anzeige aller Markierungen ein bzw. 
aus.

[Hinweis]
Wenn Marker dem Schalter ASSIGN. 2 zugewiesen ist, ist 
diese Einstellung deaktiviert.

Color White/Yellow/Cyan/Green/
Magenta/Red/Blue

Wahl der Anzeigefarbe für Markierungen.

Center Marker 1/2/3/4/Off Wenn die Mittelmarkierung angezeigt wird, kann 
hier die Art der Markierung eingestellt werden. 
Wählen Sie Off, wenn Sie nicht möchten, dass die 
Markierung angezeigt wird.

Safety Zone On/Off Schaltet die Sicherheitszonenanzeige ein bzw. 
aus.

Safety Area 80%/90%/92.5%/95% Wählen Sie die Größe der 
Sicherheitszonenmarkierung.

Aspect Marker Line/Mask/Off Wenn eine Bildformatmarkierung angezeigt 
werden soll, kann hier die Art der Anzeige 
festgelegt werden. Wählen Sie Off, wenn Sie nicht 
möchten, dass die Markierung angezeigt wird.
Line: Anzeige als weiße Linien.
Mask: Zeigt in Bereichen außerhalb des 

Markierungsbereichs ein dunkleres 
Videosignal an.

Aspect Select 15:9/14:9/13:9/4:3/1.66:1/ 
1.85:1/2.35:1/2.4:1

Wahl des Bildformats der Markierung.
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Operation >Marker
Zum Einstellen der Markierungsanzeige im Sucher.

Menüpunkt Einstellung Beschreibung

Aspect Mask 0% bis 12% bis 15% Wenn für Aspect Marker Mask eingestellt ist, 
können Sie hier den Videosignalpegel von 
Bereichen außerhalb des Markierungsbereichs als 
Prozentwert relativ zum Videosignalpegel von 
Bereichen innerhalb des Markierungsbereichs 
einstellen.

Aspect Safety Zone On/Off Schaltet die Bildformat-
Sicherheitszonenmarkierung ein bzw. aus.

Aspect Safety Area 80%/90%/92.5%/95% Wahl der Größe der Bildformat-
Sicherheitszonenmarkierung (als Prozentsatz der 
gesamten Bildschirmgröße).

100% Marker On/Off Schaltet die Anzeige der 
100%-Sicherheitszonenmarkierung ein bzw. aus.

User Box On/Off Schaltet die Anzeige des Kasten-Cursors ein bzw. 
aus.

User Box Width 40 bis 500 bis 999 Zum Einstellen der Breite des Kasten-Cursors 
(Abstand von der Mitte bis zur linken oder rechten 
Ecke).

User Box Height 70 bis 500 bis 999 Zum Einstellen der Höhe des Kasten-Cursors 
(Abstand von der Mitte bis zur oberen oder 
unteren Ecke).

User Box H Position –479 bis 0 bis 479 Zum Einstellen der horizontalen Position der Mitte 
des Kasten-Cursors.

User Box V Position –464 bis 0 bis 464 Zum Einstellen der vertikalen Position der Mitte 
des Kasten-Cursors.

Operation >Gain Switch
Zum Einstellen des Verstärkungswertschalters.

Menüpunkt Einstellung Beschreibung

Gain<L> –3dB/0dB/3dB/6dB/9dB/12dB/1
8dB/24dB/30dB/ 
36dB/42dB

Wahl des Verstärkungswerts für die L-Position des 
GAIN-Schalters.

Gain<M> –3dB/0dB/3dB/6dB/9dB/12dB/1
8dB/24dB/30dB/ 
36dB/42dB

Wahl des Verstärkungswerts für die M-Position 
des GAIN-Schalters.

Gain<H> –3dB/0dB/3dB/6dB/ 
9dB/12dB/18dB/24dB/30dB/ 
36dB/42dB

Wahl des Verstärkungswerts für die H-Position des 
GAIN-Schalters.

Gain <Turbo> –3dB/0dB/3dB/6dB/ 
9dB/12dB/18dB/24dB/30dB/ 
36dB/42dB

Wahl des Verstärkungswertes, wenn einem 
belegbaren Schalter die Turbo Gain-Funktion 
zugeordnet ist.

Operation >Gain Switch
Zum Einstellen des Verstärkungswertschalters.

Menüpunkt Einstellung Beschreibung

Shockless Gain On/Off Ein- oder Ausschalten von Shockless Gain (einer 
Funktion, die das nahtlose Umschalten der 
Verstärkung ermöglicht).

Operation >Auto Iris
Zum Einstellen der Blendenautomatik.

Menüpunkt Einstellung Beschreibung

Iris Override On/Off Schaltet die Blendenkorrektur (Einstellung, bei der 
die Blende weiter als normal geöffnet bzw. 
geschlossen wird) ein bzw. aus.

Mode Backlight/Standard/Spotlight Wahl des Steuermodus für die Blendenautomatik.
Backlight: Gegenlichtmodus (Modus für 

verringerte Verdunkelung eines Motivs bei 
Gegenlicht)

Standard: Standardmodus (kann nicht bei 
Verwendung der optionalen Fernbedienung 
ausgewählt werden)

Spotlight: Punktlichtmodus (Modus für verringerte 
Überbelichtungen eines Motivs bei 
Punktlicht)

Level –99 bis ±0 bis +99 Zum Einstellen des Ziel-Konvergenzwerts (höhere 
Werte erhöhen die Helligkeit.)

Speed –99 bis ±0 bis +99 Zum Einstellen der Geschwindigkeit der 
Steuerung (die Geschwindigkeit der Reaktion auf 
Veränderungen im Videobild). (Größere Werte 
stehen für schnellere Reaktionszeiten.)

Clip High light On/Off Schaltet die Funktion, die Überbelichtungen der 
hellsten Bereiche ignoriert, um flacher auf 
extreme Helligkeit zu reagieren, ein/aus.

Detect Window 1/2/3/4/5/6/Var Wahl des Typs des Erkennungsfensters für die 
Blendenautomatik.
Var: Variable

Detect Window 
Indication

On/Off Schaltet die Funktion, die das Erkennungsfenster 
für die Blendenautomatik mit einem Marker 
anzeigt, ein bzw. aus.

Iris APL Ratio –99 bis ±0 bis +99 Wenn der Blendenautomatikmodus Standard 
eingestellt ist, legt diese Funktion das 
Mischungsverhältnis von Spitzenwert zu 
Mittelwert für die Blendenautomatik fest.

Iris Var Width 40 bis 500 bis 999 Zum Einstellen der Breite des Erkennungsfensters, 
wenn Iris Window auf Var eingestellt ist.
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Operation >Auto Iris
Zum Einstellen der Blendenautomatik.

Menüpunkt Einstellung Beschreibung

Iris Var Height 70 bis 500 bis 999 Zum Einstellen der Höhe des Erkennungsfensters, 
wenn Iris Window auf Var eingestellt ist.

Iris Var H Position –479 bis 0 bis 479 Zum Einstellen der horizontalen Position des 
Erkennungsfensters, wenn Iris Window auf Var 
eingestellt ist.

Iris Var V Position –464 bis 0 bis 464 Zum Einstellen der vertikalen Position des 
Erkennungsfensters, wenn Iris Window auf Var 
eingestellt ist.

Operation >Zebra
Zum Einstellen der Anzeige von Streifenmustern.

Menüpunkt Einstellung Beschreibung

Zebra Select 1/2/Beide Wahl des gewünschten Streifenmusters (Zebra1, 
Zebra2, beide).

Zebra1 Level 50% bis 70% bis 107% Zum Einstellen des Anzeigepegels für Zebra 1.

Zebra1 Aperture Level 1% bis 10% bis 20% Zum Einstellen der Blendenöffnung für Zebra 1.

Zebra2 Level 52% bis 100% bis 109% Zum Einstellen des Anzeigepegels für Zebra 2.

Operation >Display On/Off
Wahl der Punkte, die im Sucher angezeigt werden.

Menüpunkt Einstellung Beschreibung

Video Level Warning On/Off Schalten Sie die Warnanzeige bei zu hellem oder 
zu dunklem Videopegel ein bzw. aus.

Shutter Setting On/Off Schaltet die Anzeige von Blendenmodus und 
Belichtungszeit ein bzw. aus.

ND Filter Position On/Off Schaltet die Anzeige der ND-Filter-Einstellung ein 
bzw. aus.

Gain Setting On/Off Schaltet die Anzeige der Verstärkungseinstellung 
ein bzw. aus.

Rec/Play Status On/Off Schaltet die Anzeigen für Aufzeichnung und 
Wiedergabe ein/aus.

Color Temp. On/Off Schaltet die Farbtemperaturanzeige ein bzw. aus.

Frame Rate/Interval On/Off Schaltet die Anzeige des 
Spezialaufzeichnungsmodus ein bzw. aus.

Operation >Display On/Off
Wahl der Punkte, die im Sucher angezeigt werden.

Menüpunkt Einstellung Beschreibung

Battery Remain Auto/Voltage/Off Dient zum Festlegen des Modus der Anzeigen der 
verbleibenden Batteriekapazität und der 
Eingangsspannung.
Auto: Die verbleibende Kapazität wird 

entsprechend dem Batterietyp angezeigt.
Voltage: Die Eingangsspannung wird unabhängig 

vom Batterietyp angezeigt.
Off: Keine Anzeige.

Timecode On/Off Schaltet die Anzeige der Zeitdaten (Zeitcode, 
Benutzerbits, Zähler, Dauer) ein bzw. aus.

Audio Level Meter On/Off Schaltet die Anzeige des Lautstärkepegels ein 
bzw. aus.

Media Status On/Off Schaltet die Statusanzeige des Mediums ein bzw. 
aus.

SD Card(Utility) On/Off Chaltet die Anzeige für die SD-Karte (Utility) ein 
bzw. aus.

Focus Position Meter/Feet/Off Schaltet die Anzeige der Fokusposition des 
Objektivs ein bzw. aus und wählt die 
Anzeigeeinheiten.

Iris Position On/Off Schaltet die Blendenpositionsanzeige des 
Objektivs ein bzw. aus.

Zoom Position On/Off Schaltet die Zoompositionsanzeige des Objektivs 
ein bzw. aus.

Extender On/Off Schaltet die Anzeige des Objektivs und des 
Konverters ein/aus.

ALAC On/Off Schaltet die Anzeige des Objektiv-Aberrations-
Ausgleichs ein/aus.

AE Mode On/Off Schaltet die Anzeige des AE-Modus und des 
AE-Werts ein bzw. aus.

Focus Mode On/Off Schaltet die Fokusmodus-Anzeige ein bzw. aus.

White Balance Mode On/Off Schaltet die Anzeige des Weißabgleichmodus ein 
bzw. aus.

CC5600K On/Off Schaltet die CC5600K-Anzeige ein bzw. aus.

Rec Format On/Off Schaltet die Anzeige des Aufzeichnungsformats 
ein bzw. aus.

Gamma On/Off Schaltet die Anzeige des ausgewählten Gamma-
Typs ein bzw. aus.

Timecode Lock On/Off Schaltet die Zeitcode-Anzeige ein bzw. aus.
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Operation >Display On/Off
Wahl der Punkte, die im Sucher angezeigt werden.

Menüpunkt Einstellung Beschreibung

Network Condition On/Off Schaltet die Anzeige des 
Netzwerkverbindungsstatus ein bzw. aus.

Proxy Status On/Off Schaltet die Anzeige des Proxystatus ein bzw. aus.

NW Client Mode Status On/Off Schaltet die Anzeige des Netzwerkclientmodus 
ein bzw. aus.

Streaming Status On/Off Schaltet die Streaming-Übertragung ein/aus.

GPS On/Off Schaltet die Anzeige des GPS-Empfangsstatus ein 
bzw. aus.

Video Signal Monitor Off/Waveform/Vector/Histogram Schaltet die Statusanzeige des 
Ausgangsvideosignals ein/aus und wählt den Typ 
des anzuzeigenden Videosignals (Seite 18).

[Hinweis]
Unter folgenden Umständen wird diese Option nicht 
angezeigt.
Wenn „Operation >Input/Output >SDI Out1 Select“ 
und „SDI Out2 Select“ im Konfigurationsmenü auf „Off“ 
gesetzt sind. 
Wenn „Operation >Input/Output >Output Format“ 
im Konfigurationsmenü auf 720×480P oder 720×576P 
gesetzt ist.

Clip Name On/Off Schaltet die Anzeige des Clipnamen ein bzw. aus.

Focus Assist Indicator On/Off Schaltet die Fokus-Assist-Anzeige ein bzw. aus.

Focus Area Marker On/Off Schaltet die Fokusbereichsmarkierung ein bzw. 
aus.

Lens Info Meter/Feet/Off Wählt aus, ob Schärfentiefe und Einheiten 
angezeigt werden sollen.

WRR RF Level On/Off Schaltet die Anzeige des Empfangsstatus des 
drahtlosen Tuners ein bzw. aus.

Clip Number On/Off Schaltet die Anzeige der Clipinformationen ein 
bzw. aus.

Operation >"!"LED
Zum Einstellen der Anzeige „!“ im Sucher. (Aktiviert bei Verwendung des HDVF-20A).

Menüpunkt Einstellung Beschreibung

Gain <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn die Verstärkung auf 
einem anderen Wert als 0 dB steht.

Shutter <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn der Schalter 
SHUTTER auf ON steht.

Operation >"!"LED
Zum Einstellen der Anzeige „!“ im Sucher. (Aktiviert bei Verwendung des HDVF-20A).

Menüpunkt Einstellung Beschreibung

White Preset <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn der Schalter WHITE 
BAL auf PRST steht.

ATW Run <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn ATW verwendet 
wird.

Extender <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn die digitale 
Konverterfunktion oder der Objektiv-Konverter 
verwendet wird.

Filter <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn der ND-Filter auf 
einem anderen Wert als 1 steht.

Iris Override <!> On/Off Schaltet die Funktion zum Beleuchten der 
Anzeige ! ein bzw. aus, wenn das Überschreiben 
der Blendenautomatik nicht auf Standard steht.

Operation >White Setting
Einstellung des Weißabgleichs.

Menüpunkt Einstellung Beschreibung

White Switch<B> Memory/ATW Zum Einstellen des Betriebsmodus, der vom 
WHITE BAL-Schalter in Position B ausgewählt wird.
Memory: Automatischer Weißabgleich
ATW: ATW-Modus (Automatische 

Weißwertanpassung)
Shockless White Off/1/2/3 Wahl der Übergangsdauer, wenn die Einstellung 

am WHITE BAL-Schalter verändert wird (1 = 
schnellste).

ATW Speed 1/2/3/4/5 Wahl der Überblendungsgeschwindigkeit der 
automatischen Weißwertanpassung (ATW, 1 = 
schnellste).

ATW Mode Natural/Pure Zum Einstellen des ATW-Modus (automatische 
Weißwertanpassung).
Natural:‌� Stellt ATW automatisch so ein, dass die 

Szene naturgetreu entsprechend der 
Beleuchtung wiedergegeben wird.

Pure:‌� Stellt ATW automatisch so ein, dass die 
Szene ohne Blau- oder Rotstich näher an den 
Primärfarben wiedergegeben wird.

AWB Fixed Area On/Off Führt den automatischen Weißabgleich für die 
Bildschirmmitte aus.
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Operation >White Setting
Einstellung des Weißabgleichs.

Menüpunkt Einstellung Beschreibung

Filter White Memory On/Off Zum Einstellen des Weißabgleich-
Speicherbereichs für jede Positionsnummer des 
FILTER-Reglers, wenn White Balance auf Preset 
oder ATW gesetzt ist.

ˎˎ Wenn einem belegbaren Schalter Electrical CC 
zugeordnet ist, werden hiermit unabhängige 
Weißabgleich-Speicherbereiche für die 
Einstellungen Electrical CC A, B, C und D 
eingestellt.

ˎˎ Wenn Electrical CC keinem belegbaren Schalter 
zugeordnet ist, werden hiermit Weißabgleich-
Speicherbereiche für alle Positionsnummern 
des Reglers FILTER eingestellt.

Operation >Offset White
Einstellen der Weißabgleich-Abweichwerte.

Menüpunkt Einstellung Beschreibung

Offset White<A> On/Off Legt fest, ob dem Weißabgleich in Speicher A ein 
Abweichwert hinzugefügt wird (On) oder nicht 
(Off).

Warm Cool <A> Ungefähre 
Farbtemperaturanzeige
(Ca. 1600 K bis 3200 K bis 
16000 K)

Wenn „Offset White<A>“ auf On gesetzt ist, kann 
hier der Abweichwert (als Farbtemperatur) 
eingestellt werden, der dem Weißabgleichswert 
in Speicher A hinzugefügt werden soll. (Beachten 
Sie, dass der Fehlerbereich bei höherer 
Abweichung der Farbtemperaturen größer wird. 
Anpassung beim Anschauen des tatsächlichen 
Bilds.)

Warm Cool 
Balance<A>

–99 bis ±0 bis +99 Hier stellen Sie eine präzisere Farbtemperatur für 
den Fall ein, dass mit der Einstellung „Warm Cool 
<A>“ kein zufriedenstellendes Ergebnis erzielt 
wird.

Offset White <B> On/Off Wenn diese Einstellung aktiviert ist, wird der hier 
eingestellte Abweichwert zum Weißabgleich von 
Kanal B hinzugefügt.

Operation >Offset White
Einstellen der Weißabgleich-Abweichwerte.

Menüpunkt Einstellung Beschreibung

Warm Cool <B> Ungefähre 
Farbtemperaturanzeige
(Ca. 1600 K bis 3200 K bis 
16000 K)

Wenn „Offset White<B>“ auf On gesetzt ist, kann 
hier der Abweichwert (als Farbtemperatur) 
eingestellt werden, der dem Weißabgleichswert 
in Speicher A hinzugefügt werden soll. (Beachten 
Sie, dass der Fehlerbereich bei höherer 
Abweichung der Farbtemperaturen größer wird. 
Anpassung beim Anschauen des tatsächlichen 
Bilds.)

Warm Cool 
Balance<B>

–99 bis ±0 bis +99 Hier stellen Sie eine präzisere Farbtemperatur für 
den Fall ein, dass mit der Einstellung „Warm Cool 
<B>“ kein zufriedenstellendes Ergebnis erzielt 
wird.

Operation >Shutter
Zum Einstellen des Blendenmodus.

Menüpunkt Einstellung Beschreibung

Mode Speed/Angle Wahl des Betriebsmodus für die elektronische 
Blende.
Speed: Zum Einstellen der Belichtungszeit als 

Zeitdauer (Einheiten: Sekunden).
Angle: Zum Einstellen der Belichtungszeit als 

Winkel (Einheiten: Grad).

Operation >Slow Shutter
Zum Einstellen des langsamen Verschlusses.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet den langsamen Blendenverschluss ein 
bzw. aus

Number of Frames 2/3/4/5/6/7/8/16 Zum Einstellen der Anzahl der akkumulierten 
Einzelbilder für den langsamen Blendenverschluss

Operation >Time Zone
Zum Einstellen der Zeitzone.

Menüpunkt Einstellung Beschreibung

Time Zone UTC + 14:00 bis UTC Greenwich 
bis UTC – 12:00

Wahl des Unterschieds zur UTC (Greenwich Mean 
Time) in 30-Minuten-Einheiten.
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Operation >Clip
Einstellungen für Clipnamen und -verwaltung.

	 [Hinweis]
Weisen Sie keine Clipnamen zu, die mit dem Symbol „.“ (Punkt) beginnen. Clips mit Namen, bei denen das erste Zeichen 
„.“ ist, können nicht in der Anwendungssoftware auf einem Computer betrachtet werden.

Menüpunkt Einstellung Beschreibung

Clip Naming Title/Plan Wahl des Formats für den Clipnamen.
Title: Durch Titelpräfix festgelegter Name.
Plan: In den Planungsmetadaten festgelegter 

Name (wenn in den Planungsmetadaten kein 
Name festgelegt wurde, wird der durch 
Titelpräfix festgelegte Name verwendet.)

Title Prefix Text input Hier kann ein Teil des Titels (4 bis 46 
alphanumerische Zeichen) von Clip-Titeln mithilfe 
eines Eingabebildschirms (Seite 92) festgelegt 
werden.

Number Set Einstellungen variieren je nach 
der Einstellung für Clip Naming.

Zum Einstellen des numerischen Teils des 
Clipnamens.
Falls für „Clip Naming“ die Option „Title“ gewählt 

wurde: 
0001 bis 9999

Falls für „Clip Naming“ die Option „Plan“ gewählt 
und eine Planungsmetadaten-Datei geladen 
wurde: 
00001 bis 99999

Operation >Update Media
Aktualisiert die Verwaltungsdatei des Mediums.

	 [Hinweis]
Diese Funktion ist nicht verfügbar, wenn das Dateisystem auf FAT eingestellt ist.

Menüpunkt Einstellung Beschreibung

Media (A) Execute/Cancel Aktualisiert die Verwaltungsinformationen der 
SxS-Speicherkarte in Einschub A (ausführen durch 
Wahl von „Execute“).

Media (B) Execute/Cancel Aktualisiert die Verwaltungsinformationen der 
SxS-Speicherkarte in Einschub B (ausführen durch 
Wahl von „Execute“).

Operation >GPS
Schaltet Ortsinformationen (GPS) ein bzw. aus.

Menüpunkt Einstellung Beschreibung

GPS On/Off Schaltet die GPS-Funktion ein bzw. aus

Operation >Planning Metadata
Einstellungen im Zusammenhang mit Planungsmetadaten-Funktionen

Menüpunkt Einstellung Beschreibung

Load Media (A) Execute/Cancel Lädt Planungsmetadaten von der SxS-
Speicherkarte in Einschub A.
Führen Sie diesen Befehl aus, um die Liste der auf 
der SxS-Speicherkarte in Einschub A abgelegten 
Planungsmetadaten-Dateien anzuzeigen. Wählen 
Sie eine Datei, um den Eigenschaftenbildschirm 
anzuzeigen.

[Hinweis]
Diese Option wird nicht angezeigt, wenn das 
Dateisystem auf FAT eingestellt ist.

Load Media (B) Execute/Cancel Lädt Planungsmetadaten von der SxS-
Speicherkarte in Einschub B.
Führen Sie diesen Befehl aus, um die Liste der auf 
der SxS-Speicherkarte in Einschub B abgelegten 
Planungsmetadaten-Dateien anzuzeigen. Wählen 
Sie eine Datei, um den Eigenschaftenbildschirm 
anzuzeigen.

[Hinweis]
Diese Option wird nicht angezeigt, wenn das 
Dateisystem auf FAT eingestellt ist.

Properties Execute/Cancel Zeigt den Inhalt der im Camcorder geladenen 
Planungsmetadaten an (ausführen durch Wahl 
von „Execute“).

Clear Memory Execute/Cancel Löscht die im Camcorder geladenen 
Planungsmetadaten (ausführen durch Wahl von 
„Execute“).

Clip Name Disp Title1(ASCII)/Title2(UTF-8) Wahl des Anzeigeformats, wenn der Clipname in 
den Planungsmetadaten angegeben ist 
(Seite 59).

Operation >USB
Einstellungen zum Kopieren von Clips von dem in einen SxS-Karteneinschub des Camcorders eingesetzten 
Speichermedium auf USB-Medien.

Menüpunkt Einstellung Beschreibung

Select Folder Zur Auswahl eines Ordners auf dem USB-Medium.
Zum Erstellen eines neuen Ordners auf dem 
USB-Medium.

View Clip List Zeigt eine Liste der Clips auf dem USB-Medium 
an.

Rename Folder Zum Umbenennen eines Ordners auf dem 
USB-Medium.
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Operation >USB
Einstellungen zum Kopieren von Clips von dem in einen SxS-Karteneinschub des Camcorders eingesetzten 
Speichermedium auf USB-Medien.

Menüpunkt Einstellung Beschreibung

Error Check On/Off Legt fest, ob beim Kopieren von Clips von dem in 
einen SxS-Karteneinschub des Camcorders 
eingesetzten Speichermedium auf USB-Medien 
eine Fehlerprüfung ausgeführt werden soll.

Format USB Execute/Cancel Zum Formatieren des USB-Mediums (ausführen 
durch Wahl von „Execute“).

Copy to USB Media(A) to USB/
Media(B) to USB/
Media(A)(B) to USB

Zur Auswahl des Zielsteckplatzes beim Kopieren 
aller Clips aus einem SxS-Kartensteckplatz.
Media(A) to USB: Kopiert alle Clips von dem in 

Einschub A eingesetzten Speichermedium.
Media(B) to USB: Kopiert alle Clips von dem in 

Einschub B eingesetzten Speichermedium.
Media(A)(B) to USB: Kopiert alle Clips von den in 

Einschub A und B eingesetzten 
Speichermedien.

Media Remain (Freier Speicherplatz: numerische 
Anzeige und Balkenanzeige)

Zeigt den verbleibenden freien Speicherplatz auf 
dem USB-Medium an.

Operation >Flash Band Reduce
Korrigiert Flashbands.

[Hinweis]
Dieser Punkt ist während der Aufnahme und wenn „Slow&Quick“ auf „On“ gesetzt ist, deaktiviert (grau angezeigt).

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Flashband-Reduzierung.

[Hinweise]
ˎˎ Wenn „Flash Band Reduce“ ein- bzw. ausgeschaltet 

wird, kann es zeitweise durch die Unterbrechung des 
Video- und Audiosignals zum Auftreten von Rauschen 
kommen.
ˎˎ Auch wenn die Option „Flash Band Reduce“ auf „On“ 

gestellt wird, ist die Funktion nicht verfügbar, wenn 
der Schalter SHUTTER auf „ON“ steht.
ˎˎ Die Einstellung kehrt nach dem Ausschalten des 

Geräts zum Standardwert zurück.

Menü „Paint“

Standardwerte sind unterstrichen und fett formatiert.

Paint >Switch Status
Ein- bzw. Ausschalten verschiedener Korrekturfunktionen und des Testsignals.

Menüpunkt Einstellung Beschreibung

Gamma On/Off Ein- oder Ausschalten der Gammafunktion.

Black Gamma On/Off Ein- oder Ausschalten der 
Schwarzgammafunktion.

Matrix On/Off Ein- oder Ausschalten der Matrixfunktion.

Knee On/Off Ein- bzw. Ausschalten der Kniefunktion.

White Clip On/Off Ein- oder Ausschalten der Weiß-
Amplitudenbegrenzungsfunktion.

[Hinweis]
Wenn diese Option auf Off gesetzt ist, wird sie beim 
nächsten Einschalten auf On zurückgestellt.

Detail On/Off Ein- bzw. Ausschalten der Detailfunktion.

Aperture On/Off Ein- bzw. Ausschalten der Blendenfunktion.

Flare On/Off Ein- bzw. Ausschalten der 
Streulichtkorrekturfunktion.

Test Saw On/Off Ein- bzw. Ausschalten des Testsignals.

Paint >White
Einstellen der Farbtemperatur und manueller Weißabgleich.

Menüpunkt Einstellung Beschreibung

Color Temp <A> 1500K bis 3200K bis 50000K Zeigt die in Speicher A gespeicherte 
Farbtemperatur des Weißabgleichs.

Color Temp Balance 
<A>

–99 bis ±0 bis +99 Zum Einstellen des in Speicher A gespeicherten 
Weißabgleichs-Verstärkungswerts (verknüpfte mit 
R-Verstärkung und B-Verstärkung).

R Gain <A> –99 bis ±0 bis +99 Zum Einstellen des in Speicher A gespeicherten 
R-Verstärkungswerts des Weißabgleichs.

B Gain <A> –99 bis ±0 bis +99 Zum Einstellen des in Speicher A gespeicherten 
B-Verstärkungswerts des Weißabgleichs.

Color Temp <B> 1500K bis 3200K bis 50000K Zeigt die in Speicher B gespeicherte 
Farbtemperatur des Weißabgleichs an.

Color Temp Balance 
<B>

–99 bis ±0 bis +99 Zum Einstellen der in Speicher B gespeicherten 
Verstärkungswerte des Weißabgleichs (verknüpfte 
R-Verstärkung und B-Verstärkung).
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Paint >White
Einstellen der Farbtemperatur und manueller Weißabgleich.

Menüpunkt Einstellung Beschreibung

R Gain <B> –99 bis ±0 bis +99 Zum Einstellen des in Speicher B gespeicherten 
R-Verstärkungswerts des Weißabgleichs.

B Gain <B> –99 bis ±0 bis +99 Zum Einstellen des in Speicher B gespeicherten 
B-Verstärkungswerts des Weißabgleichs.

Paint >Black
Zum Einstellen des Schwarzpegels (Bildfarbe ohne Beleuchtung).
Sie erzielen den gewünschten Look durch Anpassen des Schwarzpegels für tiefere oder blassere 
Schwarztöne.

Menüpunkt Einstellung Beschreibung

Master Black –99 bis ±0 bis +99 Zum Einstellen des Master-Schwarzpegels.

R Black –99 bis ±0 bis +99 Zum Einstellen des Schwarzpegels der R-Signale.

B Black –99 bis ±0 bis +99 Zum Einstellen des Schwarzpegels der B-Signale.

Paint >Flare
Einstellungen für die Streulichtkorrektur.
Streulicht ist ein Phänomen, bei dem sich aufgrund der Auswirkungen der hellen Bereiche im Bild die 
Videohelligkeit des gesamten Bilds erhöht, die dunkleren Regionen heller erscheinen und der Kontrast 
verringert wird. Dies wird durch reflektiertes Licht im Objektiv verursacht.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der 
Streulichtkorrekturfunktion.

Master Flare –99 bis ±0 bis +99 Stellen Sie den Hauptstreulicht-Korrekturpegel 
ein.

R Flare –99 bis ±0 bis +99 Stellen Sie den Streulicht-Korrekturpegel der 
R-Signale ein.

G Flare –99 bis ±0 bis +99 Stellen Sie den Streulicht-Korrekturpegel der 
G-Signale ein.

B Flare –99 bis ±0 bis +99 Stellen Sie den Streulicht-Korrekturpegel der 
B-Signale ein.

Paint >Gamma
Einstellen der Gammakorrektur.
Mithilfe der Gammakorrektur können Sie den Kontrast des Bildes und damit seinen Eindruck erheblich 
ändern.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der 
Gammakorrekturfunktion.

Step Gamma 0.35 bis 0.45 bis 0.90
(in Schritten von 0.05)

Regelt den Gammakorrekturwert in 0,05-Schritten.

Paint >Gamma
Einstellen der Gammakorrektur.
Mithilfe der Gammakorrektur können Sie den Kontrast des Bildes und damit seinen Eindruck erheblich 
ändern.

Menüpunkt Einstellung Beschreibung

Master Gamma –99 bis ±0 bis +99 Regelt den Master-Gammapegel.

R Gamma –99 bis ±0 bis +99 Regelt den R-Gammapegel.

G Gamma –99 bis ±0 bis +99 Regelt den G-Gammapegel.

B Gamma –99 bis ±0 bis +99 Regelt den B-Gammapegel.

Gamma Category STD/HG/User Wählt die Gammakategorie.
STD: Standard-Gammakurve für Videosignale
HG: Gammakurve, die die Gradation und 

Farbreproduktion von Aufnahmen mit Film 
imitiert

User: Mit CvpFileEditorTM V4.2 erstellte, 
benutzerdefinierte Gammakurve

Gamma Select Einstellungen variieren je nach 
der Einstellung für die 
Gammakategorie.

Auswahl der Gammatabelle für die 
Gammakorrektur.

Wenn Gamma Category STD ist:
STD1 DVW: DVW-Camcorder-Äquivalent
STD2 x4.5: 4,5-fache Verstärkung
STD3 x3.5: 3,5-fache Verstärkung
STD4 240M: SMPTE-240M-Äquivalent
STD5 R709: ITU-R709-Äquivalent
STD6 x5.0: 5,0-fache Verstärkung

Wenn Gamma Category HG ist:
HG1 3250G36: 325%-ige Videoeingabe zu 100%-iger Videoausgabe komprimieren.
HG2 4600G30: 460%-ige Videoeingabe zu 100%-iger Videoausgabe komprimieren.
HG3 3259G40: 325%-ige Videoeingabe zu 109%-iger Videoausgabe komprimieren.
HG4 4609G33: 460%-ige Videoeingabe zu 109%-iger Videoausgabe komprimieren.

Wenn Gamma Category User ist:
User 1: In User1 registrierte Gammatabelle
User 2: In User2 registrierte Gammatabelle
User 3: In User3 registrierte Gammatabelle
User 4: In User4 registrierte Gammatabelle
User 5: In User5 registrierte Gammatabelle
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Paint >Black Gamma
Einstellen der Schwarzgammakorrektur.
Mit der Schwarzgammakorrektur können Sie Gradationen und Farben in schwarzen oder beinahe 
schwarzen (dunklen) Teilen des Bildes abbilden.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der 
Schwarzgammakorrekturfunktion.

[Hinweis]
Zum Aktivieren der Schwarzgammakorrekturfunktion 
setzen Sie „Saturation Mode“ auf „Low Key“.

Range Low/L.Mid/H.Mid Wahl des Messbereichs der 
Schwarzgammakorrekturfunktion.
Low: 0 bis 3,6%
L.Mid: 0 bis 7,2%
H.Mid: 0 bis 14,4%

Master Black Gamma –99 bis ±0 bis +99 Zum Einstellen des Master-Schwarzgammapegels.

Paint >Knee
Einstellen der Kniekorrektur.
Mit der Kniekorrektur werden Überbelichtungen verhindert, indem die hellen Teile des Bildes in Reaktion 
auf die Obergrenze für den Dynamikbereich des aufgezeichneten und ausgegebenen Bildes komprimiert 
werden. Der Signalpegel, bei dem die Kniebearbeitung beginnt, heißt „Knee Point“, und die 
Kompressionsrate wird „Knee Slope“ genannt.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Kniekorrekturfunktion.

Point 75% bis 95% bis 109% Zum Einstellen des Kniepunkts, wenn die DCC-
Funktion ausgeschaltet ist.

Slope –99 bis ±0 bis +99 Zum Einstellen der Kompressionsrate, wenn die 
DCC-Funktion ausgeschaltet ist.

Knee Saturation On/Off Ein- bzw. Ausschalten der Kniesättigungsfunktion.

[Hinweis]
Zum Aktivieren der Kniesättigungsfunktion setzen Sie 
„Saturation Mode“ auf „Knee“.

Knee Saturation Level –99 bis ±0 bis +99 Zum Einstellen des Kniesättigungspegels.

Paint >White Clip
Einstellung der Weiß-Amplitudenbegrenzung.
Mithilfe der Weiß-Amplitudenbegrenzung wird der Höchstpegel der Videoausgangssignale begrenzt. Der 
maximale Videosignal-Ausgabewert heißt „Weiß-Amplitudenbegrenzungspegel“.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Weiß-
Amplitudenbegrenzungsfunktion.

Paint >White Clip
Einstellung der Weiß-Amplitudenbegrenzung.
Mithilfe der Weiß-Amplitudenbegrenzung wird der Höchstpegel der Videoausgangssignale begrenzt. Der 
maximale Videosignal-Ausgabewert heißt „Weiß-Amplitudenbegrenzungspegel“.

Menüpunkt Einstellung Beschreibung

Level 90.0% bis 109.0%
Die Standardeinstellung variiert 
je nach Einstellung der 
Systemfrequenz.

Regelt den Weiß-Amplitudenbegrenzungspegel.
Die Standardeinstellung ist 108,0%, wenn die 
Systemfrequenz 59,94; 29,97; 24 oder 23,98 
beträgt. Die Standardeinstellung ist 105,0%, wenn 
die Systemfrequenz 50,25 beträgt.

Paint >Detail/Detail(SD)
Einstellen der Detailanpassung im HD- und SD-Modus.
Mithilfe der Detailanpassung wird die Klarheit der Bilder durch Hinzufügen von Detailsignalen zu den 
Umrissen des Motivs verbessert.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der 
Detailanpassungsfunktion.

Level –99 bis ±0 bis +99 Einstellung des Detailpegels

H/V Ratio –99 bis ±0 bis +99 Zum Einstellen des Mischungsverhältnisses 
zwischen dem H-Detailpegel und dem 
V-Detailpegel.

Crispening –99 bis ±0 bis +99 Zum Einstellen des Kantenkorrekturpegels.

Level Depend On/Off Schaltet die Pegelabhängigkeits-Einstellfunktion 
ein/aus.

Level Depend Level –99 bis ±0 bis +99 Zum Einstellen des Werts für die 
Pegelabhängigkeit.

Frequency –99 bis ±0 bis +99 Zum Einstellen der Mittenfrequenz des 
H-Detailsignals (größere Werte ergeben feinere 
Details).

Knee Aperture On/Off Schaltet die Knieöffnungskorrekturfunktion ein 
bzw. aus.

Knee Aperture Level –99 bis ±0 bis +99 Zum Einstellen des Knieöffnungspegels.

Limit –99 bis ±0 bis +99 Zum Einstellen des Detailbegrenzers für die 
Richtungen Weiß und Schwarz.

White Limit –99 bis ±0 bis +99 Zum Einstellen des Weiß-Detailbegrenzerwerts.

Black Limit –99 bis ±0 bis +99 Zum Einstellen des Schwarz-
Detailbegrenzerwerts.

V Black Limit –99 bis ±0 bis +99 Zum Einstellen des V-Detailbegrenzerwerts für 
Schwarz.
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Paint >Detail/Detail(SD)
Einstellen der Detailanpassung im HD- und SD-Modus.
Mithilfe der Detailanpassung wird die Klarheit der Bilder durch Hinzufügen von Detailsignalen zu den 
Umrissen des Motivs verbessert.

Menüpunkt Einstellung Beschreibung

V Detail Creation NAM/Y/G/G+R Auswahl des Quellensignals zur Generierung des 
V-Detailsignals.
NAM: Ein aus dem R-Signal oder aus dem G-Signal 

oder aus dem B-Signal erzeugtes 
V-Detailsignal, je nachdem, welches Signal 
den höchsten Pegel hat

Y: Y-Signal
G: G-Signal
G+R: Gemischtes Signal bestehend aus dem G- 

und dem R-Signal im Verhältnis 1:1
Cross Color Suppress 
(SD mode)

–99 bis ±0 bis +99 Zum Einstellen des Pegels der Cross-
Farbreduzierung des Details.

[Hinweis]
Diese Einstellung ist deaktiviert, wenn die 
Detailanpassungsfunktion ausgeschaltet ist, und wenn 
Operation Format Frequency im Konfigurationsmenü 
auf 50 oder 25 festgelegt ist.

Paint >Aperture
Einstellen der Öffnungskorrektur.
Die Öffnungskorrektur verbessert die Auflösung durch Hinzufügen von Hochfrequenz-Öffnungssignalen 
zum Videosignal, was die Verschlechterung aufgrund von Hochfrequenz-Eigenschaften korrigiert.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die Öffnungskorrekturfunktion ein bzw. 
aus.

Level –99 bis ±0 bis +99 Einstellung des Blendenöffnungspegels

Paint >Skin Detail
Einstellung der Oberflächenfarbdetail-Korrektur.
Mithilfe der Korrektur der Oberflächenfarbdetails kann die Detailstufe eines bestimmten Farbbereichs 
gesteigert oder gesenkt werden, um eine ästhetische Abbildung von Hauttönen zu erzielen.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die Oberflächenfarbdetailkorrektur ein 
bzw. aus.

Area Detection Execute/Cancel Zeigt einen Farberkennungsbildschirm zum 
Erkennen von Farben für die 
Oberflächenfarbdetailkorrektur an (ausführen 
durch Wahl von „Execute“.) 

Paint >Skin Detail
Einstellung der Oberflächenfarbdetail-Korrektur.
Mithilfe der Korrektur der Oberflächenfarbdetails kann die Detailstufe eines bestimmten Farbbereichs 
gesteigert oder gesenkt werden, um eine ästhetische Abbildung von Hauttönen zu erzielen.

Menüpunkt Einstellung Beschreibung

Area Indication On/Off Ein- bzw. Ausschalten der Anzeige eines 
Streifenmusters in den Zielbereichen der 
Oberflächenfarbdetailkorrektur.

Level –99 bis ±0 bis +99 Zum Einstellen des Oberflächenfarbdetailpegels.

Saturation –99 bis ±0 bis +99 Zum Einstellen des Sättigung der Zielfarbe der 
Oberflächenfarbdetailkorrektur.

Hue 0 bis 359 Zum Einstellen des Zielfarbtons der 
Oberflächenfarbdetailkorrektur.

Width 0 bis 40 bis 90 Zum Einstellen des Zielfarbtonbereichs der 
Oberflächenfarbdetailkorrektur.

Paint >Matrix
Einstellen der Matrixkorrektur.
Passt Farbton und Lebendigkeit des Bildes mit der Matrixkorrektur an.
Sie können aus einem unter „Preset Matrix“ vordefinierten Parametersatz eine Matrix auswählen, um einen 
bestimmten Zweck zu erfüllen. Sie können auch beliebige Parameter in einer „User Matrix“ definieren. 
Mithilfe der Funktion „Adaptive Matrix“ wird die Matrix so angepasst, dass die Reproduktion der Farben 
gesteuert wird.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Matrixkorrekturfunktion.

Adaptive Matrix On/Off Ein- oder Ausschalten der adaptiven 
Matrixfunktion.

Preset Matrix On/Off Ein- bzw. Ausschalten der voreingestellten 
Matrixfunktion.

Preset Select 1: SMPTE240M
2: ITU-709
3: SMPTE Wide
4: NTSC
5: EBU
6: PAL

Auswählen einer voreingestellten Matrix.
1: SMPTE240M: SMPTE-240M-Äquivalent
2: ITU-709: ITU-709-Äquivalent
3: SMPTE Wide: SMPTE WIDE-Äquivalent
4: NTSC: NTSC-Äquivalent
5: EBU: EBU-Äquivalent
6: PAL: PAL-Äquivalent

User Matrix On/Off Ein- bzw. Ausschalten der Benutzermatrix-
Korrekturfunktion.

Level –99 bis ±0 bis +99 Zum Einstellen der Sättigung der Farbe des 
gesamten Bildes.

Phase –99 bis ±0 bis +99 Zum Einstellen des Farbtons (Phase) des 
gesamten Bildes.

User Matrix R-G –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten R-G-
Benutzermatrix.
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Paint >Matrix
Einstellen der Matrixkorrektur.
Passt Farbton und Lebendigkeit des Bildes mit der Matrixkorrektur an.
Sie können aus einem unter „Preset Matrix“ vordefinierten Parametersatz eine Matrix auswählen, um einen 
bestimmten Zweck zu erfüllen. Sie können auch beliebige Parameter in einer „User Matrix“ definieren. 
Mithilfe der Funktion „Adaptive Matrix“ wird die Matrix so angepasst, dass die Reproduktion der Farben 
gesteuert wird.

Menüpunkt Einstellung Beschreibung

User Matrix R-B –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten R-B-
Benutzermatrix.

User Matrix G-R –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten G-R-
Benutzermatrix.

User Matrix G-B –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten G-B-
Benutzermatrix.

User Matrix B-R –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten B-R-
Benutzermatrix.

User Matrix B-G –99 bis ±0 bis +99 Zum Einstellen einer benutzerdefinierten B-G-
Benutzermatrix.

Paint >Multi Matrix
Einstellen der Multimatrixkorrektur.
Die Multimatrixkorrektur stellt die Sättigung in einem 16-Achsen-Farbtonbereich ein.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der 
Multimatrixkorrekturfunktion.

Area Indication On/Off Ein- bzw. Ausschalten der Anzeige eines 
Streifenmusters im Zielfarbbereich der 
Multimatrix-Korrektur.

Color Detection Execute/Cancel Zeigt einen Farberkennungsbildschirm zum 
Erkennen von Farben für die Multimatrixkorrektur 
an (ausführen durch Wahl von „Execute“.)

Reset Execute/Cancel Setzt Farbton und Sättigung auf allen Achsen auf 
die Standardwerte zurück (ausführen durch Wahl 
von „Execute“).

Axis B/B+/MG–/MG/MG+/R/R+/YL–/
YL/YL+/G–/G/G+/CY/CY+/B–

Zum Einstellen der Zielfarbe für die 
Multimatrixkorrektur (16-Achsenmodus)

Hue –99 bis ±0 bis +99 Zum Einstellen des Zielfarbtons der 
Multimatrixkorrektur für jeden der 16-Achsen-
Modi.

Saturation –99 bis ±0 bis +99 Zum Einstellen der Zielfarbsättigung der 
Multimatrixkorrektur für jeden der 16-Achsen-
Modi.

Paint >V Modulation
Einstellen der V Modulations-Schattierungskorrektur.
Die V-Modulation korrigiert das vertikale Ungleichgewicht bei der Empfindlichkeit, das aus der Beziehung 
zwischen Objektiv und Prisma entsteht.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die V Modulation ein bzw. aus.

Master V Modulation –99 bis ±0 bis +99 Zum Einstellen des Pegels der 
V-Hauptmodulation.

R V Modulation –99 bis ±0 bis +99 Zum Einstellen des V-Modulationspegels des 
R-Signals.

G V Modulation –99 bis ±0 bis +99 Zum Einstellen des V-Modulationspegels des 
G-Signals.

B V Modulation –99 bis ±0 bis +99 Zum Einstellen des V-Modulationspegels des 
B-Signals.

Paint >Low Key Saturation
Einstellen der Korrektur der Low Key-Sättigung.
Korrigiert die Farbsättigung in den dunklen Bereichen des Bildes.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Low Key-Sättigungs-
Korrekturfunktion.

[Hinweis]
Zum Aktivieren der Sättigung dunkler Farben setzen Sie 
„Saturation Mode“ auf „Low Key“.

Level –99 bis ±0 bis +99 Zum Einstellen der Farbsättigung in niedrigen 
Luminanzbereichen.

Range Low/L.Mid/H.Mid Wahl des Luminanzpegels, für den die Sättigung 
dunkler Farben aktiviert ist.

Paint >Saturation Mode
Einstellen der Sättigungskorrektur.

Menüpunkt Einstellung Beschreibung

Saturation Mode Knee/Low Key Wählt aus, ob die Sättigungsfunktion mit hohem 
(Knee) oder niedrigem Pegel (Low Key) arbeitet.

Knee Saturation On/Off Ein- bzw. Ausschalten der Kniesättigungsfunktion.

Black Gamma On/Off Ein- bzw. Ausschalten der 
Schwarzgammakorrekturfunktion.

Low Key Saturation On/Off Ein- bzw. Ausschalten der Low-
Kniesättigungsfunktion.
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Paint >Noise Suppression
Einstellen der Rauschunterdrückung (Rauschkompression).
Hiermit können Sie Rauschkomponenten wirksam unterdrücken und gleichzeitig Komponenten mit 
feinen Rändern im Motiv bewahren.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- bzw. Ausschalten der Rauschunterdrückung.

Level Low/Mid/High Wahl des Rauschunterdrückungspegels

Menü „Maintenance“

Standardwerte sind unterstrichen und fett formatiert.

Maintenance >White Shading
Einstellen der Weißschattierungskorrektur.
Die Weißschattierung ist für jedes Objektiv notwendig, um Luminanz- und Farbabweichungen in hellen 
Bereichen zu korrigieren, die mit den Objektiveigenschaften zusammenhängen.

Menüpunkt Einstellung Beschreibung

Channel Select Red/Green/Blue Wahl des Kanals für die Korrektur der 
Weißschattierung.

White H Saw –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Weißschattierung der horizontalen Richtung.

White H Para –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Weißschattierung der horizontalen Richtung.

White V Saw –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Weißschattierung der vertikalen Richtung.

White V Para –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Weißschattierung der vertikalen Richtung.

White Saw/Para On/Off Ein- bzw. Ausschalten der SAW-/Parabel-
Korrekturfunktion der Weißschattierung.

Maintenance >Black Shading
Einstellen der Schwarzschattierungskorrektur.

Menüpunkt Einstellung Beschreibung

Channel Select Red/Green/Blue Wahl des Kanals für die Korrektur der 
Schwarzschattierung.

Black H Saw –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Schwarzschattierung der horizontalen Richtung.

Black H Para –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Schwarzschattierung der horizontalen Richtung.

Black V Saw –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Schwarzschattierung der vertikalen Richtung.

Black V Para –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Schwarzschattierung der vertikalen Richtung.

Black Saw/Para On/Off Ein- bzw. Ausschalten der SAW-/Parabel-
Korrekturfunktion der Schwarzschattierung.

Master Black –99 bis ±0 bis +99 Zum Einstellen des Master-Schwarzpegels.

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Zum Einstellen eines temporären Haupt-
Verstärkungswerts.
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Maintenance >Battery
Einstellen der Batterieoptionen.

Menüpunkt Einstellung Beschreibung

Near End: Info Battery 5%/10%/15%...95%/100% Zum Einstellen des Grenzwerts, der die Warnung 
„Battery Near End“ anzeigt, wenn ein BP-FLX75/
GL65A/GL95A-Akkusatz verwendet wird.

End: Info Battery 0%/1%/2%/3%/4%/5% Zum Einstellen des Grenzwerts, der die Warnung 
„Battery End“ anzeigt, wenn ein BP-FLX75/GL65A/
GL95A-Akkusatz verwendet wird.

Near End: Sony Battery 11.5V bis 17V  
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery Near End“ anzeigt, wenn ein BP-L60S/
L80S-Akkusatz verwendet wird.

End: Sony Battery 11.0V bis 11.5V 
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery End“ anzeigt, wenn ein BP-L60S/L80S-
Akkusatz verwendet wird.

Near End: Other Battery 11.5V bis 11.8V bis 17.0V 
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery Near End“ anzeigt, wenn ein Akkusatz 
eines Fremdherstellers verwendet wird.

End: Other Battery 11.0V bis 14.0V 
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery End“ anzeigt, wenn ein Akkusatz eines 
Fremdherstellers verwendet wird.

Detected Battery Sony Info Battery/Sony Battery/ 
Other Battery/DC IN

Zeigt das Ergebnis der automatischen Erkennung 
des Akkusatztyps an.

Maintenance >DC Voltage Alarm
Zum Einstellen der Alarme im Zusammenhang mit der externen Gleichstromversorgungsspannung.

Menüpunkt Einstellung Beschreibung

DC Low Voltage1 11.5V bis 17V 
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery Near End“ anzeigt, wenn eine an den 
Anschluss DC IN angeschlossene externe 
Stromquelle verwendet wird.

DC Low Voltage2 11.0V bis 14.0V 
(in Schritten von 0.1V)

Zum Einstellen des Grenzwerts, der die Warnung 
„Battery End“ anzeigt, wenn eine an den 
Anschluss DC IN angeschlossene externe 
Stromquelle verwendet wird.

Maintenance >Audio
Einstellen der Audiosteuerung

Menüpunkt Einstellung Beschreibung

Front MIC Select Mono/Stereo Stellen Sie ein, ob das Frontmikrofon monaural 
(Mono) oder stereo (Stereo) ist.

Rear XLR Auto On/Off Schaltet die automatische Erkennung von 
Kabelverbindungen an den Anschlüssen AUDIO 
IN CH-1/CH-2 auf der Rückseite ein bzw. aus.

Maintenance >Audio
Einstellen der Audiosteuerung

Menüpunkt Einstellung Beschreibung

Front MIC CH1 Ref –70dB/–60dB/–50dB/–40dB/ 
–30dB

Auswahl des Referenzpegels des Frontmikrofons 
für Kanal 1.

Front MIC CH2 Ref –70dB/–60dB/–50dB/–40dB/ 
–30dB

Auswahl des Referenzpegels des Frontmikrofons 
für Kanal 2.

Rear MIC CH1 Ref –70dB/–60dB/–50dB/–40dB/ 
–30dB

Wahl des Referenzeingangspegels wenn der 
Schalter AUDIO IN CH1 auf MIC gesetzt ist.

Rear MIC CH2 Ref –70dB/–60dB/–50dB/–40dB/ 
–30dB

Wahl des Referenzeingangspegels wenn der 
Schalter AUDIO IN CH2 auf MIC gesetzt ist.

Line Input Ref +4dB/0dB/–3dB/EBUL Auswahl des Referenzeingangspegels wenn die 
Schalter AUDIO IN CH1 und AUDIO IN CH2 auf 
LINE gestellt sind.

Min Alarm Volume Off/Set Auswahl der Lautstärke, wenn der ALARM-Regler 
bis ganz nach unten geschoben wird.
Off: Unhörbar
Set: Hörbar

Speaker Attenuate Off/3dB/6dB/9dB/12dB Auswahl der Lautstärke des Monitors der 
Lautsprecher (hat keinen Einfluss auf die 
Kopfhörerlautstärke).

Headphone Out Mono/Stereo Wählen Sie aus, ob die Kopfhörer monaural 
(Mono) oder stereo (Stereo) sind.

Reference Level –20dB/–18dB/–16dB/–12dB/ 
EBUL

Stellt den Referenzeingangspegel ein. Stellt auch 
den Ausgangspegel des 1 kHz-Testsignals ein.

Reference Out +4dB/0dB/–3dB/EBUL Zum Einstellen des Ausgangspegels im Verhältnis 
zum Referenzeingangspegel.

CH1&2 AGC Mode Mono/Stereo Für die automatische Anpassung des 
Eingangspegels analoger Audiosignale, die auf 
den Kanälen 1 und 2 aufgezeichnet wurden, kann 
hier eingestellt werden, ob die Anpassungen 
separat für jeden Kanal (Mono) oder im 
Stereomodus (Stereo) vorgenommen werden 
sollen.

CH3&4 AGC Mode Mono/Stereo Für die automatische Anpassung des 
Eingangspegels analoger Audiosignale, die auf 
den Kanälen 3 und 4 aufgezeichnet wurden, kann 
hier eingestellt werden, ob die Anpassungen 
separat für jeden Kanal (Mono) oder im 
Stereomodus (Stereo) vorgenommen werden 
sollen.

AGC Spec –6dB/–9dB/–12dB/–15dB/–17dB Wahl der AGC-Eigenschaft (Sättigungspegel).
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Maintenance >Audio
Einstellen der Audiosteuerung

Menüpunkt Einstellung Beschreibung

Limiter Mode Off/–6dB/–9dB/–12dB/–15dB/ 
–17dB

Wahl der Begrenzer-Eigenschaft (Sättigungs-
Pegel) für große Eingangssignale, wenn der 
Audio-Eingangspegel manuell angepasst wird. 
Wählen Sie die Option Off, wenn Sie den 
Begrenzer nicht benutzen.

Output Limiter On/Off Ein- bzw. Ausschalten des 
Audioausgangsbegrenzers.

CH1 Wind Filter On/Off Ein- bzw. Ausschalten des Windfilters für Kanal 1.

CH2 Wind Filter On/Off Ein- bzw. Ausschalten des Windfilters für Kanal 2.

CH2 Wind Filter On/Off Ein- bzw. Ausschalten des Windfilters für Kanal 3.

CH4 Wind Filter On/Off Ein- bzw. Ausschalten des Windfilters für Kanal 4.

1kHz Tone on Color 
Bars

On/Off/Auto Stellen Sie ein, ob im Farbbalkenmodus ein 
1kHz-Testsignal ausgegeben werden soll (On) 
oder nicht (Off).
Auto: Ein Testsignal wird nur ausgegeben, wenn 

der Schalter AUDIO SELECT CH1 auf AUTO 
gestellt ist.

MIC CH1 Level Side1/Front/Front+Side1 Wahl des Reglers zur Einstellung des Audiopegels, 
wenn der Audioeingang des Frontmikrofons auf 
Kanal 1 aufgezeichnet wird.
Side1: LEVEL-Regler (links) an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side1: LEVEL-Regler (links) und MIC LEVEL-

Regler (verbundene Steuerung)
MIC CH2 Level Side2/Front/Front+Side2 Wahl des Reglers zur Einstellung des Audiopegels, 

wenn der Audioeingang des Frontmikrofons auf 
Kanal 2 aufgezeichnet wird.
Side2: LEVEL-Regler (rechts) an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side2: LEVEL-Regler (rechts) und MIC 

LEVEL-Regler (verbundene Steuerung)
Rear1/WRR Level Side1/Front/Front+Side1 Hier wählen Sie den Regler aus, mit dem der 

Audiopegel eines drahtlosen Mikrofons oder eines 
Geräts eingestellt wird, das an den Anschluss 
AUDIO IN CH-1 an der Rückseite angeschlossen 
ist.
Side1: LEVEL-Regler (links) an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side1: LEVEL-Regler (links) und MIC LEVEL-

Regler (verbundene Steuerung)

Maintenance >Audio
Einstellen der Audiosteuerung

Menüpunkt Einstellung Beschreibung

Rear2/WRR Level Side2/Front/Front+Side2 Hier wählen Sie den Regler aus, mit dem der 
Audiopegel eines drahtlosen Mikrofons oder eines 
Geräts eingestellt wird, das an den Anschluss 
AUDIO IN CH-2 an der Rückseite angeschlossen 
ist.
Side2: LEVEL-Regler (rechts) an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side2: LEVEL-Regler (rechts) und MIC 

LEVEL-Regler (verbundene Steuerung)
Audio CH3 Level Side3/Front/Front+Side3 Wahl des Reglers, mit dem der auf Kanal 3 

aufgezeichnete Audiopegel eingestellt wird.
Side3: LEVEL-Regler an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side3: LEVEL-Regler und MIC LEVEL-Regler 

(verbundene Steuerung)
Audio CH4 Level Side4/Front/Front+Side4 Wahl des Reglers, mit dem der auf Kanal 4 

aufgezeichnete Audiopegel eingestellt wird.
Side4: LEVEL-Regler an der Seite
Front: MIC LEVEL-Regler an der Vorderseite
Front+Side4: LEVEL-Regler und MIC LEVEL-Regler 

(verbundene Steuerung)

Maintenance >WRR Setting
Einstellen des drahtlosen Tuners.

Menüpunkt Einstellung Beschreibung

WRR Valid CH Sel All/CH1 Stellen Sie ein, ob die Kanäle 1 und 2 des 
drahtlosen Tuners (All) oder nur Kanal 1 (CH1) 
aktiviert werden soll.

WRR CH Select TX1/TX2 Wahl des im Menü anzuzeigenden 
Empfangskanals.
TX1: Zeigt Kanal 1 an.
TX2: Zeigt Kanal 2 an.

WRR Delay Comp On/Off Wahl, ob der Verzögerungsausgleich für drahtlose 
Audioeingangssignale aktiviert (On) oder 
deaktiviert (Off) werden soll. (Wird er aktiviert, 
werden die Audiosignale in allen E-E-Ausgaben 
um ca. 8 ms verzögert.)

TX --- Hier wird der Name des Transmitters angezeigt, 
dessen Signale auf dem Kanal empfangen 
werden, der über WRR CH Select ausgewählt 
wurde.
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Maintenance >WRR Setting
Einstellen des drahtlosen Tuners.

Menüpunkt Einstellung Beschreibung

TX Audio Peak ---/Peak Zeigt an, ob der AF-Pegel des Transmitters, 
dessen Signale auf dem mittels WRR CH Select 
gewählten Kanal empfangen werden, über den 
Spitzenwert hinausgeht.

TX Input Level ---/Mic/Line Zeigt an, ob der Eingangspegel des Transmitters, 
dessen Signale auf dem mittels WRR CH Select 
gewählten Kanal empfangen werden, auf 
Mikrofon (Mic) oder Line (Line) eingestellt ist.

TX ATT Level --- Hier wird der ATT-Pegel des Transmitters 
eingestellt, dessen Signale auf dem Kanal 
empfangen werden, der über WRR CH Select 
ausgewählt wurde. (Der Einstellbereich variiert 
abhängig vom Transmitter.)

TX LCF Frequency --- Hier wird die Frequenz des Low-Cut-Filters des 
Transmitters eingestellt, dessen Signale auf dem 
Kanal empfangen werden, der über WRR CH 
Select ausgewählt wurde. (Der Einstellbereich 
variiert abhängig vom Transmitter.)

TX System Delay Auto/0.0ms bis 8.0ms Zum Einstellen des Werts der Audioverzögerung.
Auto: Die Dauer der Verzögerung wird 

automatisch eingestellt, sodass die 
Verzögerung der vom drahtlosen Tuner 
empfangenen Audiosignale gleich Null ist.

0.0ms bis 8.0ms: Stellt die Dauer der erwarteten 
Verzögerung eines drahtlosen Systems ein, 
wenn mehrere drahtlose Systeme über ein 
Gerät wie z. B. ein Audiomischpult betrieben 
werden.

TX RF Power High (Leistungswert) mW/Mid 
(Leistungswert) mW/Low 
(Leistungswert) mW

Hier wird die RF-Leistung des Transmitters 
eingestellt, der auf dem Kanal kommuniziert, der 
über WRR CH SELECT ausgewählt wurde. (Der 
Einstellbereich variiert abhängig vom Transmitter.)

TX Power Save Active/Sleep Hier wird der Energiesparmodus des Transmitters 
eingestellt, dessen Signale auf dem Kanal 
empfangen werden, der über WRR CH SELECT 
ausgewählt wurde.
Active: Schaltet den Transmitter in den 

Startmodus.
Sleep: Schaltet den Transmitter in den 

Energiesparmodus.

Maintenance >WRR Setting
Einstellen des drahtlosen Tuners.

Menüpunkt Einstellung Beschreibung

TX-Cam Power Sync Off/On Stellt ein, ob der Energiesparstatus des 
Transmitters auch synchron mit dem POWER-
Schalter des Camcorders geschaltet wird.

Maintenance >Time Code
Einstellen des Zeitcodes.

Menüpunkt Einstellung Beschreibung

TC Out Auto/Generator Wahl der Zeitcodeausgabe
Auto: Gibt während der Aufzeichnung den 

Zeitcodegeneratorwert und während der 
Wiedergabe den Zeitcodeleserwert aus.

Generator: Gibt während der Aufzeichnung und 
der Wiedergabe den Zeitcodegeneratorwert 
aus.

DF/NDF DF/NDF Wählt den Drop-Frame-Modus (DF) oder den 
Non-Drop-Frame-Modus (NDF) aus.

LTC UBIT Fix/Time Zum Einstellen der in LTC-Benutzerbits 
aufgezeichneten Daten.
Fix: Zeichnet benutzerdefinierte Daten auf.
Time: Zeichnet die aktuelle Zeit auf.

Counter Display Counter/Duration Auswahl der Methode zum Zurücksetzen des auf 
dem Sucherbildschirm angezeigten Zählerwertes.
Counter: So lange erhöhen, bis die Taste RESET 

gedrückt wird.
Duration: Bei jedem Starten einer Aufzeichnung 

zurücksetzen.

Maintenance >Essence Mark
Einstellungen bezüglich Inhaltsmarkierungen.

Menüpunkt Einstellung Beschreibung

Find Mode Clip/Rec Start Legt den Vorgang für die Betätigung der Taste 
NEXT/PREV fest.
Rec Start: Geht zur nächsten oder vorherigen 

Aufzeichnungs-Startmarkierung.
Clip: Geht zum Anfang des nächsten Clips, wenn 

die Taste NEXT gedrückt wird. Geht zum 
Anfang des aktuellen Clips, wenn die Taste 
PREV gedrückt wird (oder zum Anfang des 
vorherigen Clips, wenn die Taste PREV am 
Anfang des Clips gedrückt wird).
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Maintenance >Camera Config
Einstellen verschiedener Camcorder-Funktionen.

Menüpunkt Einstellung Beschreibung

HD SDI Remote I/F Off/Characters/ 
Green Tally/Red Tally

Legt fest, ob die Aufnahmesteuerungsfunktion für 
ein externes Gerät, das an den Anschluss SDI OUT 
1/2 (HD-SDI-Ausgang) des Camcorders 
angeschlossen ist, aktiviert wird. Wenn die 
Funktion aktiviert ist, wählt diese Option die 
Anzeige, mit der der Aufnahmestatus des 
externen Geräts angegeben wird.
Off: Aufnahmesteuerungsfunktion ist deaktiviert.
Chara: Funktion wird in der Statusanzeige des 

Suchers mit dem Symbol für die Steuerung 
eines externen Geräts angezeigt.

G-Tally: Funktion wird im Sucher mit der TALLY-
Anzeige (grüne Kontrollanzeige) angezeigt.

R-Tally: Funktion wird im Sucher mit der REC-
Anzeige (rote Kontrollanzeige) angezeigt.

Color Bars Select ARIB/100%/75%/SMPTE Wahl des Farbbalkentyps.

User Menu Only On/Off Wahl, ob nur das Menü „User“ (On) oder die 
Menüliste (Off) angezeigt werden soll, wenn der 
Camcorder das Menü anzeigt.

User Menu with Lock On/Off Wahl, ob die Menüanzeige gesperrt werden soll, 
sodass nur das Menü „User“ angezeigt wird.
On: Geben Sie eine beliebige Passcode-Nummer 

ein, um die Anzeige des Menüs zu sperren. 
(Nur das Menü „User“ wird angezeigt.)

Off: Um das Menü zu entsperren, geben Sie die 
beim Sperren des Menüs verwendete 
Passcode-Nummer ein. (Wenn das Menü 
entsperrt wurde, wird die normale Menüliste 
angezeigt.)

[Hinweis]
Bei der normalen Menüanzeige wird dieses Element 
nicht angezeigt.
Einzelheiten zur Menüanzeige siehe Seite 93.

RM Common Memory On/Off Hier wählen Sie, ob Sie die Einstellungen in 
Zeiten, wenn eine Fernsteuerung angeschlossen 
ist und wenn der Camcorder direkt betrieben 
wird, gemeinsam (On) oder nicht gemeinsam 
nutzen möchten (Off).

Maintenance >Camera Config
Einstellen verschiedener Camcorder-Funktionen.

Menüpunkt Einstellung Beschreibung

RM Rec Start RM/Camera/PARA Legt fest, welche der Start-/Stopp-Tasten für die 
Aufzeichnung aktiviert werden, wenn eine 
Fernbedienung angeschlossen wird.
RM: Fernbedienung
Camera: Camcorder
PARA: Beide

SET Key on Thumbnail Pause/Play Legt fest, welcher Vorgang ausgeführt wird, wenn 
der Regler MENU mit einem ausgewählten 
Skizzenbild gedrückt wird.

ALAC Auto/Off Gibt an, ob automatisch die Funktion ALAC 
(automatischer Objektiv-Aberrations-Ausgleich) 
ausgeführt werden soll.
Auto: ALAC automatisch ausführen, wenn ein 

ALAC-kompatibles Objektiv verwendet wird 
und ALAC aktiviert ist.

Off: Nicht ausführen.

[Hinweis]
Je nach dem Objektiv mit Bildfehlerkorrektur wird die 
Bildfehlerkorrektur-Funktion nach dem Einschalten des 
Geräts möglicherweise nicht sofort aktiviert („ALAC“ 
wird nicht auf dem Sucherbildschirm angezeigt), 
selbst wenn diese Option auf „Auto“ eingestellt ist. 
Drehen Sie in diesem Fall den Zoomring und den 
Fokusring des Objektivs bis zum Anschlag und wieder 
zurück und prüfen Sie, ob die Anzeige „ALAC“ auf dem 
Sucherbildschirm eingeblendet wird.

Wenden Sie sich für weitere Auskünfte über Objektive mit 
Bildfehlerkorrektur an einen Sony Handelsvertreter.

Maintenance >Preset White
Einstellung des voreingestellten Werts für den Weißabgleich.

Menüpunkt Einstellung Beschreibung

Color Temp <P> 1500K bis 3200K bis 50000K Legt den voreingestellten Wert für den 
Weißabgleich fest.

Color Temp  
Balance <P>

–99 bis ±0 bis +99 Legt die Feineinstellungen für die Farbtemperatur 
fest, wenn mit „Color Temp<P>“ kein 
zufriedenstellendes Bild erzielt werden kann.

R Gain <P> –99 bis ±0 bis +99 Einstellung des voreingestellten 
R-Verstärkungswerts.

B Gain <P> –99 bis ±0 bis +99 Einstellung des voreingestellten 
B-Verstärkungswerts.
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Maintenance >Preset White
Einstellung des voreingestellten Werts für den Weißabgleich.

Menüpunkt Einstellung Beschreibung

AWB Enable <P> On/Off Ein- bzw. Ausschalten der AWB-Funktion 
(automatischer Weißabgleich), wenn der WHITE 
BAL-Schalter auf PRST eingestellt ist.

Maintenance >White Filter
Einstellen der Filter.

Menüpunkt Einstellung Beschreibung

ND Filter C.Temp On/Off Hier schalten Sie die Funktion, die ND-Filtern 
elektrische CC-Filter zuweist ein bzw. aus.

ND FLT C.Temp<1> 3200K/4300K/5600K/6300K Wählt die Farbtemperatur, wenn ND-Filtern 
elektrische CC-Filter zuwiesen wurden (Filter 1).

ND FLT C.Temp<2-4> 3200K/4300K/5600K/6300K Wählt die Farbtemperatur, wenn ND-Filtern 
elektrische CC-Filter zuwiesen wurden (Filter 2 bis 
4).

Electrical CC<A> 3200K/4300K/5600K/6300K Wählt die Farbtemperatur, wenn die 
Umschaltfunktion für elektrische CC-Filter einem 
belegbaren Schalter zugewiesen wurde.

Electrical CC<B> 3200K/4300K/5600K/6300K Wählt die Farbtemperatur, wenn die 
Umschaltfunktion für elektrische CC-Filter einem 
belegbaren Schalter zugewiesen wurde.

Electrical CC<C> 3200K/4300K/5600K/6300K/ 
---

Wählt die Farbtemperatur, wenn die 
Umschaltfunktion für elektrische CC-Filter einem 
belegbaren Schalter zugewiesen wurde. Wählen 
Sie „---“, wenn Sie C nicht verwenden.

Electrical CC<D> 3200K/4300K/5600K/6300K/ 
---

Wählt die Farbtemperatur, wenn die 
Umschaltfunktion für elektrische CC-Filter einem 
belegbaren Schalter zugewiesen wurde. Wählen 
Sie „---“, wenn Sie D nicht verwenden.

Maintenance >DCC Adjust
Hier stellen Sie die DCC ein (dynamische Kontraststeuerung).

Menüpunkt Einstellung Beschreibung

DCC Function Select DCC/Fix Wählt die Einstellungsmethode für den 
Kniepunkt, wenn der Schalter OUTPUT/DCC auf 
CAM eingestellt ist und DCC aktiviert ist.
DCC: Automatische Einstellung des Kniepunkts 

entsprechend der Luminanz des Motivs.
Fix: Einstellung des Kniepunkts auf einen festen 

Wert.

Maintenance >DCC Adjust
Hier stellen Sie die DCC ein (dynamische Kontraststeuerung).

Menüpunkt Einstellung Beschreibung

DCC D Range 400%/450%/500%/550%/600% Einstellung des Dynamikbereiches, wenn der 
Schalter OUTPUT/DCC auf CAM eingestellt ist und 
DCC aktiviert ist.

DCC Point –99 bis ±0 bis +99 Stellt den minimalen Kniepunkt für DCC ein.

DCC Gain –99 bis ±0 bis +99 Legt den Verstärkungswert in Bezug auf den 
festgestellten DCC-Wert fest.

DCC Delay Time –99 bis ±0 bis +99 Zum Einstellen der DCC-
Steuerungsgeschwindigkeit (die Geschwindigkeit 
der Reaktion auf Veränderungen im Videobild).

DCC Peak Filter –99 bis ±0 bis +99 Passt die Ansprechempfindlichkeit in Bezug auf 
die Höchstwerte des festgestellten DCC-Werts an.

Maintenance >Flicker Reduce
Einstellen der Flimmerkorrekturfunktion.
Sie können das Flimmern korrigieren, das bei der Aufnahme von Motiven bei Beleuchtung mit periodisch 
schwankender Helligkeit (wie z. B. mit Leuchtstofflampen) aufgrund des Verhältnisses zwischen der 
Frequenz des Lichts und der Bildrate der Aufnahme auftritt.

Menüpunkt Einstellung Beschreibung

Mode Auto/On/Off Zum Einstellen der Flimmerkorrekturfunktion.
On: Stets aktiv.
Auto: Wird aktiviert, wenn Flimmern erkannt wird.
Off: Deaktiviert.

Frequency 60Hz/50Hz Synchronisiert mit der Stromversorgungsfrequenz 
der Beleuchtungseinrichtungen, was Flimmern 
verursacht.
Die werkseitige Einstellung beträgt 60Hz, wenn 
die Systemfrequenz auf 59.94, 29.97 oder 23.98 
eingestellt ist.
Die werkseitige Einstellung beträgt 50Hz, wenn 
die Systemfrequenz auf 50 oder 25 oder 
eingestellt ist.

Maintenance >Genlock
Einstellen des Genlock.

Menüpunkt Einstellung Beschreibung

Genlock On/Off Schaltet die Genlockfunktion ein bzw. aus.

Reference Internal/External(HD)/
External(SD)/SDI IN/CA

Anzeige des vom Camcorder verwendeten 
Referenzsignaltyps.



000 7. Menüanzeige und -einstellungen: Menüliste117

Maintenance >Auto Shading
Ausführung der automatischen Schwarzschattierungskorrektur.

Menüpunkt Einstellung Beschreibung

Auto Black Shading Execute/Cancel Ausführung der automatischen 
Schwarzschattierungskorrektur (ausführen durch 
Wahl von „Execute“). 

Reset Black Shading Execute/Cancel Löscht den Wert der 
Schwarzschattierungskorrektur (ausführen durch 
Wahl von „Execute“).

Master Gain (TMP) –3dB/0dB/3dB/6dB/9dB/12dB/ 
18dB/24dB/30dB/36dB/42dB

Zum Einstellen eines temporären Haupt-
Verstärkungswerts. (Denselben Wert wie den für 
den Schalter GAIN gewählten Wert.)

Maintenance >APR
Einstellen der automatischen Pixelrauschen-Unterdrückung.

Menüpunkt Einstellung Beschreibung

APR Execute/Cancel Führt die automatische Pixelrauschen-
Unterdrückung aus, um weiße Flecken im SLS-
Modus zu unterdrücken (ausführen durch Wahl 
von „Execute“).

Reset Execute/Cancel Löscht Daten mit weißen Flecken, die durch die 
Ausführung von APR und Anpassungsfunktionen 
des automatischen Schwarzabgleichs 
hinzugefügt wurden (ausführen durch Wahl von 
„Execute“).

Maintenance >Basic Authentication
Einstellen der Standardauthentifizierung.

Menüpunkt Einstellung Beschreibung

User Name (Zeigt den Namen des aktuellen 
Benutzers an.)

Legt den Benutzernamen (beliebiger Name für 
die Standardauthentifizierung) fest. Werkseitig auf 
„admin“ eingestellt.

Password ******* Zum Einstellen des Kennworts (für die 
Standardauthentifizierung). Werkseitig auf 
„pxw-x400“ gesetzt.

Maintenance >Network
Dient zum Konfigurieren von Einstellungen zu Netzwerkverbindungen.

Menüpunkt Einstellung Beschreibung

Setting On/Off Ein- oder Ausschalten der Netzwerkfunktion.

Wi-Fi Mode Wi-Fi Access Point/Wi-Fi Station/ 
Off

Zum Einstellen des Betriebsmodus für drahtlose 
LAN-Verbindungen.

NFC Execute/Cancel Leitet eine One-Touch-Verbindung über NFC ein 
(ausführen durch Wahl von „Execute“).

Maintenance >Network
Dient zum Konfigurieren von Einstellungen zu Netzwerkverbindungen.

Menüpunkt Einstellung Beschreibung

WPS Execute/Cancel Startet Wi-Fi Protected Setup (WPS) (ausführen 
durch Wahl von „Execute“.)

Channel Auto(5GHz)/Auto/CH1/CH2/
CH3/CH4/CH5/CH6/CH7/CH8/
CH9/CH10/CH11

Zum Einstellen des WLAN-Kanals.

[Hinweis]
„Auto(5GHz)“ wird je nach dem verwendeten WLAN-
Modul möglicherweise nicht angezeigt.

SSID & Password (SSID-Anzeige)
(Kennwortanzeige)

Zeigt SSID und Passwort an.

SSID (SSID-Anzeige) Zeigt die SSID des Access Points des 
Verbindungsziels im Wi-Fi-Station-Modus an.

Wi-Fi Station Detail 
Settings

Scan Networks (Execute/Cancel) Startet die automatische Erkennung von 
Netzwerkzielen zum Herstellen der Verbindung 
(ausführen durch Auswählen von Execute).

SSID (SSID des Access Points) Geben Sie die SSID des Access Points des 
Verbindungsziels im Wi-Fi-Station-Modus an.

Password (Kennwort des Access 
Points)

Geben Sie das Kennwort des Access Points des 
Verbindungsziels im Wi-Fi-Station-Modus an.

DHCP (On/Off) Stellt DHCP im Wi-Fi-Station-Modus ein.
Wenn diese Option auf On gesetzt ist, wird dem 
Camcorder automatisch eine IP-Adresse 
zugewiesen. Um die IP-Adresse des Camcorders 
manuell einzugeben, setzen Sie diese Option auf 
Off.

IP Address (DHCP/On: 
automatisch abrufen, DHCP/Off: 
192.168.1.50)

Geben Sie die IP-Adresse des Camcorders ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

Subnet Mask (DHCP/On: 
automatisch abrufen, DHCP/Off: 
255.255.255.0)

Geben Sie die Subnetzmaske des Camcorders ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

Gateway (DHCP/On: 
automatisch abrufen, DHCP/Off: 
0.0.0.0)

Geben Sie das Gateway für den Access Point ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

DNS Auto (On/Off) Aktiviert/deaktiviert die automatische DNS-
Adressermittlung.
Wenn diese Option auf „On“ gesetzt ist, wird die 
Adresse des DNS-Servers automatisch ermittelt.

Primary DNS Server (DNS Auto/
On: automatisch abrufen, DNS 
Auto/Off: 0.0.0.0)

Geben Sie den primären DNS-Server für den 
Router ein.
Nur aktiviert, wenn „DNS Auto“ auf „Off“ gesetzt 
ist.
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Maintenance >Network
Dient zum Konfigurieren von Einstellungen zu Netzwerkverbindungen.

Menüpunkt Einstellung Beschreibung

Wi-Fi Station Detail 
Settings

Secondary DNS Server (DNS 
Auto/On: automatisch abrufen, 
DNS Auto/Off: 0.0.0.0)

Geben Sie den sekundären DNS-Server für den 
Router ein.
Nur aktiviert, wenn „DNS Auto“ auf „Off“ gesetzt 
ist.

Device Name (Wi-Fi) Zeigt den Namen des Netzwerkgeräts an, das mit 
dem Anschluss des USB-WLAN-Moduls 
verbunden ist

IP Address (Wi-Fi) Zeigt die IP-Adresse an, wenn eine Verbindung zu 
einem WLAN besteht.

Subnet Mask (Wi-Fi) Zeigt die Subnetzmaske an, wenn eine 
Verbindung zu einem WLAN besteht.

MAC Address (Wi-Fi) Zeigt die MAC-Adresse des an den Camcorder 
angeschlossenen USB-WLAN-Moduls an.

Regenerate Password Execute/Cancel Erstellt ein Kennwort neu (ausführen durch Wahl 
von „Execute“.)

Modem On/Off Aktiviert/deaktiviert die Netzwerkverbindung über 
ein 3G/4G-Modem.

Wired LAN Enable/Disable Aktiviert/deaktiviert die kabelbasierte LAN-
Verbindung.

Wired LAN Remote On/Off Bei Verbindung mit einem Netzwerk mithilfe eines 
LAN-Kabels ist die Bedienung mit einer Wi-Fi-
Fernbedienung, über das Webmenü und mithilfe 
von „Content Browser Mobile“ aktiviert.

Wired LAN Detail 
Settings

DHCP (On/Off) Aktiviert/deaktiviert DHCP.
Wenn diese Option auf „On“ gesetzt ist, wird dem 
Camcorder automatisch eine IP-Adresse 
zugewiesen.
Um die IP-Adresse des Camcorders manuell 
einzugeben, setzen Sie diese Option auf „Off“.

IP Address (DHCP/On: 
automatisch abrufen, DHCP/Off: 
192.168.2.50)

Geben Sie die IP-Adresse des Camcorders ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

Subnet Mask (DHCP/On: 
automatisch abrufen, DHCP/Off: 
255.255.255.0)

Geben Sie die Subnetzmaske des Camcorders ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

Gateway (DHCP/On: 
automatisch abrufen, DHCP/Off: 
0.0.0.0)

Geben Sie das Gateway für den Access Point ein.
Nur aktiviert, wenn DHCP auf „Off“ gesetzt ist.

DNS Auto (On/Off) Aktiviert/deaktiviert die automatische DNS-
Bestimmung.
Wenn diese Option auf „On“ gesetzt ist, wird die 
Adresse des DNS-Servers automatisch ermittelt.

Maintenance >Network
Dient zum Konfigurieren von Einstellungen zu Netzwerkverbindungen.

Menüpunkt Einstellung Beschreibung

Wired LAN Detail 
Settings

Primary DNS Server (DNS Auto/
On: automatisch abrufen, DNS 
Auto/Off: 0.0.0.0)

Geben Sie den primären DNS-Server für den 
Router ein.
Nur aktiviert, wenn „DNS Auto“ auf „Off“ gesetzt 
ist.

Secondary DNS Server (DNS 
Auto/On: automatisch abrufen, 
DNS Auto/Off: 0.0.0.0)

Geben Sie den sekundären DNS-Server für den 
Router ein.
Nur aktiviert, wenn „DNS Auto“ auf „Off“ gesetzt 
ist.

Maintenance >Network Client Mode
Dient zum Konfigurieren von Einstellungen zum Netzwerkclientmodus.

	 [Hinweis]
Der Netzwerkclientmodus kann nur aktiviert werden, wenn für alle Elemente Werte eingegeben werden.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet den Netzwerkclientmodus ein/aus.

[Hinweis]
Wenn die Einstellung auf „On“ gesetzt ist, kann die 
Firmwareversion nicht aktualisiert werden.

Preset Select Preset 1/Preset 2/Preset 3 Wählt die Preset-Einstellungen (Preset 1/Preset 2/
Preset 3), die die zuvor konfigurierten 
Verbindungseinstellungen für den 
Netzwerkclientmodus umfassen.

Preset 1 (Anzeige des Preset-Namens) Geben Sie den Preset-Namen ein.

CCM Address Zum Einstellen der Adresse des zu verbindenden 
CCM.
Hostname oder IP-Adresse

CCM Port (1 bis 65535 (8443)) Zum Einstellen der Portnummer des zu 
verbindenden CCM.

User Name Zum Einstellen des Benutzernamen für die 
Authentifizierung des zu verbindenden CCM.

Password Zum Einstellen des Kennworts für den zu 
verbindenden CCM.

NCM with Proxy (Enable/Disable) Enable: Aktiviert bei einer Verbindung mit einem 
CCM die Proxy-Aufzeichnung.

Disable: Deaktiviert bei einer Verbindung mit 
einem CCM die Proxy-Aufzeichnung.

Camera Control (Enable/Disable) Aktiviert/deaktiviert bei einer Verbindung mit 
einem CCM den Kamerasteuerungsbetrieb.
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Maintenance >Network Client Mode
Dient zum Konfigurieren von Einstellungen zum Netzwerkclientmodus.

	 [Hinweis]
Der Netzwerkclientmodus kann nur aktiviert werden, wenn für alle Elemente Werte eingegeben werden.

Menüpunkt Einstellung Beschreibung

Preset 1 Camera Setting (Always/
Onetime/Off)

Aktiviert/deaktiviert bei einer Verbindung mit 
einem CCM die Verarbeitung von ALL-Dateien.
Always: Aktiviert die Verarbeitung von ALL-

Dateien stets.
Onetime: Aktiviert die Verarbeitung von ALL-

Dateien einmalig.
Off: Deaktiviert die Verarbeitung von ALL-Dateien.

Preset 2 Wie Preset 1 Wie Preset 1

Preset 3 Wie Preset 1 Wie Preset 1

Maintenance >File Transfer
Einstellungen für die Netzwerkübertragung von Daten auf SxS-Speicherkarten in den Camcorder.

Menüpunkt Einstellung Beschreibung

File Transfer Execute/Cancel Wechselt zum Übertragungsmodus (ausführen 
durch Wahl von „Execute“.)

Remote File Transfer Enable/Disable Aktiviert oder deaktiviert das Umschalten in den 
Übertragungsmodus zum Übertragen der auf 
dem Camcorder gespeicherten Originaldateien 
per Fernsteuerung über ein Netzwerk.
Enable: Das Umschalten in den 

Übertragungsmodus per Fernsteuerung über 
ein Netzwerk wird aktiviert.  
Übertragungen müssen nicht mit 
„Maintenance >File Transfer“ durchgeführt 
werden.

Disable: Das Umschalten in den 
Übertragungsmodus per Fernsteuerung über 
ein Netzwerk wird deaktiviert.  
Übertragungen müssen mit „Maintenance 
>File Transfer“ durchgeführt werden.

Auto Upload (Proxy) Off/On Aktivieren/Deaktivieren der automatischen 
Übertragung von Proxy-Dateien.

Maintenance >Streaming
Einstellungen zur Streaming-Funktion.

Menüpunkt Einstellung Beschreibung

Setting On/Off Schaltet die Streaming-Übertragung ein/aus.

[Hinweise]
ˎˎ Diese Einstellung ist auf „Off“ gesetzt, wenn Sie das 

Gerät wieder einschalten.
ˎˎ Wenn die Einstellung auf „On“ gesetzt ist, ist die 

Überwachungsfunktion nicht verfügbar.

Maintenance >Streaming
Einstellungen zur Streaming-Funktion.

Menüpunkt Einstellung Beschreibung

Preset Select Preset 1/Preset 2/Preset 3 Auswahl einer Streaming-Voreinstellung.
Die Einstellungen gelten für Preset 1/Preset 2/
Preset 3. Weiter unten finden Sie Beschreibungen 
der Voreinstellungen.

Size HD Auto/ 
1280×720/ 
640×360/ 
480×270/ 
320×180

Zum Festlegen des Formats der zu streamenden 
Videodaten.
Wenn „HD Auto“ ausgewählt ist, ist das Format auf 
1920×1080 oder 1280×720 festgelegt, je nach der 
Einstellung des Formats der Aufnahme auf der 
SxS-Speicherkarte oder des Formats des 
wiederzugebenden Clips.

Bit Rate 9Mbps/ 
6Mbps/ 
3Mbps/ 
2Mbps/ 
1Mbps/ 
0.5Mbps/
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

Zum Festlegen der Bitrate der zu streamenden 
Videodaten.
Die auswählbare Bitrate hängt von der Einstellung 
des Formats (Size) ab.

[Hinweise]
ˎˎ Audio-/Videodaten werden unverändert über das 

Internet übertragen. Möglicherweise können Dritte 
Zugriff auf die Daten erhalten. Prüfen Sie stets, ob das 
Übertragungsziel die Streaming-Daten empfangen 
kann.
ˎˎ Die Daten werden möglicherweise an 

unbeabsichtigte Dritte gesendet, wenn die Adresse 
oder andere Einstellungen falsch konfiguriert sind.
ˎˎ Je nach dem Status des Netzwerks werden 

möglicherweise nicht alle Einzelbilder 
wiedergegeben.
ˎˎ Die Bildqualität verringert sich möglicherweise in 

Szenen mit übermäßiger Bewegung.
ˎˎ Wenn für den Datenstrom ein großes Format 

und eine kleine Bitrate festgelegt wurden, 
werden möglicherweise nicht alle Einzelbilder 
wiedergegeben. Wählen Sie, um diesen Effekt zu 
verringern, ein kleineres Format für die Einstellung 
„Size“ aus.

Type MPEG-2 TS/UDP/MPEG-2 TS/ 
RTP

Zum Auswählen der Art der zu streamenden 
Videodaten.

Destination Address Zeichenfolge (0.0.0.0) Geben Sie hier die Adresse des Übertragungsziel-
Servers zum Streamen von Daten ein.

Destination Port 1 bis 65545 (1234) Geben Sie hier die Portnummer des zum 
Streamen verwendeten Übertragungsziel-Servers 
ein.

Audio Channel CH1/CH2/CH3/CH4 Auswahl des Audiokanals für die Streaming-
Ausgabe.
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Maintenance >Clock Set
Einstellen der internen Uhr.

Menüpunkt Einstellung Beschreibung

Date Mode YYMMDD/MMDDYY/DDMMYY Wählen Sie das Anzeigeformat für das Datum.

12H/24H 12H/24H Auswahl des Formats der Uhranzeige.

Date Zeigt den Bildschirm mit den Datumeinstellungen 
an.

Time Zeigt den Bildschirm mit den 
Uhrzeiteinstellungen an.

Maintenance >Language
Wahl der Sprache für Meldungen

Menüpunkt Einstellung Beschreibung

Select English/  /
Espanol/ Русский

Wahl der Sprache für Meldungen

Maintenance >Hours Meter
Einstellen des digitalen Stundenzählers.

Menüpunkt Einstellung Beschreibung

Hours (System) xxxxH
(xxxx Stunden)

Anzeige der Gesamtbetriebsstunden (kann nicht 
zurückgesetzt werden).

Hours (Reset) xxxxH
(xxxx Stunden)

Anzeige der Gesamtbetriebsstunden (kann 
zurückgesetzt kann).

Reset Execute/Cancel Setzt die Anzeige Hours (Reset) auf 0 zurück. 
(ausführen durch Wahl von „Execute“.)

Maintenance >Network Reset
Setzt alle Netzwerkeinstellungen auf die werkseitige Standardeinstellung zurück.

Menüpunkt Einstellung Beschreibung

Reset Execute/Cancel Setzt die Netzwerkeinstellungen zurück 
(ausführen durch Wahl von „Execute“).

Maintenance >Fan Control
Zum Einstellen des Modus für die Lüftersteuerung.

Menüpunkt Einstellung Beschreibung

Setting Auto/Minimum/Off in Rec Wahl des Modus für die Lüftersteuerung.

Maintenance >VF Display Setting
Einstellungen zur Sucheranzeige.

Menüpunkt Einstellung Beschreibung

Chara/Marker 
Brightness

5/4/3/2/1 Einstellung der Helligkeit von im Sucherbild 
eingeblendeten Zeichenketten, Symbolen und 
Markierungen.

Maintenance >Version
Anzeige der Version des Camcorders und Aktualisierung des Camcorders.

Menüpunkt Einstellung Beschreibung

Number Anzeige der Software-Version des Camcorders  
(Vx.xx).

Version Up Execute/Cancel Aktualisiert die Softwareversion des Camcorders 
mithilfe einer Karte im SD-Karteneinschub UTILITY 
(Ausführen durch Auswahl von Execute).
Die folgenden SD-Karten werden unterstützt.

ˎˎ SDHC-Speicherkarten (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 4 GB bis 
32 GB)

[Hinweis]
Kann nicht ausgewählt werden, wenn die SD-Karte mit 
der Versionsaktualisierung nicht eingesetzt wurde oder 
wenn im Menü „Maintenance“ für Network Client Mode 
>Setting die Einstellung On gewählt ist.

Net-Func Version 
Number

Anzeige der Firmware-Version der WLAN-
Verbindungsfunktion des Camcorders (Vx.xx).

[Hinweis]
Wird nicht angezeigt, wenn im Menü „Operation“ 
für Proxy Recording Mode >Setting und im Menü 
„Maintenance“ für Network >Setting die Einstellung Off 
gewählt ist.

Net-Func Ver.Up Execute/Cancel Aktualisiert die Softwareversion der WLAN-
Verbindungsfunktion des Camcorders mithilfe 
einer Karte im SD-Karteneinschub PROXY 
(Ausführen durch Auswahl von Execute).
Die folgenden SD-Karten werden unterstützt.

ˎˎ SDHC-Speicherkarten (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 4 GB bis 
32 GB)

ˎˎ SDXC-Speicherkarten (Geschwindigkeitsklasse: 
4 oder höher, Nicht-UHS, Kapazität: 64 GB bis 
256 GB)

[Hinweis]
Kann nicht ausgewählt werden, wenn im Menü 
„Maintenance“ für Network Client Mode >Setting die 
Einstellung On gewählt ist.
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Menü „File“

Standardwerte sind unterstrichen und fett formatiert.

File >User File
Einstellungen für Benutzerdateifunktionen

Menüpunkt Einstellung Beschreibung

Load SD Card Zeigt einen Bildschirm zum Laden von 
Einstellungen für Benutzerdateien von einer 
SD-Karte an.

Save SD Card Zeigt einen Bildschirm zum Speichern von 
Einstellungen für Benutzerdateien auf einer 
SD-Karte an.

File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten 
der Datei-ID von Benutzerdateien an.

Recall User Preset Execute/Cancel Zurücksetzen des Wertes von im Menü „User“ 
registrierten Menüoptionen auf die 
voreingestellten Werte (ausführen durch Wahl 
von [Execute]).

Store User Preset Execute/Cancel Speichert die Werte von im Menü „User“ 
registrierten Menüoptionen als Standardwerte 
(ausführen durch Wahl von [Execute]).

Clear All Preset Execute/Cancel Zurücksetzen der aktuellen Einstellungen und 
voreingestellten Werte von im Menü „User“ 
registrierten Menüoptionen auf die werkseitigen 
Standardwerte (ausführen durch Wahl von 
[Execute]).

Load Customize Data On/Off Legt fest, ob benutzerdefinierte 
Benutzermenüdaten beim Ausführen von [Load 
SD Card] geladen werden sollen.

Load White Data On/Off Legt fest, ob Weißabgleichsdaten beim Ausführen 
von [Load SD Card] geladen werden sollen.

File >All File
Einstellung ALLER Dateifunktionen

Menüpunkt Einstellung Beschreibung

Load SD Card Zeigt einen Bildschirm zum Laden der 
Einstellungen für alle Dateien von einer SD-Karte 
an.

Save SD Card Zeigt einen Bildschirm zum Speichern der 
Einstellungen für alle Dateien auf einer SD-Karte 
an.

File >All File
Einstellung ALLER Dateifunktionen

Menüpunkt Einstellung Beschreibung

File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten 
der Datei-ID aller Dateien an.

All Preset Execute/Cancel Setzt alle Elemente auf ihre voreingestellten 
Werte zurück (ausführen durch Auswahl von 
[Execute]).

Store All Preset Execute/Cancel Speichert die aktuellen Einstellungen aller 
Elemente als voreingestellte Werte (ausführen 
durch Wahl von [Execute]).

Clear All Preset Execute/Cancel Zurücksetzen der aktuellen Einstellungen und 
Voreinstellungen der Optionen des Menüs „All 
File“ auf die werkseitigen Standardwerte 
(ausführen durch Wahl von [Execute]).

3Sec Clear Preset On/Off Schaltet die Funktion, die die aktuellen 
Einstellungen und Voreinstellungen jedes 
Elements löscht, ein/aus, wenn der Schalter MENU 
CANCEL/PRST/ESCAPE nach oben gedrückt und 
drei Sekunden lang in der Position CANCEL/PRST 
gedrückt gehalten wird.

File >Scene File
Einstellung von Szenendateifunktionen

Menüpunkt Einstellung Beschreibung

Recall Internal Memory Zeigt einen Bildschirm zum Abrufen der 
Szenendateien aus dem internen Speicher an.

Store Internal Memory Zeigt einen Bildschirm zum Speichern der 
Szenendateien im internen Speicher an.

Load SD Card Zeigt einen Bildschirm zum Laden der 
Szenendateien von einer SD-Karte an.

Save SD Card Zeigt einen Bildschirm zum Speichern der 
Szenendateien auf einer SD-Karte an.

File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten 
der Datei-ID der Szenendateien an.

Scene White Data On/Off Legt fest, ob beim Abrufen der Szenendateien die 
Weißabgleichdaten der Szenendateien 
angewandt werden sollen.
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File >Reference File
Einstellung von Referenzdateifunktionen

Menüpunkt Einstellung Beschreibung

Store Reference Execute/Cancel Speichert die aktuellen Einstellungen von 
bestimmten Referenzdatei-Menüpunkten als 
Voreinstellungswerte (ausführen durch Wahl von 
[Execute]).

Clear Reference Execute/Cancel Setzt die aktuellen Einstellungen und 
Voreinstellungswerte von bestimmten 
Referenzdatei-Menüpunkten auf die werkseitigen 
Standardwerte zurück (ausführen durch Wahl von 
[Execute]).

Load Reference(SD 
Card)

Execute/Cancel Lädt Einstellungen für Referenzdateien von einer 
SD-Karte und legt die Voreinstellungswerte fest 
(ausführen durch Wahl von [Execute]).

Save Reference(SD 
Card)

Execute/Cancel Speichert die Voreinstellungswerte von 
bestimmten Referenzdatei-Menüpunkten auf 
einer SD-Karte (ausführen durch Auswahl von 
[Execute]).

File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten 
der Datei-ID von Referenzdateien an.

File >Lens File
Einstellung von Objektivdateifunktionen

Menüpunkt Einstellung Beschreibung

Display Mode Model Name/Lens ID Wahl der in dem Listenfeld anzuzeigenden 
Optionen, das beim Speichern oder Laden einer 
Datei erscheint.

Recall Internal Memory Zeigt einen Bildschirm zum Abrufen der 
Objektivdateien aus dem internen Speicher an.

Store Internal Memory Zeigt einen Bildschirm zum Speichern der 
Objektivdateien im internen Speicher an.

Load SD Card Zeigt einen Bildschirm zum Laden der 
Objektivdateien von einer SD-Karte an.

Save SD Card Zeigt einen Bildschirm zum Speichern der 
Objektivdateien auf einer SD-Karte an.

File ID Zeigt einen Bildschirm zum Anzeigen/Bearbeiten 
der Datei-ID der Objektivdateien an.

File Source Anzeige der Nummer der ausgewählten Datei.

Clear Lens Offset Execute/Cancel Löscht die Objektivdatei (ausführen durch Wahl 
von „Execute“.)

File >Lens File
Einstellung von Objektivdateifunktionen

Menüpunkt Einstellung Beschreibung

Lens Auto Recall Off/On(Lens Name) 
On(Serial Number)

Legt fest, ob automatisch eine Objektivdatei 
abgerufen werden soll, wenn ein Objektiv, das 
serielle Kommunikation unterstützt, angebracht 
wird.

Lens Serial Number Zeigt die Seriennummer des angebrachten 
Objektivs an (nur bei Objektiven, die die serielle 
Kommunikation unterstützen).

Lens Name Zeigt die Modellbezeichnung des angebrachten 
Objektivs an (nur bei Objektiven, die die serielle 
Kommunikation unterstützen).

Lens Manufacturer Zeigt den Herstellernamen des angebrachten 
Objektivs an (nur bei Objektiven, die Serien-
Kommunikation unterstützen).

Master V Modulation –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Schwarzschattierung der vertikalen Richtung in 
der Objektivdatei.

Lens Center H –40 bis ±0 bis +40 Zum Einstellen der horizontalen Position der 
Mittelmarkierung in der Objektivdatei.

Lens Center V –40 bis ±0 bis +40 Zum Einstellen der vertikalen Position der 
Mittelmarkierung in der Objektivdatei.

R Flare –99 bis ±0 bis +99 Zum Einstellen des Streulichtpegels der R-Signale 
in der Objektivdatei.

G Flare –99 bis ±0 bis +99 Zum Einstellen des Streulichtpegels der G-Signale 
in der Objektivdatei.

B Flare –99 bis ±0 bis +99 Zum Einstellen des Streulichtpegels der B-Signale 
in der Objektivdatei.

White Offset R –99 bis ±0 bis +99 Zum Einstellen des R-Kanal-Korrekturwerts für die 
Weißabgleich-Abweichung des Objektivs in der 
Objektivdatei.

White Offset B –99 bis ±0 bis +99 Zum Einstellen des B-Kanal-Korrekturwerts für die 
Weißabgleich-Abweichung des Objektivs in der 
Objektivdatei.

Shading Ch Select Red/Green/Blue Wahl des Kanals für die Korrektur der 
Weißschattierung.

Shading H SAW –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Weißschattierung der horizontalen Richtung in 
der Objektivdatei.

Shading H PARA –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Weißschattierung der horizontalen Richtung in 
der Objektivdatei.
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File >Lens File
Einstellung von Objektivdateifunktionen

Menüpunkt Einstellung Beschreibung

Shading V SAW –99 bis ±0 bis +99 Zum Einstellen des SAW-Korrekturwerts für die 
Weißschattierung der vertikalen Richtung in der 
Objektivdatei.

Shading V PARA –99 bis ±0 bis +99 Zum Einstellen des Parabel-Korrekturwerts für die 
Weißschattierung der vertikalen Richtung in der 
Objektivdatei.

File >User Gamma
Einstellen der Benutzer-Gammawerte.

Menüpunkt Einstellung Beschreibung

Current Settings Zeigt eine Liste der Gammadatei-Einstellungen 
des aktuellen Benutzers an (Dateinamen).

Load SD Card Zeigt einen Bildschirm zum Laden der Benutzer-
Gammaeinstellungen von einer SD-Karte an.

Reset 1/2/3/4/5/All Zurücksetzen der Einstellungen in der 
ausgewählten Benutzer-Gammadatei (ausführen 
durch Wahl von „Execute“.)
Wählen Sie „All“, um alle Benutzer-Gammadateien 
zurückzusetzen.



000 7. Menüanzeige und -einstellungen124

Mit der Option [Assignable SW] im Menü „Operation“ können Sie den Schaltern ASSIGN. 0 bis 3, den 
Schaltern ASSIGNABLE 4 und 5, der Taste ONLINE und der Taste RET auf dem Objektiv benutzerdefinierte 
Funktionen zuweisen.
In der nachstehenden Tabelle sind die bei Auslieferung des Camcorders aus der Fabrik zugewiesenen 
Funktionen angegeben.

Schalter bzw. Taste Funktion Zuweisbare 
Schaltereinstellung

Schalter ASSIGN. 0 Keine Zuweisung Off
Schalter ASSIGN. 1 Keine Zuweisung Off
Schalter ASSIGN. 2 Keine Zuweisung Off
Schalter ASSIGN. 3 Keine Zuweisung Off
Schalter ASSIGNABLE 4 Keine Zuweisung Off
Schalter ASSIGNABLE 5 Keine Zuweisung Off
Taste RET Rec Review (falls Wiedergabe möglich) Lens RET
Taste ONLINE Automatische Übertragung von Proxy Clips Network Client Mode

Funktionen, die den Schaltern ASSIGN. 0 zugewiesen werden können

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Off Keine Zuweisung —
Marker Schaltet die Anzeige aller Markierungen ein bzw. 

aus.
Die Einstellung bleibt 
erhalten.

ATW Hold Behält die Einstellung für den Weißabgleich im 
ATW-Modus (automatische Weißwertanpassung) 
bei.

—

Picture Cache Rec Schaltet den Bildpuffer-Aufzeichnungsmodus ein 
bzw. aus.

Die Einstellung bleibt 
erhalten.

Focus Magnifier Ein-/Ausschalten der 
Fokusvergrößerungsfunktion.

Die Einstellung bleibt nicht 
erhalten.

Zebra Ein-/Ausschalten des Streifenmusters. Die Einstellung bleibt nicht 
erhalten.

Shot Mark1 Schreibt Shot Mark1. —
Shot Mark2 Schreibt Shot Mark2. —
Clip Flag OK Hinzufügen/Löschen einer OK-Markierung zum/

vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Clip Flag NG Hinzufügen/Löschen einer NG-Markierung zum/
vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Clip Flag Keep Hinzufügen/Löschen einer KP-Markierung (Keep) 
zum/vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Flash Band Reduce 1) Ein- bzw. Ausschalten der Flashband-Korrektur. Die Einstellung bleibt nicht 
erhalten.

1)	 Auch wenn die Option „Flash Band Reduce“ auf „On“ gestellt wird, ist die Funktion nicht verfügbar, wenn der Schalter 
SHUTTER auf „ON“ steht.

Funktionen, die den Schaltern ASSIGN. 2 zugewiesen werden können

[Hinweis]
Es könnte sein dass, nachdem Sie dem Schalter ASSIGN. 2 eine Funktion zugewiesen oder das Aufzeichnungsformat 
umgeschaltet haben, die Einstellung des Schalters nicht sofort mit dem internen Status des Camcorders übereinstimmt. 
Schalten Sie daher nach der Zuweisung einer Funktion den Schalter ASSIGN. 2 um oder schalten Sie den Camcorder aus und 
wieder ein.

Zuweisbare 
Schaltereinstellung

Funktion

Off Keine Zuweisung
Front Mic Schaltet zwischen Stereo und Mono um, wenn ein Stereomikrofon 

angeschlossen ist.
Marker Schaltet die Anzeige aller Markierungen ein bzw. aus.
Picture Cache Rec 1) Schaltet den Bildpuffer-Aufzeichnungsmodus ein bzw. aus.
Zebra Ein-/Ausschalten des Streifenmusters.
Clip Continuous Rec Schaltet den Continuous-Rec-Modus des Clips ein bzw. aus.
Rec Source Schaltet die aufzuzeichnenden Signale zwischen dem Kamerabild und der 

externen Eingabe um. (Wenn sich der Camcorder gerade in der Aufzeichnung 
oder Wiedergabe befindet, wird das Umschalten erst nach Beenden der 
Aufzeichnung oder Wiedergabe wirksam.)

Digital Extender ×2 Schaltet die Bildschirmvergrößerungsfunktion (×2) ein bzw. aus.
Digital Extender ×3 Schaltet die Bildschirmvergrößerungsfunktion (×3) ein bzw. aus.
Digital Extender ×4 Schaltet die Bildschirmvergrößerungsfunktion (×4) ein bzw. aus.
TX Power Save Schaltet den Energiesparmodus des drahtlosen Transmitters ein/aus.

1)	 Wenn „Picture Cache Rec“ zugewiesen ist, ist „Operation >Rec Function“ deaktiviert (abgeblendet dargestellt) und kann 
nicht eingestellt werden.

Zuweisung der Funktionen belegbarer Schalter
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Funktionen, die den Schaltern ASSIGN. 1 und 3, den Schaltern ASSIGNABLE 4 und 
5 und der Taste ONLINE zugewiesen werden können

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Off Keine Zuweisung —
Front Mic Schaltet zwischen Stereo (On) und Mono (Off) um, 

wenn ein Stereomikrofon angeschlossen ist.
Die Einstellung bleibt 
erhalten.

Marker Schaltet die Anzeige aller Markierungen ein bzw. 
aus.

Die Einstellung bleibt 
erhalten.

ATW Schaltet den ATW-Modus (automatische 
Weißwertanpassung) ein/aus.

Die Einstellung bleibt nicht 
erhalten.

ATW Hold Die Einstellung für den Weißabgleich im ATW-
Modus bleibt erhalten.

—

Turbo Gain Führt eine Turboverstärkung gemäß der 
Einstellung von „Operation >Gain Switch >Gain 
Turbo“ aus.

Die Einstellung bleibt nicht 
erhalten.

Rec Review Führt eine Aufnahmekontrolle durch. —
Rec Startet oder beendet eine Aufzeichnung. —
NFC Ausführen der NFC-Funktion. — 
Network Client Mode Schaltet den Netzwerkclientmodus ein/aus. Die Einstellung bleibt 

erhalten.
Streaming Schaltet die Streaming-Übertragung ein/aus. Die Einstellung bleibt nicht 

erhalten.
Auto Upload (Proxy) Aktivieren/Deaktivieren der automatischen 

Übertragung von Proxy-Dateien.
Die Einstellung bleibt 
erhalten.

Picture Cache Rec Schaltet den Bildpuffer-Aufzeichnungsmodus ein 
bzw. aus.

Die Einstellung bleibt 
erhalten.

Spotlight Schaltet die Spotlight-Funktion im Modus für die 
automatische Blendeneinstellung ein bzw. aus.

Die Einstellung bleibt 
erhalten.

Backlight Schaltet die Gegenlichtfunktion im Modus für die 
automatische Blendeneinstellung ein bzw. aus.

Die Einstellung bleibt 
erhalten.

VF Mode Schaltet die Sucheranzeige zwischen B&W (On) 
und Farbe (Off) um.

Die Einstellung bleibt 
erhalten.

Video Signal Monitor Schaltet die Monitoranzeigefunktion für 
Videosignale um.

Die Einstellung bleibt 
erhalten.

Lens Info Schaltet die Schärfentiefenanzeige zwischen Aus, 
Anzeige in Metern und Anzeige in Fuß um.

Die Einstellung bleibt 
erhalten.

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Zoom Tele/Wide Wenn ein Objektiv angebracht ist, das Serien-
Kommunikation unterstützt, wird die Zoom 
Tele-Funktion ASSIGNABLE 4 und die Zoom 
Wide-Funktion ASSIGNABLE 5 zugewiesen (wird 
nur angezeigt, wenn <4> und <5> eingestellt 
sind).

[Hinweis]
Ändern Sie die Zuweisung nicht während der 
eigenständigen Proxy-Aufnahme.

—

Zoom Wide/Tele Wenn ein Objektiv angebracht ist, das Serien-
Kommunikation unterstützt, wird die Zoom 
Wide-Funktion ASSIGNABLE 4 und die Zoom 
Tele-Funktion ASSIGNABLE 5 zugewiesen (wird 
nur angezeigt, wenn <4> und <5> eingestellt 
sind).

[Hinweis]
Ändern Sie die Zuweisung nicht während der 
eigenständigen Proxy-Aufnahme.

—

Manual Focus Assist Ein- bzw. Ausschalten der Assist-Funktion für den 
manuellen Fokus.

Die Einstellung bleibt 
erhalten.

Focus Magnifier Ein-/Ausschalten der 
Fokusvergrößerungsfunktion.

Die Einstellung bleibt nicht 
erhalten.

Zebra Ein-/Ausschalten des Streifenmusters. Die Einstellung bleibt nicht 
erhalten.

Lens RET Zeigt das Rückvideosignal an.
Wenn kein Kamera-Erweiterungsgerät 
angeschlossen ist: Rec Review (falls Wiedergabe 
möglich)

—

Return Video Zeigt das Rückvideosignal 1 an. —
Return Video2 Zeigt das Rückvideosignal 2 an. —
Return Video3 Zeigt das Rückvideosignal 3 an. —
Return Video4 Zeigt das Rückvideosignal 4 an. —
Shot Mark1 Schreibt Shot Mark1. —
Shot Mark2 Schreibt Shot Mark2. —
Clip Flag OK Hinzufügen/Löschen einer OK-Markierung zum/

vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Clip Flag NG Hinzufügen/Löschen einer NG-Markierung zum/
vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Clip Flag Keep Hinzufügen/Löschen einer KP-Markierung (Keep) 
zum/vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.
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Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Color Temp SW 3200K Dient zum Einstellen des Weißabgleichs mit dem 
Voreinstellungswert 3200K.

Die Einstellung bleibt 
erhalten.

Color Temp SW 4300K Dient zum Einstellen des Weißabgleichs mit dem 
Voreinstellungswert 4300K.

Die Einstellung bleibt 
erhalten.

Color Temp SW 5600K Dient zum Einstellen des Weißabgleichs mit dem 
Voreinstellungswert 5600K.

Die Einstellung bleibt 
erhalten.

Color Temp SW 6300K Dient zum Einstellen des Weißabgleichs mit dem 
Voreinstellungswert 6300K.

Die Einstellung bleibt 
erhalten.

Electrical CC Funktion zum Umschalten der elektrischen CC-Filter 
(3200K/4300K/5600K/6300K), die auf die Einstellwerte 
für den Weißabgleich angewandt werden.
Bei jedem Drücken des Schalters bzw. der Taste werden 
nacheinander die folgenden Werte ausgewählt:
3200K  4300K  5600K  6300K
Kann mit den Menüeinstellungen geändert 
werden (Electrical CC <A> <B> <C> <D>).

[Hinweis]
Diese Funktion ist nicht verfügbar, wenn „Maintenance 
>White Filter >ND Filter C.Temp“ im Konfigurationsmenü 
auf „On“ eingestellt ist.
Wenn Sie ND Filter C.Temp nach dem Zuweisen der 
Funktion auf On stellen, funktioniert der zuweisbare 
Schalter nicht mehr.

Die Einstellung bleibt 
erhalten.

CC5600K Wendet einen elektrischen CC-Filter von 5600K 
auf die Einstellwerte für den Weißabgleich an.

Die Einstellung bleibt 
erhalten.

Clip Continuous Rec Schaltet den Continuous-Rec-Modus des Clips ein 
bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Slow & Quick Motion Schaltet Zeitlupen und Zeitraffer ein bzw. aus. Die Einstellung bleibt 
erhalten.

Slot Select Wenn sich sowohl im Einschub A als auch im 
Einschub B ein Aufzeichnungsmedium befindet, 
wird damit die zu verwendende Karte ausgewählt.

—

Digital Extender ×2 Schaltet die Bildschirmvergrößerungsfunktion 
(×2) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender ×3 Schaltet die Bildschirmvergrößerungsfunktion 
(×3) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender ×4 Schaltet die Bildschirmvergrößerungsfunktion 
(×4) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender
×2×3×4

Schaltet den Vergrößerungswert der 
Bildschirmvergrößerungsfunktion um.
Mit jedem Drücken des Schalters bzw. der Taste 
wird in folgender Reihenfolge umgeschaltet: Aus 
 ×2  ×3  ×4  Aus.

Die Einstellung bleibt nicht 
erhalten.

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

TX Power Save Schaltet den Energiesparmodus des drahtlosen 
Transmitters ein/aus.

Die Einstellung bleibt nicht 
erhalten.

Flash Band Reduce Ein- bzw. Ausschalten der Flashband-Korrektur.

[Hinweis]
Auch wenn die Option „Flash Band Reduce“ auf „On“ 
gestellt wird, ist die Funktion nicht verfügbar, wenn der 
Schalter SHUTTER auf „ON“ steht.

Die Einstellung bleibt nicht 
erhalten.

Proxy Recording Mode Schaltet die Funktion zur Aufzeichnung von 
Proxy-Daten ein bzw. aus.

Die Einstellung bleibt 
erhalten.

Proxy Rec Start/Stop Startet/beendet die Proxy-Aufzeichnung. Die Einstellung bleibt nicht 
erhalten.
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Funktionen, die der RET-Taste auf dem Objektiv zugewiesen werden können

Zuweisbare 
Schaltereinstellung

Funktion Status beim nächsten 
Einschalten des Camcorders

Off Keine Zuweisung —
Lens RET Zeigt das Rückvideosignal an.

Wenn kein Kamera-Erweiterungsgerät 
angeschlossen ist: Rec Review (falls Wiedergabe 
möglich)

—

Return Video Zeigt das Rückvideosignal an. —
Rec Review Führt eine Aufnahmekontrolle durch. —
Shot Mark1 Schreibt Shot Mark1. —
Shot Mark2 Schreibt Shot Mark2. —
Clip Flag OK Hinzufügen/Löschen einer OK-Markierung zum/

vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Clip Flag NG Hinzufügen/Löschen einer NG-Markierung zum/
vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Clip Flag Keep Hinzufügen/Löschen einer KP-Markierung (Keep) 
zum/vom aktuell aufgezeichneten oder 
wiedergegebenen Clip.

Die Einstellung bleibt nicht 
erhalten.

Focus Magnifier Ein-/Ausschalten der 
Fokusvergrößerungsfunktion.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender ×2 Schaltet die Bildschirmvergrößerungsfunktion 
(×2) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender ×3 Schaltet die Bildschirmvergrößerungsfunktion 
(×3) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender ×4 Schaltet die Bildschirmvergrößerungsfunktion 
(×4) ein bzw. aus.

Die Einstellung bleibt nicht 
erhalten.

Digital Extender
×2×3×4

Schaltet den Vergrößerungswert der 
Bildschirmvergrößerungsfunktion um.
Mit jedem Drücken des Schalters bzw. der Taste 
wird in folgender Reihenfolge umgeschaltet: Aus 
 ×2  ×3  ×4  Aus.

Die Einstellung bleibt nicht 
erhalten.

Proxy Rec Start/Stop Startet/beendet die Proxy-Aufzeichnung. Die Einstellung bleibt nicht 
erhalten.
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Sie können Konfigurationsmenüeinstellungen 
im internen Speicher des Camcorders und auf 
SD-Speicherkarten speichern. Dadurch können 
Sie rasch die zur aktuellen Situation passenden 
Menüeinstellungen aufrufen.
Um Konfigurationsdaten auf einer SD-Karte zu 
speichern, setzen Sie zunächst eine beschreibbare 
SD-Karte (Seite 35) in den SD-Karteneinschub 
UTILITY ein.
Einzelheiten zu den in den jeweiligen Dateien 
gespeicherten Einstellungen siehe „Technische 
Daten“ (Seite 169).

Einsetzen einer SD-Karte zum Speichern von 
Konfigurationsdaten

1	 Öffnen Sie die Abdeckung über dem Schalter.

2	 Setzen Sie die SD-Karte zum Speichern von 
Konfigurationsdaten in den SD-Karteneinschub 
UTILITY ein.

3	 Schließen Sie die Abdeckung über dem 
Schalter.

Auswerfen einer SD-Karte zum Speichern von 
Konfigurationsdaten

1	 Öffnen Sie die Abdeckung über dem Schalter.

2	 Drücken Sie die SD-Karte ein kleines Stück 
hinein und entnehmen Sie sie dann.

[Hinweise]
ˎˎ Wenn während des Zugriffs auf die SD-Karte diese 

entfernt oder der Camcorder ausgeschaltet wird, kann die 
Integrität der Daten auf der Karte nicht garantiert werden. 
In diesem Fall können alle auf der Karte gespeicherten 
Daten verloren gehen. Stellen Sie stets sicher, dass die 
Anzeige ACCESS erloschen ist, bevor sie den Camcorder 
ausschalten oder die SD-Karte entnehmen.
ˎˎ Achten Sie darauf, dass die SD-Karte beim Einsetzen und 

Auswerfen nicht aus dem Einschub herauskatapultiert 
wird.

Die folgenden Benutzerdaten werden unterstützt.

Benutzerdateien

In den Benutzerdateien werden die 
Einstellungselemente und Daten des anpassbaren 
Menüs „User“ gespeichert. Sie können bis zu 64 
Dateien auf einer SD Karte speichern. Wenn Sie 
diese Datei in den Camcorder-Speicher laden, 
können Sie die Konfiguration des Menüs „User“ 
ändern.

ALL-Dateien

In den ALL-Dateien werden die Einstellungsdaten 
aller Menüs gespeichert. Sie können bis zu 64 
Dateien auf einer SD Karte speichern.

[Hinweis]
Gerätespezifische Daten (Schattierung, Ausgangspegel und 
sonstige für ein bestimmtes Gerät benötigte Einstellungen) 
werden nicht gespeichert.

Szenendateien

In Szenendateien werden die Einstellungen von 
Punkten des Menüs „Paint“ für die Aufnahme 
einer bestimmten Szene gespeichert. Im internen 
Speicher des Camcorders können bis zu fünf 
und auf einer SD-Speicherkarte bis zu 64 Dateien 
gespeichert werden.
Mit Szenendateien können Sie die folgenden 
Datentypen speichern.
ˎˎ Im Menü „Paint“ eingestellte Werte
ˎˎ Im Standardmodus oder im Modus ECS 
eingestellte Belichtungszeiten
ˎˎ Weißabgleichdaten 
Die gespeicherten und geladenen Daten 
sind abhängig von den Einstellungen von 
„File >Scene File >Scene White Data“ im 
Konfigurationsmenü.

Szenendateien können im internen Speicher 
des Camcorders oder auf einer SD-Speicherkarte 
gespeichert werden.
Szenendateien können auch in den Camcorder 
geladen werden.

Referenzdateien

In Referenzdateien werden die 
Standardeinstellungen von Szenendateien 
gespeichert (wenn „File ID“ auf „Standard“ gesetzt 
ist). Sie können eine Datei im internen Speicher 
des Camcorders und eine Datei auf einer SD-
Speicherkarte speichern.

Objektivdateien

Sie können die folgenden Daten zur Korrektur 
der Objektiveigenschaften einstellen und sie als 
Objektivdatei speichern. Im internen Speicher 
des Camcorders können bis zu 32Objektivdateien 
und auf einer SD-Speicherkarte bis zu 
64Objektivdateien gespeichert werden.

Konfigurationsdaten Unterpunkte
Werte für V-Modulations-
Schattierungskorrektur

M V Modulation

Position der 
Mittelmarkierung

Lens Center H
Lens Center V

Streulichtpegel R Flare
G Flare
B Flare

Weißabgleich-Korrekturwert White Offset R
White Offset B

Weißschattierungs-
Korrekturwert

Shading Ch Select
Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

Gammadateien

Sie können bis zu fünf benutzerdefinierte Gamma-
Tabellendateien (Benutzer-Gammadatendateien) 
im internen Speicher speichern.

Benutzerkonfigurationsdaten
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Speichern einer Benutzerdatei

1	 Wählen Sie im Konfigurationsmenü „File > 
User File >Save SD Card“ aus.
Ein Bildschirm zur Auswahl eines Speicherorts 
für Benutzerdateien wird angezeigt.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Sie können Dateien in Zeilen mit einer leeren 
Datei-ID speichern. Bei der Auswahl einer Zeile 
mit einer angegebenen Datei-ID wird die 
ausgewählte Datei überschrieben.
Die Datei-ID wird automatisch erzeugt, kann 
jedoch geändert werden.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Ändern der Datei-ID

1	 Wählen Sie im Konfigurationsmenü „File >User 
File >File ID“ aus.
Der Bildschirm zur Bearbeiten der Datei-ID 
wird angezeigt.

2	 Wählen Sie Zeichen aus, und geben Sie die 
Datei-ID ein.

3	 Drehen Sie den Regler MENU, um [Done] 
auszuwählen, und drücken Sie dann den 
Regler.
Die Datei-ID wird aktualisiert.

Laden einer Benutzerdatei

1	 Wählen Sie im Konfigurationsmenü „File >User 
File >Load SD Card“ aus.
Ein Bildschirm mit einer Liste von 
Benutzerdateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

[Hinweis]
Der Camcorder startet nach dem Laden von 
Konfigurationsdaten automatisch neu.

Benutzerdateien
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Speichern von Konfigurationsdaten 
als ALL-Datei

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >Save SD Card“.
Ein Bildschirm zur Auswahl eines Speicherorts 
für ALL-Dateien wird angezeigt.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Sie können Dateien in Zeilen mit einer leeren 
Datei-ID speichern. Bei der Auswahl einer Zeile 
mit einer angegebenen Datei-ID wird die 
ausgewählte Datei überschrieben.
Die Datei-ID wird automatisch erzeugt, kann 
jedoch geändert werden.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Falls eine Fehlermeldung erscheint

Möglicherweise erscheint während des 
Speichervorgangs oder sobald Sie [Execute] 
wählen eine der folgenden Fehlermeldungen. In 
diesem Fall wird die Datei nicht gespeichert.

Fehlermeldung Problem Lösung

File Access
NG

Es ist kein 
beschreibbares 
Medium 
eingelegt.

Legen Sie ein 
beschreibbares 
Medium ein.

Ändern der Datei-ID

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >File ID“.
Der Bildschirm zur Bearbeiten der Datei-ID 
wird angezeigt.

2	 Wählen Sie Zeichen aus, und geben Sie die 
Datei-ID ein.

3	 Drehen Sie den Regler MENU, um [Done] 
auszuwählen, und drücken Sie dann den 
Regler.
Die Datei-ID wird aktualisiert.

Laden von Konfigurationsdaten

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >Load SD Card“.
Ein Listenbildschirm mit ALL-Dateien wird 
angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

[Hinweise]
ˎˎ Wenn Sie eine Datei von einer SD-Karte laden, werden 

die im internen Speicher des Camcorders gespeicherten 
Daten überschrieben.
ˎˎ Rufen Sie keine Datei auf einem Gerät ab, dessen Version 

älter ist als das Gerät, von dem die Datei gespeichert 
wurde. Dies kann zu einer Fehlfunktion führen.
ˎˎ Der Camcorder startet nach dem Laden von 

Konfigurationsdaten automatisch neu.

Falls eine Fehlermeldung erscheint

Möglicherweise erscheint während des 
Ladevorgangs oder sobald Sie [Execute] wählen 
eine der folgenden Fehlermeldungen. In diesem 
Fall wird die Datei nicht geladen.

Fehlermeldung Problem Lösung

File Access
NG

Es ist kein 
lesbares Medium 
eingelegt.
Die angegebene 
Datei befindet 
sich nicht auf 
dem Medium.

Legen Sie das 
Medium ein, auf 
dem sich die 
gewünschte 
Datei befindet.

Zurücksetzen sämtlicher 
Einstellungen auf die 
Voreinstellungswerte

Menüeinstellungen, die bei der Ersteinrichtung 
vom Benutzer festgelegt bzw. gespeichert 
wurden, werden in diesem Dokument als 
„Voreinstellungswerte“ bezeichnet.
Selbst nach dem Laden von Dateien zum 
Konfigurieren des Camcorders und dem 
Überschreiben von Originaldateien mit neuen 
Einstellungen können Sie den Inhalt der Dateien 
durch Wiederherstellen der Voreinstellungswerte 
zurücksetzen.

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >All Preset“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Speichern sämtlicher Einstellungen 
als Voreinstellungswerte

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >Store All Preset“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

[Hinweis]
Der Camcorder startet nach der Ausführung automatisch 
neu.

Zurücksetzen der aktuellen 
Einstellungen und 
Voreinstellungswerte auf die 
werkseitigen Einstellungen

1	 Wählen Sie im Konfigurationsmenü „File >All 
File >Clear All Preset“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

[Hinweis]
Der Camcorder startet nach der Ausführung automatisch 
neu.

ALL-Dateien
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Speichern einer Szenendatei im 
internen Speicher

1	 Wählen Sie im Konfigurationsmenü „File 
>Scene File >Store Internal Memory“.
Ein Bildschirm mit einer Liste von 
Szenendateien wird angezeigt.
Wenn die Datei-ID auf den „Standard“-
Speicherort eingestellt ist, werden 
vorkonfigurierte Standardeinstellungen 
gespeichert.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Die Szenendatei wird im gewünschten 
Zielordner gespeichert. Vorhandene Dateien 
werden dabei überschrieben.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Speichern einer Szenendatei auf einer 
SD-Karte

1	 Wählen Sie im Konfigurationsmenü „File 
>Scene File >Save SD Card“.
Ein Speicherort für Szenendateien wird 
angezeigt.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Sie können Dateien in Zeilen mit einer leeren 
Datei-ID speichern. Bei der Auswahl einer Zeile 

mit einer angegebenen Datei-ID wird die 
ausgewählte Datei überschrieben.
Die Datei-ID wird automatisch erzeugt, kann 
jedoch geändert werden.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Ändern der Datei-ID

1	 Wählen Sie im Konfigurationsmenü „File 
>Scene File >File ID“.
Der Bildschirm zur Bearbeiten der Datei-ID 
wird angezeigt.

2	 Wählen Sie Zeichen aus, und geben Sie die 
Datei-ID ein.

3	 Drehen Sie den Regler MENU, um [Done] 
auszuwählen, und drücken Sie dann den 
Regler.
Die Datei-ID wird aktualisiert.

Laden einer Szenendatei aus dem 
internen Speicher

1	 Wählen Sie im Konfigurationsmenü „File 
>Scene File >Recall Internal Memory“.
Ein Bildschirm mit einer Liste von 
Szenendateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.

Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Laden einer Szenendatei von einer 
SD-Karte

1	 Wählen Sie im Konfigurationsmenü „File 
>Scene File >Load SD Card“.
Ein Bildschirm mit einer Liste von 
Szenendateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Szenendateien
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Speichern der gegenwärtigen 
Einstellungen als 
Voreinstellungswerte

1	 Wählen Sie im Konfigurationsmenü „File 
>Reference File >Store Reference“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Speichern der aktuellen 
Einstellungen als 
Voreinstellungswerte auf einer SD-
Karte

1	 Wählen Sie im Konfigurationsmenü „File 
>Reference File >Save Reference(SD Card)“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Ändern der Datei-ID

1	 Wählen Sie im Konfigurationsmenü „File 
>Reference File >File ID“.
Der Bildschirm zur Bearbeiten der Datei-ID 
wird angezeigt.

2	 Wählen Sie Zeichen aus, und geben Sie die 
Datei-ID ein.

3	 Drehen Sie den Regler MENU, um [Done] 
auszuwählen, und drücken Sie dann den 
Regler.
Die Datei-ID wird aktualisiert.

Laden von Referenzdateien auf einer 
SD-Karte

1	 Wählen Sie im Konfigurationsmenü „File 
>Reference File >Load Reference(SD Card)“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Zurücksetzen der aktuellen 
Einstellungen und 
Voreinstellungswerte auf die 
werkseitigen Einstellungen

1	 Wählen Sie im Konfigurationsmenü „File 
>Reference File >Clear Reference“.
Ein Bestätigungsbildschirm wird angezeigt.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Referenzdateien
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Speichern einer Objektivdatei im 
internen Speicher

1	 Wählen Sie im Konfigurationsmenü „File >Lens 
File >Store Internal Memory“.
Ein Bildschirm mit einer Liste von 
Objektivdateien wird angezeigt.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Sie können Dateien in Zeilen mit der Datei-ID 
„No offset.“ speichern. Bei der Auswahl einer 
Zeile mit einer angegebenen Datei-ID wird die 
ausgewählte Datei überschrieben.
Die Datei-ID wird automatisch erzeugt, kann 
jedoch geändert werden.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Speichern einer Objektivdatei auf 
einer SD-Karte

1	 Wählen Sie im Konfigurationsmenü „File >Lens 
File >Save SD Card“.
Ein Speicherort für Objektivdateien wird 
angezeigt.

2	 Drehen Sie am Regler MENU, um einen 
Speicherort auswählen, und drücken Sie dann 
den Regler.
Sie können Dateien in Zeilen mit einer leeren 
Datei-ID speichern. Bei der Auswahl einer Zeile 
mit einer angegebenen Datei-ID wird die 

ausgewählte Datei überschrieben.
Die Datei-ID wird automatisch erzeugt, kann 
jedoch geändert werden.

3	 Drehen Sie am Regler MENU, um auf dem 
Bildschirm mit der Bestätigungsmeldung die 
Option [Execute] auszuwählen, und drücken 
Sie den Regler.

Ändern der Datei-ID

1	 Wählen Sie im Konfigurationsmenü „File >Lens 
File >File ID“.
Der Bildschirm zur Bearbeiten der Datei-ID 
wird angezeigt.

2	 Wählen Sie Zeichen aus, und geben Sie die 
Datei-ID ein.

3	 Drehen Sie den Regler MENU, um [Done] 
auszuwählen, und drücken Sie dann den 
Regler.
Die Datei-ID wird aktualisiert.

Laden einer Objektivdatei aus dem 
internen Speicher

1	 Wählen Sie im Konfigurationsmenü „File >Lens 
File >Recall Internal Memory“.
Ein Bildschirm mit einer Liste von 
Objektivdateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Laden einer Objektivdatei von einer 
SD-Karte

1	 Wählen Sie im Konfigurationsmenü „File >Lens 
File >Load SD Card“.
Ein Bildschirm mit einer Liste von 
Objektivdateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Automatisches Laden einer 
Objektivdatei

Wenn Sie ein Objektiv verwenden, das serielle 
Kommunikation unterstützt, können Sie den 
Camcorder einstellen, indem automatisch 
die Objektivdatei geladen wird, die den 
Objektiveinstellungen entspricht (Lens Auto 
Recall-Funktion).
Zum Verwenden der Lens Auto Recall-Funktion 
stellen Sie „File >Lens File >Lens Auto Recall“ 
im Konfigurationsmenü auf eine der folgenden 
Optionen ein:
Off: Keine Verwendung der Lens Auto Recall-

Funktion.

On (Objektivname): Laden der dem 
Objektivmodellnamen zugeordneten 
Objektivdatei.

On (Seriennummer): Laden der Objektivdatei, 
die dem Objektivmodellnamen und der 
Seriennummer entspricht (falls das Objektiv 
die Seriennummern-Kommunikation 
unterstützt).

Falls das Objektiv keine Seriennummern-
Kommunikation unterstützt, obwohl die 
Einstellung On (Serial Number) gewählt ist, 
wird bei beiden Einstellungen die Objektivdatei 
geladen, die dem Objektivmodellnamen 
entspricht.

Objektivdateien
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Überprüfen der aktuellen 
Gammadateieinstellungen 
(Dateinamen)

Wählen Sie im Konfigurationsmenü „File >User 
Gamma >Current Settings“, um eine Liste 
der gegenwärtig konfigurierten Benutzer-
Gammadateien anzuzeigen.

Laden einer Benutzer-Gammadatei 
von einer SD-Karte:

1	 Wählen Sie im Konfigurationsmenü „File >User 
Gamma >Load SD Card“.
Ein Bildschirm mit einer Liste von Benutzer-
Gammadateien wird angezeigt.

2	 Drehen Sie den Regler MENU, um eine zu 
ladende Datei auszuwählen, und drücken Sie 
dann den Regler.
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Verwendung von Benutzer-
Gammadateien, die mit 
CvpFileEditorTM V4.3 erstellt wurden

Speichern Sie erstellte Benutzer-Gammadateien, 
die geladen werden sollen, im Verzeichnis 
„PRIVATE/SONY/PRO/CAMERA/HD_CAM“ der 
SD-Karte.

Zurücksetzen einer Benutzer-
Gammadatei in den Anfangszustand

1	 Wählen Sie im Konfigurationsmenü „File >User 
Gamma >Reset“.
Ein Bildschirm zum Zurücksetzen einer 
Gammadatei wird angezeigt.

2	 Drehen Sie am Regler MENU, um die Nummer 
der zurückzusetzenden Gammadatei 
auszuwählen (1 bis 5).
Um alle Gammadateien zurückzusetzen, 
wählen Sie [All].
Ein Bestätigungsbildschirm wird angezeigt.

3	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.

Gammadateien
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Anschließen einer Fernbedienung
Wenn eine Fernbedienung RM-B170,  
RCP-1001/1501 oder ein anderes Steuergerät 
angeschlossen ist, können einige 
Camcorderfunktionen von diesem Gerät gesteuert 
werden.
Sie können auch mithilfe eines mit dem Anschluss 
MONITOR an der RM-B170 verbundenen Monitors 
das Menü bedienen und das Bild überwachen.

Anschließen einer Fernbedienung

Verbinden Sie den 8-poligen Anschluss REMOTE 
am Camcorder und den Kameraanschluss 
der Fernbedienung unter Verwendung des 
Fernbedienungskabels.
Wenn Sie den Camcorder nach dem Herstellen 
der Verbindung einschalten, wechselt 
er in den Fernbedienungsmodus und 
ermöglicht die Verwendung von Menü- und 
Aufzeichnungsfunktionen.

[Hinweise]
ˎˎ Die Fernbedienung wird nicht unterstützt, wenn die USB-

Verbindung mit dem Camcorder aktiviert ist.
ˎˎ Wenn bei Verwendung einer Fernbedienung eine USB-

Verbindung mit dem Camcorder aktiviert wird, wird der 
Fernbedienungsmodus deaktiviert.
ˎˎ Wenn der Camcorder eingeschaltet ist, darf die 

Fernbedienung nicht angeschlossen oder getrennt 
werden.
ˎˎ Im Lieferumfang der Fernbedienung RCP-1001/1501 ist 

kein Fernbedienungskabel enthalten.

Die folgenden Schalter des Camcorders 
sind deaktiviert, wenn eine Fernbedienung 
angeschlossen ist.
ˎˎ Schalter GAIN
ˎˎ Schalter WHITE BAL
ˎˎ Schalter AUTO W/B BAL
ˎˎ Schalter SHUTTER
ˎˎ Schalter OUTPUT/DCC
ˎˎ Die Schalter ASSIGN. 1/3, ASSIGNABLE 4/5 und 
die Taste ONLINE, der die Funktion Turbo Gain 
oder ATW zugewiesen ist

Deaktivieren des 
Fernbedienungsmodus

Schalten Sie den Camcorder aus und trennen Sie 
die Verbindung zur Fernbedienung.
Die Schaltereinstellungen am Camcorder werden 
aktiviert.

Anschließen eines Monitors an eine 
RM-B170

Der MONITOR-Anschluss (BNC-Typ) der RM-B170 
gibt das gleiche Signal aus wie der VIDEO OUT-
Anschluss.
Stellen Sie für den Anschluss VIDEO OUT des 
Camcorders ein Composite-Signal ein und 
verwenden Sie das im Lieferumfang der RM-B170 
enthaltene schwarze Kabel, um einen Monitor 
mit dem MONITOR-Anschluss der RM-B170 zu 
verbinden.

Regelung der Bildqualität bei 
angeschlossener RM-B170

Wenn die RM-B170 angeschlossen wird, 
werden die Parameter für die Regelung der 
Kamerabildqualität (Darstellungsdaten) aktiviert, 
die beim letzten Anschluss der RM-B170 
eingestellt waren.

Funktion der Aufzeichnungsstart-/ 
Aufzeichnungsstopp-Tasten bei 
angeschlossener RM-B170

Stellen Sie die Funktion der Tasten im 
Konfigurationsmenü über „Maintenance >Camera 
Config >RM Rec Start“ ein.

Im Folgenden werden die Funktionen der Tasten 
für die RM Rec Start-Einstellungen angegeben.

Taste Einstellung von RM Rec Start
RM Camera PARA

Taste REC START 
des Camcorders

Deaktiviert Aktiviert Aktiviert

Taste VTR des 
Objektivs

Deaktiviert Aktiviert Aktiviert

Die Schalter 
ASSIGN. 1/3, 
ASSIGNABLE 4/5 
und die Taste 
ONLINE, der die 
Start-/Stopp-
Funktion 
zugewiesen ist

Deaktiviert Aktiviert Aktiviert

Taste RM-B170 
MEDIA START

Aktiviert Deaktiviert Aktiviert

Datenstruktur der Daten für die 
Regelung der Bildqualität

Der nichtflüchtige Speicher des Camcorders 
zum Speichern der Daten für die Regelung 
der Kamerabildqualität (Darstellungsdaten) 
besteht aus den zwei unten gezeigten 
Bereichen: einem „Hauptdatenblock“, der 
verwendet wird, wenn keine Fernbedienung 
angeschlossen ist, und einem „Fernbedienungs-

Datenblock“, der verwendet wird, wenn eine 
Fernbedienung angeschlossen ist. Je nachdem, 
ob eine Fernbedienung wie z. B. die RM-B170 
angeschlossen ist, werden die Darstellungsdaten 
automatisch ausgewählt und an die 
Kamerasektion ausgegeben.

Konfigurationsmenü des 
Camcorders

Hauptdatenblock Fernbedienungs-
Datenblock

Kamera-Hardware

RM-B170 angeschlossen
RM-B170 nicht angeschlossen

RM-B170

Nichtflüchtiger Speicher des Camcorders

Wenn eine Fernbedienung angeschlossen ist, 
wird der „Fernbedienungs-Datenblock“ als 
aktueller Darstellungsdatenblock ausgewählt, und 
die Darstellungsparameter, die bei der letzten 
Verwendung der Fernbedienung wirksam waren, 
werden wieder geladen.
Wenn jedoch die Einstellungen der 
Absolutwertsteuerungen 1) und der 
Absolutwertschalter 2) für die Fernbedienung auf 
der Fernbedienung eingestellt sind, haben die 
Einstellungen der Fernbedienung Vorrang vor den 
Einstellungen des Camcorders.
Wenn eine Fernbedienung vom Camcorder 
getrennt wird, wird wieder der „Hauptdatenblock“ 
aktiviert und der Camcorder verwendet wieder 
die Einstellungen, die vor dem Anschließen der 
Fernbedienung aktiv waren.
1)	 Absolutwertsteuerungen: Daten werden entsprechend 

der Winkelposition der Regler ausgegeben. Regler, für die 
Daten entsprechend der Gesamtdrehung ausgegeben 
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werden, werden als Relativwertsteuerungen bezeichnet.
2)	 Absolutwertschalter: Schalter (oder Regler) wie z. 

B. Positionsschalter oder Schieberegler (außer den 
meisten Tastern), deren Positionen notwendigerweise 
mit ihren Funktionen zusammenfallen, werden als 
Absolutwertschalter bezeichnet.

Wenn „Maintenance >Camera Config >RM 
Common Memory“ im Konfigurationsmenü 
auf [On], gesetzt ist, können Sie auch dann 
die Einstellungen für die Darstellungsdaten 
im Hauptdatenblock verwenden, wenn eine 
Fernbedienung angeschlossen ist. In diesem Fall 
werden die im Hauptdatenblock gespeicherten 
Einstellungen aktualisiert, wenn Sie die 
Einstellungen auf der Fernbedienung ändern. 
Die mit der Fernbedienung vorgenommenen 
Einstellungen der Darstellungsdaten werden 
beibehalten, auch wenn die Fernbedienung 
entfernt wird. Wenn jedoch die Schalterstellung 
auf der Fernbedienung von der auf dem 
Camcorder abweicht, hat die Schalterstellung auf 
dem Camcorder Vorrang.
Außerdem ist es möglich, die Einstellungen 
beizubehalten, die vor dem Anschließen der 
Fernbedienung in Kraft sind. In diesem Fall müssen 
Sie die Regler auf der Fernbedienung in den 
Relativwertmodus schalten.

Einzelheiten entnehmen Sie bitte der Bedienungsanleitung der 
Fernbedienung.

Bedienung des Menüs mit der 
RM-B170

1	 Drücken Sie zum Einschalten der RM-B170 
daran die Taste CHARACTER und dann die 
Taste MENU.
Das Menü wird auf dem an den Anschluss 
MONITOR der RM-B170 angeschlossenen 
Monitor angezeigt.

2	 Wählen Sie Menüpunkte mit dem Einstellregler 
aus und nehmen Sie mit der Taste CANCEL/
ENTER Einstellungen vor.

3	 Stellen Sie zum Abschluss die Taste MENU auf 
OFF, um das Menü zu verlassen.
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An RCP-1001/1501, RM-B170 unterstützte Hauptfunktionen

Tabellenerklärung
Die Signalunterstützung wird wie folgt angegeben. 
Ja: Verfügbar
–: Nicht verfügbar
Menüoption Unteroption Einstellungen Funktion RCP-1001 RCP-1501 RM-B170
Panel Active Panel Active On/Off Schaltet die Funktion der Bedientafel ein/aus. Ja Ja Ja
Bars Bars On/Off Schaltet die Ausgabe von Farbbalken ein/aus. Ja Ja Ja
Call Call On/Off Ruft den Camcorder von der RCP/RM aus an. Ja Ja Ja 1)

Standard Standard On/Off Schaltet den Standardmodus ein/aus. Ja Ja Ja 1)

ND Filter ND Filter 1/2/3/4 Zeigt den ausgewählten ND-Filter an. Ja Ja Ja
CC Filter CC Filter A/B/C/D Zeigt den ausgewählten CC-Filter an. – – –

Gain Step Gain –6/–3/0/3/6/9/12/18/24/30/ 
36/42dB

Hauptverstärkungseinstellung Ja Ja Ja

White Balance AWB Start/Stop Startet den automatischen Weißabgleich.
Während seiner Ausführung wird hierdurch der automatische 
Weißabgleich gestoppt.

Ja Ja Ja

White Memory A/B/PRESET Wechselt den Voreinstellungsspeicher des Weißabgleichs. Ja Ja Ja
ATW On/Off Schaltet ATW ein/aus. Ja 1) Ja Ja 1)

5600K On/Off Schaltet die elektrische Farbtemperaturwandlung ein/aus. Ja Ja Ja 1)

Black ABB Start/Stop Startet die automatische Einstellung des Schwarzabgleichs.
Während seiner Ausführung wird hierdurch der Schwarzabgleich 
gestoppt.

Ja Ja Ja

Knee Point 75% bis 90% bis 109% Legt den Kniepunkt fest. – Ja Ja 1)

Detail Level –99 bis ±0 bis +99 Legt den HD-Detailpegel fest. Ja Ja Ja
Shutter Shutter Setting On/Off Schaltet den Verschluss ein/aus. – Ja Ja

Shutter Speed – Legt die Belichtungszeit fest. – Ja Ja
ECS Setting On/Off Schaltet den ECS-Modus ein/aus. – Ja Ja
ECS Frequency – Legt die Frequenz des ECS-Modus fest. – Ja Ja
SLS Setting On/Off Schaltet den SLS-Modus ein/aus. – Ja Ja
SLS Speed – Legt die Geschwindigkeit des SLS-Modus fest (Anzahl 

Einzelbilder).
– Ja Ja

Iris Iris Mode Auto/Manual Legt den Blendenmodus fest. Ja Ja Ja

Iris Level –99 bis ±0 bis +99 Passt den Zielpegel der Blendenautomatik an. Ja Ja Ja
Close On/Off Schaltet die Schließung der Blendensteuerung ein/aus. Ja Ja –
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Menüoption Unteroption Einstellungen Funktion RCP-1001 RCP-1501 RM-B170
Switch Status Gamma On/Off Ein- bzw. Ausschalten der Gammakorrekturfunktion. – Ja Ja 1)

Black Gamma On/Off Ein- bzw. Ausschalten der Schwarzgammakorrekturfunktion. Ja 1) Ja Ja 1)

Matrix On/Off Ein- oder Ausschalten der Matrixfunktion. – Ja Ja 2)

Knee On/Off Ein- bzw. Ausschalten der Kniekorrekturfunktion. – Ja Ja 1)

White Clip On/Off Ein- bzw. Ausschalten der Weiß-
Amplitudenbegrenzungsfunktion.

– Ja Ja 2)

Detail On/Off Ein- bzw. Ausschalten der Detailanpassungsfunktion. – Ja Ja
Flare On/Off Ein- bzw. Ausschalten der Streulichtkorrekturfunktion. – Ja Ja 1)

Test Saw On/Off Ein- bzw. Ausschalten des Testsignals. – Ja Ja 1)

White R Gain –99 bis ±0 bis +99 Legt den R-Verstärkungswert des Weißabgleichs fest. Ja Ja Ja
B Gain –99 bis ±0 bis +99 Legt den B-Verstärkungswert des Weißabgleichs fest. Ja Ja Ja

Black Master Black –99 bis ±0 bis +99 Zum Einstellen des Master-Schwarzpegels. Ja Ja Ja
R Black –99 bis ±0 bis +99 Zum Einstellen des Schwarzpegels des R-Kanals. Ja Ja Ja
B Black –99 bis ±0 bis +99 Zum Einstellen des Schwarzpegels des B-Kanals. Ja Ja Ja

Camcorder Menu Menu On/Off Zeigt das Camcorder-Menü an. – – Ja
Cancel/Preset Cancel/Preset – – Ja
Select/Set Select(Up/Down)/Set – – Ja

Media Rec Start/Stop Startet/beendet die Aufzeichnung. – – Ja
Play Play/Pause Startet die Wiedergabe. – – Ja
FREV – Schnelle Wiedergabe rückwärts – – Ja
FFWD – Schnelle Wiedergabe vorwärts – – Ja
STOP – Stoppt die Wiedergabe. – – Ja
Rec Review – Startet die Aufnahmekontrolle. – – Ja
PREV – Springt zum Anfang des aktuellen Clips. – – Ja
NEXT – Springt zum Anfang des nächsten Clips. – – Ja

Shot Mark Shot Mark1 – Setzt die Szenenmarkierung 1. – – Ja
Shot Mark2 – Setzt die Szenenmarkierung 2. – – Ja 1)

ZOOM – – Zoom-Betrieb (mit kompatiblem Objektiv) – – Ja 1)

FOCUS – – Fokus-Betrieb (mit kompatiblem Objektiv) – – Ja 1)

1)	 Betrieb wird unterstützt, wenn die Funktion an der RCP/RM einem belegbaren Schalter zugewiesen wurde.
2)	 Bedienung des Camcorder-Menüs von RM aus unterstützt.
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Wählen Sie das Ausgangssignal und schließen Sie den Monitor mit einem geeigneten Kabel an.

BNC-Kabel (nicht mitgeliefert)

BNC-Kabel (nicht mitgeliefert)

Unabhängig davon, ob es sich um ein HD- oder 
SD-Signal handelt, können auf dem externen 
Monitor dieselben Statusinformationen und 
Menüs wie in der Sucheranzeige angezeigt 
werden.

[Hinweis]
Die abwärts konvertierte Ausgabe des SD-Signals ist aktiviert, 
wenn „Operation >Input/Output >Output Format“ im 
Konfigurationsmenü auf 720×486i oder 720×576i gesetzt ist.

Anschluss SDI OUT (BNC)

Der Anschluss SDI OUT kann zum Anschließen 
eines Geräts verwendet werden, das SDI 
unterstützt. Es kann sich bei dem Gerät um einen 
Monitor, Schalter, Videorekorder oder ein sonstiges 

Aufnahmegerät handeln.
Die Ausgabe aus diesem Anschluss kann durch 
„Operation >Input/Output >SDI Out1 Output/SDI 
Out2 Output“ im Konfigurationsmenü ein- oder 
ausgeschaltet werden (Seite 98).
Verwenden Sie für den Anschluss ein BNC-Kabel 
(nicht mitgeliefert).

Anschluss VIDEO OUT

Der Anschluss VIDEO OUT kann zum Verbinden 
eines Geräts verwendet werden, das analoge 
FBAS-Signale unterstützt. Es kann sich bei dem 
Gerät um einen Monitor, Videorekorder oder ein 
sonstiges Aufnahmegerät handeln.
Das Ausgabeformat ändert sich mit der Einstellung 

„Operation >Input/Output >Output Format“ im 
Einstellungsmenü.
Zur Eingabe des Ausgabesignals aus dem 
Anschluss VIDEO OUT in ein externes analoges 
FBAS-Gerät ist es eventuell notwendig, die 
Eingangssignaleinstellungen dieses externen 
Geräts zu ändern, damit sie zu den Einstellungen 
des analogen FBAS-Signals des Anschlusses VIDEO 
OUT passen.
Zur Eingabe von Audio-Ausgabesignalen in 
ein externes Gerät wie einen Monitor, einen 
Videorecorder oder ein anderes Aufnahmegerät, 
verbinden Sie die Audioausgabe des Anschlusses 
AUDIO OUT mit dem Audioeingang des externen 
Gerätes.
Verwenden Sie für den Anschluss ein BNC-Kabel 
(nicht mitgeliefert).

Anschluss HDMI OUT (Typ A)

Sie können das Ausgangssignal des Camcorders 
mit „Operation >Input/Output >HDMI Output“ im 
Konfigurationsmenü ein bzw. ausschalten.
Das Ausgabesignalformat wird mit „Operation 
>Input/Output >Output Format“ im 
Einstellungsmenü eingestellt.
Verwenden Sie für die Verbindung ein 
handelsübliches HDMI-Kabel.

Anschließen eines externen Monitors
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Die Clips, die mit diesem Camcorder auf eine 
SxS-Speicherkarte aufgezeichnet wurden, 
können mithilfe der optionalen nonlinearen 
Bearbeitungssoftware auf einem Computer editiert 
werden.
Sie können Clips auf SxS-Speicherkarten auf ein 
mobiles Speichergerät oder auf andere USB-
Medien kopieren, wenn mobile Speichergeräte/
USB-Medien an den Anschluss für externe Geräte 
angeschlossen sind.

USB-Verbindung mit einem 
Computer

Wenn Sie den Camcorder über ein USB-Kabel 
(nicht mitgeliefert) mit einem Computer 
verbinden, erkennt der Computer die 
Speicherkarte im Einschub als erweiterten 
Datenträger.
Wenn zwei Speicherkarten in den Camcorder 
eingesetzt sind, werden sie als zwei unabhängige 
Laufwerke vom Computer erkannt.

USB-Kabel  
(nicht mitgeliefert)

[Hinweise]
ˎˎ Schalten Sie den Camcorder ein, und warten Sie, bis auf 

dem Bildschirm das Bild und Informationen angezeigt 
werden. Schließen Sie dann das USB-Kabel an den 
Camcorder an.
ˎˎ Achten Sie beim Anschließen eines USB-Kabels am 

Computer auf die Form und Richtung des USB-
Anschlusses.
ˎˎ Der Camcorder arbeitet nicht über die Bus-

Stromversorgung des Computers.

Starten einer USB-Verbindung

Wenn Sie einen Computer über den USB-
Anschluss mit einem USB-Kabel (nicht mitgeliefert) 
verbinden, wird die Meldung „Connect USB 
Now?“ angezeigt, um Sie dazu aufzufordern, die 
Aktivierung der USB-Verbindung zu bestätigen.
Wenn Sie „Cancel“ wählen oder den Schalter 
MENU CANCEL/PRST/ESCAPE nach unten in 
Richtung ESCAPE drücken, oder wenn Sie das USB-
Kabel trennen, wird die Meldung „Connect USB 
Now?“ ausgeblendet.
Wenn Sie „Execute“ wählen und den Regler MENU 
drücken, wird Sie USB-Verbindung aktiviert und 
der Camcorder wird als Erweiterungslaufwerk 
erkannt.
Wenn die USB-Verbindung während des 
Aufzeichnungs-/Wiedergabebetriebs aktiviert wird, 
wird der Betrieb angehalten und die Meldung 
„USB Connecting“ erscheint auf der Sucheranzeige.
Dabei wird das Ausgabesignal der Anschlüsse 
VIDEO OUT und SDI OUT 1/2 zu einem 
Schwarzsignal.

[Hinweise]
ˎˎ Der Camcorder steht nicht für Aufzeichnung, Wiedergabe 

etc. zur Verfügung, während die Meldung „USB 
Connecting“ angezeigt wird.
ˎˎ Versuchen Sie nicht, die folgenden Funktionen 

auszuführen, während der Computer auf die in den 
Camcorder eingesetzten Medien zugreift.

–– Betreiben des Camcorders (Ein- und Ausschalten der 
Stromversorgung, Umschalten des Betriebsmodus 
usw.)

–– Entfernen bzw. Einlegen eines Mediums aus bzw. in 
einen aktiven Einschub (auf den der Computer zugreift)

–– Abtrennen bzw. Anschließen des USB-Kabels

Deaktivieren der USB-Verbindung

Zum Deaktivieren der USB-Verbindung gehen Sie 
auf die gleiche Weise vor wie beim Entfernen eines 
Geräts von dem Computer.
Um die USB-Verbindung erneut zu aktivieren 
trennen Sie zuerst das USB-Kabel und schließen 
Sie es dann erneut an. Die Meldung „Connect USB 
Now?“ erscheint erneut.

Herausnehmen einer SxS-Speicherkarte

Unter Windows

1	 Klicken Sie in der Taskleiste des Computers auf 
das Symbol „Hardware sicher entfernen“.

2	 Wählen Sie „Sichere Entfernung der SxS-
Speicherkarte - Laufwerk(X:)“ aus dem Menü.

3	 Wenn die Meldung „Hardware kann jetzt 
entfernt werden“ erscheint, können Sie die 
Speicherkarte entnehmen.

Auf Macintosh
Ziehen Sie das Symbol der SxS-Speicherkarte auf 
dem Desktop in den Papierkorb.
Wenn die SxS-Speicherkarte im Finder angezeigt 
wird, klicken Sie auf das Symbol für Auswerfen.

Verwendung der Anwendersoftware

Um Clips auf die lokale Festplatte des 
Computers zu kopieren, muss die dedizierte 
Anwendungssoftware heruntergeladen und auf 
dem Computer installiert werden. Einzelheiten 
zum Herunterladen von Software siehe „Software-
Downloads“ (Seite 172).
Obwohl die Daten des aufgezeichneten 
Materials in mehreren Dateien und Ordnern 
gespeichert werden, können Sie die Clips 
mithilfe der dedizierten Anwendungssoftware 
problemlos handhaben, ohne die Daten- und 

Verzeichnisstruktur zu berücksichtigen.

[Hinweis]
Wenn Sie über den Explorer (Windows) oder Finder 
(Macintosh) Dateioperationen mit Clips ausführen, 
beispielsweise die Clips auf der SxS-Speicherkarte kopieren, 
bleiben die Nebendaten der Clips u. U. nicht erhalten.

Verwenden eines nonlinearen 
Bearbeitungssystems

Ein nonlineares Bearbeitungssystem erfordert 
ein Bearbeitungsprogramm (Option), das 
die Aufzeichnungsformate des Camcorders 
unterstützt.
Speichern Sie zuerst die Clips, die bearbeitet 
werden sollen, mithilfe der mitgelieferten 
Anwendersoftware auf der Festplatte Ihres 
Computers.
Bei einigen Bearbeitungsprogrammen können 
Funktionsprobleme auftreten. Stellen Sie vor 
Verwendung eines Programms sicher, dass es 
mit den Aufzeichnungsformaten des Camcorders 
kompatibel ist.

Anschließen eines mobilen 
Speichergeräts/USB-Mediums

Wenn ein mobiles Speichergerät, eine USB-
Festplatte o. ä. Medien an den Anschluss für 
externe Geräte angeschlossen sind, können Sie 
Clips von dem in einen SxS-Karteneinschub des 
Camcorders eingesetzten Speichermedium auf 
USB-Medien kopieren.

1	 Geben Sie den Zielordner zum Kopieren der 
Clips mit „Operation >USB >Select Folder“ im 
Konfigurationsmenü an.
Sie können zum Erstellen eines neuen Ordners 
auch die Option [New] auf dem Bildschirm 
wählen.

Verwalten und Bearbeiten von Clips auf einem Computer
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	 [Hinweis]
Wenn kein Ordner angegeben wird, wird automatisch 
ein Ordner erstellt, dessen Ordnername dem 
Erstellungsdatum des ersten zu kopierenden Clips 
entspricht, und die Clips werden in diesen Ordner 
kopiert.

2	 Wählen Sie im Konfigurationsmenü die 
Befehlsfolge „Operation >USB >Copy to USB“.

3	 Wählen Sie den Einschub, in den das Ziel-
Speichermedium eingesetzt ist.
Media(A) to USB: Kopieren aller Clips von dem 

in Einschub A eingesetzten 
Speichermedium.

Media(B) to USB: Kopieren aller Clips von dem 
in Einschub B eingesetzten 
Speichermedium.

Media(A)(B) to USB: Kopieren aller Clips von 
den in Einschub A und B eingesetzten 
Speichermedien.

	 [Hinweis]
Wenn in Schritt 1 ein Kopierzielordner angegeben und 
„Media(A)(B) to USB“ ausgewählt wird, werden die Clips 
von Einschub A in den angegebenen Zielordner kopiert. 
Die Clips von Einschub B werden in einen automatisch 
erstellten Ordner kopiert, dessen Ordnername dem 
Erstellungsdatum des ersten zu kopierenden Clips 
entspricht.

4	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Alle Clips auf dem Ziel-Aufnahmemedium 
werden auf das USB-Medium kopiert.

	 [Hinweis]
Wenn im Zielordner bereits ein Clip vorhanden ist, 
dessen Dateiname dem zu kopierenden Clip entspricht, 
wird der Clip nicht kopiert.

Anzeigen einer Liste von Clips im mobilen 
Speichergerät bzw. auf dem USB-Medium

Mit der Befehlsfolge „Operation >USB >View Clip 

List“ im Konfigurationsmenü können Sie eine Liste 
der Clips auf dem mobilen Speichergerät bzw. 
dem USB-Medium anzeigen.

Umbenennen eines Ordners auf dem mobilen 
Speichergerät bzw. dem USB-Medium

Mit der Befehlsfolge „Operation >USB >Rename 
Folder“ im Konfigurationsmenü können Sie einen 
Ordner umbenennen.

1	 Wählen Sie im Konfigurationsmenü die 
Befehlsfolge „Operation >USB >Rename 
Folder“.

2	 Wählen Sie den Ordner aus, den Sie 
umbenennen möchten, und drücken Sie die 
Taste SET.
Ein Bildschirm zur Eingabe des Dateinamens 
wird angezeigt.

3	 Geben Sie einen Ordnernamen ein und 
wählen Sie die Option [Done] auf dem 
Bildschirm.
Der Ordner wird umbenannt.

Überprüfen auf Lesefehler beim Kopieren

Nach dem Schreiben von Clips können Sie diese 
auf Lesefehler prüfen, indem Sie „Operation >USB 
>Error Check“ im Konfigurationsmenü auf „On“ 
setzen.

Formatieren eines mobilen Speichergeräts bzw. 
USB-Mediums

Mit der Befehlsfolge „Operation >USB >Format 
USB“ im Konfigurationsmenü können Sie mobile 
Speichergeräte bzw. USB-Medien im exFAT-Format 
formatieren.

1	 Wählen Sie im Konfigurationsmenü die 
Befehlsfolge „Operation >USB >Format USB“.

2	 Drehen Sie am Regler MENU, um [Execute] 
auszuwählen, und drücken Sie dann den 
Regler MENU.
Die Initialisierung (Formatierung) wird 
gestartet.

3	 Wenn die Formatierung abgeschlossen ist, 
erscheint eine Meldung auf dem Bildschirm. 
Wählen Sie [OK].

Überprüfen des freien Speicherplatzes auf dem 
mobilen Speichergerät bzw. dem USB-Medium

Der freie Speicherplatz auf dem mobilen 
Speichergerät bzw. dem USB-Medium wird in 
der Zeile „Media Remain“ auf dem Bildschirm 
angezeigt, wenn der Befehl „Operation >USB“ im 
Konfigurationsmenü ausgewählt wird.

Die Stromversorgung des mobilen Speichergeräts 
bzw. der USB-Medien

Mobile Speichergeräte bzw. USB-Medien werden 
automatisch vom Anschluss für externe Geräte mit 
Strom versorgt, wenn im Konfigurationsmenü ein 
mit „Operation >USB“ beginnender Bedienvorgang 
ausgeführt wird.
Unter den folgenden Umständen wird die 
Stromversorgung jedoch nicht gestartet, wenn 
im Konfigurationsmenü ein mit „Operation >USB“ 
beginnender Bedienvorgang ausgeführt wird. 
Wenden Sie zum Starten der Stromversorgung die 
in der Tabelle dargestellte Lösung an.

Status Lösung
Während der 
Aufzeichnung oder 
Wiedergabe von Clips, 
der Skizzenbildanzeige, 
der Proxy-Aufzeichnung, 
bei Streaming, Proxy-
Übertragung oder im 
Live-
Übertragungsmodus

Vorherigen Vorgang 
beenden.

Status Lösung
Network Client Mode ist 
auf On gestellt.

Network Client Mode auf 
Off stellen.

Medienadapter ist 
angeschlossen

Medienadapter 
auswerfen.

[Hinweise]
ˎˎ Clips auf dem mobilen Speichergerät oder einem anderen 

USB-Medium können nicht auf Speichermedien in SxS-
Kartensteckplätzen kopiert werden.
ˎˎ Während der Anschluss für externe Geräte mit Strom 

versorgt wird, können keine Clips aufgezeichnet werden. 
Um die Aufzeichnung von Clips zu starten, beenden Sie 
den mit „Operation >USB“ beginnenden Bedienvorgang 
im Konfigurationsmenü.
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Sie können den HD-Kamera-Adapter CA-FB70/TX70 anbringen und eine Kamerakontrolleinheit (CCU) 
anschließen.
Sie können so ein System für Aufnahmen und Aufzeichnungen konfigurieren, das aus mehreren 
Camcordern mit Kamera-Erweiterungsgeräten besteht, die an eine Fernbedienung angeschlossen sind.

Weitere Informationen zu dem CA-FB70 und der CA-TX70 finden Sie in den jeweiligen Bedienungsanleitungen.

[Hinweise]
ˎˎ Schließen Sie keine Videoleuchte an den Camcorder an, wenn Sie den Camcorder in diesem System verwenden.
ˎˎ Wird nur für XAVC- und MPEG HD-Aufzeichnung unterstützt.
ˎˎ Nicht unterstützt für Proxy-Aufzeichnung und WLAN-Verbindungsfunktion.

Kontroll- und Anrufanzeigen

Die Kontroll- und Anrufanzeigen für ein System sind vorhanden:

Vom System empfangene Daten HDVF LED-Anzeigen Textanzeige auf 
Sucherbildschirm

Kontrollanzeige Grüne 
Kontrollanzeige

CA-Anruf Nicht-
CA-Anruf

REC/
TALLY 
LED

GREEN 
TALLY 
LED

  CALL

OFF OFF OFF OFF Leuchtet 
nicht

Leuchtet 
nicht

Keine 
Anzeige.

Keine 
Anzeige.

Keine 
Anzeige.

OFF OFF OFF ON Leuchtet Leuchtet 
nicht

 Keine 
Anzeige.

CALL

OFF OFF ON OFF Leuchtet 
nicht

Leuchtet 
nicht

Keine 
Anzeige.

Keine 
Anzeige.

CALL

OFF OFF ON ON Leuchtet Leuchtet 
nicht

 Keine 
Anzeige.

CALL

OFF ON OFF OFF Leuchtet 
nicht

Leuchtet Keine 
Anzeige.

 Keine 
Anzeige.

OFF ON OFF ON Leuchtet Leuchtet   CALL

OFF ON ON OFF Leuchtet 
nicht

Leuchtet Keine 
Anzeige.

 CALL

OFF ON ON ON Leuchtet Leuchtet   CALL

ON OFF OFF OFF Leuchtet Leuchtet 
nicht

 Keine 
Anzeige.

Keine 
Anzeige.

ON OFF OFF ON Leuchtet 
nicht

Leuchtet 
nicht

Keine 
Anzeige.

Keine 
Anzeige.

CALL

ON OFF ON OFF Leuchtet Leuchtet 
nicht

 Keine 
Anzeige.

CALL

ON OFF ON ON Leuchtet 
nicht

Leuchtet 
nicht

Keine 
Anzeige.

Keine 
Anzeige.

CALL

ON ON OFF OFF Leuchtet Leuchtet   Keine 
Anzeige.

ON ON OFF ON Leuchtet 
nicht

Leuchtet Keine 
Anzeige.

 CALL

ON ON ON OFF Leuchtet Leuchtet   CALL

ON ON ON ON Leuchtet 
nicht

Leuchtet Keine 
Anzeige.

 CALL

[Hinweis]
Alarmanzeigen mit der Kontrollanzeige in der Warnanzeige werden nicht eingeblendet, wenn der Kamera-Adapter CA-FB70/
TX70 angeschlossen ist.

Konfigurieren eines Systems für Aufnahmen und Aufzeichnungen
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Unterstützte Formate und Einschränkungen bei Aufnahme-/
Aufzeichnungssystemen

Die folgende Tabelle enthält die unterstützten Formate und Einschränkungen beim Betrieb 
eines Aufnahme-/Aufzeichnungssystems bestehend aus Camcorder, Kamera-Adapter und 
Kamerasteuerungsgerät.

Menü „Operation“ Systemformat des  
Kamera-Adapters /  
Kamerasteuerungsgeräts

Camcorder-
Einschränkung

Format Input/Output Rückvideo-
AnzeigeFrequency Rec Format Output Format

SDI
59.94 XAVC-I 1920×1080P 1920×1080i 1920×1080 59.94i Nein

XAVC-L 50 
1920×1080P
XAVC-L 35 1080P
XAVC-I 1920×1080i 1920×1080i 1920×1080 59.94i Ja
XAVC-L 50 
1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HQ 1920×1080i
HQ 1440×1080i
SP 1440×1080i
XAVC-I 1280×720P 1280×720P 1280×720 59.94P Ja
XAVC-L 50 
1280×720P
HD422 50 720P
HQ 1280×720P

29.97 XAVC-I 1920×1080P 1920×1080PsF 1920×1080 29.97PsF a)

1920×1080 59.94i
Ja

XAVC-L 50 
1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 59.94P Nein

Menü „Operation“ Systemformat des  
Kamera-Adapters /  
Kamerasteuerungsgeräts

Camcorder-
Einschränkung

Format Input/Output Rückvideo-
AnzeigeFrequency Rec Format Output Format

SDI
23.98 XAVC-I 1920×1080P 1920×1080i 

(2-3PD)
1920×1080 59.94i Nein

XAVC-L 50 
1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P

HD422 50 720P 1280×720P 
(2-3PD)

1280×720 59.94P Nein

50 XAVC-I 1920×1080P 1920×1080i 1920×1080 50i Nein
XAVC-L 50 
1920×1080P
XAVC-L 35 1080P
XAVC-I 1920×1080i 1920×1080i 1920×1080 50i Ja
XAVC-L 50 
1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HQ 1920×1080i
HQ 1440×1080i
SP 1440×1080i
XAVC-I 1280×720P 1280×720P 1280×720 50P Ja
XAVC-L 50 
1280×720P
HD422 50 720P
HQ 1280×720P

25 XAVC-I 1920×1080P 1920×1080PsF 1920×1080 25PsF a)

1920×1080 50i
Ja

XAVC-L 50 
1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 50P Nein

a)	 Die PsF-Einstellung wird empfohlen, wenn der Kamera-Adapter CA-TX70 angeschlossen ist.

[Hinweis]
In einem Aufnahme-/Aufzeichnungssystem können spezielle Aufnahmefunktionen wie WLAN-Verbindungsfunktion oder 
Zeitlupe und Zeitraffer nicht gleichzeitig verwendet werden.
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Sie können SDI-Signale von Geräten aufzeichnen, die an den SDI-IN-Anschluss des Camcorders 
angeschlossen sind.

Um Signale anstelle des Kamerabilds auszugeben und aufzuzeichnen, stellen Sie „Operation >Input/
Output >Source Select“ im Konfigurationsmenü auf [External].

[Hinweise]
ˎˎ Externe Eingangssignale können im Zeitlupen- und Zeitraffermodus nicht aufgezeichnet werden. Wenn ein Spezial-

Aufzeichnungsmodus wie Zeitlupe und Zeitraffer ausgewählt wird, wird der Aufzeichnungsmodus abgebrochen, wenn Sie 
„Operation >Input/Output >Source Select“ im Konfigurationsmenü auf [External] stellen.
ˎˎ Die Ausführung der automatischen Anpassungsfunktionen wie automatischer Schwarzabgleich und Operationen wie 

Wiedergabe, Rec Review und Miniaturbildanzeige werden beendet, wenn „Operation >Input/Output >Source Select“ im 
Konfigurationsmenü auf [External] gesetzt wird. Der Camcorder schaltet in den Stoppmodus und das Kamerabild wechselt 
zum externen Eingang.
ˎˎ Die Aufzeichnung wird ggf. gestoppt, wenn beim Aufnehmen von externen Eingangssignalen das Eingangssignal gestört 

wird. Sobald das Eingangssignal wieder einen normalen Zustand angenommen hat, wird die Aufzeichnung fortgesetzt.
ˎˎ Nicht unterstützt für Proxy-Aufzeichnung und WLAN-Verbindungsfunktion.

Unterstützte externe Eingangssignalformate und Aufzeichnungsformate des 
Camcorders

HD/SD „Operation >Format >Rec 
Format“ im 
Konfigurationsmenü

„Operation >Format 
>Frequency“ im 
Konfigurationsmenü

Unterstützte externe 
Eingangssignalformate

HD XAVC-I 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-I 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-L 50 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-L 50 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD/SD „Operation >Format >Rec 
Format“ im 
Konfigurationsmenü

„Operation >Format 
>Frequency“ im 
Konfigurationsmenü

Unterstützte externe 
Eingangssignalformate

HD HD422 50 1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD422 50 720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

SP 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i 
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i 
HD 1280×720 50P

HQ 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

SD MPEG IMX 50 59.94 SD 486 59.94i
50 SD 576 50i

DVCAM 59.94 SD 486 59.94i
50 SD 576 50i

Aufzeichnung externer Eingangssignale
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Wartung
Reinigung des Suchers

Reinigen Sie den CRT-Sucher und den Spiegel im 
Zylinder des Suchers mit einem Blasepinsel.
Reinigen Sie das Objektiv und die Schutzfilter mit 
einem im Handel erhältlichen Objektivreiniger.

[Hinweis]
Verwenden Sie keine Lösungsmittel, wie z. B. Verdünner.

Hinweis zum Batteriekontakt

Der Batteriekontakt dieses Geräts (der Anschluss 
für Akkus und Netzteile) ist ein Verbrauchsteil.
Das Gerät wird möglicherweise nicht richtig 
mit Strom versorgt, wenn die Stifte des 
Batteriekontakts durch Stöße oder Vibrationen 
verbogen oder deformiert sind, oder wenn 
sie aufgrund längerer Verwendung im Freien 
korrodiert sind.
Regelmäßige Kontrollen werden empfohlen, um 
richtige Funktion und lange Lebensdauer des 
Geräts sicherzustellen.
Wenden Sie sich für weitere Auskünfte über 
Kontrollen am Gerät an Ihren Sony-Kundendienst 
oder -Händler.

Auswechseln der Batterie der 
internen Uhr

Die interne Uhr des Camcorders wird mit einer 
Lithium-Batterie betrieben. Beim Erscheinen der 
Meldung „BackUp Battery End“ im Sucher muss die 
Batterie ersetzt werden. Wenden Sie sich an einen 
Sony Handelsvertreter.
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Wenn eine mit „Warnung“ oder „Achtung“ gekennzeichnete Situation oder ein Betriebszustand eintritt, bei dem eine Bestätigung erforderlich ist, wird im Sucher des Camcorders eine Meldung angezeigt, die 
entsprechenden Anzeigen beginnen zu blinken und ein Warnton wird ausgegeben.
Sie können die Lautstärke des Warnsignals mit dem Regler ALARM einstellen. Wenn der Regler ALARM auf den Minimalwert eingestellt ist, ist der Warnton nicht hörbar.

Fehlermeldungen

Der Camcorder stellt den Betrieb ein, wenn eine der folgenden Situationen eintritt.

Fehlermeldung Warntöne Anzeige 
WARNING

Anzeige Tally/REC Ursache und Lösung

E + error code Kontinuierlich — Sehr schnelles Blinken Weist auf eine Störung des Camcorders hin.
Camcorder ausschalten und auf Fehler bei den angeschlossenen Geräten, Kabeln oder Medien überprüfen.
(Falls sich der Camcorder nicht ausschalten lässt, indem der Schalter POWER auf OFF gestellt wird, Batterie entnehmen oder 
Wechselstromversorgung trennen.)
Falls der Fehler weiterhin auftritt, wenn der Camcorder erneut eingeschaltet wird, wenden Sie sich an Ihren Sony-
Kundendienstmitarbeiter.

Warnmeldungen

Befolgen Sie in den folgenden Fällen den entsprechenden Anweisungen.

Warnmeldung Warntöne Anzeige 
WARNING

Anzeige Tally/REC Ursache und Lösung

Media Near Full Unterbrochen blinkt blinkt Auf der SxS-Speicherkarte ist nur noch wenig Kapazität frei.
Bei nächster Gelegenheit ersetzen.

Media Full Kontinuierlich On Sehr schnelles Blinken Clips konnten nicht aufgezeichnet, kopiert oder gesplittet werden, da keine Restkapazität auf der SxS-Speicherkarte vorhanden 
ist.
Sofort ersetzen.

Battery Near End Unterbrochen blinkt blinkt Die Akkuladung geht zu Ende.
Bei nächster Gelegenheit aufladen.
(Die Batterieanzeige blinkt im Sucher.)

Battery End Kontinuierlich On Sehr schnelles Blinken Der Akku ist leer.
Die Aufzeichnung wird deaktiviert.
Stromquelle mit dem Anschluss DC IN verbinden und den Akku aufladen, ohne den Camcorder zu bedienen.
(Die Batterieanzeige blinkt im Sucher.)

Temperature High Unterbrochen blinkt blinkt Die interne Temperatur ist zu hoch.
Camcorder ausschalten und vor der erneuten Verwendung abkühlen lassen.

Voltage Low Unterbrochen blinkt blinkt Die Spannung am Anschluss DC IN ist zu niedrig (Stufe 1).
Stromquelle prüfen.

Fehler-/Warnsystem
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Warnmeldung Warntöne Anzeige 
WARNING

Anzeige Tally/REC Ursache und Lösung

Insufficient Voltage Kontinuierlich On Sehr schnelles Blinken Die Spannung am Anschluss DC IN ist zu niedrig (Stufe 2).
Die Aufzeichnung wird deaktiviert.
Eine andere Stromquelle anschließen.
(Die Batterieanzeige blinkt im Sucher.)

Clips Full Kontinuierlich On Sehr schnelles Blinken Die Höchstanzahl Clips, die auf einer SxS-Speicherkarte aufgezeichnet werden können, wurde erreicht. Das Aufzeichnen oder 
Kopieren weiterer Clips ist nicht möglich. Sofort ersetzen.

Last Clip Recording Unterbrochen blinkt blinkt Der gegenwärtig aufgezeichnete Clip ist der letzte, der aufgezeichnet werden kann, da die Höchstanzahl Clips erreicht wurde.
Neue SxS-Speicherkarte vorbereiten.

Clips Near Full Unterbrochen blinkt blinkt Die Anzahl zusätzlicher Clips, die auf einer SxS-Speicherkarte aufgezeichnet werden können, geht zur Neige.
Bei nächster Gelegenheit ersetzen.

Media(Proxy) Full Kontinuierlich On Sehr schnelles Blinken Proxy-Daten können nicht aufgezeichnet werden, da kein freier Speicherplatz mehr auf der SD-Karte für Proxy-Daten ist. Sofort 
ersetzen.

Clips(Proxy) Full Kontinuierlich On Sehr schnelles Blinken Die Höchstanzahl Clips, die auf der SD-Karte für Proxy-Daten aufgezeichnet werden können, wurde erreicht. Das Aufzeichnen 
weiterer Clips ist nicht möglich. Sofort ersetzen.

Media(Proxy) Near Full Unterbrochen blinkt blinkt Der verbleibende freie Speicherplatz auf der SD-Karte für Proxy-Daten geht zur Neige.
Bei nächster Gelegenheit ersetzen.

Last Clip(Proxy) Rec Unterbrochen blinkt blinkt Die gegenwärtig aufgezeichneten Proxy-Daten sind der letzte Clip, der aufgezeichnet werden kann, da die Höchstanzahl Clips 
erreicht wurde.
Neue SD-Karte für Proxy-Daten vorbereiten.

Clips(Proxy) Near Full Unterbrochen blinkt blinkt Die Anzahl zusätzlicher Clips, die auf der SD-Karte für Proxy-Daten aufgezeichnet werden können, geht zur Neige. Bei nächster 
Gelegenheit ersetzen.

Media(A) 1) Full Kontinuierlich On Sehr schnelles Blinken Bei Verwendung der Funktion Simul Rec
Media(A) 1) Clips Full Kontinuierlich On Sehr schnelles Blinken Bei Verwendung der Funktion Simul Rec
Media(A) 1) Near Full Unterbrochen blinkt blinkt Bei Verwendung der Funktion Simul Rec
Media(A) 1) Last Clip Rec Unterbrochen blinkt blinkt Bei Verwendung der Funktion Simul Rec

1)	 Für Karten im Einschub B wird „(B)“ angezeigt.
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Meldungen der Kategorie „Achtung“ und Bedienungsmeldungen

Die folgenden Meldungen der Kategorie „Achtung“ und Bedienungsmeldungen können in der Mitte des 
Bildschirms angezeigt werden. Folgen Sie den Anweisungen zur Behebung des Problems.

Display-Anzeige Ursache und Lösung
Battery Error
Please Change Battery

Ein Fehler beim Akkupack wurde erkannt.
Durch ordnungsgemäßen Akku ersetzen.

Backup Battery End
Please Change

Die verbleibende Kapazität der Pufferbatterie reicht nicht aus.
Pufferbatterie ersetzen.

Unknown Media(A) 1)

Please Change
•	 Eine Speicherkarte, die partitioniert wurde, oder eine 

Speicherkarte mit mehr Clips, als vom Camcorder verarbeitet 
werden können, wurde eingesetzt.

•	 Eine SxS-Karte wurde eingesetzt und das Dateisystem ist auf 
FAT eingestellt.

•	 Eine SDHC-Karte wurde eingesetzt und das Dateisystem ist auf 
exFAT oder UDF eingestellt. 

Die Karte kann nicht im Camcorder verwendet werden und muss 
ersetzt werden.

Media Error
Media(A) 1) Needs to be Restored

Beim Lesen der Speicherkarte ist ein Fehler aufgetreten, und die 
Karte muss wiederhergestellt werden.
Karte auswerfen, erneut einsetzen und dann reparieren.

Media Error
Cannot Record to Media(A) 1)

Die Speicherkarte ist möglicherweise beschädigt und kann nicht 
mehr für die Aufnahme verwendet werden.
Wiedergabe ist möglich. Es empfiehlt sich, eine Kopie zu erstellen 
und die Speicherkarte zu ersetzen.

Media Error
Cannot Use Media(A) 1)

Die Speicherkarte ist möglicherweise beschädigt und kann nicht 
mehr für die Aufnahme oder Wiedergabe verwendet werden.
Die Karte kann nicht im Camcorder verwendet werden und muss 
ersetzt werden.

Cannot Use Media(A) 1)

Unsupported File System
Es wurde eine Karte mit einem anderen Dateisystem oder eine 
unformatierte Karte eingesetzt.
Die Karte kann nicht im Camcorder verwendet werden und muss 
ersetzt oder mit dem Camcorder formatiert werden.

Media(A) 1) Error
Playback Halted

Wiedergabe kann nicht fortgesetzt werden, da ein Fehler beim 
Lesen von der Speicherkarte aufgetreten ist.
Wenn das Problem weiterhin auftritt, Kopie erstellen und 
Speicherkarte ersetzen.

Media(A) 1) Error Aufzeichnung wurde angehalten, da ein Speicherkarten-Fehler 
aufgetreten ist.
Wenn das Problem weiterhin auftritt, Speicherkarte ersetzen.

Display-Anzeige Ursache und Lösung
Different Media is Inserted
Cannot Use Media(A) 1)

Es wurde ein anderes Medium eingesetzt. Entfernen Sie die 
eingesetzte Karte, und setzen Sie eine Karte desselben Typs wie 
bei der zuvor eingesetzten Karte ein.

1)	 Für Karten im Einschub B wird „(B)“ angezeigt.
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Während des Betriebs angezeigte Meldungen
Dieser Abschnitt beschreibt die Bedeutung der Meldungen, die als Reaktion auf die Bedienung von Tasten, Schaltern oder Reglern Betrieb angezeigt werden können.

[Hinweise]
ˎˎ Es werden nur Meldungen behandelt, die im Zusammenhang mit möglichen Ursachen als Reaktion auf Bedienvorgänge angezeigt werden.
ˎˎ Meldungen, die angezeigt werden, wenn ein Bedienvorgang mit einem nicht verfügbaren (abgeblendet dargestellten) Menüpunkt versucht wird, werden nicht beschrieben.

Bedienvorgang Meldung Bedeutung und mögliche Ursache
Taste REC wurde gedrückt Media not exist Aufnahme nicht möglich, weil der SxS-Karteneinschub kein Speichermedium enthält.

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

Der Proxydaten-Aufzeichnungsmodus ist auf „On“ gestellt, es können jedoch keine Proxy-Daten aufgezeichnet werden, weil die 
SD-Karte für die Proxyfunktion nicht eingesetzt ist.

Media(Proxy)
Cannot Record
Media(Proxy) Error

Proxydaten können nicht aufgezeichnet werden, weil die Proxy-SD-Karte aufgrund eines Medienfehlers nicht beschrieben werden 
kann.

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

Proxydaten können nicht aufgezeichnet werden, weil die Proxy-SD-Karte schreibgeschützt ist.

Media(Proxy)
Cannot Record
NG: Preparing

Proxydaten können nicht aufgezeichnet werden, weil die Initialisierung des Proxydaten-Aufzeichnungsmoduls nicht abgeschlossen ist.

Der belegbare Schalter mit der Funktion 
„Proxy Rec Start/Stop“ wurde betätigt.

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

Proxydaten können nicht aufgezeichnet werden, weil die Proxy-SD-Karte nicht eingesetzt ist.

Media(Proxy)
Cannot Record
Media(Proxy) Error

Proxydaten können nicht aufgezeichnet werden, weil die Proxy-SD-Karte aufgrund eines Medienfehlers nicht beschrieben werden 
kann.

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

Proxydaten können nicht aufgezeichnet werden, weil die Proxy-SD-Karte schreibgeschützt ist.

Media(Proxy)
Cannot Record
NG: Preparing

Proxydaten können nicht aufgezeichnet werden, weil die Initialisierung des Proxydaten-Aufzeichnungsmoduls nicht abgeschlossen ist.

Taste PREV wurde gedrückt First Clip Top! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am ersten Einzelbild des ersten Clips befindet.
Taste F REV wurde gedrückt First Clip Top! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am ersten Einzelbild des ersten Clips befindet.
Tasten PREV und F REV wurden gedrückt First Clip Top! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am ersten Einzelbild des ersten Clips befindet.
Taste PLAY wurde gedrückt Last Clip End! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am letzten Einzelbild des letzten Clips befindet.
Taste NEXT wurde gedrückt Last Clip End! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am letzten Einzelbild des letzten Clips befindet.
Taste F FWD wurde gedrückt Last Clip End! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am letzten Einzelbild des letzten Clips befindet.
Tasten NEXT und F FWD wurden gedrückt Last Clip End! Der Befehl kann nicht ausgeführt werden, weil die Wiedergabeposition sich am letzten Einzelbild des letzten Clips befindet.
Medieneinschub wurde geändert Cannot Switch Slots Einschübe können während der Wiedergabe nicht ändern werden.
Speichermedium wurde entfernt Media removed Das Speichermedium wurde während des Lese- oder Schreibzugriffs (bei leuchtender Anzeige ACCESS) entfernt.
Schalter GAIN wurde betätigt Gain: xxdB

(wobei „xx“ für den Verstärkungswert steht)
Verstärkungseinstellung wurde geändert.
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Bedienvorgang Meldung Bedeutung und mögliche Ursache
Schalter DCC wurde betätigt DCC: On DCC wurde auf „On“ gesetzt.

DCC: Off DCC wurde auf „Off“ gesetzt.
Fixed By Hyper Gamma ! DCC kann nicht auf „On“ gesetzt werden, da „Gamma Category“ auf „HG“ oder „User“ eingestellt ist.

Weißabgleich-Schalter wurde betätigt White: Preset xxxxK
(wobei „xxxx“ für den Wert der 
Farbtemperatur steht)

Weißabgleich wurde auf den voreingestellten Wert geändert.

White: A xxxxK 
(wobei „xxxx“ für den Wert der 
Farbtemperatur steht)

Weißabgleich wurde auf den Wert von Speicher A geändert.

White: B xxxxK 
(wobei „xxxx“ für den Wert der 
Farbtemperatur steht)

Weißabgleich wurde auf den Wert von Speicher B geändert.

White: ATW     xxxxK 
(wobei „xxxx“ für den Wert der 
Farbtemperatur steht)

Weißabgleichmodus wurde zu ATW geändert.

Schalter SHUTTER wurde betätigt Shutter: 1/xxxx
(wobei „xxxx“ für die Belichtungszeit steht)

Verschlusszeit wurde geändert (Standard, Einstellungen für Speed-Modus).

Shutter: xxxx
(wobei „xxxx“ für die Belichtungszeit steht)

Verschlusszeit wurde geändert (Standard, Einstellungen für Angle-Modus).

ECS: xxxxHz
(wobei „xxxx“ für den Frequenzwert steht)

Verschlusszeit wurde geändert (ECS-Modus).

Regler MENU wurde gedreht ECS: xxxxHz
(wobei „xxxx“ für den Frequenzwert steht)

Verschlusszeit wurde geändert (ECS-Modus).

Iris Override: +x.xx
(wobei „+x.xx“ ein numerischer Wert ist)

Überschreibpegel der Blendenautomatik wurde geändert.

Schalter „Auto black“ wurde betätigt Color Bars
Cannot Proceed

Funktion kann nicht ausgeführt werden, weil ein Farbbalkensignal ausgegeben wird.

Test Saw
Cannot Proceed

Funktion kann nicht ausgeführt werden, weil ein Testsignal ausgegeben wird.

Not Available
Recording

Funktion kann nicht ausgeführt werden, weil eine Aufzeichnung im Gange ist.

Not Available
Playing back

Funktion kann nicht ausgeführt werden, weil eine Wiedergabe im Gange ist.

Not Available
Displaying Thumbnails

Funktion kann nicht ausgeführt werden, weil die Skizzenanzeige angezeigt wird.

Schalter „Auto White“ wurde betätigt Color Bars
Cannot Proceed

Funktion kann nicht ausgeführt werden, weil ein Farbbalkensignal ausgegeben wird.

Not Available Funktion kann nicht ausgeführt werden, weil eine Wiedergabe im Gange ist.
Playing back
Not Available
Displaying Thumbnails

Funktion kann nicht ausgeführt werden, weil die Skizzenanzeige angezeigt wird.

White Balance Preset Funktion kann nicht ausgeführt werden, weil der Weißabgleich auf den Voreinstellungswert eingestellt ist.
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Bedienvorgang Meldung Bedeutung und mögliche Ursache
Der belegbare Schalter mit der Funktion 
„ATW Hold“ wurde betätigt

ATW Hold Funktion „ATW Hold“ wurde aktiviert.
ATW Hold Off Funktion „ATW Hold“ wurde deaktiviert.

Der belegbare Schalter mit der Funktion 
„Clip Continuous Rec“ wurde betätigt

Cannot Proceed
Recording

Funktion kann nicht ausgeführt werden, weil eine Aufzeichnung im Gange ist.

Cannot Proceed Funktion kann nicht ausgeführt werden, weil ein CA-FB70/TX70-Kameraadapter an die CCU angeschlossen ist.
Der belegbare Schalter mit der Funktion 
„Picture Cache Rec“ wurde betätigt

Cannot Proceed
Recording

Funktion kann nicht ausgeführt werden, weil eine Aufzeichnung im Gange ist.

Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.
•	 Eine Wiedergabe ist im Gange
•	 Die Skizzenanzeige wird angezeigt
•	 Ein CA-FB70/TX70-Kameraadapter ist an die CCU angeschlossen.

Der belegbare Schalter mit der Funktion 
„Streaming“ wurde betätigt

Cannot Proceed
Network Client Mode Setting is “On”

Funktion kann nicht ausgeführt werden, weil der Netzwerkclientmodus aktiviert ist.

Cannot Proceed
Network Function is Disabled

Funktion kann nicht ausgeführt werden, weil die Netzwerkverbindungseinstellung auf „Off“ gesetzt ist.

Cannot Proceed
Network Client Mode Setting is “On”
Network Function is Disabled

Netzwerkclientmodus ist auf „On“ gesetzt, aber Funktion kann nicht ausgeführt werden, weil keine Netzwerkverbindung verfügbar ist.

Cannot Start Streaming
Streaming Disabled Temporarily

Funktion kann aus folgenden Gründen nicht ausgeführt werden.
•	 Eine Wiedergabe von Proxydaten ist im Gange
•	 Ein Clip mit dem Aufnahmeformat 1920×1080 wird im Format 1280×720 wiedergegeben
•	 Ein Clip mit dem Aufnahmeformat 1280×720 wird im Format 1920×1080 wiedergegeben

Cannot Start Streaming
Please stop Recording or Playback

Funktion kann nicht ausgeführt werden, weil eine Aufzeichnung bzw. Wiedergabe gestartet wurde, während das WLAN-Modul 
initialisiert wurde (einschließlich Skizzenbildanzeige).
Stoppen Sie die Aufzeichnung bzw. Wiedergabe (einschließlich Skizzenbildanzeige), um die Ausführung zu ermöglichen.
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Bedienvorgang Meldung Bedeutung und mögliche Ursache
Der belegbare Schalter mit der Funktion 
„Streaming“ wurde bei aktiviertem 
Netzwerkclientmodus betätigt.

Cannot Proceed
Streaming Setting is “On”

Die Konfiguration kann nicht ausgeführt werden, weil eine Streaming-Übertragung im Gange ist.

Cannot Connect to CCM
Network Function is Disabled

Die Verbindung zum Connection Control Manager kann nicht hergestellt werden, weil keine Netzwerkverbindung verfügbar ist.

Cannot Record Proxy Die Aufzeichnung von Proxydaten kann nicht gestartet werden, weil die Option „Maintenance >Network Client Mode >Preset 1, Preset 
2 oder Preset 3 >NCM with Proxy“ im Konfigurationsmenü auf „Disable“ eingestellt ist.

Proxy Recoding will be Stopped Die Aufzeichnung von Proxydaten wird gestoppt, weil die Option „Maintenance >Network Client Mode >Preset 1, Preset 2 oder Preset 
3 >NCM with Proxy“ im Konfigurationsmenü auf „Disable“ eingestellt ist.

Cannot Connect to CCM
Cannot Record Proxy

•	 Die Verbindung zum Connection Control Manager kann nicht hergestellt werden, weil keine Netzwerkverbindung verfügbar ist.
•	 Die Aufzeichnung von Proxydaten kann nicht gestartet werden, weil die Option „Maintenance >Network Client Mode >Preset 1, 

Preset 2 oder Preset 3 >NCM with Proxy“ im Konfigurationsmenü auf „Disable“ eingestellt ist.
Cannot Connect to CCM
Proxy Recoding will be Stopped

•	 Die Verbindung zum Connection Control Manager kann nicht hergestellt werden, weil keine Netzwerkverbindung verfügbar ist.
•	 Die Aufzeichnung von Proxydaten wird gestoppt, weil die Option „Maintenance >Network Client Mode >Preset 1, Preset 2 oder Preset 

3 >NCM with Proxy“ im Konfigurationsmenü auf „Disable“ eingestellt ist.
Cannot Connect to CCM
Invalid User Name or Password

Bei der Authentifizierung am Connection Control Manager ist ein Fehler aufgetreten.

Cannot Connect to CCM
Invalid Address or Port Number

Verbindung zum Connection Control Manager kann nicht hergestellt werden, weil die Adresse oder Portnummer des Connection 
Control Managers falsch angegeben wurde.

Der belegbare Schalter mit der Funktion 
„Auto Upload (Proxy)“ wurde betätigt

Cannot Proceed
Network Function is Disabled

Funktion kann nicht ausgeführt werden, weil die Initialisierung des Proxydaten-Aufzeichnungsmoduls und des WLAN-Modul nicht 
abgeschlossen ist.

Taste ONLINE wurde gedrückt und gehalten Cannot Proceed Funktion kann nicht ausgeführt werden, weil der Modus des WLAN-Moduls gewechselt oder die Stromversorgung abgeschaltet wird.
Der belegbare Schalter mit der Funktion 
„Zebra“ wurde betätigt oder die Stellung 
des Schalters ZEBRA am Sucher wurde 
geändert

Zebra: On Zebra wurde auf „On“ gesetzt.
Zebra: Off Zebra wurde auf „Off“ gesetzt.

Der Schalter ZEBRA am Sucher wurde 
betätigt

Zebra: On Zebra wurde auf „On“ gesetzt.
Zebra: Off Zebra wurde auf „Off“ gesetzt.

Der belegbare Schalter mit der Funktion 
„Master“ wurde betätigt

Marker: On Marker wurde auf „On“ gesetzt.
Marker: Off Marker wurde auf „Off“ gesetzt.

Der belegbare Schalter mit der Funktion 
„Peaking“ wurde betätigt

Peaking: On Peaking wurde auf „On“ gesetzt.
Peaking: Off Peaking wurde auf „Off“ gesetzt.

Der belegbare Schalter mit der Funktion 
„Video Signal Monitor“ wurde betätigt

Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.
•	 „Operation >Input/Output >SDI Out1 Select“ und „SDI Out2 Select“ im Konfigurationsmenü sind auf „Off“ gesetzt 
•	 „Operation >Input/Output >Output Format“ im Konfigurationsmenü ist auf 720×480P oder 720×576P gesetzt

Schalter OUTPUT wurde in die Position BARS 
(Farbbalkenanzeige) gestellt

Not Available
S&Q Motion: On

Funktion kann nicht ausgeführt werden, weil der Aufzeichnungsmodus S&Q Motion (Zeitlupe & Zeitraffer) aktiviert ist.

Der belegbare Schalter mit der Funktion 
„Digital Extender“ wurde betätigt

Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.
•	 Eine Wiedergabe ist im Gange
•	 Die Skizzenanzeige wird angezeigt
•	 Ein externes Eingangssignal wird eingegeben
•	 Farbbalken oder ein Testsignal werden ausgegeben
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Bedienvorgang Meldung Bedeutung und mögliche Ursache
ND-Filter wurde geändert 2: 1/4ND  xxxxK

(wobei „2: 1/4ND“ der ND-Filtertyp und 
„xxxx“ der Farbtemperaturwert ist)

ND-Filter wurde geändert.

ND:3 CC: x  xxxxK
(wobei „ND: 3“ der ausgewählte ND-Filtertyp 
und „CC: x  xxxx“ der ausgewählte CC-Filter- 
und Farbtemperaturwert nach der 
elektrischen Farbtemperatur-Konvertierung 
ist)

Der ND-Filter wurde geändert, während „ND Filter C.Temp“ auf „Off“ gesetzt und einem belegbaren Schalter die Funktion „Electrical 
CC“ zugewiesen war.

Der belegbare Schalter mit der Funktion 
„Color Temp SW 3200K“ wurde betätigt

Color Temp SW 3200K Color Temp SW 3200K wurde aktiviert.
Cannot Proceed 
ND Filter C.Temp: On

Änderung nicht möglich, weil „ND Filter C.Temp“ auf „On“ gesetzt ist.

Der belegbare Schalter mit der Funktion 
„Color Temp SW 4300K“ wurde betätigt

Color Temp SW 4300K Color Temp SW 4300K wurde aktiviert.
Cannot Proceed
ND Filter C.Temp: On

Änderung nicht möglich, weil „ND Filter C.Temp“ auf „On“ gesetzt ist.

Der belegbare Schalter mit der Funktion 
„Color Temp SW 5600K“ wurde betätigt

Color Temp SW 5600K Color Temp SW 5600K wurde aktiviert.
Cannot Proceed
ND Filter C.Temp: On

Änderung nicht möglich, weil „ND Filter C.Temp“ auf „On“ gesetzt ist.

Der belegbare Schalter mit der Funktion 
„Color Temp SW 6300K“ wurde betätigt

Color Temp SW 6300K Color Temp SW 6300K wurde aktiviert.
Cannot Proceed
ND Filter C.Temp: On

Änderung nicht möglich, weil „ND Filter C.Temp“ auf „On“ gesetzt ist.

Der belegbare Schalter mit der Funktion 
„Electrical CC“ wurde betätigt

ND:3 CC: x  xxxxK
(wobei „ND: 3“ der ausgewählte ND-Filtertyp 
und „CC: x  xxxx“ der ausgewählte CC-Filter- 
und Farbtemperaturwert nach der 
elektrischen Farbtemperatur-Konvertierung 
ist)

Elektrischer CC-Filter wurde geändert.

Cannot Proceed Änderung nicht möglich, weil „ND Filter C.Temp“ auf „On“ gesetzt ist.
Der belegbare Schalter mit der Funktion 
„CC5600K“ wurde betätigt

CC 5600K Die Einstellung „5600K“ wurde gewählt.
Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.

•	 „ND Filter C.Temp“ ist auf „On“ gesetzt
•	 „Electrical CC“ ist einem belegbaren Schalter zugewiesen, aber „5600K“ ist nicht „Electrical CC“ zugewiesen.

Der belegbare Schalter mit der Funktion 
„Shot Mark1“ wurde betätigt

Shot Mark1
(willkürliche Zeichenfolge bei der Definition 
der Planungsmetadaten)

Szenenmarkierung 1 wurde hinzugefügt.

Cannot Record Essence Mark
Reached Essence Mark Limit

Inhaltsmarkierung kann nicht hinzugefügt werden, da die maximale Anzahl von Inhaltsmarkierungen erreicht wurde.

Cannot Proceed Hinzufügen ist aus folgenden Gründen nicht möglich.
•	 Der Schreibvorgang ist nicht möglich, weil das Medium, auf dem die Clips aufgezeichnet werden sollen, schreibgeschützt ist.
•	 Funktion „Picture Cache Rec“ ist auf „On“ gesetzt
•	 Interval-Rec-Aufnahme ist im Gange 
•	 Medium ist schreibgeschützt
•	 Zielclip ist auf einer SD-Karte aufgezeichnet
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Bedienvorgang Meldung Bedeutung und mögliche Ursache
Der belegbare Schalter mit der Funktion 
„Shot Mark2“ wurde betätigt

Shot Mark2
(willkürliche Zeichenfolge bei der Definition 
der Planungsmetadaten)

Szenenmarkierung 2 wurde hinzugefügt.

Cannot Record Essence Mark
Reached Essence Mark Limit

Inhaltsmarkierung kann nicht hinzugefügt werden, da die maximale Anzahl von Inhaltsmarkierungen erreicht wurde.

Cannot Proceed Hinzufügen ist aus folgenden Gründen nicht möglich.
•	 Der Schreibvorgang ist nicht möglich, weil das Medium, auf dem die Clips aufgezeichnet werden sollen, schreibgeschützt ist.
•	 Funktion „Picture Cache Rec“ ist auf „On“ gesetzt
•	 Interval-Rec-Aufnahme ist im Gange
•	 Medium ist schreibgeschützt
•	 Zielclip ist auf einer SD-Karte aufgezeichnet

Der belegbare Schalter mit der Funktion 
„Clip Flag OK“ wurde betätigt

OK Clip Flag Clipmarkierung (OK-Markierung) wurde hinzugefügt.
Delete Clip Flag Clipmarkierung (OK-Markierung) wurde gelöscht (durch zweimaliges Drücken des Schalters).
Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.

•	 Medium ist schreibgeschützt
•	 Zielclip ist auf einer SD-Karte aufgezeichnet

Der belegbare Schalter mit der Funktion 
„Clip Flag NG“ wurde betätigt

NG Clip Flag Clipmarkierung (NG-Markierung) wurde hinzugefügt.
Delete Clip Flag Clipmarkierung (NG-Markierung) wurde gelöscht (durch zweimaliges Drücken des Schalters).
Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.

•	 Medium ist schreibgeschützt
•	 Zielclip ist auf einer SD-Karte aufgezeichnet

Der belegbare Schalter mit der Funktion 
„Clip Flag Keep“ wurde betätigt

KEEP Clip Flag Clipmarkierung (KEEP-Markierung) wurde hinzugefügt.
Delete Clip Flag Clipmarkierung (KEEP-Markierung) wurde gelöscht (durch zweimaliges Drücken des Schalters).
Cannot Proceed Funktion kann aus folgenden Gründen nicht ausgeführt werden.

•	 Medium ist schreibgeschützt
•	 Zielclip ist auf einer SD-Karte aufgezeichnet

Der belegbare Schalter mit der Funktion 
„Flash Band Reduce“ wurde betätigt

Flash Band Reduce: On Flash Band Reduce wurde auf „On“ gesetzt.
Flash Band Reduce: Off Flash Band Reduce wurde auf „Off“ gesetzt.

Taste SLOT SELECT wurde betätigt Switched Slot Zu verwendendes Speichermedium wurde geändert.
Eine mit Slow & Quick Motion belegte 
belegbare Taste wurde in einem 
Aufnahmeformat betätigt, das Slow & Quick 
Motion nicht unterstützt.

Cannot Proceed
S&Q Unsupported Rec Format

Slow & Quick Motion kann aufgrund des nicht unterstützten Formats nicht verwendet werden.
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In „User Data“ gespeicherte Einstellungen
Tabellenerklärung
Ja: Gespeichert
Nein: Nicht gespeichert
—: Nicht gespeichert (temporäre Einstellung)
Standardwert: ‌�Nicht in der Datei „Reference“ gespeichert, aber als Standardmenüvoreinstellung 

gespeichert, wenn File >Reference im Menü „Setup“ ausgeführt wird.

Menü „User“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Edit User Menu — Ja Nein Nein Nein

Menü „Operation“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Format Frequency Ja Nein Nein Nein
File System Ja Nein Nein Nein
Rec Format Ja Nein Nein Nein
Aspect Ratio (SD) Ja Nein Nein Nein
Audio Length (IMX) Ja Nein Nein Nein

Input/Output Output Format Ja Nein Nein Nein
Source Select Ja Nein Nein Nein
SDI Out1 Output Ja Nein Nein Nein
SDI Out2 Output Ja Nein Nein Nein
HDMI Output Ja Nein Nein Nein
SDI Out2/HDMI Super Ja Nein Nein Nein
Video Out Super Ja Nein Nein Nein
Down Converter Ja Nein Nein Nein
Wide ID Ja Nein Nein Nein
Wide Mode(Ext.) Ja Nein Nein Nein

Super Impose Super(VF Display) Ja Nein Nein Nein
Super(Menu) Ja Nein Nein Nein
Super(Marker) Ja Nein Nein Nein

LCD LCD Color Ja Nein Nein Nein
LCD Marker&Zebra Ja Nein Nein Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Rec Function Slow & Quick Motion Ja Nein Nein Nein
Frame Rate Ja Nein Nein Nein
Clip Continuous Rec Ja Nein Nein Nein
Picture Cache Rec Ja Nein Nein Nein
Cache Rec Time Ja Nein Nein Nein
Interval Rec Nein Nein Nein Nein
Number of Frames Ja Nein Nein Nein
Interval Time Ja Nein Nein Nein
Pre-Lighting Ja Nein Nein Nein
Simul Rec Ja Nein Nein Nein

Proxy Recording 
Mode

Setting Ja Nein Nein Nein
Size Ja Nein Nein Nein
Frame Rate — — — —
Bit Rate — — — —
Audio Channel Ja Nein Nein Nein

Assignable Switch <0> Ja Nein Nein Nein
<1> Ja Nein Nein Nein
<2> Ja Nein Nein Nein
<3> Ja Nein Nein Nein
<4> Ja Nein Nein Nein
<5> Ja Nein Nein Nein
Lens RET Ja Nein Nein Nein
Online Ja Nein Nein Nein
Zoom Speed Ja Nein Nein Nein

VF Setting Color Ja Nein Nein Nein
Color Mode Ja Nein Nein Nein
Peaking Type Ja Nein Nein Nein
Peaking Frequency Ja Nein Nein Nein
Peaking Color Ja Nein Nein Nein
VF Detail Level Ja Nein Nein Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Marker Setting Ja Nein Nein Nein
Color Ja Nein Nein Nein
Center Marker Ja Nein Nein Nein
Safety Zone Ja Nein Nein Nein
Safety Area Ja Nein Nein Nein
Aspect Marker Ja Nein Nein Nein
Aspect Select Ja Nein Nein Nein
Aspect Mask Ja Nein Nein Nein
Aspect Safety Zone Ja Nein Nein Nein
Aspect Safety Area Ja Nein Nein Nein
100% Marker Ja Nein Nein Nein
User Box Ja Nein Nein Nein
User Box Width Ja Nein Nein Nein
User Box Height Ja Nein Nein Nein
User Box H Position Ja Nein Nein Nein
User Box V Position Ja Nein Nein Nein

Gain Switch Gain<L> Ja Nein Nein Nein
Gain<M> Ja Nein Nein Nein
Gain<H> Ja Nein Nein Nein
Gain <Turbo> Ja Nein Nein Nein
Shockless Gain Ja Nein Nein Nein

Auto Iris Iris Override Ja Nein Nein Nein
Mode Ja Nein Nein Nein
Level Ja Nein Nein Nein
Speed Ja Nein Nein Nein
Clip High light Ja Nein Nein Nein
Detect Window Ja Nein Nein Nein
Detect Window Indication Nein Nein Nein Nein
Iris APL Ratio Ja Nein Nein Nein
Iris Var Width Ja Nein Nein Nein
Iris Var Height Ja Nein Nein Nein
Iris Var H Position Ja Nein Nein Nein
Iris Var V Position Ja Nein Nein Nein

Zebra Zebra Select Ja Nein Nein Nein
Zebra1 Level Ja Nein Nein Nein
Zebra1 Aperture Level Ja Nein Nein Nein
Zebra2 Level Ja Nein Nein Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Display On/Off Video Level Warning Ja Nein Nein Nein
Shutter Setting Ja Nein Nein Nein
ND Filter Position Ja Nein Nein Nein
Gain Setting Ja Nein Nein Nein
Rec/Play Status Ja Nein Nein Nein
Color Temp. Ja Nein Nein Nein
Frame Rate/Interval Ja Nein Nein Nein
Battery Remain Ja Nein Nein Nein
Timecode Ja Nein Nein Nein
Audio Level Meter Ja Nein Nein Nein
Media Status Ja Nein Nein Nein
SD Card(Utility) Ja Nein Nein Nein
Focus Position Ja Nein Nein Nein
Iris Position Ja Nein Nein Nein
Zoom Position Ja Nein Nein Nein
Extender Ja Nein Nein Nein
ALAC Ja Nein Nein Nein
AE Mode Ja Nein Nein Nein
Focus Mode Ja Nein Nein Nein
White Balance Mode Ja Nein Nein Nein
CC5600K Ja Nein Nein Nein
Rec Format Ja Nein Nein Nein
Gamma Ja Nein Nein Nein
Timecode Lock Ja Nein Nein Nein
Network Condition Ja Nein Nein Nein
Proxy Status Ja Nein Nein Nein
NW Client Mode Status Ja Nein Nein Nein
Streaming Status Ja Nein Nein Nein
GPS Ja Nein Nein Nein
Video Signal Monitor Ja Nein Nein Nein
Clip Name Ja Nein Nein Nein
Focus Assist Indicator Ja Nein Nein Nein
Focus Area Marker Ja Nein Nein Nein
Lens Info Ja Nein Nein Nein
WRR RF Level Ja Nein Nein Nein
Clip Number Ja Nein Nein Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

“!”LED Gain <!> Ja Nein Nein Nein
Shutter <!> Ja Nein Nein Nein
White Preset <!> Ja Nein Nein Nein
ATW Run <!> Ja Nein Nein Nein
Extender <!> Ja Nein Nein Nein
Filter <!> Ja Nein Nein Nein
Iris Override <!> Ja Nein Nein Nein

White Setting White Switch <B> Ja Nein Nein Nein
Shockless White Ja Nein Nein Nein
ATW Speed Ja Nein Nein Nein
ATW Mode Ja Nein Nein Nein
AWB Fixed Area Ja Nein Nein Nein
Filter White Memory Ja Nein Nein Nein

Offset White Offset White <A> Ja Nein Nein Nein
Warm Cool  <A> Ja Nein Nein Nein
Warm Cool Balance<A> Ja Nein Nein Nein
Offset White <B> Ja Nein Nein Nein
Warm Cool <B> Ja Nein Nein Nein
Warm Cool Balance<B> Ja Nein Nein Nein

Shutter Mode Ja Ja Nein Nein
Slow Shutter Setting Ja Ja Nein Nein

Number of Frames Ja Ja Nein Nein
Time Zone Time Zone Ja Nein Nein Nein
Clip Clip Naming Ja Nein Nein Nein

Title Prefix Ja Nein Nein Nein
Number Set Nein Nein Nein Nein

GPS GPS Ja Nein Nein Nein
Planning 
Metadata

Load Media(A) — — — —
Load Media(B) — — — —
Properties — — — —
Clear Memory — — — —
Clip Name Disp Ja Nein Nein Nein

USB Select Folder — — — —
View Clip List — — — —
Rename Folder — — — —
Error Check Ja Nein Nein Nein
Format USB — — — —
Copy to USB — — — —

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Flash Band 
Reduce

Setting Nein Nein Nein Nein

Menü „Paint“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Switch Status Gamma Ja Ja Standardwert Nein
Black Gamma Ja Ja Ja Nein
Matrix Ja Ja Ja Nein
Knee Ja Ja Ja Nein
White Clip Nein Ja Nein Nein
Detail Ja Ja Standardwert Nein
Aperture Ja Ja Standardwert Nein
Flare Ja Ja Standardwert Nein
Test Saw Ja Nein Nein Nein

White Color Temp <A> Ja Ja Ja Nein
Color Temp Balance <A> Ja Ja Ja Nein
R Gain <A> Ja Ja Ja Nein
B Gain <A> Ja Ja Ja Nein
Color Temp <B> Ja Ja Ja Nein
Color Temp Balance <B> Ja Ja Ja Nein
R Gain <B> Ja Ja Ja Nein
B Gain <B> Ja Ja Ja Nein

Black Master Black Ja Ja Ja Nein
R Black Ja Ja Ja Nein
B Black Ja Ja Ja Nein

Flare Setting Ja Ja Standardwert Nein
Master Flare Ja Ja Ja Nein
R Flare Ja Ja Ja Nein
G Flare Ja Ja Ja Nein
B Flare Ja Ja Ja Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Gamma Setting Ja Ja Standardwert Nein
Step Gamma Ja Ja Ja Nein
Master Gamma Ja Ja Ja Nein
R Gamma Ja Ja Ja Nein
G Gamma Ja Ja Ja Nein
B Gamma Ja Ja Ja Nein
Gamma Category Ja Ja Ja Nein
Gamma Select Ja Ja Ja Nein

Black Gamma Setting Ja Ja Ja Nein
Range Ja Ja Ja Nein
Master Black Gamma Ja Ja Ja Nein

Knee Setting Ja Ja Ja Nein
Point Ja Ja Ja Nein
Slope Ja Ja Ja Nein
Knee Saturation Ja Ja Ja Nein
Knee Saturation Level Ja Ja Ja Nein

White Clip Setting Nein Ja Nein Nein
Level Ja Ja Ja Nein

Detail Setting Ja Ja Standardwert Nein
Level Ja Ja Ja Nein
H/V Ratio Ja Ja Ja Nein
Crispening Ja Ja Ja Nein
Level Depend Ja Ja Ja Nein
Level Depend Level Ja Ja Ja Nein
Frequency Ja Ja Ja Nein
Knee Aperture Ja Ja Ja Nein
Knee Aperture Level Ja Ja Ja Nein
Limit Ja Ja Ja Nein
White Limit Ja Ja Ja Nein
Black Limit Ja Ja Ja Nein
V Black Limit Ja Ja Ja Nein
V Detail Creation Ja Ja Ja Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Detail (SD) Setting Ja Ja Standardwert Nein
Level Ja Ja Ja Nein
H/V Ratio Ja Ja Ja Nein
Crispening Ja Ja Ja Nein
Level Depend Ja Ja Ja Nein
Level Depend Level Ja Ja Ja Nein
Frequency Ja Ja Ja Nein
Knee Aperture Ja Ja Ja Nein
Knee Aperture Level Ja Ja Ja Nein
Limit Ja Ja Ja Nein
White Limit Ja Ja Ja Nein
Black Limit Ja Ja Ja Nein
V Black Limit Ja Ja Ja Nein
V Detail Creation Ja Ja Ja Nein
Cross Color Suppress Ja Ja Ja Nein

Aperture Setting Ja Ja Standardwert Nein
Level Ja Ja Ja Nein

Skin Detail Setting Ja Ja Ja Nein
Area Detection — — — —
Area Indication Nein Nein Nein Nein
Level Ja Ja Ja Nein
Saturation Ja Ja Ja Nein
Hue Ja Ja Ja Nein
Width Ja Ja Ja Nein

Matrix Setting Ja Ja Ja Nein
Adaptive Matrix Ja Ja Ja Nein
Preset Matrix Ja Ja Ja Nein
Preset Select Ja Ja Ja Nein
User Matrix Ja Ja Ja Nein
Level Ja Ja Ja Nein
Phase Ja Ja Ja Nein
User Matrix R-G Ja Ja Ja Nein
User Matrix R-B Ja Ja Ja Nein
User Matrix G-R Ja Ja Ja Nein
User Matrix G-B Ja Ja Ja Nein
User Matrix B-R Ja Ja Ja Nein
User Matrix B-G Ja Ja Ja Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Multi Matrix Setting Ja Ja Ja Nein
Area Indication Nein Nein Nein Nein
Color Detection — — — —
Reset — — — —
Axis Nein Nein Nein Nein
Hue Ja Ja Ja Nein
Saturation Ja Ja Ja Nein

V Modulation Setting Ja Nein Standardwert Nein
Master V Modulation Ja Ja Standardwert Nein
R V Modulation Ja Ja Standardwert Nein
G V Modulation Ja Ja Standardwert Nein
B V Modulation Ja Ja Standardwert Nein

Low Key 
Saturation

Setting Ja Ja Ja Nein
Level Ja Ja Ja Nein
Range Ja Ja Ja Nein

Saturation Mode Saturation Mode Ja Ja Ja Nein
Knee Saturation Ja Ja Ja Nein
Black Gamma Ja Ja Ja Nein
Low Key Saturation Ja Ja Ja Nein

Noise Suppression Setting Ja Ja Ja Nein
Level Ja Ja Ja Nein

Menü „Thumbnail“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Display Clip 
Properties

— — — — —

Set Index Picture — — — — —
Thumbnail View Essence Mark Thumbnail — — — —

Clip Thumbnail — — — —
Set Shot Mark Add Shot Mark1 — — — —

Delete Shot Mark1 — — — —
Add Shot Mark2 — — — —
Delete Shot Mark2 — — — —

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Set Clip Flag Add OK — — — —
Add NG — — — —
Add KEEP — — — —
Delete Clip Flag — — — —

Lock/Unlock Clip Select Clip — — — —
Lock All Clips — — — —
Unlock All Clips — — — —

Copy Clip Select Clip — — — —
All Clips — — — —

Delete Clip Select Clip — — — —
All Clips — — — —

Filter Clips OK — — — —
NG — — — —
KEEP — — — —
None — — — —

Customize View Thumbnail Caption Ja Ja Nein Nein

Menü „Maintenance“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

White Shading Channel Select Ja Nein Standardwert Nein
White H Saw Nein Nein Nein Nein
White H Para Nein Nein Nein Nein
White V Saw Nein Nein Nein Nein
White V Para Nein Nein Nein Nein
White Saw/Para Ja Nein Standardwert Nein

Black Shading Channel Select Ja Nein Standardwert Nein
Black H Saw Nein Nein Nein Nein
Black H Para Nein Nein Nein Nein
Black V Saw Nein Nein Nein Nein
Black V Para Nein Nein Nein Nein
Black Saw/Para Ja Nein Standardwert Nein
Master Black Ja Ja Ja Nein
Master Gain (TMP) — — — —
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Battery Near End:Info Battery Ja Nein Nein Nein
End:Info Battery Ja Nein Nein Nein
Near End:Sony Battery Ja Nein Nein Nein
End:Sony Battery Ja Nein Nein Nein
Near End:Other Battery Ja Nein Nein Nein
End:Other Battery Ja Nein Nein Nein
Detected Battery — — — —

DC Voltage Alarm DC Low Voltage1 Ja Nein Nein Nein
DC Low Voltage2 Ja Nein Nein Nein

Audio Front MIC Select Ja Nein Nein Nein
Rear XLR Auto Ja Nein Nein Nein
Front MIC CH1 Ref Ja Nein Nein Nein
Front MIC CH2 Ref Ja Nein Nein Nein
Rear MIC CH1 Ref Ja Nein Nein Nein
Rear MIC CH2 Ref Ja Nein Nein Nein
Line Input Ref Ja Nein Nein Nein
Min Alarm Volume Ja Nein Nein Nein
Speaker Attenuate Ja Nein Nein Nein
Headphone Out Ja Nein Nein Nein
Reference Level Ja Nein Nein Nein
Reference Out Ja Nein Nein Nein
CH1&2 AGC Mode Ja Nein Nein Nein
CH3&4 AGC Mode Ja Nein Nein Nein
AGC Spec Ja Nein Nein Nein
Limiter Mode Ja Nein Nein Nein
Output Limiter Ja Nein Nein Nein
CH1 Wind Filter Ja Nein Nein Nein
CH2 Wind Filter Ja Nein Nein Nein
CH3 Wind Filter Ja Nein Nein Nein
CH4 Wind Filter Ja Nein Nein Nein
1kHz Tone on Color Bars Ja Nein Nein Nein
MIC CH1 Level Ja Nein Nein Nein
MIC CH2 Level Ja Nein Nein Nein
Rear1/WRR Level Ja Nein Nein Nein
Rear2/WRR Level Ja Nein Nein Nein
Audio CH3 Level Ja Nein Nein Nein
Audio CH4 Level Ja Nein Nein Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

WRR Setting WRR Valid CH Sel Ja Nein Nein Nein
WRR CH Select Nein Nein Nein Nein
WRR Delay Comp Ja Nein Nein Nein
TX — — — —
TX Audio Peak — — — —
TX Input Level — — — —
TX ATT Level — — — —
TX LCF Frequency — — — —
TX System Delay Ja Nein Nein Nein
TX RF Power — — — —
TX Power Save — — — —
TX-Cam Power Sync Ja Nein Nein Nein

Timecode TC Out Ja Nein Nein Nein
DF/NDF Ja Nein Nein Nein
LTC UBIT Ja Nein Nein Nein
Counter Display Ja Nein Nein Nein

Essence Mark Find Mode Ja Nein Nein Nein
Camera Config HD SDI Remote I/F Ja Nein Nein Nein

Color Bars Select Ja Nein Nein Nein
User Menu Only Ja Nein Nein Nein
User Menu with Lock Nein Nein Nein Nein
RM Common Memory Ja Nein Nein Nein
RM Rec Start Ja Nein Nein Nein
SET Key on Thumbnail Ja Nein Nein Nein
ALAC Ja Nein Nein Nein

Preset White Color Temp <P> Ja Nein Nein Nein
C.Temp BAL <P> Ja Nein Nein Nein
R Gain <P> Ja Nein Nein Nein
B Gain <P> Ja Nein Nein Nein
AWB Enable <P> Nein Nein Nein Nein

White Filter ND Filter C.Temp Ja Nein Nein Nein
ND FLT C.Temp<1> Ja Nein Nein Nein
ND FLT C.Temp<2-4> Ja Nein Nein Nein
Electrical CC<A> Ja Nein Nein Nein
Electrical CC<B> Ja Nein Nein Nein
Electrical CC<C> Ja Nein Nein Nein
Electrical CC<D> Ja Nein Nein Nein



000 11. Anhang: In „User Data“ gespeicherte Einstellungen161

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

DCC Adjust DCC Function Select Ja Nein Nein Nein
DCC D Range Ja Nein Nein Nein
DCC Point Ja Nein Nein Nein
DCC Gain Ja Nein Nein Nein
DCC Delay Time Ja Nein Nein Nein
DCC Peak Filter Ja Nein Nein Nein

Flicker Reduce Mode Ja Nein Nein Nein
Frequency Ja Nein Nein Nein

Genlock Genlock Ja Nein Nein Nein
Reference — — — —

Auto Shading Auto Black Shading — — — —
Reset Black Shading — — — —
Master Gain (TMP) — — — —

APR APR — — — —
Reset — — — —

Basic 
Authentication

User Name Nein Nein Nein Nein
Password Nein Nein Nein Nein

Authentication User Name Nein Nein Nein Nein
Password Nein Nein Nein Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Network Setting Ja Nein Nein Nein
Wi-Fi Mode Ja Nein Nein Nein
NFC — — — —
WPS — — — —
Channel Ja Nein Nein Nein
SSID & Password — — — —
SSID — — — —
Wi-Fi 
Station 
Detail 
Settings

Scan Networks — — — —
SSID Nein Nein Nein Nein
Password Nein Nein Nein Nein
DHCP Ja Nein Nein Nein
IP Address Ja Nein Nein Nein
Subnet Mask Ja Nein Nein Nein
Gateway Ja Nein Nein Nein
DNS Auto Ja Nein Nein Nein
Primary DNS 
Server

Ja Nein Nein Nein

Secondary DNS 
Server

Ja Nein Nein Nein

Device Name (Wi-Fi) — — — —
IP Address (Wi-Fi) — — — —
Subnet Mask (Wi-Fi) — — — —
MAC Address (Wi-Fi) — — — —
Regenerate Password — — — —
Modem Ja Nein Nein Nein
Wired LAN Ja Nein Nein Nein
Wired LAN Remote Ja Nein Nein Nein
Wired 
LAN 
Detail 
Settings

DHCP Ja Nein Nein Nein
IP Address Ja Nein Nein Nein
Subnet Mask Ja Nein Nein Nein
Gateway Ja Nein Nein Nein
DNS Auto Ja Nein Nein Nein
Primary DNS 
Server

Ja Nein Nein Nein

Secondary DNS 
Server

Ja Nein Nein Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Network Client 
Mode

Setting Ja Nein Nein Nein
Preset Select Ja Nein Nein Nein
Preset 1 Display Name Ja Nein Nein Nein

CCM Address Ja Nein Nein Nein
CCM Port Ja Nein Nein Nein
User Name Nein Nein Nein Nein
Password Nein Nein Nein Nein
NCM with Proxy Ja Nein Nein Nein
Camera Control Ja Nein Nein Nein
Camera Setting Nein Nein Nein Nein

Preset 2 Wie Preset 1
Preset 3 Wie Preset 1

File Transfer File Transfer — — — —
Remote File Transfer Ja Nein Nein Nein
Auto Upload (Proxy) Ja Nein Nein Nein

Streaming Setting Nein Nein Nein Nein
Preset Select Ja Nein Nein Nein
Preset1 Size Ja Nein Nein Nein

Bit Rate Ja Nein Nein Nein
Type Ja Nein Nein Nein
Destination 
Address

Ja Nein Nein Nein

Destination Port Ja Nein Nein Nein
Preset2 Size Ja Nein Nein Nein

Bit Rate Ja Nein Nein Nein
Type Ja Nein Nein Nein
Destination 
Address

Ja Nein Nein Nein

Streaming Preset2 Destination Port Ja Nein Nein Nein
Preset3 Size Ja Nein Nein Nein

Bit Rate Ja Nein Nein Nein
Type Ja Nein Nein Nein
Destination 
Address

Ja Nein Nein Nein

Destination Port Ja Nein Nein Nein
Audio Channel Ja Nein Nein Nein

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Clock Set Date Mode Ja Nein Nein Nein
12H/24H Ja Nein Nein Nein
Date — — — —
Time — — — —

Language Select Ja Nein Nein Nein
Hours Meter Hours (System) — — — —

Hours (Reset) — — — —
Reset — — — —

Network Reset Reset — — — —
Fan Control Setting Ja Nein Nein Nein
VF Display Setting Chara/Marker Brightness Ja Nein Nein Nein
Version Number — — — —

Version Up — — — —
Net-Func Version Number — — — —
Net-Func Ver.Up — — — —

Menü „File“

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

User File Load SD Card — — — —
Save SD Card — — — —
File ID Nein Nein Nein Nein
Recall User Preset — — — —
Store User Preset — — — —
Clear User Preset — — — —
Load Customize Data Ja Nein Nein Nein
Load White Data Ja Nein Nein Nein

All File Load SD Card — — — —
Save SD Card — — — —
File ID Ja Nein Nein Nein
All Preset — — — —
Store All Preset — — — —
Clear All Preset — — — —
3Sec Clear Preset Nein Nein Nein Nein
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Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

Scene File Recall Internal Memory — — — —
Store Internal Memory — — — —
Load SD Card — — — —
Save SD Card — — — —
File ID Nein Ja Nein Nein
Scene White Data Ja Nein Nein Nein

Reference File Store Reference — — — —
Clear Reference — — — —
Load Reference(SD Card) — — — —
Save Reference(SD Card) — — — —
File ID Nein Nein Ja Nein

Lens File Display Mode Nein Nein Nein Nein
Recall Internal Memory — — — —
Store Internal Memory — — — —
Load SD Card — — — —
Save SD Card — — — —

Lens File File ID Nein Nein Nein Ja
File Source — — — —
Clear Lens Offset — — — —
Lens Auto Recall Ja Nein Nein Nein
Lens Serial Number — — — —
Lens Name — — — —
Lens Manufacturer — — — —
Master V Modulation Nein Nein Nein Ja
Lens Center H Nein Nein Nein Ja
Lens Center V Nein Nein Nein Ja
R Flare Nein Nein Nein Ja
G Flare Nein Nein Nein Ja
B Flare Nein Nein Nein Ja
White Offset R Nein Nein Nein Ja
White Offset B Nein Nein Nein Ja
Shading Ch Select Ja Nein Nein Nein
Shading H SAW Nein Nein Nein Ja
Shading H PARA Nein Nein Nein Ja
Shading V SAW Nein Nein Nein Ja
Shading V PARA Nein Nein Nein Ja

Menüpunkt Unterpunkt Dateityp
All Scene Reference Lens

User Gamma Current Settings — — — —
Load SD Card — — — —
Reset — — — —
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Spezialaufnahmenunterstützung der Aufzeichnungsformate

Format
Normale 

Aufnahme

Spezialaufnahme 1)

Picture Cache Rec Interval Rec
Slow & Quick 

Motion
Clip Continuous 

Rec
2-Slot Simul Rec

HD XAVC-I HD exFAT Ja Ja Ja Ja Ja Ja
XAVC-L422 HD 50 Ja Ja Ja Ja Ja Ja
XAVC-L422 HD 35 Ja Ja Ja Ja Ja Ja
XAVC-L422 HD 25 Ja Ja Ja – Ja Ja
MPEG HD422 exFAT Ja Ja Ja Ja Ja Ja

UDF Ja Ja Ja Ja Ja –
MPEG HD420 HQ exFAT Ja Ja – – – Ja

UDF Ja Ja – – – –
FAT Ja Ja – – – –

MPEG HD420 SP Ja Ja – – – –
SD MPEG IMX 50 exFAT Ja Ja – – – –

UDF Ja Ja – – – –
DVCAM exFAT Ja – – – – –

UDF Ja – – – – –

1) Einzelheiten zu unterstützter Bildgröße und Bildrate sowie zu unterstützten Funktionen siehe „Fortgeschrittene Funktionen“ (Seite 52).
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Aufzeichnung im Bildpuffermodus
Operation >Format im Konfigurationsmenü Cache Rec Time
Frequency Rec Format 0–2 sec 2–4 sec 4–6 sec 6–8 sec 8–10 sec 10–12 sec 12–14 sec 13–15 sec
59.94
50 (6 3/4)

XAVC-I 1920×1080P Ja Ja – – – – – –
XAVC-I 1920×1080i Ja Ja Ja Ja – – – –
XAVC-I 1280×720P Ja Ja Ja Ja – – – –
XAVC-L 50/35/25 Ja Ja Ja Ja Ja Ja Ja Ja
MPEG HD422 Ja Ja Ja Ja Ja Ja Ja Ja
MPEG HD420 HQ/SP Ja Ja Ja Ja Ja Ja Ja Ja
MPEG IMX50 Ja Ja Ja Ja Ja Ja Ja Ja
DVCAM – – – – – – – –

29.97
25
23.98

XAVC-I 1920×1080P Ja Ja Ja Ja – – – –
XAVC-L 50/35 Ja Ja Ja Ja Ja Ja Ja Ja
MPEG HD422 Ja Ja Ja Ja Ja Ja Ja Ja
MPEG HD420 HQ Ja Ja Ja Ja Ja Ja Ja Ja
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Lüfter und Batterie des Geräts sind 
Verbrauchsmaterialien, die regelmäßig ersetzt 
werden müssen.
Wenn das Gerät bei Raumtemperatur betrieben 
wird, sollten die Teile ca. alle 5 Jahre ersetzt 
werden.
Diese Ersatzfristen stellen jedoch nur eine 
allgemeine Richtlinie und keine Garantie 
der Lebensdauer dieser Teile dar. Weitere 
Informationen zum Austausch von Komponenten 
erhalten Sie bei Ihrem Händler.

Die Lebensdauer des Netzteils und des 
Elektrolytkondensators beträgt bei normalen 
Betriebstemperaturen und normaler Verwendung 
etwa 5 Jahre (8 Stunden pro Tag; 25 Tage 
pro Monat). Falls die Nutzung die normale 
Nutzungshäufigkeit überschreitet, ist die 
Lebensdauer ggf. entsprechend geringer.

Verwendung und Lagerung

Schützen Sie den Camcorder vor Stößen
ˎˎ Der interne Mechanismus könnte beschädigt 
oder das Gehäuse verzogen werden.
ˎˎ Wird ein auf dem Zubehörschuh angebrachtes 
Zubehörteil einem starken Stoß ausgesetzt, 
könnte der Zubehörschuh beschädigt werden. 
Verwenden Sie ihn in einem solchen Fall nicht 
mehr und wenden Sie sich an Ihren Fachhändler 
oder eine Sony Kundendienstvertretung.

Den Camcorder während des Betriebs nicht abdecken
Ein über den Camcorder gelegtes Kleidungsstück 
kann zu übermäßiger Wärmebildung im Inneren 
des Geräts führen.

Nach der Verwendung
Den Schalter POWER stets ausschalten.

Bei längerer Unterbrechung der Verwendung des 
Camcorders
Den Akkusatz entfernen.

Transport
ˎˎ Entfernen Sie die Medien vor dem Transport des 
Camcorders.
ˎˎ Wird der Camcorder in einem LKW, Schiff, 
Flugzeug oder sonstigen Transportmittel 
transportiert, packen Sie ihn wieder in seine 
Transportverpackung ein.

Camcorderpflege
Entfernen Sie mit einem Blasepinsel Staub und 
Schmutz von den Objektiven und optischen 
Filtern.
Reinigen Sie das Innere der Kamera nicht mit 
einem Blasepinsel. Wenn in der Luft enthaltene 
Staubpartikel in die Komponenten eindringen, 
kann es zu Funktionsstörungen kommen.
Wenn das Gehäuse des Camcorders verschmutzt 
ist, wischen Sie es mit einem weichen, trockenen 
Tuch ab. Verwenden Sie in extremen Fällen ein 
leicht mit Reinigungsmittel angefeuchtetes Tuch 
und trocknen Sie das Gehäuse anschließend ab. 
Verwenden Sie keine organischen Lösungsmittel 
wie Alkohol oder Verdünner, da diese die 
Oberfläche des Camcorders verfärben oder 
beschädigen können.

Im Fall von Betriebsproblemen
Sollten Sie Probleme mit dem Camcorder haben, 
wenden Sie sich an einen Sony Handelsvertreter.

Verwendungs- und Lagerort

Der Camcorder sollte waagerecht und gut belüftet 
aufbewahrt werden.
Folgende Umgebungen sind nicht zur 
Verwendung und Lagerung des Camcorders 
geeignet.
ˎˎ Übermäßige Hitze oder Kälte 
(Temperaturbereich: –5 °C bis +40 °C) 
Denken Sie daran, dass in warmen 
Klimazonen die Temperatur in einem Auto bei 
geschlossenen Fenstern im Sommer schnell 
50 °C überschreiten kann.
ˎˎ Feuchte oder staubige Orte

ˎˎ Orte, an welchen Einwirkung von Regen nicht 
ausgeschlossen ist
ˎˎ Starken Vibrationen ausgesetzte Orte
ˎˎ In der Nähe von Magnetfeldern
ˎˎ In unmittelbarer Nähe starker Magnetfelder 
aufbauender Radio- oder Fernsehsender.
ˎˎ Über längere Zeit in direktem Sonnenlicht oder 
der Nähe von Heizapparaten

So verhindern Sie elektromagnetische Interferenzen durch 
tragbare Kommunikationsgeräte
Die Verwendung von Mobiltelefonen und 
anderen Kommunikationsgeräten in der Nähe 
des Camcorders kann zu Fehlfunktionen und 
Interferenzen mit den Audio- und Videosignalen 
führen.
Es wird empfohlen, tragbare 
Kommunikationsgeräte in der Nähe des 
Camcorders auszuschalten.

Hinweis zu Laserstrahlen

Laserstrahlen können den CMOS-Bildsensor 
beschädigen. Falls Sie eine Szene aufnehmen, in 
der Laserstrahlen vorkommen, achten Sie darauf, 
den CMOS-Bildsensor nicht dem Laserstrahl 
oder reflektiertem bzw. gestreutem Laserlicht 
auszusetzen.

Kondensation

Wenn das Gerät aus einer kalten Umgebung in 
einen warmen Raum gebracht wird oder die 
Umgebungstemperatur schnell ansteigt, kann sich 
auf der Oberfläche des Geräts bzw. im Inneren des 
Geräts Feuchtigkeit ansammeln (Kondensation). 
Schalten Sie in diesem Fall das Gerät aus, und 
warten Sie, bis die Kondensation verdunstet ist, 
ehe Sie das Gerät verwenden. Die Verwendung 
des Gerätes bei gebildetem Kondenswasser kann 
zu Beschädigungen führen.

Installation des Zoomobjektivs

Das Objektiv muss korrekt montiert werden, 
da es sonst beschädigt werden kann. Lesen Sie 
dazu unbedingt den Abschnitt „Montage und 
Einstellung des Objektivs“ (Seite 28).

Sucher

Verhindern Sie, dass die Okularlinse des 
Camcorders direkt in die Sonne zeigt.  
Die Okularlinse kann die Sonnenstrahlen bündeln 
und das Innere des Suchers zum Schmelzen 
bringen.

Informationen zu den LCD-Anzeigen

Die LCD-Anzeige in diesem Gerät wird mit 
Hochpräzisionstechnologie hergestellt und 
erzielt so eine effektive Pixelrate von mindestens 
99,99%. Ein sehr geringer Anteil von Pixeln kann 
jedoch eventuell „hängenbleiben“, entweder 
immer aus (schwarz), immer an (rot, grün oder 
blau), oder blinkend. Außerdem können nach sehr 
langem Gebrauch diese „hängengebliebenen“ 
Pixel spontan auftreten aufgrund der äußeren 
Eigenschaften der Flüssigkristallanzeige. Diese 
Probleme stellen keine Fehlfunktion dar. Bitte 
beachten Sie, dass solche Probleme keinen Einfluss 
auf aufgezeichnete Daten haben.

Typischerweise bei CMOS-Bildsensoren 
auftretende Phänomene

Folgende, evtl. auf den Bildern erscheinende 
Phänomene sind typisch bei CMOS 
(Complementary Metal Oxide Semiconductor)- 
Bildsensoren. Sie stellen keine Fehlfunktion dar.

Weiße Flecken
Obwohl CMOS-Bildsensoren mit 
Hochpräzisionstechnologie hergestellt werden, 
können in seltenen Fällen winzige weiße Flecken 
auf der Anzeige erscheinen, die von kosmischer 

Wichtige Hinweise zur Verwendung
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Strahlung o. Ä. herrühren. Dies liegt an der 
generellen Beschaffenheit von CMOS-Bildsensoren 
und stellt keine Fehlfunktion dar. Diese weißen 
Flecken treten vor allem in folgenden Fällen auf:
ˎˎ beim Betrieb unter hohen 
Umgebungstemperaturen
ˎˎ bei erhöht eingestellten 
Hauptverstärkungswerten (Empfindlichkeiten)
ˎˎ beim Betrieb mit Langzeitbelichtung

Dieses Problem könnte durch das Ausführen des 
automatischen Schwarzabgleichs behoben werden.

Treppeneffekt (Aliasing)
Bei der Aufnahme von Streifen- oder 
Linienmustern erscheinen diese möglicherweise 
treppenförmig oder flimmern.

Flimmern
Bei Aufzeichnungen unter Beleuchtung 
von Entladungslampen, z. B. Leuchtstoff-, 
Natriumlampen oder Quecksilberdampflampen 
können Bildschirmflimmern, Farbabweichungen 
oder verzerrte horizontale Streifen auftreten.

Stellen Sie in solchen Fällen die automatische 
Flimmer-Reduzierung ein (siehe Seite 116). 
Wenn die für die Aufzeichnung gewählte 
Bildfrequenz ähnlich der Stromfrequenz ist, 
wird das Flimmern evtl. auch bei aktivierter 
Flimmer-Reduzierungsfunktion nicht ausreichend 
herabgesetzt. Verwenden Sie in solchen Fällen die 
elektronische Blende.

Fokalebene
Aufgrund der Charakteristiken der 
Erfassungselemente (CMOS-Bildsensoren) zum 
Einlesen der Videosignale können Motive, die 

schnell über die Anzeige laufen, leicht verzerrt 
erscheinen.

Blitzstreifen
Die Luminanz am oberen und unteren 
Bildschirmrand kann sich ändern, wenn ein 
Blitzstrahl oder eine schnell blinkende Lichtquelle 
aufgezeichnet wird. Sie können die mitgelieferte 
Anwendersoftware verwenden, um Clips zu 
korrigieren, die Einzelbilder mit Blitzstreifen 
enthalten.

Fragmentierung

Falls die Bilder nicht ordnungsgemäß 
aufgezeichnet/wiedergegeben werden können, 
versuchen Sie, das Medium zu formatieren.
Wenn die Bildaufzeichnung/-wiedergabe 
mit einem bestimmten Medium wiederholt 
wird, könnten die Dateien auf dem Medium 
fragmentiert und so deren ordnungsgemäße 
Aufzeichnung/Speicherung verhindert 
werden. Erstellen Sie in einem solchen Fall eine 
Sicherheitskopie der Clips auf dem Medium, 
und formatieren Sie dann das Medium mit 
Operation >Format Media (Seite 98) im 
Konfigurationsmenü.

Hinweise zur Sicherheit

ˎˎ SONY KANN KEINE HAFTUNG FÜR SCHÄDEN 
JEDER ART DURCH UNTERLASSENE 
GEEIGNETE SICHERHEITSMASSNAHMEN 
AN ÜBERTRAGUNGSGERÄTEN, DURCH 
UNVERMEIDBARE DATENPREISGABE AUFGRUND 
DER ÜBERTRAGUNGSSPEZIFIKATIONEN ODER 
DURCH SICHERHEITSPROBLEME JEGLICHER ART 
ÜBERNEHMEN.
ˎˎ Je nach Betriebsumgebung können unbefugte 
Dritte im Netzwerk unter Umständen auf dieses 
Gerät zugreifen. Achten Sie beim Verbinden 
des Geräts mit dem Netzwerk darauf, dass das 
Netzwerk gut abgesichert ist.
ˎˎ Der Kommunikationsinhalt kann von 

unautorisierten Dritten in der Nähe des 
Signals abgefangen werden, ohne dass 
Sie es merken. Wenn Sie die WLAN-
Kommunikation nutzen, implementieren Sie 
geeignete Sicherheitsmaßnahmen, um den 
Kommunikationsinhalt zu schützen.
ˎˎ Vom Sicherheitsstandpunkt sollten Sie 
unbedingt über einen Webbrowser auf 
das Steuerfenster zugreifen und die 
werkseitig eingestellten Werte für die 
Zugriffseinschränkung ändern, wenn das Gerät 
mit dem Netzwerk verbunden ist (Seite 77). 
Es wird auch empfohlen, das Passwort 
regelmäßig zu ändern.
ˎˎ Rufen Sie keine andere Website im Webbrowser 
auf, während Sie Einstellungen vornehmen 
oder nachdem Sie Einstellungen vorgenommen 
haben. Da der Anmeldestatus beim 
Webbrowser gespeichert bleibt, schließen Sie 
den Webbrowser, wenn Sie die Einstellungen 
abgeschlossen haben, um zu verhindern, dass 
unautorisierte Dritte das Gerät nutzen oder 
schädliche Programm ausführen.

Informationen zu GPS

Beim GPS-System (Global Positioning System) 
kann mithilfe höchst präziser USWeltraumsatelliten 
eine geografische Position berechnet werden. Das 
heißt, mit diesem System können Sie Ihre genaue 
Position auf der Erde feststellen.
Die GPS-Satelliten umkreisen die Erde in 20.000 
km Höhe auf 6 Erdumlaufbahnen. Das GPS-System 
besteht aus mindestens 24 GPSSatelliten.
Über einen GPS-Empfänger werden Funksignale 
von den Satelliten empfangen, aus denen sich 
auf der Grundlage der Bahndaten der Satelliten 
(Almanach-Daten) und der Signallaufzeit usw. die 
aktuelle Position des Empfängers berechnen lässt.
Die Positionsbestimmung erfolgt mithilfe der 
„Triangulation“. Ein GPS-Empfänger kann den 
Breitengrad und Längengrad einer Position 
anhand der Signale von mindestens 3 Satelliten 
bestimmen.

ˎˎ Da die Positionen von GPS-Satelliten ständig 
wechseln, kann die Positionsbestimmung 
längere Zeit dauern. Je nachdem, wo und 
wann Sie den Camcorder verwenden, kann der 
Empfänger die Position möglicherweise gar 
nicht bestimmen.
ˎˎ Mit dem „GPS“-System lässt sich die 
geografische Position durch die Triangulation 
der Funksignale von GPS-Satelliten bestimmen. 
Verwenden Sie den Camcorder dazu möglichst 
nicht an Orten, an denen Funksignale blockiert 
oder reflektiert werden, z. B. an einer von 
Gebäuden oder Bäumen usw. umgebenen 
Stelle im Schatten.
ˎˎ Verwenden Sie den Camcorder unter freiem 
Himmel, wo nichts den Empfang stört. An 
folgenden Orten bzw. in folgenden Fällen 
können unter Umständen keine Positionsdaten 
aufgenommen werden, weil der Camcorder 
keine Funksignale von den GPS-Satelliten 
empfangen kann.

–– In Tunnels, in Gebäuden oder im Schatten 
von Gebäuden.

–– Zwischen hohen Gebäuden oder in engen 
Straßenschluchten.

–– An unterirdischen oder von dichten Bäumen 
umgebenen Orten, unter hohen Brücken 
oder an Orten, an denen Magnetfelder 
erzeugt werden, z. B. in der Nähe von 
Hochspannungskabeln.

–– In der Nähe von Geräten, die Funksignale im 
vom Camcorder genutzten Frequenzbereich 
erzeugen, also in der Nähe von 
Mobiltelefonen usw. im 1,5-GHz- 
Frequenzbereich.

ˎˎ Wenn Sie Bilder, die bei Einstellung von „GPS“ 
auf „On“ aufgenommen wurden, hochladen 
oder teilen, kann der Aufnahmeort auf dem 
Internet aufgedeckt werden, selbst wenn 
dies nicht Ihre Absicht ist. Wenn Sie die 
Positionsdaten nicht aufzeichnen wollen, 
wählen Sie „Off“ für „GPS” (Seite 105).
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Abweichungen bei der Triangulation
ˎˎ Wenn Sie sich unmittelbar, nachdem Sie „GPS“ 
im Menü auf „On“ gesetzt haben, an einen 
anderen Ort begeben, braucht der Camcorder 
unter Umständen mehr Zeit, die Triangulation 
zu starten, als wenn Sie am gleichen Ort bleiben.
ˎˎ Abweichung aufgrund der Position von GPS-
Satelliten 
Der Camcorder nimmt automatisch eine 
Triangulation Ihrer aktuellen Position vor, wenn 
der Camcorder die Funksignale von mindestens 
3 GPS-Satelliten empfängt.  
Bei der Triangulation mithilfe der Signale von 
den GPS-Satelliten kann es zu einer Abweichung 
von etwa 10 m kommen. Je nach der 
Umgebung der Position kann die Abweichung 
auch höher ausfallen. In diesem Fall entspricht 
Ihre aktuelle Position unter Umständen nicht der 
anhand der GPS-Daten berechneten Position 
auf der Karte. Außerdem unterstehen die GPS-
Satelliten dem Verteidigungsministerium der 
USA und die Genauigkeit wird unter Umständen 
absichtlich reduziert.
ˎˎ Abweichung während des 
Triangulationsvorgangs 
Der Camcorder empfängt während der 
Triangulation regelmäßig Positionsdaten.

Einschränkungen beim Gebrauch von GPS
Verwenden Sie GPS je nach Situation und in 
Übereinstimmung mit den Vorschriften der Länder 
bzw. Regionen, in denen Sie es einsetzen.

Das geografische Koordinatensystem
Verwendet wird das geografische 
Koordinatensystem „WGS-84“.
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Technische Daten
Allgemeines

Masse	 Ca. 3,6 kg (nur Hauptgerät)
Abmessungen
		  (Einheit: mm, ohne herausragende 

Teile, nur Hauptgerät) 1)

15
0

26
9

332

1)	 Die Werte für die Abmessungen sind ungefähre Werte.

Spannungsversorgung
		  12 V (11 V bis 17,0 V) DC
Leistungsaufnahme
		  Ca. 22 W (nur Hauptgerät, beim 

Aufnehmen im XAVC-Format, LCD-
Monitor eingeschaltet)

		  Ca. 24 W (Sucher CBK-VF02, manuelles 
Objektiv, Mikrofon, beim 
Aufnehmen im XAVC-Format, LCD-
Monitor eingeschaltet)

[Hinweise]
ˎˎ Schließen Sie keine Videoleuchte mit einer 

Leistungsaufnahme von 50 W oder mehr an.
ˎˎ Bei Verwendung eines Akkus darf der 

Gesamtstromverbrauch der angeschlossenen 
Peripheriegeräte 40 W nicht überschreiten.
ˎˎ Bei Verwendung des AC-DN10 darf der 

Gesamtstromverbrauch der angeschlossenen 
Peripheriegeräte 50 W nicht überschreiten.
ˎˎ Bei Verwendung des AC-DN2B darf der 

Gesamtstromverbrauch der angeschlossenen 
Peripheriegeräte 85 W nicht überschreiten.
ˎˎ Schließen Sie am Anschluss DC OUT nur Geräte mit einer 

Betriebsstromstärke von maximal 1,8 A an.

Betriebstemperatur
		  0 °C bis 40 °C
Lagertemperatur
		  –20 °C bis +60 °C
Dateisystem
		  exFAT, UDF, FAT
Maximale Dauerbetriebszeit
		  Ca. 170 Minuten (mit BP-FLX75)
Aufzeichnungsformat (Video)
	 XAVC Intra
		  XAVC-I-Modus: CBG, 223 Mbit/s (max.), 

MPEG-4 AVC/H.264
	 XAVC Long
		  XAVC-L 50-Modus: VBR, 50 Mbit/s 

(max.), MPEG-4 AVC/H.264
		  XAVC-L 35-Modus: VBR, 35 Mbit/s 

(max.), MPEG-4 AVC/H.264
		  XAVC-L 25-Modus: VBR, 25 Mbit/s 

(max.), MPEG-4 AVC/H.264
	 MPEG-2 Long GOP
		  MPEG HD422-Modus: CBR, 50 Mbit/s, 

MPEG-2 422P@HL
		  MPEG HD420 HQ-Modus: VBR, 

35 Mbit/s (max.), MPEG-2 MP@HL
		  MPEG HD420 SP-Modus: CBR, 

25 Mbit/s, MPEG-2 MP@H-14
	 MPEG IMX
		  CBR, 50 Mbit/s
	 DVCAM
		  CBR, 25 Mbit/s
	 Proxy
		  AVC/H.264 Hauptprofil 4:2:0 Long GOP
		  1280×720/9 Mbit/s, 6 Mbit/s,
		  640×360/3 Mbit/s,
		  480×270/1 Mbit/s, 500 Kbit/s (VBR)
Aufzeichnungsformat (Audio)
	 XAVC Intra
		  LPCM 24 Bit, 48 kHz, 4-Kanal
	 XAVC Long
		  LPCM 24 Bit, 48 kHz, 4-Kanal
	 MPEG-2 Long GOP
		  MPEG HD422-Modus: LPCM 24 Bit, 

48 kHz, 4-Kanal
		  MPEG HD420 HQ-Modus: LPCM 16 Bit, 

48 kHz, 4-Kanal

	 MPEG IMX
		  LPCM 16/24 Bit, 48 kHz, 4-Kanal
	 DVCAM
		  LPCM 16 Bit, 48 kHz, 4-Kanal
	 Proxy
		  AAC-LC, 128 Kbit/s, 2-Kanal
Aufzeichnungs-/Wiedergabezeit
	 XAVC Intra
	   XAVC-I-Modus
		  Ca. 30 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	 XAVC Long
	   XAVC-L 50-Modus
		  Ca. 120 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	   XAVC-L 35-Modus
		  Ca. 170 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	   XAVC-L 25-Modus
		  Ca. 220 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	 MPEG-2 Long GOP
	   MPEG HD422-Modus
		  Ca. 120 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	   MPEG HD420 HQ-Modus
		  Ca. 180 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	   MPEG HD420 SP-Modus
		  Ca. 240 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	 MPEG IMX
		  Ca. 120 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)
	 DVCAM	
		  Ca. 220 Minuten: Mit SBP-64D/SBS-

64G1B (64 GB)

[Hinweis]
Die Angaben zu Aufnahme- und Wiedergabezeiten gelten 
für eine kontinuierliche Aufzeichnung als einzelner Clip. 
Je nach der Anzahl der gespeicherten Clips können die 
tatsächlichen Zeiten unter Umständen kürzer sein.

Bildfrequenz für Aufnahme
	 XAVC Intra

	   XAVC-I-Modus
		  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
		  1280×720/59.94P, 50P
	 XAVC Long
	   XAVC-L 50-Modus
		  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
		  1280×720/59.94P, 50P
	   XAVC-L 35-Modus
		  1920×1080/59.94P, 50P, 59.94i, 50i, 

29.97P, 23.98P, 25P
	   XAVC-L 25-Modus
		  1920×1080/59.94i, 50i
	 MPEG-2 Long GOP
	   MPEG HD422-Modus
		  1920×1080/59.94i, 50i, 29.97P, 23.98P, 

25P
		  1280×720/59.94P, 50P, 29.97P, 23.98P, 

25P
	   MPEG HD420 HQ-Modus
		  1920×1080/59.94i, 50i, 29.97P, 23.98P, 

25P
		  1440×1080/59.94i, 50i
		  1280×720/59.94P, 50P
	   MPEG HD420 SP-Modus
		  1440×1080/59.94i, 50i
	 MPEG IMX
		  720×486/59.94i
		  720×576/50i
	 DVCAM
		  720×480/59.94i
		  720×576/50i
	 Proxy
		  Hauptleitung 1920×1080: 29.97P, 25P, 

23.98P
		  Hauptleitung 1280×720: 59.94P, 50P, 

29.97P, 25P, 23.98P
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Eingänge/Ausgänge

Eingänge
GENLOCK IN:
		  BNC-Typ, 1,0 Vp-p, 75 Ohm, 

asymmetrisch
TC IN:	 BNC-Typ, 0,5 V bis 18 Vp-p, 10 Kiloohm 
AUDIO IN CH1/CH2:
		  XLR-Typ, 3-polig, Buchse
		  LINE / AES/EBU / MIC / MIC+48V 

umschaltbar
		  LINE: +4, 0, –3 dBu
		  AES/EBU: AES3-kompatibel
		  MIC: –70 dBu bis –30 dBu
MIC IN:	 XLR-Typ, 5-polig, Buchse, –70 dBu bis 

–30 dBu
WRR:	 D-sub 15-polig
		  Analog CH1: –40 dBu
		  Digital CH1/CH2: –40 dBFS
SDI IN:	 Kompatibel mit SMPTE ST292-1/259-

Standard
		  4-Kanal-Audio

Ausgänge
VIDEO OUT:
		  BNC-Typ, umschaltbar zwischen SD 

analog FBAS/HD-Y
SDI OUT 1/2:
		  BNC-Typ, 0,8 Vp-p, asymmetrisch  

(3G HD/1.5G HD/SD umschaltbar)
		  SMPTE ST424/425 Level-A/B, 

kompatibel mit ST292-1/259-
Standard

		  4-Kanal-Audio
AUDIO OUT:
		  XLR-Typ, 5-polig, Stecker, +4/0/–3 dBu 

(symmetrisch)
TC OUT:	 BNC-Typ, 1,0 Vp-p, 50 Ohm
EARPHONE (Stereo, Minibuchse):
		  –11 dBu (Referenzpegelausgang, 

maximale Monitorlautstärke, 
16 Ohm Last)

HDMI:	 Typ A, 19-polig

Sonstiges
DC IN:	 XLR-Typ, 4-polig, Stecker, 11 V bis 17 V 

DC
DC OUT:	 Runder 4-poliger Anschluss, 11 V 

bis 17 V DC, 1,8 A maximale 
Nennstromstärke

LENS:	 12-polig, Spannungsversorgung 
für Objektiv (11 V bis 17 V 
Gleichspannung, 1,0 A maximale 
Nennstromstärke)

REMOTE:	 8-polig
LIGHT:	 2-polig
USB:	 4-polig (Typ A) (2), 4-polig (Typ B)
VF:		  Rechteckiger 26-poliger Anschluss, 

runder 20-poliger Anschluss
Netzwerkanschluss:
		  Typ RJ45, 100BASE-TX (IEEE 802.3u), 

10BASE-T (IEEE 802.3)

Kamera

Bildwandler
		  2/3-Zoll-Typ, Full HD CMOS-Bildsensor 

“Exmor”  
1920 (H) × 1080 (V)

Typ		 3-Chip RGB
Optisches System
		  Prismensystem F1.4
ND-Filter	 1: Klar
		  2: 1/4ND
		  3: 1/16ND
		  4: 1/64ND
Empfindlichkeit
		  F12 (Systemfrequenz: 59.94i) 

(Standard)
		  (2000 Lux, 89,9% Reflexionsgrad, 

3200 K)
Minimale Beleuchtungsstärke
		  0,013 Lux (F1.4, +42 dB, 16-Bild-

Akkumulierung)
Signal/Rausch-Abstand des Bildes
		  62 dB (Rauschunterdrückung aktiviert) 

(Standard)
Horizontale Auflösung 
		  1000 TV-Bildzeilen oder höher
Schwarzpegel
		  3 ±1% (falls für Black im 

Konfigurationsmenü [±0] gewählt 
ist)

Verschlusszeit
		  59.94i/P, 50i/P: 1/60 bis 1/2000 s
		  29.97P: 1/40 bis 1/2000 s
		  25P: 1/33 bis 1/2000 s
		  23.94P: 1/32 bis 1/2000 s
Lange Verschlusszeit
		  2 bis 8, 16 Bilder
Dynamikbereich
		  600%
Schmiereffekte
		  –135 dB

Audiobereich

Sampling-Frequenz
		  48 kHz
Quantisierung
		  16/24 Bit
Belastbarkeit
		  20 dB (Werksvorgabe) (20, 18, 16, 

12 dB), EBUL
Frequenzgang
		  20 Hz bis 20 kHz (±3 dB oder weniger)
Dynamikbereich
		  90 dB (Standard)
Verzerrung
		  0,08% oder niedriger (–40 dBu 

Eingangspegel)
Eingebauter Lautsprecher
		  Monaural, 300 mW Ausgang

Anzeigebereich

LCD-Monitor
		  Bildschirmgröße 

8,8 cm (3,5 Zoll) Diagonale
		  Seitenverhältnis 

16:9
		  Anzahl der Pixel 

960 (H) × 540 (V)

Medienbereich

Karteneinschübe für SxS-Karten
		  Formfaktor: Express Card/34
		  Anzahl der Einschübe: 2
		  Anschluss: Entspricht dem PCMCIA 

Express Card-Standard
		  Bitrate beim Schreiben: 50 Mbit/s oder 

höher
		  Bitrate beim Lesen: 50 Mbit/s oder 

höher
SD-Karteneinschübe
		  Proxy (1), Dienstprogramm (1)

Objektivabschnitt (PXW-X400KC)

Objektivanschluss
		  Sony-Bajonettverschluss 2/3-Zoll
Brennweite
		  8,2 mm bis 164 mm
Zoom	 Manuell
Zoomfaktor
		  20
Maximale Blendenöffnung
		  1:1,9
Blende	 Umschaltbar autom./manuell
		  F1.9 bis F16 und C (geschlossen)



000 11. Anhang: Technische Daten171

Fokusbereich
		  Umschaltbar autom./manuell
		  Bereich 

900 mm bis ∞ (Makro aus) 
10 mm bis ∞ (Makro ein, 
Weitwinkel)

Filterdurchmesser
		  M82 mm, 0,75 mm Pitch
Makro	 Umschaltbar ein/aus

Objektivabschnitt (PXW-X400KF)

Objektivanschluss
		  Sony-Bajonettverschluss 2/3-Zoll
Brennweite
		  8 mm bis 128 mm 

(35-mm-Äquivalent: 31,5 mm bis 
503 mm)

Zoom	 Umschaltbar Motor/manuell
Zoomfaktor
		  16
Maximale Blendenöffnung
		  1:1,9
Blende	 Umschaltbar autom./manuell
		  F1.9 bis F16 und C (geschlossen)
Fokusbereich
		  Umschaltbar autom./manuell
		  Bereich 

800 mm bis ∞ (Makro aus) 
50 mm bis ∞ (Makro ein, 
Weitwinkel) 
732 mm bis ∞ (Makro ein, Tele)

Filterdurchmesser
		  M82 mm, 0,75 mm Pitch
Makro	 Umschaltbar ein/aus

Mitgeliefertes Zubehör

Schultergurt (1)

Cold Shoe-Zubehörsatz (1)
Objektivanschlusskappe
USB-WLAN-Modul (IFU-WLM3)
Schutzkappe (1)
Schutzvorrichtung (1)
Vor Verwendung dieses Geräts (1)
Bedienungsanleitung (CD-ROM) (1)
Objektiv (im Lieferumfang des PXW-X400KC 
enthalten) (1)
Autofokus-Objektiv (im Lieferumfang des  
PXW-X400KF enthalten) (1)
Auflagemaß-(Flanschbrennweite)-Einstellkarte (1)
Stereomikrofon (im Lieferumfang des  
PXW-X400KC/PXW-X400KF enthalten) (1)
Sucher (im Lieferumfang des PXW-X400KC/ 
PXW-X400KF enthalten) (1)
Windschutz für Stereomikrofon (im Lieferumfang 
des PXW-X400KC/PXW-X400KF enthalten) (1)

Zugehörige Geräte

Ausstattung zur Stromversorgung

Netzteil	 AC-DN10/DN2B
Akkusatz	 BP-FLX75
Akkuladegerät
		  BC-L70/L90/L70A

Objektiv, Sucher und Zusatzausstattung

Objektiv	 Nur 2/3-Zoll-Bajonettverschluss-
Objektiv

Sucher	 HDVF-20A/L750/EL20/EL30
Sucherdreharm
		  BKW-401

Ausstattung zur Fernbedienung

Fernbedienung
		  RM-B170/B750
		  RCP-1000/1500/1530

		  RCP-1001/1501

[Hinweis]
Netzwerksteuereinheit (CNU) wird nicht unterstützt.

HD-Kamera-Adapter

CA-FB70/TX70

[Hinweis]
Wenn der CA-FB70 angebracht ist und SDI OUT2 verwendet 
wird, benutzen Sie einen L-förmigen Adapter.

Medienadapter

MEAD-SD02 (für SD-Karten)

XQD ExpressCard-Adapter

QDA-EX1 (für XQD-Speicherkarten)

Datenträger für die Aufzeichnung

SxS-Speicherkarten
		  SxS PRO+
		  SxS PRO
		  SxS-1

Audiogeräte

Mikrofon	 ECM-678/674/673/680S
Mikrofonhalter
		  CAC-12
Drahtloser Digitalempfänger
		  DWR-S02D
UHF-Synthesizer-Tuner
		  WRR-855S
		  URX-S03D

Sonstige Peripheriegeräte

Stativbefestigung
		  VCT-14/U14
Videoleuchte
		  UC-D200A (Nippon Video System - 

NIPROS)
		  Ultralight (Anton Bauer)

Polster	 Schulterpolster (weich) CBK-SP01
WLAN-Adapter
		  CBK-WA02
Netzwerkadaptersatz
		  CBK-NA1

Produkte für Instandhaltung, Handhabung

Halterung	 A-2092-367-

Konstruktive Änderungen, die dem technischen 
Fortschritt dienen, bleiben vorbehalten.
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Hinweise
ˎˎ Führen Sie immer eine Probeaufnahme 
aus, und bestätigen Sie, dass die Aufnahme 
erfolgreich war. 
SONY KANN KEINE HAFTUNG FÜR SCHÄDEN 
JEDER ART, EINSCHLIESSLICH ABER 
NICHT BEGRENZT AUF KOMPENSATION 
ODER ERSTATTUNG, AUFGRUND VON 
FEHLFUNKTION DIESES GERÄTS ODER SEINER 
DATENTRÄGER, EXTERNEN SPEICHERSYSTEMEN 
ODER JEGLICHEN ANDEREN DATENGRÄGERN 
ODER SPEICHERSYSTEMEN ZUR AUFNAHME 
VON INHALTEN JEDER ART ÜBERNEHMEN.
ˎˎ Bestätigen Sie vor dem Gebrauch immer, 
dass das Gerät richtig arbeitet. SONY KANN 
KEINE HAFTUNG FÜR SCHÄDEN JEDER ART, 
EINSCHLIESSLICH ABER NICHT BEGRENZT 
AUF KOMPENSATION ODER ERSTATTUNG, 
AUFGRUND VON VERLUST VON AKTUELLEN 
ODER ERWARTETEN PROFITEN DURCH 
FEHLFUNKTION DIESES GERÄTS ODER AUS 
JEGLICHEM ANDEREN GRUND, ENTWEDER 
WÄHREND DER GARANTIEFRIST ODER NACH 
ABLAUF DER GARANTIEFRIST, ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR 
ANSPRÜCHE JEDER ART VON DEN BENUTZERN 
DIESES GERÄTS ODER VON DRITTER SEITE 
ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR VERLUST, 
RETTUNG ODER WIEDERHERSTELLUNG VON 
DATEN IM INTERNEN SPEICHERSYSTEM, 
AUF AUFZEICHNUNGSMEDIEN, EXTERNEN 
SPEICHERSYSTEMEN ODER ANDEREN MEDIEN 
BZW. SPEICHERSYSTEMEN ÜBERNEHMEN.
ˎˎ SONY KANN KEINE HAFTUNG FÜR DIE 
BEENDIGUNG ODER EINSTELLUNG VON 
DIENSTLEISTUNGEN BEZÜGLICH DIESES 
GERÄTS GLEICH AUS WELCHEM GRUND 
ÜBERNEHMEN.

Software-Downloads

Wenn das Gerät mit einer PC-Verbindung verwendet 
wird, laden Sie benötigte Treiber, Plugins und 
Anwendungssoftware von der folgenden Website 
herunter.

Sony-Website für professionelle Produkte:
USA	 http://pro.sony.com
Kanada	 http://www.sonybiz.ca
Lateinamerika	 http://sonypro-latin.com
Europa	 http://www.pro.sony.eu/pro
Naher Osten, Afrika	 http://sony-psmea.com
Russland	 http://sony.ru/pro/
Brasilien	 http://sonypro.com.br
Australien	 http://pro.sony.com.au
Neuseeland	 http://pro.sony.co.nz
Japan	 http://www.sonybsc.com
Asien-Pazifik	 http://pro.sony-asia.com
Korea	 http://bp.sony.co.kr
China	 http://pro.sony.com.cn
Indien	 http://pro.sony.co.in

Sony Creative Software, Software- Downloadseite: 
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment

Schaubild Peripheriegeräte und Zubehör

ECM-680S/678/674/673 
Mikrofon HD-Monitor/SD-Monitor

HD-Kamera-Adapter CA-FB70

HD-Kamera-Adapter CA-TX70

BP-FLX75 
Akku

BC-L70A 
Akkuladegerät

AC-DN10/DN2B 
Netzteil

SxS-Speicherkarten
SBS-32G1B, SBS-64G1B, SBS-128G1B, 
SBS-64D, SBS-128D, SBS-256D

Medienadapter MEAD-SD02

XQD ExpressCard-Adapter QDA-EX1

WRR-855S, URX-S03D 
UHF-Synthesizer-Tuner
Drahtloser Digitalempfänger DWR-S02D

CAC-12 
Mikrofonhalter

CBK-VF02 
Sucher

RM-B170/B750
RCP-1000/1500/1530
RCP-1001/1501
Fernbedienung

PXW-X400

HDVF-20A/L750/EL20/EL30 
Sucher

VCT-14 
Stativbefestigung

http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
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MPEG-4 AVC Patent Portfolio Lizenz

DIESES PRODUKT IST LIZENSIERT IM RAHMEN 
DER AVC PATENT PORTFOLIOLIZENZ FÜR DEN 
PERSÖNLICHEN GEBRAUCH EINES VERBRAUCHERS 
ODER SONSTIGE ZWECKE, FÜR DIE KEINE 
VERGÜTUNG GEZAHLT WIRD

(i)	 KODIEREN VON VIDEODATEN ENTSPRECHEND 
DEM STANDARD („AVC VIDEO“) UND/ODER 
(ii)	DEKODIEREN VON AVC-VIDEODATEN, DIE 
VON EINEM VERBRAUCHER ZUM PERSÖNLICHEN 
GEBRAUCH KODIERT UND/ODER VON EINEM 
ZUM ANGEBOT VON AVC VIDEO ERMÄCHTIGTEN 
VIDEOANBIETER ERHALTEN WURDEN.

FÜR JEGLICHE ANDERE VERWENDUNG WIRD KEINE 
LIZENZ ERTEILT, DIES WEDER AUSDRÜCKLICH 
NOCH IMPLIZIT. WEITERE INFORMATIONEN 
ERHALTEN SIE VON MPEG LA, L.L.C. SIEHE 
HTTP://WWW.MPEGLA.COM

END USER LICENSE AGREEMENT

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
CAMCORDER, PLEASE READ THIS END USER LICENSE 
AGREEMENT (“EULA”) CAREFULLY. BY USING THE SOFTWARE 
YOU ARE ACCEPTING THE TERMS OF THIS EULA. IF YOU DO 
NOT ACCEPT THE TERMS OF THIS EULA, YOU MAY NOT USE 
THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the camcorder, together with any 
updates/ upgrades provided by SONY, any printed, on-line or 
other electronic documentation for such software, and any 
data files created by operation of such software (collectively, 
the “SOFTWARE”). 

Notwithstanding the foregoing, any software in the 
SOFTWARE having a separate end user license agreement 
(including, but not limited to, GNU General Public license 
and Lesser/Library General Public License) shall be covered 
by such applicable separate end user license agreement 
in lieu of the terms of this EULA to the extent required by 
such separate end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property laws 
and international treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE (including, but not 
limited to, any images, photographs, animation, video, audio, 
music, text and “applets” incorporated into the SOFTWARE) 
is owned by SONY or one or more of the THIRD-PARTY 
SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the camcorder and only for your 
individual use. SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest (including, but 
not limited to, all intellectual property rights) in and to the 
SOFTWARE that this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt to 
derive source code, modify, reverse engineer, decompile, or 
disassemble any of the SOFTWARE, whether in whole or in 
part, or create any derivative works from or of the SOFTWARE 
unless such derivative works are intentionally facilitated by 
the SOFTWARE. You may not modify or tamper with any 
digital rights management functionality of the SOFTWARE. 
You may not bypass, modify, defeat or circumvent any 
of the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You may 
not separate any individual component of the SOFTWARE 
for use on more than one camcorder unless expressly 
authorized to do so by SONY. You may not remove, alter, 
cover or deface any trademarks or notices on the SOFTWARE. 
You may not share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, network 
services or other products other than SOFTWARE upon 
which the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). SONY 
and such suppliers do not warrant that the SOFTWARE, 
network services, contents or other products will continue 
to be available, or will operate without interruption or 
modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, you 
acknowledge that the SOFTWARE may include EXCLUDED 
SOFTWARE. Certain EXCLUDED SOFTWARE may be 
covered by open source software licenses (“Open Source 
Components”), which means any software licenses approved 
as open source licenses by the Open Source Initiative or any 
substantially similar licenses, including but not limited to any 
license that, as a condition of distribution of the software 
licensed under such license, requires that the distributor 
make the software available in source code format. If and 
to the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list of 
applicable OPEN SOURCE COMPONENTS included in the 
SOFTWARE from time to time, and the applicable terms and 
conditions governing its use. Such terms and conditions 
may be changed by the applicable third party at any time 
without liability to you. To the extent required by the licenses 
covering EXCLUDED SOFTWARE, the terms of such licenses 
will apply in lieu of the terms of this EULA. To the extent the 
terms of the licenses applicable to EXCLUDED SOFTWARE 
prohibit any of the restrictions in this EULA with respect to 
such EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms of 
the licenses applicable to Open Source Components require 
SONY to make an offer to provide source code in connection 

with the SOFTWARE, such offer is hereby made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you to 
view, store, process and/or use content created by you and/
or third parties. Such content may be protected by copyright, 
other intellectual property laws, and/or agreements. You 
agree to use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such content. You 
acknowledge and agree that SONY may take appropriate 
measures to protect the copyright of content stored, 
processed or used by the SOFTWARE. Such measures 
include, but are not limited to, counting the frequency of 
your backup and restoration through certain SOFTWARE 
features, refusal to accept your request to enable restoration 
of data, and termination of this EULA in the event of your 
illegitimate use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE DESIGNED 
TO BE USED WITH CONTENT AVAILABLE THROUGH ONE OR 
MORE CONTENT SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS SUBJECT TO THE TERMS 
OF SERVICE OF THAT CONTENT SERVICE. IF YOU DECLINE 
TO ACCEPT THOSE TERMS, YOUR USE OF THE SOFTWARE 
WILL BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are solely 
responsible for payment of any third party fees associated 
with your Internet connection, including but not limited 
to Internet service provider or airtime charges. Operation 
of the SOFTWARE may be limited or restricted depending 
on the capabilities, bandwidth or technical limitations of 
your Internet connection and service. The provision, quality 
and security of such Internet connectivity are the sole 
responsibility of the third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-export 
restrictions and regulations of the area or country in which 
you reside, and not to transfer, or authorize the transfer, 
of the SOFTWARE to a prohibited country or otherwise in 
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violation of any such restrictions or regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-line control 
equipment in hazardous environments requiring fail-safe 
performance, such as in the operation of nuclear facilities, 
aircraft navigation or communication systems, air traffic 
control, direct life support machines, or weapons systems, 
in which the failure of the SOFTWARE could lead to death, 
personal injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-PARTY 
SUPPLIERS, and each of their respective affiliates specifically 
disclaim any express or implied warranty, duty or condition 
of fitness for HIGH RISK ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE is 
at your sole risk and that you are responsible for use of the 
SOFTWARE. The SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, NONINFRINGEMENT AND FITNESS FOR 
A PARTICULAR PURPOSE. SONY DOES NOT WARRANT OR 
MAKE ANY CONDITIONS OR REPRESENTATIONS (A) THAT 
THE FUNCTIONS CONTAINED IN ANY OF THE SOFTWARE 
WILL MEET YOUR REQUIREMENTS OR THAT THEY WILL 
BE UPDATED, (B) THAT THE OPERATION OF ANY OF THE 
SOFTWARE WILL BE CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT THE SOFTWARE 
WILL NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE 
OR DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND (E) REGARDING 
THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN 
BY SONY OR AN AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR CONDITION OR 
IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SHOULD THE SOFTWARE PROVE DEFECTIVE YOU ASSUME 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW 

THE EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-PARTY 
SUPPLIERS shall be collectively referred to as “SONY”) SHALL 
NOT BE LIABLE FOR ANY INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY EXPRESS OR IMPLIED 
WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL THEORY RELATED 
TO THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO, ANY 
DAMAGES ARISING OUT OF LOSS OF PROFITS, LOSS OF 
REVENUE, LOSS OF DATA, LOSS OF USE OF THE SOFTWARE 
OR ANY ASSOCIATED HARDWARE, DOWN TIME AND USER’S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, EACH AND 
ALL OF THEIR AGGREGATE LIABILITY UNDER ANY PROVISION 
OF THIS EULA SHALL BE LIMITED TO THE AMOUNT 
ACTUALLY PAID FOR THE PRODUCT. SOME JURISDICTIONS 
DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA SECURITY
You acknowledge and agree that SONY and its affiliates, 
partners and agents may read, collect, transfer, process and 
store certain information collected from the SOFTWARE, 
including but not limited to information about (i) the 
SOFTWARE and (ii) the software applications, contents and 
peripheral devices that interact with your camcorder and the 
SOFTWARE (“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your camcorder 
and its components; (2) performance of the camcorder, the 
SOFTWARE and their components; (3) configurations of your 
camcorder, the SOFTWARE and the software applications, 
contents and peripheral devices that interact with the 
camcorder and the SOFTWARE; (4) use and frequency of use 
of the functions of (x) the SOFTWARE, and (y) the software 
applications, contents and peripheral devices that interact 
with the SOFTWARE; and (5) location data, as indicated 
below. SONY and its affiliates, partners and agents may use 
and disclose Information subject to applicable laws in order 
to improve its products and services or to provide products 
or services to you. Such uses include, but are not limited 
to: (a) administering the functionalities of the SOFTWARE; 
(b) to improve, service, update or upgrade the SOFTWARE; 
(c) improving, developing and enhancing the current and 
future products and services of SONY and other parties; (d) 
to provide you with information about the products and 
services offered by SONY and other parties; (e) complying 
with applicable laws or regulations; and (f) to the extent 

offered, providing you with location-based services of SONY 
and other parties, as indicated below. In addition, SONY 
retains the right to use Information to protect itself and third 
parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE may rely 
upon location information, including, but not limited to, the 
geographic location of the camcorder. You acknowledge 
that for the purpose of providing such services, SONY, 
the THIRD-PARTY SUPPLIERS or their partners may collect, 
archive, process and use such location data, and that such 
services are governed by the privacy policies of SONY or 
such third party. By using any such services, you agree that 
you have reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not intentionally 
use Information to personally identify the owner or user of 
the SOFTWARE without your knowledge or consent. Any use 
of Information will be in accordance with the privacy policies 
of SONY or such third party. Please contact applicable 
contact address of each area or country for SONY’s current 
privacy policy.

Please contact applicable third parties for privacy policies 
relating to personally identifiable and other information 
you provide when you use or access third party software or 
services.

Information may be processed, stored or transferred to 
SONY, its affiliates or agents which are located in countries 
outside of your country of residence. Data protection and 
information privacy laws in certain countries may not offer 
the same level of protection as your country of residence and 
you may have fewer legal rights in relation to Information 
processed and stored in, or transferred to, such countries. 
SONY will use reasonable efforts to take appropriate 
technical and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does not warrant it 
will eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-PARTY SUPPLIERS may 
automatically update or otherwise modify the SOFTWARE, 
including, but not limited to, for purposes of enhancement 
of security functions, error correction and improvement of 
functions, at such time as you interact with SONY’s or third 
parties’ servers, or otherwise. Such updates or modifications 
may delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not limited to, 
functions you may rely upon. You acknowledge and agree 
that such activities may occur at SONY’s sole discretion and 
that SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 

update or modifications. Any updates/modifications shall be 
deemed to be, and shall constitute part of, the SOFTWARE 
for purposes of this EULA. By acceptance of this EULA, you 
consent to such update/ modification. 

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA and SONY’s privacy policy, each as amended and 
modified from time to time, together constitute the entire 
agreement between you and SONY with respect to the 
SOFTWARE. The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not constitute a waiver of 
such right or provision. If any part of this EULA is held invalid, 
illegal, or unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to maintain the intent 
of this EULA, and the other parts will remain in full force and 
effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, without 
regards to conflict of laws provisions. Any dispute arising out 
of this EULA shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties hereby consent 
to the venue and jurisdiction of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or non-compliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY obtaining 
any injunctive or equitable relief that SONY deems necessary 
or appropriate in such circumstances. SONY may also take 
any legal and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not limited to, 
immediate termination of your use of the SOFTWARE, if 
SONY believes in its sole discretion that you are violating or 
intend to violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in equity or 
under contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its terms. 
In case of such termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) comply with the 
requirements in the section below entitled “Your Account 
Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE TERMS 
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OF THIS EULA AT ITS SOLE DISCRETION BY POSTING NOTICE 
ON A SONY DESIGNATED WEB SITE, BY EMAIL NOTIFICATION 
TO AN EMAIL ADDRESS PROVIDED BY YOU, BY PROVIDING 
NOTICE AS PART OF THE PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER LEGALLY 
RECOGNIZABLE FORM OF NOTICE. If you do not agree to 
the amendment, you should promptly contact SONY for 
instructions. Your continued use of the SOFTWARE after 
the effective date of any such notice shall be deemed your 
agreement to be bound by such amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended third-
party beneficiary of, and shall have the right to enforce, each 
provision of this EULA with respect to the SOFTWARE of such 
party.

Should you have any questions concerning this EULA, you 
may contact SONY by writing to SONY at applicable contact 
address of each area or country.

Copyright © 2012 Sony Corporation.

Lizenzen für freie Software

Auf der Grundlage von Lizenzverträgen zwischen 
Sony und den Software-Rechteinhabern 
verwendet dieses Produkt freie Software.
Um den Anforderungen der Software-
Rechteinhaber gerecht zu werden, ist Sony 
verpflichtet, Sie über den Inhalt dieser Lizenzen 
informieren.
Weitere Einzelheiten zum Inhalt dieser Lizenzen 
siehe „License1.pdf“ im Ordner „License“ auf der 
mitgelieferten CD-ROM.

Marken

ˎˎ XDCAM ist eine Marke der Sony Corporation.
ˎˎ XAVC und  sind eingetragene Marken der 
Sony Corporation.
ˎˎ XQD ist eine Marke der Sony Corporation.
ˎˎ Android und Google Chrome sind 
Handelsmarken oder eingetragene 
Handelsmarken von Google, Inc.
ˎˎ Microsoft und Windows sind in den USA 
bzw. anderen Ländern Handelsmarken oder 
eingetragene Handelsmarken der Microsoft 
Corporation.
ˎˎ Apple, Macintosh, Safari und iPhone und ihre 
Logos sind Marken oder eingetragene sind in 
den USA und anderen Ländern Handelsmarken 
oder eingetragene Handelsmarken von Apple 
Inc.
ˎˎ Die Begriffe HDMI und HDMI High-Definition 
Multimedia Interface sowie das HDMI-Logo sind 
Marken oder eingetragene Marken von HDMI 
Licensing Administrator, Inc. in den Vereinigten 
Staaten und anderen Ländern.
ˎˎ Wi-Fi, Wi-Fi-Logo und Wi-Fi Protected Setup sind 
Marken oder eingetragene Marken der Wi-Fi 
Alliance.
ˎˎ Das N-Symbol ist in den USA und anderen 
Ländern eine Marke oder registrierte Marke von 
NFC Forum, Inc.
ˎˎ Alle System- und Produktnamen sind 
Handelsmarken oder eingetragene 
Handelsmarken ihrer jeweiligen Eigentümer. 
Geschützte Elemente werden in diesem 
Dokument nicht durch die Symbole ® oder ™ 
gekennzeichnet.
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